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Notice
While reasonable efforts have been made to ensure that the 
information in this document is complete and accurate at the time 
of printing, Avaya assumes no liability for any errors. Avaya reserves 
the right to make changes and corrections to the information in this 
document without the obligation to notify any person or organization 
of such changes.
Documentation disclaimer
“Documentation” means information published in varying media 
which may include product information, subscription or service 
descriptions, operating instructions and performance specifications 
that are generally made available to users of products. 
Documentation does not include marketing materials. Avaya shall 
not be responsible for any modifications, additions, or deletions 
to the original published version of Documentation unless such 
modifications, additions, or deletions were performed by or on the 
express behalf of Avaya. End user agrees to indemnify and hold 
harmless Avaya, Avaya's agents, servants and employees against 
all claims, lawsuits, demands and judgments arising out of, or in 
connection with, subsequent modifications, additions or deletions to 
this documentation, to the extent made by End user.
Link disclaimer
Avaya is not responsible for the contents or reliability of any linked 
websites referenced within this site or Documentation provided by 
Avaya. Avaya is not responsible for the accuracy of any information, 
statement or content provided on these sites and does not 
necessarily endorse the products, services, or information described 
or offered within them. Avaya does not guarantee that these links will 
work all the time and has no control over the availability of the linked 
pages.
Warranty
Avaya provides a limited warranty on Avaya hardware and software. 
Please refer to your agreement with Avaya to establish the terms of 
the limited warranty. In addition, Avaya’s standard warranty language 
as well as information regarding support for this product while under 
warranty is available to Avaya customers and other parties through 
the Avaya Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link 
“Warranty & Product Lifecycle” or such successor site as designated 
by Avaya. Please note that if the product(s) was purchased from an 
authorized Avaya channel partner outside of the United States and 
Canada, the warranty is provided by said Avaya Channel Partner and 
not by Avaya.
“Hosted Service” means an Avaya hosted service subscription that 
You acquire from either Avaya or an authorized Avaya Channel 
Partner (as applicable) and which is described further in Hosted SAS 
or other service description documentation regarding the applicable 
hosted service. If You purchase a Hosted Service subscription, 
the foregoing limited warranty may not apply but You may be 
entitled to support services in connection with the Hosted Service 
as described further in your service description documents for the 
applicable Hosted Service. Contact Avaya or Avaya Channel Partner 
(as applicable) for more information.
Hosted Service
THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN 
AVAYA HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR 
AN AVAYA CHANNEL PARTNER (AS APPLICABLE), THE TERMS 
OF USE FOR HOSTED SERVICES ARE AVAILABLE ON THE 
AVAYA WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO 
UNDER THE LINK “Avaya Terms of Use for Hosted Services” 
OR SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND 
ARE APPLICABLE TO ANYONE WHO ACCESSES OR USES THE 
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED 
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON 
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE 
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY 
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. 
IF YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A 
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT 
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE 

TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, 
OR IF YOU DO NOT WISH TO ACCEPT THESE TERMS OF 
USE, YOU MUST NOT ACCESS OR USE THE HOSTED SERVICE 
OR AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED 
SERVICE.
Licenses
The Global Software License Terms (“Software License Terms”) 
are available on the following website https://www.avaya.com/en/
legal-license-terms/ or any successor site as designated by Avaya. 
These Software License Terms are applicable to anyone who 
installs, downloads, and/or uses Software and/or Documentation. By 
installing, downloading or using the Software, or authorizing others to 
do so, the end user agrees that the Software License Terms create 
a binding contract between them and Avaya. In case the end user is 
accepting these Software License Terms on behalf of a company or 
other legal entity, the end user represents that it has the authority to 
bind such entity to these Software License Terms.
Copyright
Except where expressly stated otherwise, no use should be made 
of materials on this site, the Documentation, Software, Hosted 
Service, or hardware provided by Avaya. All content on this site, the 
documentation, Hosted Service, and the product provided by Avaya 
including the selection, arrangement and design of the content is 
owned either by Avaya or its licensors and is protected by copyright 
and other intellectual property laws including the sui generis rights 
relating to the protection of databases. You may not modify, copy, 
reproduce, republish, upload, post, transmit or distribute in any way 
any content, in whole or in part, including any code and software 
unless expressly authorized by Avaya. Unauthorized reproduction, 
transmission, dissemination, storage, or use without the express 
written consent of Avaya can be a criminal, as well as a civil offense 
under the applicable law.
Virtualization
The following applies if the product is deployed on a virtual machine. 
Each product has its own ordering code and license types. Unless 
otherwise stated, each Instance of a product must be separately 
licensed and ordered. For example, if the end user customer or 
Avaya Channel Partner would like to install two Instances of the 
same type of products, then two products of that type must be 
ordered.
Third Party Components
The following applies only if the H.264 (AVC) codec is distributed 
with the product. THIS PRODUCT IS LICENSED UNDER THE AVC 
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A 
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH 
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC 
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE 
IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, 
L.L.C. SEE HTTP://WWW.MPEGLA.COM.
Service Provider
WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL 
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR 
EMBED THE H.264 CODEC OR H.265 CODEC, THE AVAYA 
CHANNEL PARTNER ACKNOWLEDGES AND AGREES THE 
AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY AND 
ALL RELATED FEES AND/OR ROYALTIES. THE H.264 (AVC) 
CODEC IS LICENSED UNDER THE AVC PATENT PORTFOLIO 
LICENSE FOR THE PERSONAL USE OF A CONSUMER 
OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO: (i) ENCODE VIDEO IN COMPLIANCE WITH 
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC 
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE 
IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) 
CODECS MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.
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Compliance with Laws
You acknowledge and agree that it is Your responsibility to comply 
with any applicable laws and regulations, including, but not limited 
to laws and regulations related to call recording, data privacy, 
intellectual property, trade secret, fraud, and music performance 
rights, in the country or territory where the Avaya product is used.
Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications 
system by an unauthorized party (for example, a person who is not a 
corporate employee, agent, subcontractor, or is not working on your 
company's behalf). Be aware that there can be a risk of Toll Fraud 
associated with your system and that, if Toll Fraud occurs, it can 
result in substantial additional charges for your telecommunications 
services.
Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You 
need technical assistance or support, please contact your Avaya 
Sales Representative.
Security Vulnerabilities
Information about Avaya’s security support policies can be 
found in the Security Policies and Support section of https://
support.avaya.com/security.
Suspected Avaya product security vulnerabilities are handled 
per the Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).
Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this 
site, the Documentation, Hosted Service(s), and product(s) provided 
by Avaya are the registered or unregistered Marks of Avaya, its 
affiliates, its licensors, its suppliers, or other third parties. Users 
are not permitted to use such Marks without prior written consent 
from Avaya or such third party which may own the Mark. Nothing 
contained in this site, the Documentation, Hosted Service(s) and 
product(s) should be construed as granting, by implication, estoppel, 
or otherwise, any license or right in and to the Marks without the 
express written permission of Avaya or the applicable third party.
Avaya is a registered trademark of Avaya LLC.
All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and 
other countries.
Downloading Documentation
For the most current versions of Documentation, see the Avaya 
Support website: https://support.avaya.com, or such successor site 
as designated by Avaya.
Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for 
Product or Cloud Service notices and articles, or to report a 
problem with your Avaya Product or Cloud Service. For a list of 
support telephone numbers and contact addresses, go to the Avaya 
Support website: https://support.avaya.com (or such successor site 
as designated by Avaya), scroll to the bottom of the page, and select 
Contact Avaya Support.
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Chapter 1: Introduction

Purpose
This guide describes the tasks that administrators and supervisors of Avaya Contact Center Select 
can perform in Contact Center Manager Administration.

Intended audience
This guide is for personnel who administer and customize the Avaya Contact Center Select 
solution.

Related resources

Avaya Contact Center Select documentation
The following table lists the documents related to Avaya Contact Center Select. Download the 
documents from the Avaya Support website at https://support.avaya.com.

Title Document purpose Audience
Overview
Avaya Contact Center Select 
Solution Description

This document provides a technical 
description of Avaya Contact Center 
Select. It describes the product 
features, specifications, licensing, and 
interoperability with other supported 
products.

Customers and sales, 
services, and support 
personnel

Avaya Contact Center Select 
Documentation Catalog

This document describes available Avaya 
Contact Center Select documentation 
resources and indicates the type of 
information in each document.

Customers and sales, 
services, and support 
personnel

Table continues…
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Title Document purpose Audience
Contact Center Performance 
Management Data Dictionary

This document contains reference tables 
that describe the statistics and data in the 
historical and real-time reports generated in 
Contact Center.

System 
administrators and 
contact center 
supervisors

Implementing
Deploying Avaya Contact Center 
Select DVD

This document contains information 
about Avaya Contact Center Select 
DVD installation, initial configuration, 
and verification. This document contains 
information about maintaining and 
troubleshooting the Avaya Contact Center 
Select server.

Implementation 
personnel

Deploying Avaya Contact Center 
Select Software Appliance

This document contains information 
about Avaya Contact Center Select 
Software Appliance (VMware) preparation, 
deployment, initial configuration, and 
verification. This document contains 
information about maintaining and 
troubleshooting the software appliance.

Implementation 
personnel

Deploying Avaya Contact Center 
Select Hardware Appliance

This document contains information about 
Avaya Contact Center Select Hardware 
Appliance (physical server) installation, 
initial configuration, and verification. This 
document contains information about 
maintaining and troubleshooting the 
hardware appliance.

Implementation 
personnel

Deploying Avaya Contact Center 
Select on Microsoft Azure

This document contains information about 
deploying Avaya Contact Center Select 
using an ISO image on Microsoft Azure.

Implementation 
personnel

Avaya Contact Center Select 
Business Continuity

This document contains information about 
deploying Avaya Contact Center Select 
Business Continuity.

Implementation 
personnel

Upgrading and patching Avaya 
Contact Center Select

This document contains information about 
upgrading and patching Avaya Contact 
Center Select.

Implementation 
personnel 
and system 
administrators

Administering
Administering Avaya Contact Center 
Select

This document contains information and 
procedures to configure the users, skillsets, 
and contact center configuration data. 
This document contains information about 
creating Avaya Contact Center Select real-
time and historical reports.

System 
administrators and 
contact center 
supervisors

Table continues…
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Title Document purpose Audience
Avaya Contact Center Select 
Advanced Administration

This document contains information about 
managing the Avaya Contact Center 
Select server, licensing, and multimedia 
configuration.

System 
administrators

Using Contact Center Orchestration 
Designer

This document contains information and 
procedures to configure script and 
flow applications in Contact Center 
Orchestration Designer.

System 
administrators

Maintaining
Contact Center Event Codes This document contains a list of 

errors in the Contact Center suite and 
recommendations to resolve them.

This document is a Microsoft Excel 
spreadsheet.

System 
administrators and 
support personnel

Using
Using Agent Desktop for Avaya 
Contact Center Select 

This document provides information and 
procedures for agents who use the Agent 
Desktop application to accept, manage, 
and close contacts of all media types in 
Contact Center.

Contact center 
agents and 
supervisors

Using the Contact Center Agent 
Browser application

This document provides information and 
procedures for agents who use the Agent 
Browser application to log on to Contact 
Center and perform basic tasks.

Contact center 
agents

Using Avaya Workspaces for AACC 
and ACCS

This document describes the tasks that 
Contact Center agents can perform using 
Avaya Workspaces.

Contact center 
agents and 
supervisors

Release Notes
Avaya Contact Center Select 
Release Notes

The Release Notes contain information 
about known issues, patches, and 
workarounds.

System 
administrators and 
support personnel

Finding documents on the Avaya Support website
Procedure

1. Go to https://support.avaya.com.

2. To log in, click Sign In at the top of the screen and then enter your login credentials when 
prompted.

3. Click Product Support > Documents.

4. In Search Product, start typing the product name and then select the appropriate product 
from the list displayed.

5. In Select Release, select the appropriate release number.

Related resources
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This field is not available if there is only one release for the product.

6. (Optional) In Enter Keyword, type keywords for your search.

7. From the Select Content Type list, select one or more content types.

For example, if you only want to see user guides, click User Guides in the Select Content 
Type list.

8. Click  to display the search results.

Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot 
Avaya products.

About this task
Videos are available on the Avaya Support website, listed under the video document type, and on 
the Avaya-run channel on YouTube.

• To find videos on the Avaya Support website, go to https://support.avaya.com/ and do one of 
the following:

- In Search, type Avaya Mentor Videos, click Clear All and select Video in the Select 
Content Type.

- In Search, type the product name. On the Search Results page, click Clear All and select 
Video in the Select Content Type.

The Video content type is displayed only when videos are available for that product.

In the right pane, the page displays a list of available videos.

• To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and do 
one of the following:

- Enter a keyword or keywords in the Search Channel to search for a specific product or 
topic.

- Scroll down Playlists, and click a topic name to see the list of videos available. For 
example, Contact Centers.

Note:

Videos are not available for all products.

Support
Go to the Avaya Support website at https://support.avaya.com for the most up-to-date 
documentation, product notices, and knowledge articles. You can also search for release notes, 
downloads, and resolutions to issues. Use the online service request system to create a service 
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request. Chat with live agents to get answers to questions, or request an agent to connect you to a 
support team if an issue requires additional expertise.

Support
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Chapter 2: Changes in this release

The following sections outline the changes in Administering Avaya Contact Center Select Release 
7.1.x.

Features
See the following sections for information about new features in Release 7.1.x.

New features in the Release 7.1 base build
See the following section for information about new features in the Release 7.1 base build:

Support for Avaya Workspaces
From Release 7.1, Contact Center supports Avaya Workspaces — a client for the voice, email 
and, web chat contact types.

New features in Release 7.1 Feature Pack 1
See the following sections for information about new features in Release 7.1 Feature Pack 1:

Avaya Workspaces supports Open Queue
From Release 7.1 Feature Pack 1, agents using Avaya Workspaces can handle Open Queue 
contacts. Avaya Workspaces displays Open Queue contacts as Generic.

Avaya Workspaces supports outbound campaign contacts
From Release 7.1 Feature Pack 1, agents using Avaya Workspaces can handle outbound 
campaign calls. The feature provides the interface that presents outbound campaign contacts 
to agents, provides agents with preview dial capability, displays agent call scripts (if configured), 
and saves disposition codes and script results.

Cookie timeout configuration
From Release 7.1. Feature Pack 1, you can configure the cookie timeout period in CCMA Security 
Settings.
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Multimedia Data Management utility access
From Release 7.1 Feature Pack 1, you must access the Multimedia Data Management utility using 
CCMA. The Multimedia Data Management utility is no longer available from the Windows start 
menu.

Lockout of inactive CCMA accounts
From Release 7.1 Feature Pack 1, you can configure CCMA to lock accounts that have not been 
used for a configured period of time. Only administrators can unlock the locked accounts.

New features in Release 7.1 Feature Pack 2
See the following sections for information about new features in Release 7.1 Feature Pack 2:

CCMA Password Policy configuration for human and programmatic 
accounts

From Release 7.1 Feature Pack 2, Contact Center provides the ability to configure CCMA 
Password Policy. Password Policy is a set of rules that CCMA uses to validate passwords for 
CCMA accounts. You can select one of the CCMA Password Policy modes: Basic Security mode 
and Advanced Security mode. You can either use default Basic Security mode with fixed password 
rules, or enable Advanced Security mode, which allows you to customize your Password Policy 
for human and programmatic accounts. When creating or updating a CCMA user, you can view 
current CCMA password rules.

Contact Center Manager Administration supported in Microsoft Edge with 
IE mode

From Release 7.1 Feature Pack 2, you can access Contact Center Manager Administration using 
Microsoft Edge with Internet Explorer (IE) mode.

New features in Release 7.1 Feature Pack 2 Post GA Patches
See the following sections for information about new features in Release 7.1 Feature Pack 2 Post 
GA Patches:

Avaya Contact Center Select Release 7.1 Feature Pack 2 Post GA Patches 
supports Microsoft Windows 11

From Release 7.1 Feature Pack 2 Post GA Patches, Avaya Contact Center Select supports 
Microsoft Windows 11 for Avaya Agent Desktop, Contact Center Manager Administration, Contact 
Center Multimedia Administration, and Communication Control Toolkit.

Avaya Contact Center Select Release 7.1 Feature Pack 2 Post GA Patches 
supports Microsoft Windows Server 2019

Avaya Contact Center Select Release 7.1 Feature Pack 2 Post GA Patches supports the Microsoft 
Windows Server 2019 operating system. Customers that upgrade to Avaya Contact Center Select 

Features
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Release 7.1 Feature Pack 2 Post GA Patches and want to use Windows Server 2019 must 
perform a fresh installation on a new Microsoft Windows Server 2019. For more information about 
restoring the database to the new server, see Upgrading and patching Avaya Contact Center 
Select.

New features in Release 7.1.2 Service Pack 2
Release 7.1.2.2 introduces new Avaya Workspaces features. Other changes, which are described 
later in this chapter, include interoperability and related updates.

Avaya Workspaces features for Release 7.1.2.2
Release 7.1.2.2 introduces the following Avaya Workspaces features for Avaya Aura® Contact 
Center (AACC) and Avaya Contact Center Select (ACCS). For more information about Avaya 
Workspaces features, see Using Avaya Workspaces for AACC and ACCS.

Consult, transfer, and conference options for web chat
You can consult with another agent during a chat interaction. Messages between agents are 
whispered so the customer does not see them.
If the other agent agrees, you can do one of the following when ending the consultation:

• Transfer the web chat to the other agent.
• Start a conference.

Observe web chat
A supervisor can observe a chat interaction from the My Agents widget.

Whisper coaching during web chat
While observing a chat interaction, the supervisor can start coaching. During the coaching 
session, the supervisor can whisper guidance to the agent. The customer does not see whispered 
messages.

Barge in to web chat
A supervisor can barge in to the chat interaction and communicate with the customer directly.

Email approval
A supervisor can approve or reject an email and add review comments. The agent can edit the 
email and add comments if it is rejected.

Reschedule email
You can postpone work on an email and reschedule it for a later time. This is a useful option if you 
need more time to gather information before completing the email.

Email transfer enhancements and new forwarding option
Previously, you could only transfer an email interaction to a skillset. Now, you can also transfer the 
email to another agent. In addition, you can also forward an email to any email address.

Multiple keyword search
You can use multiple keywords when searching through email templates and suggested content.

Changes in this release
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Customer history view
Customer history information for all contact types (voice and multimedia) is now displayed 
together in the same table.

Other changes in Release 7.1.2 Service Pack 2
This section lists other changes for Release 7.1.2.2. Outdated information from previous 7.1.x 
releases has been removed.

End of support for Internet Explorer
Microsoft ended support for the Internet Explorer (IE) web browser in June 2022.
Many Contact Center applications, such as Contact Center Manager Administration (CCMA), 
Contact Center Multimedia (CCMM), and Communication Control Toolkit (CCT) require the IE 
engine. To run these applications, you must use Microsoft Edge in IE mode. If you are using 
Windows 10, IE can be disabled but cannot be removed from your computer. With Windows 11, 
you do not need to install the IE browser because Edge already includes the IE engine.

Interoperability with the latest WebLM releases
In Release 7.1.2.2, the latest versions of WebLM 8.1.3.x and 10.1.x are supported.

VMware support
Contact Center Release 7.1.2.2 supports ESXi 7.0 and 8.0 Update 2. Earlier VMware versions, 
including 6.5 and 6.7, are no longer supported.

See the VMware website for general lifecycle policy information.

Windows operating system support
The following Microsoft operating systems are no longer supported:

• Windows 7 and 8.1

• Windows Server 2012 R2 and earlier versions

See the Microsoft website for lifecycle policy information.

Avaya Aura® Media Server interoperability
Contact Center now supports Avaya Aura® Media Server Release 10.1.x. Release 8.0.x is also 
supported.

Other changes in Release 7.1.2 Service Pack 2
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Supported IP Office versions
In Release 7.1.2.2, Avaya Contact Center Select supports IP Office Release 10.1, 11.1.2, and 
11.1.3.x.

Changes in this release
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Chapter 3: Avaya Contact Center Select 
overview

Avaya Contact Center Select is a context-sensitive, collaborative, voice and multimedia customer 
experience solution that allows small to midsize enterprises to anticipate, accelerate, and enhance 
customer interactions. Avaya Contact Center Select uses the Avaya IP Office telephone system 
to provide a real-time telephony platform. Avaya IP Office is a flexible and scalable phone system 
designed specifically for small and midsize enterprises. IP Office supports a wide range of phones 
and devices for use in contact centers. 

Avaya Contact Center Select provides a feature rich voice and multimedia solution with integrated 
routing and reporting for the small to midsize enterprises. Voice-enabled agents and agent-
supervisors created in Avaya Contact Center Select are automatically added to the IP Office 
platform. Avaya Contact Center Select synchronizes agent and agent-supervisor details from Avaya 
Contact Center Select to the IP Office platform.

Avaya Contact Center Select supports the following routed contact types:

• Voice

• Email

• Outbound

• Web communications (Web chat)

• SMS text messages

• Fax messages

• Scanned documents

• Voice mail messages

• Open Queue

Avaya Contact Center Select also supports peer-to-peer Instant Messaging. To support the 
email-based contact types, you must add an email server to your solution. To support the Web 
communications contact type, you must add a Web communications server to your solution.  

Contact Center Manager Administration (CCMA) is a Web browser-based tool for Avaya Contact 
Center Select administrators and supervisors to manipulate the data and reporting for the contact 
center database. You can use Contact Center Manager Administration to configure contact center 
resources, contact flows, components, and activities. You can also use Contact Center Manager 
Administration to define access levels to data and provide dynamic reporting to fit your business 
needs.
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Avaya Contact Center Select provides a simplified voice prompt management utility. The contact 
center supervisor can perform prompt management work without requiring administrator access to 
the Avaya Contact Center Select server. Avaya Contact Center Select provides a number of status 
monitoring utilities to monitor the integration points with the IP Office software.

User Data Synchronization
Avaya Contact Center Select provides unified administration for contact center agents and IP Office 
users. The users (agents and agent-supervisors) that you configure in Avaya Contact Center Select 
are automatically mirrored to the connected IP Office.
When you create an agent in Avaya Contact Center Select, a matching user account is created in IP 
Office.
When you modify agent details in Avaya Contact Center Select, the corresponding IP Office user 
details are automatically updated. If you delete an agent in Avaya Contact Center Select, the 
corresponding IP Office user is not deleted.
Synchronization works in one direction — from Avaya Contact Center Select to IP Office. The 
Contact Center Manager Administration administrator can manually force a data synchronization 
from Avaya Contact Center Select.

Avaya Contact Center Select users
Avaya Contact Center Select includes two types of users in Contact Center Manager 
Administration: an administrator user and a supervisor user. By default, Contact Center creates 
one administrator user and two supervisor users. Contact Center assigns the appropriate access 
classes and partitions to the created accounts.

A supervisor user can perform only a subset of the tasks an administrator can perform. These 
tasks include:

• Assigning agents to skillsets

• Changing the supervisor of an agent

• Creating and editing activity codes

• Viewing existing real-time reports

• Making private copies of real-time reports

• Launching Emergency Help

• Running historical reports

• Using the Audit Trail

A supervisor user has limited options available to them in Contact Center Manager Administration. 
The administrator can choose to edit the access classes and partitions assigned to a supervisor 
user.

The administrator performs advanced configuration tasks in Contact Center Manager 
Administration, in addition to the tasks listed above.

Avaya Contact Center Select overview
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This guide describes the tasks a supervisor user and an administrator user can perform. For more 
information, see Part 1: Reporting supervisor users on page 50 or Part 2: Administrator users on 
page 132.

Sample data
Avaya Contact Center Select provides sample data to minimize the time and effort needed 
to validate basic contact center operation. You can also use the sample data as the initial 
configuration for your solution. When you log on to Contact Center Manager Administration for the 
first time, the following sample data is visible in the Management and Configuration components:

• Two sample supervisors, each created as a supervisor/agent. Contact Center creates a local 
Windows user account on the server linked to each supervisor/agent.

• Eight sample agents, each assigned to one of the two sample supervisor/agents. Contact 
Center creates a local Windows user account on the server linked to each agent.

• One sample Agent Skillset Assignment and one sample Agent Supervisor Assignment.
• A sample skillset for each supported contact type. Avaya Contact Center Select assigns each 

sample agent to the voice skillset.
• A sample skillset for each contact type is assigned to one supervisor/agent.
• Sample Activity codes, After Call Work Item codes, and Not Ready Reason codes.
• A sample CDN (Route Point) number for voice calls.
• A sample Open Queue Route Point for multimedia contacts.
• Three sample Call Presentation Classes.
• Two sample Multiplicity Presentation Classes. With Multiplicity Presentation Classes, agents 

can handle more than one contact type concurrently.
• One sample Route to provide music on a customer call.
• Three sample Threshold Classes with preconfigured values. Threshold Classes determine 

how real-time and historical reports display statistics.

Using CCMA Prompt Management, administrators can manage prompts on Avaya Aura® Media 
Server (Avaya Aura® MS). Contact Center provides a number of sample prompts and sample 
music that administrators can use in your Orchestration Designer flow applications to treat Contact 
Center calls. Contact Center also provides sample Orchestration Designer flow applications that 
use the sample prompts and music provided, in addition to the standard Orchestration Designer 
flows available previously. All the sample prompts have an associated variable that exists in 
Orchestration Designer. This allows the administrator to modify the prompts within the flow 
applications without opening Orchestration Designer.

Contact Center uses the sample CDN (Route Point) number to deliver calls to the sample 
Customer_Service flow application. The Customer_Service flow application provides sample 
treatments and routes the call to a sample agent.

The sample data provided allows you to make a first routed call in your contact center. It also 
serves as your initial configuration and allows you to rapidly commission your Avaya Contact 
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Center Select solution. To view the lists of sample data that Avaya Contact Center Select 
provides, see Default sample data on page 406.
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Chapter 4: Contact Center Manager 
Administration initial operations

This chapter describes the initial procedures to log in and operate Contact Center Manager 
Administration (CCMA). The procedures in this chapter apply to both administrators and 
supervisors.

Contact Center Multimedia Administration and Multimedia 
Data Management utility access

Access Contact Center Multimedia (CCMM) Administration and the Multimedia Data Management 
utility by using Contact Center Manager Administration (CCMA). Use CCMM Administration to 
configure and maintain multimedia resources. Use the Multimedia Data Management utility to 
manage database contacts and customer privacy requests. This guide explains how to access 
CCMM Administration and the Multimedia Data Management utility.
For more information about accessing these utilities, see Starting the CCMM Administration 
utility on page 34 and Starting the Multimedia Data Management Administration utility on 
page 35. For information about using these utilities, see Avaya Contact Center Select Advanced 
Administration.

Configuring browser security settings
About this task
Use Microsoft Edge in Internet Explorer mode to access Contact Center Manager Administration.

Procedure
1. In your Microsoft Edge browser, navigate to More Tools > Internet Options.

The browser displays the Internet Properties window.

2. On the Security tab, click the Trusted sites option.

3. Click Custom level.
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4. In the Security Settings - Trusted Sites Zone window, under the .NET Framework-reliant 
components heading, click Enable for the following:

• Run components not signed with Authenticode
• Run components signed with Authenticode

5. Under the ActiveX controls and plug-ins heading, click Enable for the following:

• Automatic prompting for ActiveX controls
• Run ActiveX Controls and plug-ins
• Script ActiveX Controls marked safe for scripting

6. Under the Downloads heading, click Enable for the following:

• Automatic prompting for file downloads
• File download

7. Under the Miscellaneous heading, click Enable for the following:

• Allow script-initiated windows without size or position constraints
• Allow websites to open windows without address or status bars

8. In the Reset custom settings area, select Medium-low from the Reset to: list.

9. Click Reset.
10. In the Warning dialog box, click Yes to confirm.

11. Click OK.

12. If you enabled ActiveX options, click Yes to confirm your selection when prompted.

13. Click Trusted Sites.

14. Click Sites.

15. Clear the Require server verification {https:} for all sites in this zone check box.

16. In the Add this website to the zone field, type the server name (not the IP address) for 
your Avaya Contact Center Select server.

17. Click Add.

18. Click Close to return to the Internet Options window.

19. Click the Privacy tab.

20. In the Pop-up Blocker area, select the Turn on Pop-up Blocker check box.

21. Click Settings.

22. On the Pop-up Blocker Settings window, in the Address of website to allow field, type the 
Avaya Contact Center Select server URL.

The default URL is https://<server name>. Alternatively, if you turned off Web 
Services security, type http://<server name>, where <server name> is the name of 
the Avaya Contact Center Select server.
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23. Click Add.

24. Click Close.

25. On the Internet Options window, click the Advanced tab.

26. Under Browsing, clear the Reuse windows for launching shortcuts check box.

27. Click OK to close the Internet Options window.

28. Restart the browser to activate your changes.

Logging in to Contact Center Manager Administration
About this task
Log in to CCMA to configure and administer your contact center resources. You can access 
CCMA from Microsoft Edge in Internet Explorer mode. For more information, see Accessing 
Contact Center Manager Administration from Microsoft Edge in Internet Explorer mode on 
page 37.
You can log in to CCMA for the first time as an administrator or a supervisor. For security reasons, 
you must change the default password when you first log in to the application. CCMA user 
passwords can contain only English characters and special characters. Passwords must be at 
least eight characters long with no spaces, and include at least one number, one uppercase letter, 
and one lowercase letter. For information about the default administrator and supervisor accounts 
and passwords, see Default sample data on page 406.

Note:
CCMA supports one concurrent user session only. If the same credentials are used to log in to 
CCMA on a different client, the active session is terminated.

Procedure
1. In the Address field in your browser, type the URL of the Avaya Contact Center Select 

server.

The default URL is https://<server name> OR if you turned off Web Services 
security, type http://<server name>, where <server name> is the name of the Avaya 
Contact Center Select server.

If your site does not use the default port for Internet Information Services (IIS), the URL of 
the server is https://<server name>:<port number>, where <server name> is the 
computer name of the Avaya Contact Center Select server, and <port number> is the port 
for the CCMA site in IIS. For example, https://accsserver:81.

2. Press Enter.

3. In the main login window, in the User ID field, type the username.

4. In the Password field, type the password.

5. Click Login.
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Contact Center Manager Administration (CCMA) displays the date and time of your last 
login and also the number of failed login attempts before a successful login.

6. On the Change Password window, in the Old password field, type the old password.

7. In the New password field, type the new password.

8. In the Confirm password field, retype the new password.

9. Click Change Password.

The main login window is displayed.

10. In the User ID field, type the username.

11. In the Password field, type the new password.

12. Click Login.

Logging out of Contact Center Manager Administration
About this task
Log out to exit Contact Center Manager Administration.

Procedure
On the Contact Center Manager Administration Launchpad, click Logout.

Changing a user password
Before you begin

• Log on to Contact Center Manager Administration, using the credentials for the user whose 
password you are changing.

About this task
In Contact Center Release 7.0, administrators can configure a setting that forces users to change 
their password when users log on to Contact Center Manager Administration (CCMA) for the first 
time. By default, the force password change feature is enabled.
Change a default user password in CCMA for security reasons. Before you change a user 
password, you must re-authenticate using your password.
Avaya highly recommends that you change default passwords. Passwords must fulfill the following 
complexity criteria:

• Must be between 8 to 20 characters
• Must contain a number
• Must contain at least one uppercase letter and at least one lowercase letter
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• Must not contain spaces
• Must not contain any of these characters: \ & : < > |

Procedure
1. On the Launchpad, click Change Password.

The Change Password window appears.

2. In the Old password box, type the old password.

3. In the New password box, type the new password.

4. In the Confirm password box, retype the new password.

5. Click Change Password.

The main logon window appears, and you must now log on again using the new password.

Opening the Connection Status window
Before you begin

• Log on to Contact Center Manager Administration.

About this task
Open the Connection Status window to display a list of servers currently administered by CCMA, 
along with the local time and connection status of each server.

Procedure
1. On the CCMA launchpad, click a component.

2. From the Status menu, choose Connection Status.

A green dot beside the server indicates that it is online and operational. A red dot indicates 
that the server is off-line or not responding. A brown dot indicates that the server is in 
grace period.

3. In the CCM Server Connection Status window, click Refresh to refresh the status and local 
time of all the servers listed.

4. Click Close.

Using the Audit Trail
Before you begin

• Log on to Contact Center Manager Administration.
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About this task
Use the Audit Trail to view a list of actions performed in Contact Center Management, Access and 
Partition Management, Historical Reporting, Scripting, Configuration, and Prompt Management as 
well as the user ID of the person who made the changes.
You can also monitor when a user logs on or logs off of Contact Center Manager Administration.

Procedure
On the Contact Center Manager Administration Launchpad banner, click the Audit Trail link.

OR

To open the Audit Trail if you are within a component, click the Launchpad menu of that 
component.

Starting the CCMM Administration utility
About this task
Use this procedure to log on to the Contact Center Multimedia (CCMM) Administration utility. 
You use the CCMM Administration utility to configure and maintain multimedia resources. For 
information about using CCMM Administration to configure and maintain multimedia resources, 
see Avaya Contact Center Select Advanced Administration.

Procedure
1. Log on to Contact Center Manager Administration as an administrator.

2. On the Launchpad, click Multimedia.

3. In the left pane, select the Contact Center Multimedia (CCMM) server to administer.

The system displays the Multimedia Administration screen in the right pane.

4. Select Install prerequisite software.

5. Click Launch Multimedia Client.
6. On the File Download box, click Run.

The prerequisite software takes some time to install. After the install, the CCMM 
Administration utility appears.
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Starting the Multimedia Data Management Administration 
utility

About this task
Use this procedure to log on to the Multimedia Data Management utility, so that you can manage 
database contacts and customer privacy requests. For information on using the Data Management 
Administration utility, see Avaya Contact Center Select Advanced Administration.

Procedure
1. Log on to Contact Center Manager Administration.

If configured in Contact Center Manager Administration (CCMA) Security Settings, CCMA 
displays the date and time of your last login and also the number of failed login attempts 
since your last successful login.

2. On the Launchpad, click Data Management.
3. In the left pane, select the CCMM server to administer.

The system displays the Multimedia Administration screen in the right pane.

4. Select Install prerequisite software.

5. Click Launch Data Management Client.
6. On the File Download box, click Run.

The prerequisite software takes some time to install. After the install, the system displays 
the CCMM Data Management Administration utility.

Configuring Contact Center Manager Administration 
security settings

Before you begin
• Ensure that you have administrator privileges on the Contact Center Manager Administration 

server.

About this task
For new installations of Contact Center Release 7.0 Feature Pack 1 and later, Contact Center 
Manager Administration(CCMA) security settings are turned on by default. If you are upgrading 
from Contact Center Release 7.0, your existing CCMA security settings are not modified. You can 
customize various security settings that appear when users attempt to log on to the CCMA server 
using the CCMA Security Settings window.

Procedure
1. Log on to the Contact Center Manager Administration server.
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2. From the Start menu, in the Avaya area, click Manager Administration Configuration.

3. In the Avaya Applications Configuration window, in the right pane, click the CCMA 
Security Settings icon.

4. In the CCMA Security Settings window, configure the following settings:

a. If you want CCMA to display the date and time of the users last login, select Show 
time of last login.

b. If you want CCMA to temporarily lock out users if users incorrectly enter the 
application password a specified number of times, select Lockout Enabled and 
configure the following settings:

a. Enter the number of times the users can enter an incorrect password in Failed 
attempts before lockout. By default, users can enter an incorrect password 
three times before getting locked out.

b. Enter the time, in minutes, for which the users get locked out of CCMA in 
Lockout Duration. By default, the lockout period is three minutes.

c. If you want the password used in CCMA to expire after a specified duration, in the 
Password expiry section, select Enabled and configure the following settings:

a. Enter the number of days from when CCMA displays a warning to the users 
about CCMA password expiry in Expiry warning period. By default, CCMA 
displays a warning about password expiry 14 days before the CCMA password 
expires.

b. Enter the number of days after which the CCMA password must be changed in 
Maximum password age. By default, the CCMA password must be changed 
every 30 days.

d. If you want CCMA to force users to change their passwords when users log on to 
Contact Center Manager Administration for the first time, select Force password 
change on first login.

e. If you want the CCMA login session to expire after a specified period of time, in the 
Cookie Timeout section, configure the following settings:

a. For Cookie timeout duration, enter the number of minutes the login session 
can live.

By default, the CCMA login session expires after 15 minutes.

b. Select the Timeout Renewal check box.

By default, timeout renewal is enabled.

f. If you want CCMA to lock inactive accounts after a configured period of time, in the 
Inactive Account Duration section, enter the number of days.

When a user exceeds the configured inactive account time period, CCMA blocks the 
user from logging in to the system.
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Accessing Contact Center Manager Administration from 
Microsoft Edge in Internet Explorer mode

You can access Contact Center Manager Administration using the Microsoft Edge browser 
in Internet Explorer (IE) mode. To enable IE mode in Microsoft Edge, perform the following 
procedures:

1. Adding the Microsoft Edge administrative templates on page 37.
2. Configuring integration with Internet Explorer on page 38.
3. Configuring the Enterprise Mode Site List on page 39.

Before enabling IE mode in Microsoft Edge, install all recent Windows updates. Ensure that 
Microsoft Edge is installed at the system level. You can check it by typing edge://version 
in the Microsoft Edge address field. The executable path must start with C:\Program Files, 
which indicates a system install.
For more information about IE mode in Microsoft Edge, refer to the Microsoft documentation.

Important:
• Always start CCMA in a new browser tab.
• If you enabled SSO for your Contact Center, add the System Manager server FQDN to 

the Enterprise Mode Site List.
• For solutions with geographic redundancy, add the RGN server short name and FQDN to 

the Enterprise Mode Site List.
• For Business Continuity solutions, add the Managed Name and Managed FQDN of the 

BC pair to the Enterprise Mode Site List. Do not add short names and FQDNs of your 
active and standby servers.

Adding the Microsoft Edge administrative templates
About this task
Use this procedure to add the Microsoft Edge administrative templates to your computer.

Procedure
1. On the Microsoft website, go to the Edge for Business download page: https://

www.microsoft.com/en-us/edge/business/download.

2. From the lists, select your current browser version, build, and platform.

3. Click the Get Policy Files button.

4. Click Accept and download to download the MicrosoftEdgePolicyTemplates file.

The MicrosoftEdgePolicyTemplates archive is downloaded to the default folder on 
your computer.

5. Unzip the MicrosoftEdgePolicyTemplates archive.

6. Open the MicrosoftEdgePolicyTemplates folder and navigate to windows\admx.
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7. From the admx folder, copy the msedge.admx file.

8. Navigate to C:\Windows\PolicyDefinitions and paste the msedge.admx file to the 
PolicyDefinitions folder.

9. In the admx folder, open the required language folder.

For example, for the United States, open the en-Us folder.

10. From the language folder, copy the msedge.adml file.

11. Navigate to C:\Windows\PolicyDefinitions and paste the msedge.adml file to the 
matching language folder in the PolicyDefinitions folder.

12. (Optional) Verify that you have added the Microsoft Edge administrative template correctly 
by doing the following:

a. Press Win+R and run gpedit.msc to open the Local Group Policy Editor.
b. Click Computer Configuration > Administrative Templates.

The Administrative Templates folder contains folders with the Microsoft Edge 
administrative templates.

Next steps
Configure web browser integration using Local Group Policy Editor.

Configuring integration with Internet Explorer
About this task
Use this procedure to enable your browser to work with Local Group Policy Editor.

Before you begin
Add the Microsoft Edge administrative templates to your computer.

Procedure
1. Press Win+R and run gpedit.msc to open the Local Group Policy Editor.

2. Click Computer Configuration > Administrative Templates > Microsoft Edge.

3. In the Microsoft Edge pane, double-click Configure Internet Explorer integration.

4. In the Configure Internet Explorer integration window, select Enabled.

5. From the Configure Internet Explorer integration list, select Internet Explorer mode.

This is the default option for accessing CCMA in Microsoft Edge.

6. Click OK.

Result
IE mode in Microsoft Edge is now enabled.

Next steps
Configure the site list that you want to access using IE mode in Microsoft Edge.
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Configuring the Enterprise Mode Site List
About this task
Use this procedure to configure the Enterprise Mode Site List.
On your computer, create an XML file with the list of sites that you want to access using Microsoft 
Edge in Internet Explorer mode.
The XML file must contain the following elements:

• site-list version number: The browser uses this number to verify whether the site list is new. 
Approximately 65 seconds after the browser starts, it compares your site list version to the 
stored version number. You must increase the site-list version number every time you update 
the Enterprise Mode Site List version.

• <compat-mode> tag: This tag specifies the compatibility settings for a specific site or 
domain. Use the default value.

• <open-in> tag: This tag specifies which browser version opens for a specific site or domain. 
Use the latest supported browser version.

Before you begin
• Add the Microsoft Edge Policy templates to your computer.
• Ensure that you have your Contact Center server short name and FQDN.
• If you enabled SSO for your Contact Center, ensure that you have your System Manager 

server FQDN.
• For a solution with geographic redundancy, ensure that you know your RGN server short 

name and FQDN.
• For a BC solution, ensure that your have your BC pair managed name and managed FQDN.

Procedure
1. On your computer, create the sites.xml file using the following template:

<site-list version="1">
    <!-- File creation header -->
    <created-by>
        <tool>EnterpriseSitelistManager</tool>
        <version>10240</version>
        <date-created>20200717.142200</date-created>
    </created-by>
    <!-- Begin Site List -->  
    <site url="server short name">
        <compat-mode>default</compat-mode>
        <open-in>IE11</open-in>
    </site>
    <site url="server FQDN">
        <compat-mode>default</compat-mode>
        <open-in>IE11</open-in>
    </site>
</site-list>

2. In the first <site> element, for the url attribute, type the Contact Center server short 
name.

For example, if your Contact Center server short name is auracc12680, use the following 
code: <site url="auracc12680">.
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For a BC solution, you must use your BC pair managed name instead of the server short 
name.

3. In the second <site> element, for the url attribute. type the Contact Center server 
FQDN.

For example, if your Contact Center server FQDN is auracc12680.aacc7dc2012.com, 
use the following code: <site url="auracc12680.aacc7dc2012.com">.

For a BC solution, you must use your BC pair managed FQDN instead of the server 
FQDN.

4. (Optional) Add your System Manager server to the site list using the following template:
<site url="SMGR server FQDN">
        <compat-mode>default</compat-mode>
        <open-in>IE11</open-in>
</site>    

For example, if your System Manager server FQDN is smgr80176.aacc7dc2012.com, 
use the following code: <site url="smgr80176.aacc7dc2012.com">.

5. (Optional) Add your RGN server to the site list using the following template:
<site url="RGN server short name">
        <compat-mode>default</compat-mode>
        <open-in>IE11</open-in>
</site>
<site url="RGN server FQDN">
        <compat-mode>default</compat-mode>
        <open-in>IE11</open-in>
</site>   

6. Press Win+R and run gpedit.msc to open the Local Group Policy Editor.

7. Click Computer Configuration > Administrative Templates > Microsoft Edge.

Local Group Policy Editor displays the Microsoft Edge pane.

8. In the Microsoft Edge pane, double-click Configure the Enterprise Mode Site List.
9. In the Configure the Enterprise Mode Site List window, select Enabled.

10. In the Options field, type the sites.xml location.

For example: file:///c:/Users/user_name/Documents/sites.xml.

11. Click OK.

12. (Optional) In the Microsoft Edge address bar, type edge://compat/enterprise and 
press Enter.

Microsoft Edge displays the Enterprise Mode Site List page, where you can view the 
current list of sites that Microsoft Edge opens in IE mode. Microsoft Edge automatically 
checks if there is a newer site list version and updates it approximately 65 seconds after 
launch. However, you can also manually configure Microsoft Edge to use the latest site list 
version by clicking Force Update.
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Next steps
Launch Microsoft Edge and wait for approximately 65 seconds. You can now access CCMA using 
Microsoft Edge in IE mode.

Internet Explorer mode and Compatibility View 
configuration on the domain server

If you cannot configure IE mode or Compatibility View from a local computer, you can configure 
these settings on the domain server. For example, if you cannot use Internet Explorer according 
to your enterprise security policies, you can configure Compatibility View settings on the domain 
server.
To enable IE mode for Microsoft Edge on the domain server, perform the following procedures:

1. Adding the Microsoft Edge administrative templates to the domain server on page 41.
2. Creating a configuration file for Internet Explorer mode on page 42.
3. Enabling IE mode on the domain server on page 45.
4. Completing IE mode configuration on a local computer on page 46.

To enable Compatibility View on the domain server, see Configuring Compatibility View settings on 
the domain server on page 47.
For more information about IE mode in Microsoft Edge and Compatibility View, refer to the 
Microsoft documentation.

Important:
• If you use Windows 10, do not delete the Internet Explorer browser from your computer. 

Microsoft Edge for Windows 11 includes the Internet Explorer engine. Microsoft Edge 
uses the Internet Explorer engine to launch CCMA.

• Always launch CCMA in a new tab of Microsoft Edge.
• If you enabled SSO, add the System Manager server FQDN to the Enterprise Mode Site 

List.
• For solutions with geographic redundancy, add the RGN server short name and FQDN to 

the Enterprise Mode Site List.
• For Business Continuity solutions, add only the Managed Name and Managed FQDN of 

the BC pair to the Enterprise Mode Site List. Do not add short names and FQDNs of your 
active and standby servers.

Adding the Microsoft Edge administrative templates to the 
domain server

About this task
Use this procedure to add the Microsoft Edge administrative templates to the domain server.
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Procedure
1. On the Microsoft website, go to the Edge for Business download page: https://

www.microsoft.com/en-us/edge/business/download.

2. Click the GET POLICY FILES button.

3. Click Accept and download to download the MicrosoftEdgePolicyTemplates file.

The MicrosoftEdgePolicyTemplates archive is downloaded to the default folder on 
your computer.

4. Unzip the MicrosoftEdgePolicyTemplates archive.

5. Open the MicrosoftEdgePolicyTemplates folder and navigate to windows\admx.

6. From the admx folder, copy the msedge.admx file.

7. Upload the msedge.admx file to the domain server to the 
C:\Windows\PolicyDefinitions folder.

Use a file transfer program of your choice, such as SFTP, SCP, or WinSCP.

8. On your local computer, re-open the MicrosoftEdgePolicyTemplates folder and 
navigate to the windows\admx\ folder.

9. In the admx folder, open a folder corresponding to the language and locale you use on 
Contact Center.

For example, for the United States, open the en-US folder.

10. From the language folder, copy the msedge.adml file.

11. Upload the msedge.adml file to the domain server to the 
C:\Windows\PolicyDefinitions\<LANGUAGE_FOLDER> folder.

In this file path, <LANGUAGE_FOLDER> is the language folder with the same name that 
you selected in step 9. For example, for the United States, copy msedge.adml to the 
C:\Windows\PolicyDefinitions\en-US folder.

Next steps
Create a configuration file for IE mode.

Creating a configuration file for Internet Explorer mode
About this task
Create an XML file that contains a list of sites you need to access from Microsoft Edge in IE mode. 
You will use this file to configure the Enterprise Mode Site List on the domain server.
The XML file must contain the following elements:

• site-list version number: The browser uses this number to verify whether the site list is new. 
Approximately 65 seconds after the browser starts, it compares your site list version to the 
stored version number. You must increase the site-list version number every time you update 
the Enterprise Mode Site List version.
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• <compat-mode> tag: This tag specifies the compatibility settings for a specific site or 
domain. Use the default value.

• <open-in> tag: This tag specifies the browser version that opens for a specific site or 
domain.
Use the latest supported browser version.

Before you begin
• Add the Microsoft Edge Policy templates to the domain server.
• Ensure that you have your Contact Center server short name and FQDN.
• If you enabled SSO for your Contact Center, ensure that you have your System Manager 

server FQDN.
• For a solution with geographic redundancy, ensure that you know your RGN server short 

name and FQDN.
• For a BC solution, ensure that your have your BC pair managed name and managed FQDN.

Procedure
1. Create an XML file using the following template:

<site-list version="1">
    <!-- File creation header -->
    <created-by>
        <tool>EnterpriseSitelistManager</tool>
        <version>10240</version>
        <date-created>20200717.142200</date-created>
    </created-by>
    <!-- Begin Site List -->
    <site url="<SERVER SHORT NAME>">
        <compat-mode>default</compat-mode>
        <open-in>IE11</open-in>
    </site>
    <site url="<SERVER FQDN>">
        <compat-mode>default</compat-mode>
        <open-in>IE11</open-in>
    </site>
</site-list>

2. In the first <site> element, for the url attribute, type the short name of your Contact 
Center server.

For example, if the short name of your Contact Center server is auracc12680, use the 
following code:
<site url="auracc12680">

For a BC solution, you must use your BC pair managed name instead of the server short 
name.

3. In the second <site> element, for the url attribute, type the Contact Center server 
FQDN.

For example, if your Contact Center server FQDN is auracc12680.aacc7dc2012.com, 
use the following code:
<site url="auracc12680.aacc7dc2012.com">
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For a BC solution, you must use your BC pair managed FQDN instead of the server 
FQDN.

4. (Optional) If you use SSO on your Contact Center, add a new <site> element for System 
Manager to the file using the following template:
<site url="SMGR server FQDN">
        <compat-mode>default</compat-mode>
        <open-in>IE11</open-in>
</site>

For example, if your System Manager FQDN is smgr80176.aacc7dc2012.com, use the 
following code:
<site url="smgr80176.aacc7dc2012.com">
        <compat-mode>default</compat-mode>
        <open-in>IE11</open-in>
</site>

5. (Optional) For a solution with geographic redundancy, add a new <site> element for 
your RGN server to the site list using the following template:
<site url="RGN server short name">
        <compat-mode>default</compat-mode>
        <open-in>IE11</open-in>
</site>
<site url="RGN server FQDN">
        <compat-mode>default</compat-mode>
        <open-in>IE11</open-in>
</site>   

6. Save the file using the sites.xml name.

Next steps
• Upload the configuration file to one of the following locations:

- To the CCMA server. For more information about uploading the file to the CCMA server, 
see Uploading the configuration file for IE mode to the CCMA server on page 44.

- To a shared folder on the domain server.
• Enable IE mode on the domain server.

Uploading the configuration file for IE mode to the CCMA server
About this task
You can store the configuration file sites.xml for IE mode on the CCMA server.

Before you begin
Create the configuration file sites.xml for IE mode.

Procedure
1. Copy the sites.xml file to the CCMA server to the D:\Avaya\Contact 

Center\Manager Administration\Apps folder.

Use a file transfer program of your choice, such as SFTP, SCP, or WinSCP.
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2. If you use SSO, do the following:

a. Add the following entry to the AgentPromValues.xml file, which is located in the 
D:\Avaya\Contact Center\Manager Administration\Server\Data folder:

<NOT_ENFORCED value="sites.xml*" />
b. On the Contact Center, disable SSO.

c. Re-enable SSO.

3. Open Microsoft Edge, enable the Internet Explorer mode, and then type the following URL 
in the address bar:

https://<CCMA_FQDN>/sites.xml
In this URL, <CCMA_FQDN> is the FQDN of the CCMA server.

4. Ensure that you can view the sites.xml file contents in the browser.

Next steps
Enable IE mode on the domain server.

Enabling IE mode on the domain server
About this task
Enable IE mode on the domain server to access CCMA from Microsoft Edge.

Before you begin
• Add the Microsoft Edge Policy templates to your computer.
• Create the configuration file sites.xml for IE mode.

• Upload the configuration file to one of the following locations:
- To the CCMA server. For more information about uploading the file to the CCMA server, 

see Uploading the configuration file for IE mode to the CCMA server on page 44.
- To a shared folder on the domain server.

Procedure
1. On the domain server, navigate to Control Panel > Administrative tools > Group Policy 

Management.
2. Go to your domain.

3. Right-click the domain group policy and click Edit.
4. In the Group Policy Management Editor, go to Computer Configuration > Policies > 

Administrative Templates > Microsoft Edge.

The Group Policy Management Editor displays the Microsoft Edge pane.

5. In the Microsoft Edge pane, double-click Configure Internet Explorer integration.

6. In the Configure Internet Explorer Integration window, select Enabled.
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7. In the Options area, from Configure Internet Explorer integration, select one of the 
following:

• Internet Explorer mode: To open sites in Microsoft Edge in IE mode.

• None: To prevent users from configuring IE mode using edge://flags or CLI.

8. Click OK.

9. In the Group Policy Management Editor, go to Computer Configuration > Policies > 
Administrative Templates > Microsoft Edge.

10. In the Microsoft Edge pane, double-click Configure the Enterprise Mode Site List.
11. In the Configure the Enterprise Mode Site List window, select Enabled.

12. In the Options area, from Configure the Enterprise Mode Site List, specify the location of 
the sites.xml configuration file as follows:

• If the sites.xml file is on the CCMA server, use the following format:

https://<CCMA FQDN>/sites.xml
In this entry, <CCMA_FQDN> is the FQDN of the CCMA server. For example:

https://192.0.2.1/sites.xml
• If the sites.xml file is in a shared folder on the domain server, use the following 

format:

\\<NETWORK_PATH>\sites.xml
In this entry, <NETWORK_PATH> is the full path to the sites.xml on the domain server. 
For example:

\\198.51.100.1\Shared\sites.xml
13. Click OK to save the policy settings.

Next steps
Complete IE mode configuration on a client computer.

Completing IE mode configuration on a local computer
About this task
After configuring IE mode on the domain server, update group policies on the local computer you 
use to access CCMA and ensure you can access CCMA using Microsoft Edge.

Before you begin
• Configure IE mode on the domain server.
• Ensure that the operating system and Microsoft Edge browser installed on your 

local computer comply with the system requirements for IE mode listed at https://
docs.microsoft.com/en-us/deployedge/edge-ie-mode.
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Procedure
1. On your local computer, run the following command:

gpupdate /force
2. To check if Group Policy Objects are applied, run the following command:

gpresult /r
In the command output, the Applied Group Policy Objects section must contain the domain 
group policy name that you configured on the domain server.

3. In the Microsoft Edge address bar, type edge://compat/enterprise and ensure that 
the Enterprise Mode Site List tab contains the sites.xml file you added to the domain 
server.

4. In Microsoft Edge, open the CCMA site.

Next steps
Configure the Compatibility View List on the domain server.

Configuring Compatibility View settings on the domain server
About this task
Compatibility View is a feature that enables you to open websites that are incompatible with the 
latest browser version. If Microsoft Edge cannot display the CCMA site even in IE mode, you can 
configure Compatibility View settings for the CCMA site. If you cannot configure the Compatibility 
View settings on your local computer, you can configure them on the domain server.
If you are using Windows 11, you do not need to enable Compatibility View.

Important:
In this procedure, you will add a registry key to Group Policy Objects. If you change your 
Compatibility View settings, you must delete this registry key and then add it again.

Procedure
1. On the domain server, start Microsoft Edge with Internet Explorer mode.

2. Click the Tools icon and then click Compatibility View Settings.

The browser displays the Compatibility View Settings window.

3. In Add this website, type your domain name and then click Add.

4. On the domain server, go to Control Panel > Administrative tools > Group Policy 
Management.

5. Select your domain.

6. Right-click the domain group policy and click Edit.

You can also create a new domain group policy and link it to the domain.
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7. In the Group Policy Management Editor, go to User Configuration > Preferences > 
Windows Settings > Registry.

8. Right-click Registry and click New > Registry Wizard.

9. In the Registry Wizard, select the local machine and then navigate to 
HKEY_CURRENT_USER > Software > Microsoft > Internet Explorer > 
BrowserEmulation > ClearableListData.

10. Select the check box for the UserFilter parameter.

11. Click Finish.

12. On your local computer, to update the group policy settings, run the following command:
gpupdate /force

13. To check if Group Policy Objects are applied, run the following command:
gpresult /r

In the command output, the Applied Group Policy Objects section must contain the domain 
group policy name that you configured on the domain server.

14. (Optional) Verify that the registry 
key HKEY_CURRENT_USER\Software\Microsoft\Internet 
Explorer\BrowserEmulation\ClearableListData\UserFilter contains the 
same value that is configured on the domain server.

15. Restart Microsoft Edge in Internet Explorer mode to apply the changes in the Compatibility 
View settings.

Disabling Internet Explorer 11 as a standalone browser
About this task
Disable Internet Explorer 11 as a standalone browser to force users in your domain to use 
Microsoft Edge. When users try to open shortcuts or files associated with Internet Explorer 11, 
URLs open in Microsoft Edge instead.

Before you begin
Ensure that the operating system and Microsoft Edge browser installed on your local computer 
comply with the system requirements for IE mode listed at https://docs.microsoft.com/en-us/
deployedge/edge-ie-disable-ie11.

Procedure
1. On the domain server, navigate to Control Panel > Administrative Tools > Group Policy 

Management.
2. Go to your domain.

3. Right-click the domain policy and click Edit.

You can also create a new domain policy and link it to the domain.
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4. In the Group Policy Management Editor, go to Computer Configuration > Policies > 
Administrative Templates > Windows components > Internet Explorer.

5. In the Microsoft Edge pane, double-click Disable Internet Explorer 11 as a standalone 
browser and select Enabled.

6. In the Options area, select one of the following:

• Never: To notify users that Internet Explorer is disabled.

• Always: To notify users every time they are redirected from Internet Explorer.

• Once per user: To notify users only the first time they are redirected.

7. Click OK.

8. Log in to a computer in the domain and run the gpupdate /force command.

9. To check if Group Policy Objects are applied, run the gpresult /r command.
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Part 1: Reporting supervisor users

This part of the guide describes all of the tasks that Avaya Contact Center Select default 
supervisor users can perform in Contact Center Manager Administration.
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Chapter 5: Real-time reporting

The Contact Center Manager Administration (CCMA) Real-Time Reporting displays provide up-to-
date statistics for your contact center and resources. With access to statistics that update in real-
time, such as the number of contacts waiting to be answered, the number of agents assigned to 
each skillset, and the number of abandoned calls, you can view changes in contact activity as they 
occur.

Contact Center can present real-time data in the most appropriate format - graphical, tabular, or a 
combination of both. This allows supervisors to react immediately to changing circumstances, adjust 
skillsets and staffing levels, or reroute calls to other resources. Real-Time Reporting displays make 
it easy to monitor peak periods and adjust staffing levels as appropriate to maintain the highest 
levels of customer service.

Launching the Contact Center Status real-time display
About this task
Access Avaya Contact Center Select Real-Time Reporting and launch the Contact Center Status 
real-time display. Use the displays to monitor the performance of the contact center in near 
real-time.
Avaya Contact Center Select offers a number of sample public real-time displays. Create a private 
copy of these displays and experiment with them to create displays that meet the day-to-day 
requirements of your solution.
For example, the CC Status public graphical display has the following panels:

Panel Type Description
CC_Standard_Agent_Display (CC) Tabular This tabular panel displays the agent 

status and time in current state. Use this 
panel to monitor individual agent activity.

CC_Contacts_Wait Chart This pie chart displays the number of 
contact waiting for each skillset.

CC_Standard_Application_Display Tabular This tabular panel displays the maximum 
wait times, and the number of contacts 
offered, waiting, answered, or abandoned.

CC_Sample_Skills Chart This panel displays the service level for 
each skillset.
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This combined display provides a real-time status report about important Avaya Contact Center 
Select performance parameters.

Procedure
1. Log on to Contact Center Manager Administration.

2. On the Contact Center Manager Administration Launchpad, click Real-Time Reporting.

3. In the left pane, select the Public Graphical Displays folder.

4. In the left pane, from the list of displays, select CC_Status.

5. On the Public Collection properties tab, select the default display options for CC Status. 
These standard displays combine to form an effective Real-Time Reporting graphical 
display.

6. Click Launch.

The Contact Center Status real-time display appears.

7. Use the display to monitor contact center performance in near real-time.

8. Experiment with Real-Time Reporting to find, copy, or create a set of displays that meets 
your solution requirements.

Example of the Contact Center Status real-time display
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Creating a private real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
Create a private real-time display to customize real-time displays.

Procedure
1. In the left pane, select the Public Tabular Displays folder under the CC server.

2. From the expanded Public Tabular Displays folder, select the display to copy.

3. In the Public Display window, type the name of your new private display. You can use only 
alphanumeric characters in the display name; do not use special characters.

When you copy a display, the system gives the new display a default name in the format 
[server name]_[display name]. Since each private display must have a unique 
name, you must type a new name, if you save a public display with the same default name. 
If you do not type a new name, the system overwrites the existing display.

4. To save the display in the Private Tabular Displays folder, click Make Private Copy.

5. On the Properties page, you can change the colors, font size, and the refresh rate.

Applying custom formulas to real-time displays
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
After you create custom formulas in the Formula Editor, apply them to your private real-time 
displays in the Real-Time Reporting component.
You can customize only the columns in private displays. If you choose a public display, you must 
first copy and save it in your Private Displays folder before you can customize the columns.
For more information about custom formulas, see Formulas on page 185.

Procedure
1. Select the Private Tabular Displays folder under the CC server.

2. Click the display to customize.

3. Click the Columns tab.

4. From the Available Fields list, select the formula to add to the real-time display.

5. Click Add Field.
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6. Click Submit to save your changes.

7. Click Launch Display to view your changes.

Printing a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
If you require a hard copy, you can print a real-time display.

Procedure
1. In the left pane, navigate to the real-time display that you want to print.

2. Click Launch Display.

3. On the real-time display window, click Print.
4. In the Print dialog box, from the Printer Name list, select the desired printer.

5. Click Print.

Deleting a private display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• At least one private display must exist.

About this task
Delete private tabular displays and private graphical displays.

Note:
Once you delete a display, you cannot recover it.

Procedure
1. In the left pane, select the CC server.

2. Click the Private Tabular Displays folder to delete a private tabular display.

OR

Click the Private Graphical Displays folder to delete a private graphical display.

3. In the selected folder, click the private display to delete.
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4. In the right pane, click Remove Private Display to delete a private tabular display.

OR

Click Remove Display to delete a private graphical display.

5. In the Confirmation dialog box, click OK.

The system permanently deletes the display.

Logging out an agent from a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Customize a private real-time display to include the Logout column, or select a previously 

customized display.

About this task
Use this procedure to log out an agent from a real-time display.

Procedure
1. In the left pane, select an Agent Display that has the Logout column and shows the agent 

you want to log out.

2. In the right pane, click Launch Display.

CCMA opens the real-time display window.

3. Scroll to the agent that you want to log out.

4. Click the Force Log out button ( ).

5. On the Logout Confirmation dialog, click Yes.

Contact Center logs out the agent, and displays a message on the agent’s Agent Desktop 
interface informing them that a supervisor has logged them out.

Changing an agent’s Ready status from a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Customize a private real-time display to include the Change State column, or select a 

previously customized display. For more information, see Real-time report customization on 
page 83.
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About this task
Use this procedure to change an agent’s status from a real-time display.

Procedure
1. In the left pane, select an Agent Display that has the Change State column and shows the 

agent whose status you want to change.

2. In the right pane, click Launch Display.

CCMA opens the real-time display window.

3. Scroll to the agent for whom you want to change the ready status.

4. Click the Change State button ( / ).

CCMA displays the Change Agent State Confirmation dialog.

5. If you changed the agent’s status from Ready to Not Ready, on the Change Agent State 
Confirmation dialog, enter a Not Ready Reason code, and click Yes.

Contact Center displays a message on the agent’s Agent Desktop interface informing them 
of the state change.

6. If you changed the agent’s status from Not Ready to Ready, on the Change Agent State 
Confirmation dialog click Yes.

Contact Center displays a message on the agent’s Agent Desktop interface informing them 
of the state change.

Viewing the non-staffed skillsets
About this task
Use the Non-Staffed Skillsets window to view a list of all the skillsets within your partition, without 
logged-on agents. The list of non-staffed skillsets automatically refreshes every 20 seconds with 
the most recent information.

Procedure
1. Log on to the Real-Time Reporting component.

2. In the left pane, click the relevant server and then click the folder that contains the skillset 
display.

3. Click the skillset display that you want to launch.

4. In the right pane click Launch Display

The display launches.

5. In the display, click Non-Staffed Skillsets.
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The Non-Staffed Skillsets window appears, listing all of the skillsets within your partition, 
without logged-on agents.
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Chapter 6: Filter management

In Avaya Contact Center Select, you can create skillset, application, and agent filters for real-time 
reporting. You can configure filters with a combination of the three data types.

Use filters to specify the skillset, application, and agent data that you want to see in the realtime 
displays. In the Filters window, configure the filters from all elements in the partition assigned to you. 
After configuring filters, you can assign the filters to your private real-time displays.

The real-time displays show subtotals of data for each filter, which are further divided into subtotals 
for each site that belongs to the filter.

Note:

Some statistical fields cannot be accumulated.

Creating a filter in Real-time reporting
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Ensure that you have access to filters.

About this task
Create filters to specify the skillsets, applications, and agents that you want to see in the real-time 
display grids, and the agents that you want to see in the agent map graphical displays.

Procedure
1. From the Filters menu, select Manage Filters.

2. Right-click on the Filters folder and select Add Filter.
3. In the New Filter Name box, type the name of the filter. You can use only alphanumeric 

characters. Do not use special characters.

4. Click Submit to save the filter.
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Adding skillset elements to a filter
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

About this task
Add skillset elements to a filter to view the required statistics.

Procedure
1. From the Filters menu, select Manage Filters.

2. In the left pane, select the filter to edit.

3. Select the server on which to add the elements.

4. Select the Skillsets tab.

5. Click the Assign Skillsets heading.

6. From the list, select contains, is equal to, or starts with.

7. In the box, type the skillset name.

8. Click Search.

9. In the list of available skillsets, select the check box for each skillset to add to the filter.

OR

To select all available skillsets, select the Select All check box.

10. Click Submit to save your changes.

Adding application elements to a filter
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

About this task
When you select an application element to filter in billboards and charts, your new application 
element appears in the Filter Selection list under Available.

Procedure
1. From the Filters menu, select Manage Filters.

2. In the left pane, select the filter to edit.

3. Select the server on which to add the elements.
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4. Select the Application tab.

5. In the list of available applications, select the check box for each application to add to the 
filter.

OR

To choose all available applications, select the Select All check box.

6. Click Submit to save your changes.

Adding agent elements to a filter
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

About this task
Include statistics for specific agents by adding agent elements.
When you select an application element to filter in billboards and charts, the new application 
element appears in the Filter Selection list under Available.

Procedure
1. From the Filters menu, select Manage Filters.

2. In the left pane, select the filter to edit.

3. Select the server on which to add the elements.

4. Select the Agents tab.

5. Click the Assign Agents heading.

6. From the first list, select Last Name, First Name, Department, Comment, or Login ID.

7. From the second list, select contains, is equal to, or starts with.

8. In the box, type a value to search.

You can search for up to five levels by selecting And or Or from the last list.

9. Click Search.

Agents that match your criteria appear in a table.

10. In the list of available agents, select the check box for each agent to add to the filter.

OR

To choose all available agents, select the Select All check box.

11. Click Submit to save your changes.
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Removing elements from a filter
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

About this task
To modify the report display, remove elements from a filter.

Procedure
1. From the Filters menu, select Manage Filters.

2. In the left pane, select the filter from which to remove applications, skillsets, or agents.

3. On the Skillset, Application, and Agent tabs, clear the check boxes for each skillset, 
application, or agent to remove from the filter.

4. Click Submit to save your changes.

Deleting a filter
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

About this task
If you need to rename a filter, you must delete the filter and create a new one with a new name.

Procedure
1. From the Filters menu, select Manage Filters.

2. In the left pane, select the filter to delete.

3. In the right pane, click Delete Filter.
4. On the message box that appears asking you to confirm your choice, click Yes.

Applying filters to real-time tabular displays
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

Removing elements from a filter
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About this task
Use the Filters page to apply filters to customize your real-time tabular displays. You can apply a 
filter, a supervisor-reporting agent combination, or both.

Procedure
1. In the left pane, under the server containing the real-time display to which to apply filters, 

select the Private Tabular Displays folder.

2. Click the private display to customize.

3. Click the Filters tab.

4. From the list of available filters, select the check box for each filter to assign to the 
real-time display.

OR

To assign all of the available filters (and supervisor-reporting agent combinations listed, if 
you customize the Standard Agent Display), click Select All.

5. Click Submit to save your changes.

6. Click Launch Display to start the display and view your changes

Applying filters to graphical displays
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

About this task
Filters on real-time displays provide a mechanism for a supervisor to group together a number 
of agents, applications, or skillsets. Real-time reporting is capable of providing summary statistics 
for filters when they are added to a display. Filters are available for selection as an alternative to 
skillsets or applications on a number of the real-time reporting billboards and charts. The following 
displays support filters:

• Application Billboards
• Skillset Billboards
• Application Chart (statistics per application)
• Skillset Chart (statistics per skillset)
• Time Line Chart (statistics per skillset)
• Time Line Chart (statistics per application)
• Agent Map
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Note:
Filters are not supported on dashboard displays.

Procedure
1. In the left pane, under the server containing the real-time graphical display to which you 

require to apply filters, select the Private Graphical Displays folder.

2. Click the private display to customize.

3. From the drop-down list of Applications or Skillsets, select the filter to assign to the 
real-time display.

The filters are grouped together at the end of the Applications list or the Skillsets list.

4. Click Submit to save your changes.

5. Click Launch to start the display and view your changes.

Applying supervisor-reporting agent combinations to real-
time displays

About this task
You can apply supervisor-reporting agent combinations to the Standard Agent display.

Before you begin
• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

Procedure
1. In the left pane, select the server containing the Standard Agent real-time display.

2. Select the Private Tabular Displays folder.

3. Click the private agent display to customize.

4. Click the Filters tab.

5. From the list of available supervisor-reporting agent combinations, do one of the following:

• Select the check box for each supervisor you want to assign to the real-time display.

• To assign all available supervisor-reporting agent combinations and filters, select the 
Select All check box.

6. Click Submit to save your changes.

7. Click Launch Display to start the display and view your changes.
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Removing filters from a real-time display
About this task
You can remove filters you do not require to modify a real-time display.

Before you begin
• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

Procedure
1. In the left pane, select the server that contains the real-time display.

2. Select the Private Tabular Displays folder.

3. Click the display to customize.

4. Click the Filters tab.

5. From the list of assigned filters, do one of the following:

• Clear the check box for each filter you want to remove from the real-time display.

• To remove all filters, select the Clear All check box.

6. Click Submit to save your changes.
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Chapter 7: Exported displays

The procedures in this section describe how to work with exported real-time displays.

Exporting real-time displays
Before you begin
Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can export real-time displays to open the file in a new browser window. Exporting real-time 
displays creates a snapshot file in HTML format.

Important:
You must carefully manage exported displays. Exported displays consume disk space on the 
Contact Center Manager Administration server.

Procedure
1. In the left pane, double-click the real-time display to export.

2. On the real-time display, click Export.
3. To open the file in a new browser window, click View.

Viewing an exported real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You must view an exported real-time display, to print the display.

Procedure
1. From the Displays menu, select Manage Exported Displays.

2. In the right pane, from the list of HTML files, click the name of the file to view.
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A snapshot of the real-time display grid opens in a new browser window.

3. From the File menu in your browser, click Print to print the exported grid.

4. To view the colored rows of the real-time display, in the Print window, select a color printer.

5. Click Print.

Changing the file name prefix of exported real-time display 
grids

Before you begin
• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can choose the prefix to appear in the file name when you export the real-time display grids 
to the server as HTML files. An example of the prefix for the Consolidated Skillset Display is 
ConsolidatedSkillSet.
The exported file name includes your user name, the prefix that you select, the date 
and time you save the file. For example, if your user name is John, your prefix is 
ConsolidatedSkillSet, and you chose to export the Consolidated Skillset Display as an 
HTML file on April 10, 2000 at 2:45:28 p.m., the system saves it on the server as 
John_ConsolidatedSkillSet_20000410_144528.htm.

Procedure
1. In the left pane, under the CC server, click the Private Tabular Displays folder.

2. Click the display name.

3. On the Properties page, in the Grid export prefix box, type the prefix to appear in the 
HTML file name.

Note:

Do not include spaces in the prefix.

4. Click Submit to save your changes.
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Chapter 8: Graphical displays

In the Graphical Display window, you can configure one of seven types of graphical displays:

• Billboard displays

• Chart displays

• Time Line displays

• Agent maps

• Collections

• Billboard collections

• Dashboard displays

Adding a graphical display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
Create a graphical display.

Procedure
1. From the Displays menu, select Add Graphical Display.

2. In the Name box, type the name of the new graphical display.

The system displays this name on the system tree.

3. From the Server list, select the CC server.

4. In the Element Type area, select the type of element corresponding to the type of graphical 
display that you want to create, from the following list:

• Agent: Create an agent map.

• Application: Create an application billboard, chart, or time line.

• IVR: Create an IVR billboard, chart, or time line.

• Skillset: Create a skillset billboard, chart, or time line.
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• All: Create a dashboard, a private or public collection, a private billboard or public 
billboard collection.

5. In the Presentation area, select the type of graphical display to create.

The type of chart you can create varies according to the selection you made in the Element 
type area.

6. Click Edit Properties to configure the graphical display.

The system displays the corresponding properties window.

7. Click Submit to save the graphical display.

Opening a graphical display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one graphical display.

About this task
View a graphical display.

Procedure
1. In the left pane, click the folder containing the graphical display to view.

2. Click the graphical display to view.

3. In the right pane, review the current settings for the graphical display.

4. If you change the settings, click Submit to save your changes.

5. Click Launch.

While you view an agent map or billboard graphical display, the display can change color. 
This change alerts you when the statistic values exceed the configured threshold values. 
For agent map displays, text flashes when a threshold value is reached, while you view the 
display in the box view (if you configure the display with this feature).

If you select Pop to front, the display appears in front of all open windows. On each 
refresh, the display continues to pop to the front of all open windows, until the data on the 
display falls below the threshold level.
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Deleting a graphical display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
When you no longer require a graphical display, you can delete the display.

Procedure
1. In the left pane, click the Public Graphical Displays or the Private Graphical Displays 

folder.

Note:

When you delete a graphical display, you cannot restore it. Instead, you must create a 
new graphical display.

2. In the list of displays, click the graphical display to delete.

3. In the right pane, click Remove Display.

4. In the message box that appears asking you to confirm your choice, click OK.

Creating a Real-time Dashboard display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can create a Real-time Dashboard display to provide you with multiple views of up-to-date 
statistics for your contact center and its resources. A real-time dashboard display is click-once 
client application that displays performance related real-time statistics. Contact Center uses Click 
Once Deployment technology to download and install the application from the Contact Center 
server.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new dashboard.

This is the name that appears in the system tree. You can use only alphanumeric 
characters in the collection name, you cannot use special characters.

3. From the Servers list, select the CC server.

4. In the Element Type area, select All.
5. In the Presentation area, select Dashboard.

Deleting a graphical display
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6. Click Edit Properties to configure the new collection.

7. The Collection Properties window appears.

8. In the Dashboard title box, accept the default name, or delete the default name and 
type a custom name to appear as the title of the window when the dashboard display is 
launched.

9. The Install button is enabled if the prerequisite software required to run the dashboard is 
not found on your computer. Click the Install button download and install the relevant .Net 
Framework.

10. Click Submit to save your changes.

The new dashboard appears on the system tree under Graphical Displays.

Adding charts to the Real-time Dashboard
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a Real-time Dashboard display.

About this task
You can add charts to the Real-time Dashboard to view them.

Procedure
1. In the left pane, click the Private Graphical Displays folder.

2. Click the Real-time Dashboard display.

3. Click Launch.

4. From the Displays menu, select a display chart.

5. From the display chart menu, select the data to display on the chart.

The data appears on the chart in the Real-time Dashboard display.

Changing chart properties in the Real-time Dashboard 
display

Before you begin
• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a Real-time Dashboard display.
• Add a display chart to the Real-time Dashboard.
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About this task
You can change the items that appear on the charts in the Real-time Dashboard to meet your 
requirements.

Procedure
1. Click the Properties tab of the chart to change.

2. Select the skillsets, applications, and statistics to display on the chart.

3. Click the Display tab to display the updated chart.

Note:

If you choose None from the Color Palette drop-down list, in the Display > Options 
menu, the chart is displayed in its default color.

Removing display charts from the Real-time Dashboard 
display

Before you begin
• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a Real-time Dashboard display.
• Add a display chart to the Real-time Dashboard.

About this task
You can remove display charts from the Real-time Dashboard display.

Procedure
1. In the left pane, click the Private Graphical Displays folder.

2. Select the Real-time Dashboard display.

3. Click Launch.

4. Click the X button beside the display to remove the display.

Saving the Real-Time Dashboard display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a Real-time Dashboard display.
• Add a display chart to the Real-time Dashboard.

Removing display charts from the Real-time Dashboard display
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About this task
Save the Real-time Dashboard display window size and the following attributes of each Real-time 
Display chart:

• size and position of the window
• display type
• list of selected statistics
• list of selected skillsets or applications

Procedure
Close the Real-time Dashboard display window and select Yes on the Save dialog.

OR

Select Save from the File menu.

Configuring an agent map
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can configure an agent map to view a representation of all the agents to whom you have 
access in your contact center.

Note:
You cannot log out an agent, or change an agent’s status, from an agent map; these actions 
are possible only from tabular displays.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new agent map. This is the name that appears in 
the system tree. You can only use alphanumeric characters in the agent map name; you 
cannot use special characters.

3. From the Server list, select the CC server.

4. In the Element Type area, select Agent.
5. In the Presentation area, confirm that Agent Map is selected.

6. Click Edit Properties to configure the new agent map.

The Agent Map Properties dialog box appears.
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7. In the Agent map title box, type the agent map name to appear at the top of the agent 
map display, or accept the default name. Do not include spaces, special characters, 
punctuation, or the ampersand (&) in the agent map title.

8. From the Data collection mode list, select Moving window or Interval-to-date.

9. From the Agent Name list, select how you want the agent name and login ID to appear in 
the header of each icon in the Icon view. You can choose from the following options:

• agent first name, followed by last name

• agent last name, followed by first name

• agent first name and login ID

• agent last name and login ID

10. From the Linked Display list, select the display.

You can choose from all the private, public, and standard displays (both tabular and 
graphical) to which you have access to. If you choose nothing from the Linked Display list 
when you configure the agent map, the Standard Agent Display appears when you click 
Linked Display.

11. From the Associated filter list, select the agent filter to assign to the agent map.

The filters containing agents appear.

12. In the Threshold settings area, click the colors to which the text in the box view agent 
map change, when a threshold level is exceeded.

In the icon view, the agent icon changes to these colors when a threshold level is 
exceeded.

When you choose the threshold colors, select colors that make the text easy to view 
against the agent state background colors in box view.

If you do not use a mouse, press Tab until the status bar indicates that you have reached 
the desired color. After reaching the desired color, press the Spacebar to select the color.

13. Select the Text Flash on threshold check box to view the text in the launched box view.

The agent map flashes when a threshold level is exceeded. (This option is not applicable 
to the View Agent Map Displays icon.)

14. Select the Hide logged out Agents check box to view logged on agents only when you 
activate the agent map.

If you do not select this check box, you see all agents in the filter that you attach to the 
display, both logged on and logged off.

15. In the Agent State Colors area, select the appropriate check boxes to choose the colors 
to shown for each agent state.

16. Click Submit to save your changes.

The new agent map appears in the system tree under Graphical Displays.
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Arranging agents in an agent map using drag and drop
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Launch an agent map display.

About this task
Position an agent within the agent map.

Procedure
1. On the agent map display, click the agent block to move within the display.

2. While pressing the left mouse button on the agent, drag the agent to the new position 
within the agent map.

3. Release the mouse button to leave the agent in the new position.

4. Click Save Layout to save the new arrangement.

Customizing the agent map layout
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Launch an agent map display.

About this task
Adapt an agent map layout to meet your requirements.

Procedure
1. In the agent map, click and drag the agent icons to the desired position.

2. To change the size of the window, place your cursor on the edge of the window until a 
two-headed arrow appears.

3. Click the edge of the window, and then drag it to the desired size.

4. Click Save Layout to save your changes. The next time you open the agent map, your 
custom layout appears.

5. To rearrange the icons automatically in the window, click Tile Agents.
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Zooming in or out on an agent map display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Launch an agent map display.

About this task
While you look at the agent map in the box view, you can resize the display to 50, 75, 125, 150, 
200, or 300 percent of normal size when you use the zoom feature. The resizing option does not 
apply to agent maps that appear in the icon view. When you resize an agent map, the text within 
the agent blocks are also resized, and the relative position of the icons are maintained. To return 
the display to the normal size, select 100 percent from the list.
If you resize an agent map to 50 percent of the normal size, the spacing between the agent map 
icons is halved.

Procedure
From the Zoom list, select a value to resize the agent map.

Activate a display from an agent map
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Configure an agent map.

About this task
On the agent map graphical display, you can view a grid display. When you customize the agent 
map, you can choose which display to view when you click the Linked Display button. You can 
choose from all the private, public, and standard displays (both tabular and graphical) to which you 
have access.
If you do not configure which display to view with the Linked Display feature, the Standard Agent 
Display becomes the default display when you click the Linked Display button.

Procedure
On the agent map display, click Linked Display.

The display that you chose from the Linked Display list activates.

Zooming in or out on an agent map display
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Activate an agent details window from an agent map
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Configure an agent map.

About this task
When you look at an agent map in box view, you can double-click the agent icons to view a 
separate window that lists details about the agent. The window displays the name, login ID, 
supervisor, position ID, and personal DN of the agent. You can double-click the agent icons in the 
display, for both logged on and logged off agents, to activate this details window.

Procedure
1. Launch the required agent map display.

2. Double-click an agent icon in the agent map display.

A new window appears that lists the agent details.

Configuring a billboard display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can configure a billboard display to select a statistic to monitor closely.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new billboard graphical display. This is the name 
that appears in the system tree. You can use alphanumeric characters only.

3. From the Server list, select the CC server.

4. In the Element Type area, select Application, IVR or Skillset.
5. In the Presentation area, select Billboard.

6. Click Edit Properties to configure the new billboard display.

7. In the Billboard title box, accept the default name provided, or delete the default name 
and type a custom name to appear at the top of the billboard display.

Do not include spaces, special characters, punctuation, or the ampersand (&) in the 
billboard title.

8. From the Data collection mode list, select either Moving window or Interval-to-date.
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9. From the Application or Skillset list, select the application or skillset to monitor, or select 
Summary.

10. From the Statistic list, select the statistic to monitor in the billboard. The name of the 
statistic that you monitor appears in the title bar of the billboard display window when you 
activate it.

11. From the Font color boxes, select the color for the statistic.

The background color of the billboard display is black until a threshold value is reached, 
at which time it changes to either of the threshold colors you selected, and the font color 
changes to black.

If you do not use a mouse, press Tab until the status bar indicates that you have the 
selected color. After reaching the desired color, press the Spacebar to select the color.

12. From the Threshold settings boxes, click to select the colors for the thresholds below 
level 1, between level 1 and level 2, and above level 2, or accept the default colors shown.

You can view the current Level 1 and Level 2 threshold values configured for this statistic 
in the Value boxes beside the threshold settings boxes.

13. Select the Pop to front check box to move the activated billboard to the front on your 
desktop when a threshold level is reached.

The billboard display appears in front of all open windows. On each refresh, the billboard 
display continues to pop to the front of all open windows, until the data on the display falls 
below the threshold level.

14. Click Submit to save your changes.

The new billboard appears in the system tree under Private Graphical Displays.

Configuring a chart display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can configure a chart display for skillsets, applications, or statistics to monitor in a customized 
chart.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new chart graphical display.

This is the name that appears in the system tree. You can use alphanumeric characters 
only.
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3. From the Server list, select the CC server.

4. In the Element Type area, select Application, IVR or Skillset.
5. If you select Application, in the Presentation area, select the Chart (choose statistics 

per application) or the Chart (choose applications per statistic).
6. If you select Skillset, in the Presentation area, select the Chart (choose statistics per 

skillset) or the Chart (choose skillsets per statistic).
7. If you select IVR, in the Presentation area, select Chart (choose statistics for IVR 

summary).
8. Click Edit Properties to configure the new chart display.

9. In the Chart title box, accept the default name, or delete the default name and type a 
custom name to appear at the top of the chart display.

10. From the Chart type list, select the type of chart to configure. You can choose from 
Horizontal Bar, Vertical Bar, or Pie.

11. From the Chart fill list, select Color or Pattern (Black & White).
12. If you select Chart (choose applications per statistic), or Chart (choose skillsets per 

statistic) from the Statistics list, select a statistic.

13. From the Application list, select an application to monitor. Choose Summary to view a 
summary of all applications in your partition.

14. For Chart (choose statistics per skillset), from the Skillset list, select a skillset to 
monitor.

15. Choose Summary to view a summary of all skillsets in your partition.

If you select Summary, the total for statistics such as Agents Staffed, Agents Active, 
Agents Not Ready, or Agents Idle is shown as 0 because one agent is typically assigned to 
more than one skillset, which results in misleading totals.

16. From the Data Collection Mode list, select the Moving window or Interval-to-date.

17. In the Export path box, type the path in which to save a copy of the chart that you export 
as a BMP or JPG file (for example, C:\My Documents). If you leave this field blank, the 
file is exported to your desktop.

18. If you select Chart (choose statistics per application), Chart (choose statistics for 
IVR summary), or Chart (choose statistics per skillset), in the Statistic area, select the 
check box for each statistic to view in the chart display.

19. If you select Chart (choose applications per statistic), in the Applications area, select 
the check box for each application to view in the chart display.

20. If you select Chart (choose skillsets per statistic), in the Skillsets area, select the check 
box for each application to view in the chart display.

21. To select all check boxes, click Select All. To clear all check boxes, click Clear All.
22. Click Submit to save your changes.
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The new chart appears in the system tree under Graphical Displays and the Graphical 
Display window refreshes.

23. To create a public copy of your custom display, in the Type in the name of your public 
display box, type a name for the public display, and then click Make Public Copy.

A copy of your display appears in the Public Graphical Displays folder.

Creating a private collection
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can configure and save your favorite combination of data windows.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new collection.

This is the name that appears on the system tree. You can use only alphanumeric 
characters in the collection name; you cannot use special characters.

3. From the Server list, select the CC server.

4. In the Element Type area, select All.
5. In the Presentation area, select Private Collection.

6. Click Edit Properties to configure the new collection.

The Private Collection Properties window appears.

7. From each display list, select a display to include in this collection.

The display lists include all of the public displays and private displays saved on the server. 
You can choose a maximum of six different displays.

You must configure the graphical displays on the server before you can include them in 
your collection.

8. Click Submit to save your changes.

The new collection appears on the system tree under Private Graphical Displays.
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Creating a private billboard collection
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can configure and save your favorite combination of billboards.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new collection or billboard collection.

This is the name that appears on the system tree. You can use only alphanumeric 
characters in the collection name; you cannot use special characters.

3. From the Server list, select the CC server.

4. In the Element Type area, select All.
5. In the Presentation area, select Private Billboard Collection.

6. Click Edit Properties to configure the new collection.

The Private Billboard Collection Properties window appears.

7. In the Available box, highlight each public or private billboard to include in your billboard 
collection, and then click the right arrow (>) to move the billboard to the Selected box.

Private billboards are marked with an asterisk (*). You can choose from all public or private 
billboards on the server, up to a maximum of 25 billboards.

8. Click Submit to save the private billboard collection.

The new billboard collection appears on the system tree under your Private Graphical 
Displays folder on the currently selected server.

Configuring a Time Line display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can configure a time line display for skillsets, applications, or IVR statistics to monitor in a 
customized chart.
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Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new time line graphical display.

This is the name that appears in the system tree. You can use alphanumeric characters 
only.

3. From the Servers list, select the CC server.

4. In the Element Type area, select Application, IVR, or Skillset.
5. If you select Application, in the Presentation area, select Time Line (choose statistics 

per application) or Time Line (choose applications per statistic).
6. If you select Skillset, in the Presentation area, select Time Line (choose statistics per 

skillset) or Time Line (choose skillsets per statistic).
7. If you select IVR, in the Presentation area, select Time Line (choose statistics for IVR 

summary).
8. Click the Edit Properties button.

9. In the Chart title box, accept the default name, or delete the default name and type a 
custom name to appear at the top of the time line display.

10. From the Chart fill list, select Color or Pattern (Black & White).
11. If you select Time Line (choose applications per statistic), or Time Line (choose 

skillsets per statistic) from the Statistics list, select a statistic.

12. From the Application list, select an application to monitor.

13. Choose Summary to view a summary of all applications on the server.

14. For Time Line (choose statistics per skillset), from the Skillset list, select a skillset to 
monitor.

15. Choose Summary to view a summary of all skillsets on the server.

If you select Summary, the total for statistics such as Agents Staffed, Agents Active, 
Agents Not Ready, or Agents Idle is shown as 0 because one agent is typically assigned to 
more than one skillset, which results in misleading totals.

16. From the Data Collection Mode list, select the Moving window or Interval-to-date.

17. From the Refresh Rate (seconds) list, select from the available refresh rates of 1, 5, 10 or 
30 seconds.

18. From the Display History (minutes) list, select from the available history values of 1, 5, 
10 or 30 minutes.

19. In the Export path box, type the path in which to save a copy of the chart that you export 
as a BMP or JPG file (for example, C:\My Documents). If you leave this field blank, the 
file is exported to your desktop.
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20. If you select Time Line (choose statistics per application), Time Line (choose 
statistics for IVR summary), or Time Line (choose statistics per skillset), in the 
Statistic area, select the check box for each statistic to view in the chart display.

21. If you select Time Line (choose applications per statistic), in the Applications area, 
select the check box for each application to view in the time line display.

22. If you select Time Line (choose skillsets per statistic), in the Skillsets area, select the 
check box for each application to view in the time line display.

23. To select all check boxes, click Select All. To clear all check boxes, click Clear All.
24. Click Submit to save your changes.

The new chart appears in the system tree under Graphical Displays and the Graphical 
Display window refreshes.

25. To create a public copy of your custom display, in the Type in the name of your public 
display box, type a name for the public display, and then click Make Public Copy.

A copy of your display appears in the Public Graphical Displays folder.
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Chapter 9: Real-time report customization

The procedures in this section describe how to customize your real-time reports. You can customize 
real-time report displays and real-time report summary charts.

Adding a new column to a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
When you customize your private real-time display grids, you can add new columns by choosing 
from a list of available statistics.

Procedure
1. In the left pane, click the Private Tabular Displays folder.

The folder expands to show a list of private displays.

2. Click the display to customize.

3. Click the Columns tab.

4. From the Available Fields list, select the statistic to add to the real-time display.

5. Click Add Field.

The column appears in the sample display table.

6. Click Submit to save your changes.

Customizing display properties
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a private real-time display.
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About this task
You can customize private display properties to meet your requirements.

Procedure
1. In the left pane, click the Private displays folder.

2. Click the real-time display to customize.

3. On the Properties page, select your customized settings.

4. Click Submit to save your changes.

Changing the refresh rate of a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a private real-time display.

About this task
A slight delay occurs between the events in the contact center and the statistics that you see 
in the displays. The length of the delay depends on the refresh rate settings in the Real-time 
Statistics Multicast (RSM) component and on the application server.
The refresh rate that you specify applies to both the private real-time displays and summary 
charts.

Procedure
1. In the left pane, click the Private Tabular Displays folder.

2. Click the display name.

3. In the right pane, click the Properties tab.

4. In the Refresh rate box, type the rate at which to refresh data in the real-time display.

You can specify a minimum value of 0.5 seconds or a number from 1 to 99 (seconds).

5. Click Submit to save your changes.

Changing the font size in a real-time display grid
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a private real-time display.
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About this task
You can select the font size for the column headings and the column data in your private real-time 
displays.

Procedure
1. In the left pane, click the Private Tabular Displays folder.

2. Click the display name.

3. In the right pane, click the Properties tab.

4. In the Column font size boxes, type the size for the column headings and the column 
data. You can choose a font size from 8 to 14.

If you make no selection, the system applies the default font size of 8.

5. Click Submit to save your changes.

Changing the color settings of a real-time display grid
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can configure the color settings for the data, filter and site subtotals, and the summary rows of 
the real-time display grids. If you choose no custom color, the system applies the default colors to 
each area.

Procedure
1. In the left pane, navigate to the real-time display.

2. In the right pane, on the Properties tab, in the Color settings area, choose the color 
settings to appear in the real-time display grids.

3. Click Submit to save your changes.

Changing column names
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can change the column names of private displays. You can customize the columns of only 
private displays. If you choose a public display, you must first copy it and save it in your Private 
Displays folder before you can customize the columns.

Changing the color settings of a real-time display grid
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Procedure
1. In the left pane, navigate to the real-time display to customize.

2. In the right pane, click the Columns tab.

3. To add columns to the display, from the Available Fields list, select a column, and then 
click Add Field.

4. In the Column Name box, type the new name to appear in the real-time display grid, and 
then press Tab.

The new column name appears in the sample table.

You can change as many names as you want.

5. After you change the names, click Submit to save your changes.

6. Click Launch Display to view the real-time display to see your changes.

Changing the column width in a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can customize the columns of only private displays. If you choose a public display, you must 
first copy it and save it in your private folder before you can customize the columns.

Procedure
1. In the left pane, under the server that contains the real-time display to customize, navigate 

to the display.

2. In the right pane, click the Columns tab.

3. Click the name of the column to resize.

4. In the Column width box, type the width of the column in characters.

Note:

You cannot make the column narrower than the column text. To shrink the column to 
the exact width of the column heading text, type a low number of characters in the 
Column width box (for example, type 5).

5. Click Submit to save your changes.

6. Click Launch Display to start the real-time display and to view your changes.
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Rearranging columns in a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can rearrange the columns only of private displays. If you choose a public display, you must 
first copy it and save it in your Private Tabular Displays folder before you can customize the 
columns.
You cannot move the Site, Filter, Skillset, or Application column headings. However, you can 
choose the order in which they appear in the private network-consolidated real-time displays.

Procedure
1. In the left pane, click the Private Tabular Displays folder.

2. Click the private display to customize.

3. In the right pane, click the Columns tab.

4. Click the name of the column to move.

5. Click Move Left or Move Right to move the column heading to the desired position.

6. Click Submit to save your changes.

Changing the data collection mode of a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
Specify the mode in which you want to view collected contact center data.

Procedure
1. In the left pane, click the Private Tabular Displays folder.

2. Click the display name.

3. In the right pane, click the Properties tab.

4. From the Data collection mode list, select the mode in which to view the collected data.

5. Click Submit to save your changes.

Rearranging columns in a real-time display

April 2024 Administering Avaya Contact Center Select 87
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AdministeringAvayaContactCenterSelect&p3=33


Changing the title of a real-time display grid
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
Select the title to appear at the top of each private real-time display grid.

Procedure
1. In the left pane, click the Private Tabular Displays folder.

2. Click the display name.

3. In the right pane, click the Properties tab.

4. In the Display Title box, type the title to appear at the top of the real-time display.

If you do not type a title, the system applies the default title.

5. Click Submit to save your changes.

Deleting columns from a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• You can customize the columns of only private displays. If you choose a public display, 

you must first copy it and save it in your Private Tabular Displays folder before you can 
customize the columns.

About this task
When you customize your private real-time display grids, you can delete any column except for 
the Site, Filter, Skillset, and Application columns.

Note:
If you delete the Answered Skillset column, the Contact Type icons do not display in the 
Contact Status column.

Procedure
1. In the left pane, navigate to the private display to customize.

2. In the right pane, click the Columns tab.

3. From the sample table, click the statistic to delete from the real-time display.

4. Click Delete.

5. Click Submit to save your changes.
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Moving the chart contents within the window
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can move the summary chart contents within the window frame to concentrate on specific 
areas of the chart.

Procedure
1. While viewing the chart, press Shift.
2. While pressing Shift, hold down both mouse buttons.

3. On the chart, move your mouse to drag the contents to the desired position.

4. Release Shift and the mouse buttons.

5. To restore the chart to the original state, press R on your keyboard.

Rotating a summary chart
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Open a summary chart.

About this task
Rotate a summary chart to view the complete content.

Procedure
1. While viewing the chart, press Shift.
2. While pressing Shift, hold down both mouse buttons.

3. Move your mouse in a circular direction.

The chart contents rotate.

Increasing or decreasing the summary chart size
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Open a summary chart.
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About this task
Customize the size of the chart contents within the chart frame. You cannot increase the size of 
the chart frame.

Procedure
1. While viewing the chart, press Ctrl.
2. While pressing Ctrl, hold down both mouse buttons.

3. On the chart, move your mouse upward to decrease the size of the chart contents or 
downward to increase the size of the chart contents.

4. After you adjust the size appropriately, release Ctrl and the mouse buttons.

5. To restore the chart to the original state, press R on your keyboard.

Zooming in on areas of a summary chart
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Open a summary chart.

About this task
Zoom in on a summary chart to view specific information.

Procedure
1. While viewing the summary chart, press Shift.
2. While pressing Shift, click and drag to select the area of the chart to view more closely.

3. Release Shift and the mouse button.

The area increases in size.

4. To restore the chart to the original state, press R on your keyboard.
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Chapter 10: Contact Center Management 
fundamentals

Contact Center Management contains the following main data views:

• Supervisors view

• Agents view

• Skillsets view

• Assignments view

You can use Contact Center Management to perform the following tasks:

• View users defined in Contact Center Manager Server.

• View agent-to-supervisor assignments.

• View agent-to-skillset assignments.

• View the schedule of all agent-to-skillset and agent-to-supervisor assignments.

• Assign agents to skillsets, and make supervisor changes.

• Display agent logon status in Agents, Supervisors, Skillsets, Assignments and Agent Details 
views.

• Force log out agents.

Force Agent Log out and Change Agent Status
The Force Agent Log out feature allows a supervisor to remotely log an agent out of Contact 
Center from the Contact Center Manager Administration (CCMA) user interface. This allows 
supervisors to log out agents who forget to log out or to go not-ready at the end of their shift.

Important:

Use the option to log out an agent only in exceptional circumstances, where there is no other 
option. If an agent has active contacts and a supervisor forces them to log out, Agent Desktop 
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shuts down: in certain scenarios this leaves their active contacts in an incorrect state. The 
following use cases indicate situations in which a supervisor can use the force log out feature:

• An agent falls sick at work, and transfers their current contacts, but leaves their desk 
without logging off. A locked screensaver prevents anyone accessing their desktop to 
close Agent Desktop. The supervisor forces this agent to log off, and there is no impact 
to customer contacts.

The supervisor can also force an agent state change to toggle it between Ready or Not Ready. 
When they force an agent into the Not Ready state, supervisors have the option to enter a 
Not Ready Reason code for the agent. The following use cases indicate situations in which a 
supervisor chooses to force an agent state change:

• A trainee agent goes Not Ready, entering a reason code of At_Lunch. They return from lunch 
but forget to reset their status to Ready. Their supervisor can see that they are at their desk, 
and also that they show Not Ready on the Real time Display (RTD). The supervisor uses the 
Change State button to make the agent Ready.

• A trainee agent leaves their desk for lunch, but forgets to set their status to Not Ready. 
Contacts continue to alert on their Agent Desktop. The supervisor notices that the agent is 
not at their desk, and that they show Ready on the RTD. The supervisor uses the Change 
State button to make the agent Not Ready.

When a supervisor logs out an agent, or changes the agent’s status, the agent receives a 
notification in Agent Desktop. With normal usage of the Force Agent Log out option, this 
is not required, because the agent is not present at their desktop. However, if a supervisor 
accidentally selects the wrong agent to log out, this notification gives the agent a time period in 
which to gracefully complete their active contacts. This time period is configurable in Multimedia 
Administration. If the agent has an active voice contact, they are able to continue the call on 
their physical phoneset after Agent Desktop closes; where the agent is using the Agent Desktop 
softphone, this is not possible and the voice contact drops.

Administrators can use a new Access and Partition management setting to restrict access to the 
Force Agent Log out feature. A new Force Agent State Change access privilege controls access 
to Force Agent Log out and Change Agent State. Only supervisors who have the Force Agent 
State Change privilege can use the feature, and supervisors can log out or change the state of 
only those agents that they can see in their partition.

Supervisors access the Force Agent Log out feature either from an agent Real-Time Display 
(RTD) or from the Contact Center Management user interface. From the CCM interface, Force 
Agent Log out enables a supervisor to log out a single agent or a group of agents. Changing an 
agent’s ready state is possible only from a Real Time Display (RTD).

The columns that display the Force Agent Log out and Change State buttons on an RTD are 
optional, and are not available on the standard RTDs. To use the buttons, supervisors must create 
a private RTD with the Change State and Logout columns included. While a supervisor can make 
public an RTD with these columns, supervisors viewing the public RTD cannot use the buttons if 
they do not have the “Force Agent State Change” access privilege.
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The CCMA audit trail records both the force logout and the force state change events. The audit 
details the time at which the event happened, the agent that the supervisor modified, and the 
CCMA user id of the supervisor who carried out the action.
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Chapter 11: Agents

In the Agents view, you can search for particular agents or list all agents on a server. You can also 
use the agents view to

• view and edit the agents' properties, including the skillsets and supervisors to which the agents 
are assigned

• log out an agent or multiple agents

Partly configured agents appear in the Contact Center Management Agents list with a grey agent 
icon.

Two types of agents are available in Contact Center Management:

• Agents

• Supervisor/agents

Editing agent details
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.

About this task
Complete this procedure to edit agent details in Contact Center Management.
As a supervisor, you can change the skillsets and supervisors to which agents are assigned.

Procedure
1. From the View/Edit menu, select Agent.
2. In the left pane, click the CC server.

In the right pane, the Agents List appears.

3. Double-click on the agent to edit.

4. Under Agent Information, from the Primary Supervisor list, select the supervisor to 
assign the agent to.

5. Click the Skillsets heading.
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6. In the Skillsets area, click List All to list all skillsets configured on the server.

7. From the Priority list for each skillset to assign to the agent, select the priority level or 
select Standby to put the agent in standby mode for this skillset.

Priority levels range from 1 to 48, with 1 being the highest priority for the skillset.

Important:

You can only assign skillsets to an agent that belongs to the same contact type.

8. To remove the skillset from the agent, select Unassigned.

9. Click Submit to save your changes.

Logging out multiple agents from the Agents list
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.

About this task
Use this procedure to force log out multiple agents.

Important:
Forcing multiple agents to log out can have a detrimental effect to contact center operation. 
Consider this option only in exceptional circumstances where there is no alternative method of 
logging out these agents. If an agent has active contacts and you force them to log out, Agent 
Desktop closes, and this can leave their active contacts in an incorrect state.

Procedure
1. From the View/Edit menu, select Agents.

2. In the left pane, click the CC server.

3. In the list of agents, select each agent that you want to log off.

4. Click Logout.
5. On the Message from Webpage dialog box, click OK.

Contact Center logs out the agents, and displays a message on the agents’ Agent Desktop 
interfaces informing them that a supervisor has logged them out.
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Logging out an agent from the Agent Details screen
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.

About this task
Use this procedure to force log out a single agent.

Important:
Use Force Agent Log out only in exceptional circumstances, where there is no other option to 
log out an agent. If an agent has active contacts and you force them to log out, Agent Desktop 
closes, and this can leave their active contacts in an incorrect state.

Procedure
1. From the View/Edit menu, select Agents.

2. In the left pane, click the CC server.

3. In the list of agents, double click the agent that you want to log off.

CCMA displays the Agent Details screen.

4. On the Agent Details window, in the Agent Information section, check the status of the 
agent in the Login Status field.

5. Click the Logout Agent.
6. On the confirmation dialog box, click Yes.

Contact Center logs out the agent, and displays a message on the agent’s Agent Desktop 
interface informing them that a supervisor has logged them out.
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Chapter 12: Historical Reporting

Using the Historical Reporting component, you can run and schedule performance and configuration 
reports. Reports help you monitor system performance by providing information about system 
activity. You can obtain standard reports which provide information about the past performance of 
the Contact Center and Contact Center configuration data. The data for historical reports is gathered 
from the Avaya Contact Center Select server.

Contact Center Manager Administration limits the number of scheduled reports that can run in 
parallel to five. Contact Center Manager Administration queues requests to run additional reports 
and processes these requests once the running report completes.

Note:

Contact Center blocks historical reports that pull more than 50,000 records from the database. 
This maximum limit safeguards the memory and CPU usage on the Contact Center server. 
Avaya recommends that you run reports with selection criteria that reduce the amount of data 
on the report.

Note:

Contact Center limits the number of items shown in the document map of the Report Viewer to 
5000. The document map is the navigation pane that appears on the left side of most reports. 
Once the limit is reached, Contact Center disables the document map and it is no longer visible 
in the Report Viewer. However, if there are multiple levels in the document map of a report, 
Contact Center removes the lowest level first and continues the removal until the number of 
items falls below 5000. For example, the document map for the Agent Performance report 
shows two items: Agent Name & ID, and the Date. If removing the Date from the document map 
reduces the number of items to 5000 or less, the Report Viewer displays the Agent Name & ID 
only. If Contact Center cannot reduce the number of items in the document map to 5000 or less, 
the document map is disabled.

Microsoft SQL Server Reporting Services (SSRS) has limitations when exporting reports. If the 
report exceeds SSRS limits, the export fails. For more information about SSRS limitations when 
exporting to different formats, refer to Microsoft SSRS documentation.

April 2024 Administering Avaya Contact Center Select 97
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AdministeringAvayaContactCenterSelect&p3=33


Logging on to Historical reporting
Before you begin

• Ensure that you have access to Historical reporting.

About this task
To access Historical Reporting, log on to the Historical Reporting component in Contact Center 
Manager Administration.

Procedure
1. Log on to Contact Center Manager Administration.

2. On the Launchpad, click Historical Reporting.

The Historical Reporting window appears.

Opening a public, private, or shared report
Before you begin

• Ensure that you have access to public report groups in Access and Partition Management.
• Log on to Historical Reporting. For information, see Logging on to Historical Reporting on 

page 98.

About this task
Open a public, private, or shared report to view a historical report.

Procedure
1. In the left pane, select the server on which to view the list of reports.

2. Select one of the following folders:

• Public Report Templates: This folder contains the standard report templates available 
in Avaya Contact Center Select. Run public reports on a demand basis, or save them 
in your Group or Private Report Templates folders and schedule the reports to run at 
a defined time. The Public Report Templates folder contains seven template folders 
corresponding to the following types of reports:

- Agent Performance reports

- Call-by-Call reports

- Configuration reports

- Contact Summary reports

- Multimedia reports

- Other reports

Historical Reporting

April 2024 Administering Avaya Contact Center Select 98
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AdministeringAvayaContactCenterSelect&p3=33


- Outbound reports

• Private Report Templates: This folder contains the report templates that you create 
by modifying an existing public, shared, or private report template, and saving your 
changes in your Private Report Templates folder. You can modify report information, 
schedule the report, and apply filters. For more information about creating private 
reports, see Creating a shared or private report on page 102.

• Group: This folder contains shared report templates. When you customize a public or 
private report template and save it in your Group folder, all other users who have access 
to your group can run and schedule the group report templates.

Note:

In the Group folder, you can modify a report template only if you are the owner of 
the report template.

3. From the expanded list, select a report template to modify or schedule the template, or run 
the report on demand.

The report properties appear in the right pane.

Running an Ad hoc report
Before you begin

• Ensure that you have access to the report folder that contains the report to run.
• Log on to Historical Reporting.

About this task
You can specify the amount of data to include in an Ad hoc report by choosing the data range and 
applying selection criteria. After you customize your report, click Run Now to generate the report 
immediately. In the resulting Ad-hoc Report Viewer window, you can choose to print or save the 
report.
You can select the data range for agent performance and call-by-call reports before you generate 
them. You cannot select the data range for configuration reports.

Procedure
1. In the left pane, select the server that contains the report to run.

2. In the expanded list, select the folder that contains the report template to run.

3. Click the folder containing the report to run.

4. Select the report template to run.

5. To view the current report properties, in the right pane, click the following headings:

• Report Details

Running an Ad hoc report
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• Selection Criteria
• Data Range
• Schedule
• Output Options: This section applies only if you previously scheduled the report.

6. To run the report with the current properties, proceed to step 8.

Note:

If you do not define the selection criteria, the system enforces partition rules to 
generate the report.

7. To define the selection criteria and the data range, see Defining the selection criteria on 
page 100.

8. To save your properties, in the Save As box, type a report name, choose a save location, 
and then click Save Report.

9. Click Run Now to generate the report.

Defining the selection criteria
Before you begin

• Log on to Historical Reporting.

About this task
You can select the elements to include in your reports by assigning filter elements to your reports. 
For example, in an agent performance report, you can choose the agents for whom to generate 
the report. You can define the selection criteria for public, private, and shared reports that you 
schedule or run on demand.
By default, if you do not define the selection criteria, the system applies partition rules to generate 
the report. However, if you select a filter element, you see only that element in the report. You 
can select a maximum of 300 elements from the available list to run the report. For example, you 
choose a skillset report and see a list of 20 skillsets in the Available filter elements box. If you 
select no skillsets, you see all 20 skillsets in the report, whereas if you select 3 skillsets, you see 
only 3 skillsets in the report. For two table reports, for example, Skillset By Agent Performance 
report, you can select 300 agents and 300 skillsets to run the Skillset by Agent Performance 
report.
The number of elements defined in a users partition profile is an important consideration when 
running historical reports. If the combined number of a particular element is greater than 300, then 
it is necessary for the user to select a subset of 300 elements or less in order to run that report. 
If no selection criteria is selected, all available elements to that user are applied to the report – 
Contact Center supports only 300 elements or less. Consider the following example:
A user is assigned three user defined partitions, configured as follows:

Historical Reporting
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Partition Name Elements
Sales Agents Contains 200 agents
Support Agents Contains 80 agents
Service Agents Contains 50 agents

If the user runs the standard Agent Performance report, the report fails to run and displays this 
error: “The maximum number of elements supported by the SQL Query is 300. Select up to 300 
elements to save/run this report or leave the selection criteria blank to report on all data.” This 
error appears because the user did not define any selection criteria and the maximum element 
limit is reached. In a user defined partition, the number of elements must not exceed 300. If the 
number of elements exceeds 300, it has the same effect as defining a selection criteria of more 
than 300 elements. To avoid this, assign less partitions to the user or use standard partitions to 
allow reports to be run for all elements.
The filter elements available depend on the type of statistics included in the report. If you select 
multiple filter elements, only those that satisfy all filter criteria appear in the report. For example, 
if you choose to report on five agents and three activity codes, if one agent uses no activity code, 
the agent does not appear in the report.

Procedure
1. In the left pane, click the server that contains the report to define.

2. Expand the folder that contains the report template to use.

3. Click the folder containing the type of report to change.

4. Select the report to use.

5. In the right pane, click the Selection Criteria heading.

6. In the Selection Criteria area, enter information in the following boxes:

• Available heading: Click this heading to view the available filter elements for this report. 
A table appears, listing the available elements. If multiple filters exist for this report, 
more than one Available table appears. Select the check box for each filter element 
to apply to the report, and then click Update Selection Criteria. The selected filter 
elements appear in the Selected table.

• Selected heading: Click this heading to view the filter elements selected for the report. 
A table appears, listing the selected elements. To remove selected filter elements, clear 
the check box for each filter element, and then click Update Selection Criteria. The 
element appears in the Available table.

7. Click Run Now to generate the report.

8. To save your changes, click Report Details, in the Save As box, type a name, choose a 
save location, and then click Save Report.
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Exporting an Ad hoc report
Before you begin

• Log on to Historical Reporting.

About this task
Export a report to convert the visual display to a required format.

Procedure
1. In the left pane, click the server that has the report to print.

2. Double-click the folder with the report to print.

3. From the expanded folder, select the report.

4. In the right pane, click Run Now to generate the report with the specified properties.

The Ad-Hoc Report Viewer appears and displays the generated report.

5. Click the Export drop-down menu and select an export type. Choose from Excel, PDF, or 
Word.

6. After you select the export type, you can choose to open or save the report in the chosen 
exported format.

Creating a shared or private report
Before you begin

• Ensure that you have access to the folder that contains the report to use.
• If you schedule the report, activate the schedule. See Activating a scheduled report on 

page 112.
• Log on to Historical Reporting.

About this task
You can create custom reports if you change existing public, shared, or private report templates to 
suit your needs. Save them in your Group or Private Report Templates folders. When you save a 
report in your Group folder, you save a shared report; that is, you share the report with other users 
who have access to your Group folder.
If you do not want to use an existing report as the basis for your custom report, you must create 
a new report using Microsoft Report Designer and import it into the Contact Center Manager 
Administration Historical Reporting application. See Importing a report on page 105.

Procedure
1. In the left pane, select the server on which to create the report.

2. Navigate to the folder that contains the report template to use.
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3. Click the report to change.

4. In the right pane, click the following headings:

• Selection criteria.

• Data range (not applicable for configuration reports)

• Schedule
5. Click Report Details.

6. In the Report Title box, type the name to appear at the top of the generated report. If 
you do not type a new report title, the default title in this box appears at the top of the 
generated report.

Note:

If you save multiple copies of the same public report in your Group or Private report 
templates folders, change the report title to distinguish between reports when you 
generate them. If you do not change the report title, all copies of the same public report 
have the same standard title when you generate the reports.

7. In the Save As box, type the new report name.

Note:

If you choose a Public report template as the basis for your custom report, and you 
want to save the new properties that you enter, you must type a new name in the 
Save As box and specify whether to save it in your Private or Group folder. If you use 
an existing private or shared template as the basis for your custom report, you can 
choose to make a copy of the report by changing the report name in the Save As 
box, or you can leave the report name and overwrite the existing template with your 
changes.

8. From the Location list, select the save location for your custom report. You can choose 
between your Private and Group folders (if you have access to a group folder).

9. In the Comment box, type comments about the report.

10. From the Time Zone list, select the time zone in which you want to define the data range 
for this report, or accept the default time shown (the system defaults to the client’s time 
zone). The data range depends on Contact Center time since the server stores the data. 
Therefore, the system always converts the data range times that you enter to Contact 
Center time.

11. Click Save Report to save your changes.

The report appears in the Group or Private Report Templates folder on the server that you 
select.
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Defining the report output
Before you begin

• Log on to Historical Reporting.

About this task
You can specify whether to print the scheduled report when it generates, save it as a file, or both. 
You can also specify one or more email addresses where the system can send a notification after 
the report generates.
If you save the report to a file, you must specify a shared folder to which the Contact Center server 
sends the output file. This folder can be on your computer, on another computer in the network, 
or on the application server. To send the file to a folder on a computer in the network, the network 
computer must be accessible from the Contact Center server.

Procedure
1. In the left pane, click the server containing the report whose output options you want to 

define.

The server expands to reveal a choice between Public, Private, and Group folders (if you 
have access to a group folder).

2. Expand the folder containing the report template to use.

3. Navigate to the report to edit.

The report properties appear in the right pane.

4. Click the Report Details heading.

5. In the Report Title box, type the name to appear at the top of the generated report.

If you do not type a new report title, the default title in this box appears at the top of the 
generated report. Do not include apostrophes (’) in the report title.

Note:

If you save multiple copies of the same public report in your Group or Private report 
templates folders, change the report title to distinguish between reports when you 
generate them. If you do not change the report title, all copies of the same public report 
have the same standard title when you generate the reports.

6. In the Save As box, type the new report name.

The name appears in the system tree. This name cannot contain apostrophes (’) and it 
must be unique, if you save the report in the same folder.

7. From the Location list, select the folder in which to save your report. You can choose 
either Private or Group (if you have access to a group folder).

8. From the Time Zone list, select the time zone in which to schedule your report, or accept 
the system default (the system defaults to the client's time zone).
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Note:

When you select the schedule time for your report, the system converts the time that 
you choose to the Contact Center server time, and gives the generated report the 
Contact Center server timestamp (if you choose a time zone other than the one on the 
Contact Center server).

9. Click the Schedule heading.

The heading expands to reveal a series of boxes.

10. In the schedule area, enter the report schedule.

11. Click the Output Options heading.

The heading expands to reveal a series of boxes.

The Output Options heading is disabled until you schedule the report.

12. In the Output Options area, choose the report output type:

• Print: When you select this option, you can choose the printer, or accept the default 
printer shown. You can also select the paper size for the report from the Paper Size list.

• Output to file: When you select this option, you must type the location where the 
report is saved in the Output box in the format \\[computer name]\[shared 
folder name]\[file name]. You can then choose the report file format. Choose 
between .doc, .pdf, or ,xls.

• Email Notification: When you choose this option, you must enter an email address 
in the box provided. The system notifies you by email when the report run is finished 
and report is generated. To enable multiple users to receive notification that a report is 
generated, you can type multiple email addresses in the box, each address is separated 
by a semicolon (;). You can type a maximum of 255 characters in the email address box.

13. Click Save Report to save your changes.

14. To activate the schedule, in the left pane, select the Scheduled Events folder.

15. In the expanded folder, select the report that you just scheduled.

16. Click Activate.

The system activates the schedule and outputs the report to the location that you specify.

Importing a report
Before you begin

• Log on to Historical Reporting.

About this task
You can use the Report Template Importing Wizard to import report templates into Contact Center 
Manager Administration that you create using Microsoft Report Designer. When you import a 
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report template, you save it on the Contact Center server. However, you access the report 
template by opening your Private Report Templates folder.
To share the report template with other users, you must save your private report in your Group 
folder (if you have access to a group folder). For more information, see Creating a shared or 
private report on page 102.
You can import two types of reports: Historical or Configuration.

Note:
For imported reports, characters are limited to the English language and characters supported 
by the server code page only. A code page is an internal table that the operating system 
uses to map symbols (letters, numerals, and punctuation characters) to a number. For more 
information about server code pages and language support for Contact Center Manager 
Administration, see Avaya Contact Center Select Advanced Administration.

Procedure
1. In the left pane, click the server to which to import the new report template.

2. On the Report menu, click Import.

The system displays the Template Importing Wizard dialog box.

3. Click the Browse button next to the Select Your Report template field, and navigate to 
the report.

4. In the Template Name box, type the name of the report to import.

5. From the Report is based on the following data list, select the type of report.

6. If applicable, provide Database alias, timestamp, and report data range details.

7. Optionally, select Synchronize report template from the network drive to ensure the 
server automatically applies any updates made to the imported report.

8. Click Import.

Follow the wizard prompts to import your report template to the server.

Editing a report
Before you begin

• Log on to Historical Reporting.
• Ensure that you are familiar with defining selection criteria. See Defining the selection 

criteria on page 100.
• Ensure that you are familiar with scheduling reports. See Scheduling a report on page 109.
• If you edit a scheduled report, you must deactivate the schedule before you can save your 

changes. See Deactivating a scheduled report on page 112.
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About this task
You can edit the properties of private reports or shared reports that you create and save in 
your Group folder. You can change properties such as the data range, the selection criteria, the 
schedule, and the report title. You must click Save Report to save the new properties.
You can change the properties of a public report template only if you save a copy of the template 
as a shared or private report. See Creating a shared or private report on page 102.

Procedure
1. In the left pane, click the server containing the report to edit.

2. Navigate to the report to edit.

The system loads the report properties, and a series of headings appears in the right pane.

3. Click the Report Details heading.

The heading expands to reveal a series of boxes.

4. In this section, you can change information in the following boxes:

• Report Title: The title that appears at the top of the generated report. Do not include 
apostrophes (’) in the report title.

• Comment: Type comments about the report.

• Save As: The name of the report. All reports saved in the same folder must have unique 
names. This name cannot include apostrophes (’). You must enter a name in this box 
when you save the report in a different folder. If you save the report in the same folder 
and do not change this name, the system overwrites the existing report with your new 
properties.

• Save Location: Select the folder in which to save the custom report. If you select 
Group, all members of your group have access to the report. If you select Private, only 
you have access to the report.

• Time Zone: Select the time zone in which to schedule or define the data range for this 
report, or accept the default time shown (the system defaults to the client's time zone). 
The data range depends on Contact Center Manager Server time since the server 
stores the data. Therefore, the system always converts the data range times that you 
enter to the Contact Center Manager Server time.

5. Click the Selection Criteria heading.

The heading expands to reveal a series of boxes.

6. Specify the information to include in your report by assigning filter elements.

7. Click the Data Range heading.

The heading expands to reveal a series of boxes.

8. Change the time range, during which the data collects, to specify the amount of data to 
include in your report.

If the data range is None and disabled, the report does not require a data range.
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9. Click the Schedule heading.

10. Indicate when and how often to generate your report.

11. Click the Output Options heading (only if you schedule the report). The heading expands 
to reveal a series of boxes.

12. Specify whether to save or print the report.

You can enter email addresses on which the system sends a notification to indicate if the 
report generates successfully.

13. Click Save Report.

Note:

If you click Run Now to generate an on-demand report, property changes are not 
saved.

Printing an Ad hoc report
Before you begin

• Log on to Historical Reporting.

About this task
You can print an on-demand report from the Ad-Hoc Report viewer.
Before you can print the report, you must run it. You can run the report with the current properties, 
or you can define the selection criteria and the data range, and then run the report. See Defining 
the selection criteria on page 100.
By default, if you do not define the selection criteria, all available data is included in the report 
when you run it. When you define the selection criteria, you can choose the data that you want to 
see.
For information about printing scheduled reports, see Defining the report output on page 104.

Procedure
1. In the left pane, click the server containing the report to print.

2. Double-click the folder containing the report to print.

3. From the expanded folder, select the report.

4. In the right pane, click Run Now to generate the report with the properties specified.

The system displays the Ad-Hoc Report Viewer and the generated report.

5. Click the printer icon to print the report to the default printer configured on your computer.
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Scheduling a report
Before you begin

• Log on to Historical Reporting.
• Ensure that you are familiar with defining selection criteria.

About this task
You can schedule reports in your group and private folders to send a report to a file or to print 
a report, or both. You can also specify one or more email addresses where you can receive 
notification that the report generated, or if problems occurred that prevented it from generating 
successfully.
You can change the properties of a public report template only by saving a copy of the template as 
a shared or private report. See Creating a shared or private report on page 102.
If you choose to send the report to a file, you must specify a shared folder where the Contact 
Center server sends the file. This folder can be on your computer, on another computer in the 
network, or on the application server. To send the file to a folder on a computer on the network, the 
network computer must be accessible from the Contact Center server.
Avaya recommends that you select a start time that does not exactly match an interval start time. 
If the scheduled report start time matches the start of an interval, it is possible that the report does 
not contain data for the previous interval. This happens when Contact Center does not complete 
writing interval data to the database before the scheduled report starts. This can occur because 
of, for example, the database size, or the volume of contacts processed in the interval. Avaya 
recommends that you avoid starting reports on the hour, or on fifteen, thirty, or forty-five minutes 
after the hour. Instead, schedule reports five minutes after intervals, for example 07:05 or 16:20.

Note:
The report schedule that you define cannot start in the p.m. range and end in the a.m. range. 
After the system converts your selected time to Contact Center server time, if the converted 
start time is in the p.m. range and the converted end time is in the a.m. range, an error 
message appears. In this case, you must re-enter the schedule start and end times, taking 
into account the time difference with the application server.

Procedure
1. In the left pane, click the server containing the report to schedule.

2. Expand the folder containing the report template to use.

3. Click the folder containing the report type to schedule.

4. In the expanded folder, select the report to schedule.

5. In the right pane, click the Report Details heading.

6. In the Report Title box, type the name to appear at the top of the generated report.

Note:

If you do not type a new report title, the default title in this box appears at the top of the 
generated report. Do not include apostrophes (’) in the report title.
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7. If you save multiple copies of the same public report in your Group or Private report 
templates folders, change the report title to distinguish between reports.

Note:

If you do not change the report title, all copies of the same public report have the same 
standard title when you generate the reports.

8. In the Save As box, type the new report name.

The name appears in the system tree. This name cannot contain apostrophes (’) and it 
must be unique, if you save the report in the same folder.

9. From the Location list, select the folder in which to save the report.

You can choose either Private or Group (if you have access to a group folder).

10. From the Time zone list, select the time zone in which to schedule your report, or accept 
the system default (the system defaults to the client's time zone).

11. Click the Selection Criteria heading.

12. In the Selection Criteria area, click the Available and Selected headings to choose the 
selection criteria for the report.

13. Click the Schedule heading.

14. In the Schedule area, select the report schedule criteria.

Note:

If you select dates for the report to generate, the report generates for the selected 
dates each year for as long as the report is scheduled. For this reason, you cannot 
select to generate the report on February 29 in a leap year, as the following year is not 
a leap year.

15. Click the Output Options heading.

16. In the Output Options area, choose the report output:

• Report output: Choose whether to print the report, send it to a file, or both.
• Printer: Select the printer.
• Paper Size: Choose the paper size.
• Output: Type the path to the shared network folder in which to save the report.
• Format: Select the report format.
• Save the file under different name each time: Save each report with a unique name. 

If you do not choose this option, the system overwrites the existing report.
• Email Notification: Select this option to receive an email notification after the report 

generates, or if the report does not generate successfully. Enter an email address in 
the box provided. The system notifies you by email when the report run is finished and 
the report is generated. To enable multiple users to receive notification that a report 
generated, you can type multiple email addresses in the box, each address is separated 
by a semicolon (;). You can type a maximum of 255 characters in the email address box.

Historical Reporting
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17. Click Save Report to save your schedule.

18. Click Activate to activate the schedule.

19. To verify that the report schedule is active, select the Scheduled Events folder, and then 
locate the scheduled and activated report to view the status and properties.

Variable definitions
Variable Definition
start time The time in the selected range in which to 

generate a report. If you select the schedule time 
for your report, the system converts the time 
that you choose to the Contact Center Manager 
Administration server time and gives the generated 
report the Contact Center Manager Administration 
server timestamp (if you choose a time zone 
other than the one in the Contact Center Manager 
Administration server).

Avaya recommends that you avoid starting reports 
on the hour, or on fifteen, thirty, or forty-five 
minutes after the hour. Instead, schedule reports 
five minutes after intervals, for example 07:05 or 
16:20.

Printing a report schedule
Before you begin

• Log on to Historical Reporting.

About this task
You can use the Scheduled Events window to print the schedules of all reports scheduled by you.

Procedure
1. In the left pane, click the Scheduled Events folder. The list of your scheduled reports 

appears.

2. In the right pane, select a report, and then click Print.
3. In the message box that appears, select one of the following options:

• Print: Click Print to print the entire list of scheduled reports shown in the window.

• Page Setup: Use the Page Setup option to select the paper size of the printed 
schedules. If you choose A4 or Letter size, the Schedule Type and Status columns 
do not appear on the print preview or the printed copy. If you choose Legal size, you 
can preview and print all the displayed grid columns.

Printing a report schedule
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• Print Preview: You can preview the report schedule.

Activating a scheduled report
Before you begin

• Log on to Historical Reporting.
• Schedule at least one report.

About this task
When you first schedule a report, or when you deactivate a scheduled report, you must activate it 
to schedule the report again. You can activate a report in one of two ways:

• Click Activate in the Report Properties window while you view a saved, scheduled, but 
inactive report.

• Click Activate in the Scheduled Events window.
This procedure shows you how to activate a report from the Scheduled Events window.

Procedure
1. In the left pane, click the Scheduled Events folder.

2. In the right pane, select the report to activate.

3. Click Activate.

The scheduled report activates and runs according to the specified schedule.

Deactivating a scheduled report
Before you begin

• Log on to Historical Reporting.
• Schedule and activate at least one report.

About this task
You must deactivate the report to pause the report run for an active scheduled report.
You must deactivate a report schedule before you change the report properties, or before you 
delete the scheduled report. To resume the report on schedule, you must reactivate the scheduled 
report after you make the changes.
You have two options to deactivate a scheduled report:

• In the Report Properties window while viewing a saved, scheduled, and activated report.
• In the Scheduled Events window.

This procedure shows you how to deactivate a report from the Scheduled Events window.

Historical Reporting
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Procedure
1. In the left pane, click the Scheduled Events folder.

2. In the right pane, select the scheduled report to deactivate.

3. Click De-Activate.

Running a report from a different time zone
Before you begin

• Log on to Historical Reporting. For information, see Logging on to Historical reporting on 
page 98.

About this task
You can select the time zone to run an on-demand report or schedule a report. The time zone that 
you select applies to the data range of the report and the report schedule. You can choose the 
time zone to appear in:

• the current computer time zone
• the Contact Center (server) time zone
• any other time zone

Procedure
1. In the left pane, select the server that contains the report to run.

2. In the expanded list, double-click the folder that contains the report to run.

3. Select the report to run.

4. In the right pane, click Report Details.
5. In the Time Zone field, select a time zone.

6. Click Run Now to generate the report.

Deleting a report
Before you begin

• Log on to Historical Reporting.
• Deactivate the schedule. See Deactivating a scheduled report on page 112.

About this task
You can delete reports from your private report templates folder and reports in your group folder 
that you create. You cannot delete public reports.
Deletions appear in the in the Audit Trail log.

Running a report from a different time zone

April 2024 Administering Avaya Contact Center Select 113
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AdministeringAvayaContactCenterSelect&p3=33


Procedure
1. In the left pane, click the server from which to delete the report.

The server appears to reveal a choice of Public, Private, and Group folders (if you have 
access to a group).

2. Navigate to the report to delete.

3. Right-click the report, and then click Delete.

4. In the confirmation dialog box, click Yes.

Historical Reporting
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Chapter 13: Emergency Help

Use Emergency Help to monitor whether the agents configured on the Contact Center server 
require your assistance. You can keep the display open on your desktop, or you can minimize the 
display to continue working in Contact Center Manager Administration. When an agent presses the 
Emergency key, the minimized Emergency Help display automatically opens on your desktop.

For each agent who presses the Emergency key, one line of data appears in the Emergency Help 
display. The display shows information about the agent, including the agent's name, location, and 
time when the agent pressed the Emergency key.

Agents can press the Emergency key when they require assistance from the supervisor, for 
example, if the caller is abusive.

Starting the Emergency Help display
About this task
Start the Emergency Help display to monitor whether the agents configured on the Contact Center 
server require your assistance. You can keep the display open on your desktop, or you can 
minimize the display to continue working in Contact Center Manager Administration. When an 
agent presses the Emergency key, the minimized Emergency Help display automatically opens on 
your desktop.

Procedure
1. Log on to Contact Center Manager Administration.

2. On the Launchpad, click Emergency Help.

3. In the left pane, select the CC server.

The Emergency Help display appears.

Printing an Emergency Help display
Before you begin

• Log on to Contact Center Manager Administration Emergency Help.
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About this task
Complete this procedure to print an Emergency Help display.

Procedure
In the Emergency Help display, click Print.

Exporting an Emergency Help display
Before you begin

• Log on to Contact Center Manager Administration Emergency Help.

About this task
You can export a snapshot of an Emergency Help display to the application server for future 
reference. The system saves the snapshot data as HTML files with a name containing your user 
name, a prefix relating to the type of display that you are exporting, and the date and time when 
you exported the data.

Procedure
1. In the Emergency Help display, click Export.

A message box appears, informing you of the HTML file name that you exported.

2. To view the exported display, click View.

Viewing an exported Emergency Help display
Before you begin

• Log on to Contact Center Manager Administration Emergency Help.

About this task
View an exported Emergency Help display to view a snapshot of an Emergency Help display that 
you exported as an HTML file to the Contact Center Manager Administration server.

Procedure
1. In the Emergency Help display, on the menu, choose Displays > Manage Exported 

Displays.

2. On the Exported Displays dialog box, from the list of HTML files, click the file to view.

The snapshot of the Emergency Help display appears in a browser window.

Emergency Help
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Deleting an exported Emergency Help display
Before you begin

• Log on to Contact Center Manager Administration Emergency Help.

About this task
You can delete from the Contact Center Manager Administration server Emergency Help displays 
that you exported as HTML files.

Procedure
1. On the menu, choose Displays > Manage Exported Displays.

2. In the Exported Displays section, from the list of HTML files, select the check box for 
each file to delete.

3. Click Delete to remove the selected files from the Contact Center Manager Administration 
server.

Deleting an exported Emergency Help display
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Chapter 14: Contact Center Configuration 
fundamentals

Use the Contact Center Manager Administration Configuration component to view your contact 
center resources.

Use the Configuration component to view the following resource types:

• activity codes

• contact types

• skillsets

• threshold classes

You can also add and edit activity codes, assign different skillsets to existing contact types, and 
manually synchronize data from Avaya Contact Center Select to IP Office using the Configuration 
component.

Synchronizing data to IP Office manually
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
You can manually synchronize data from Avaya Contact Center Select to IP Office using 
the Configuration component in Contact Center Manager Administration. When you manually 
synchronize data, Avaya Contact Center Select synchronizes agent and agent-supervisor details 
to IP Office.

Procedure
1. In the left pane, click IPOFFICE.

You need not enter your IP Office server credentials to synchronize data. If you want to 
change your IP Office server credentials, then on the IP Office, right-click IPOFFICE and 
select Edit Properties . Enter your new credentials and click Submit.

2. In the right pane, click Synchronize.
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Avaya Contact Center Select synchronizes agent and supervisor details to IP Office.

Next steps
On IP Office, verify that the data synchronized successfully.

Synchronizing data to IP Office manually
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Chapter 15: Activity codes

An activity code is a number that an agent can enter on Agent Desktop to track time spent on 
activities and service areas, not ready reasons, and after call work.
Activity codes are of the following three types:

• Activity codes
• Not Ready Reason codes
• After Call Work Item (ACW) codes

You configure activity codes that correspond to a contact type and a skillset. Therefore, activity 
codes are filtered on a contact type and skillset basis. Agent Desktop displays the activity codes 
list based on either the contact skillset or the contact type. For example, if you are handling email 
contacts, Agent Desktop populates the Activity Code list both with activity codes that correspond to 
the email contact type and with activity codes that map to the skillset.

Activity codes
An agent can enter Activity codes when they are on a Contact Center call.
If an agent does not enter an activity code, Contact Center assigns a default activity code to the 
contact.

• System default activity code—If an agent does not enter an activity code while working on a 
contact, and if the contact is not queued to a skillset, the system assigns the System default 
activity code to the contact.

• Skillset default activity code—If an agent clicks on the activity code key twice during a contact 
without entering an activity code, the system assigns the Skillset default activity code to the 
contact.

Not Ready Reason codes
An agent can enter Not Ready Reason codes when they are on a Contact Center call or when they 
are idle. If an agent enters a Not Ready Reason code while on a call, then the agent transitions to 
the Not Ready state immediately following the call. If an agent enters a Not Ready Reason code 
when idle, the agent transitions to the Not Ready state. When the agent is Not Ready and wants 
to change the reason for being in the Not Ready state, the agent can enter a different Not Ready 
Reason code. Some examples of Not Ready Reason codes are Lunch or Tea Break.

After Call Work Item codes
An agent can use Agent Desktop to enter an After Call Work Item (ACW) code either while working 
on a contact, or immediately after releasing the contact.
Agents must enter ACW codes when they perform post call processing work, such as adding 
contact information to a Customer Relationship Management (CRM) system. Agents can enter ACW 
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codes only for post call processing work related to the contact that the they just released. In a 
multiplicity environment, the ACW code applies to the last contact that you release.
Agents can enter ACW codes:

• while working on a contact, which prevents Agent Desktop from presenting new contacts to the 
agent

• after releasing the contact, and before Agent Desktop presents a new contact to the agent or 
the agent goes into the Not Ready state.

The After Call Work Item codes are unavailable when:
• the agent first logs on to Agent Desktop
• when the agent has gone into the Not Ready state after a call and then returned to an Idle state

Configuring activity codes
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
Configure activity codes that agents can enter on a phone or on Agent Desktop to track time 
agents spend on activities and service areas, Not Ready reasons and After Call Work Item (ACW) 
items.
You can configure activity codes that correspond to a type and to a skillset. Therefore, activity 
codes are filtered on contact type or skillset basis, or both. Agent Desktop displays the activity 
codes list based on either the skillset of the call or the contact type of the call.
You cannot overwrite the following default activity codes:

• activity code 00000 (Default_ACW)
• activity code 0000 (NotRdy_Pull_Mode_Default_Code)
• activity code 000 (Not_Ready_Default_Reason_Code)
• activity code 00 (Skillset_Default_Activity_Code)
• activity code 0 (System_Default_Activity_Code)

You can add Not Ready Reason codes and After Call Work Item codes in the same way that you 
add activity codes. Use unique numbers for Not Ready Reason codes, Activity codes, and After 
Call Work Item codes. Agent Desktop displays a maximum of 16 digits for Not Ready Reason 
codes, Activity codes, and After Call Work Item codes.

Note:
If you associate an activity code with both contact types and skillsets, the activity codes 
appears on Agent Desktop for all of the skillsets of the selected contact type and for all of the 
skillsets individually selected.

Configuring activity codes

April 2024 Administering Avaya Contact Center Select 121
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AdministeringAvayaContactCenterSelect&p3=33


Procedure
1. In the system tree, expand the server on which you need to add the activity code.

The server displays the server resources.

2. Select the Activity Codes folder.

3. In the right pane of the Activity Codes section, click New.

4. In the Name field, type the name of the new activity code.

5. In the Number field, type the number of the new activity code.

6. In the Display Name field, type the name of the new activity code that the system displays 
in reports.

7. From the Type drop-down list, select the type of the new activity code. You can choose 
from the following:

• Not Ready Reason
• Activity Code
• After Call Work Item

Note:

You cannot change the code type once the code is created.

8. If you are creating an activity code of type Activity Code that applies to all of the skillsets 
of a particular contact type, select the contact type that corresponds to the activity code 
by clicking the right arrow ( > ) under the Available Contact Types list. If the activity code 
applies only to a limited number of skillsets, skip to step 10.

The contact type moves to the Selected Contact Types list.

Note:

Assigning both contact types and skillsets to activity codes is not required. You must 
map skillsets to an activity code only if the activity code is applicable to specific set of 
skillsets.

9. (Optional) To associate all the contact types with an activity, click the double right arrow 
( >> ) under the Available Contact Types list.

All the contact types move to the Selected Contact Types list.

10. (Optional) If you are creating an activity code of type Activity Code, select the skillsets 
that correspond to the activity code by clicking the right arrow ( > ) under the Available 
Skillsets list.

This skillset moves to the Selected Skillsets list.

11. (Optional) To associate all the skillsets with an activity, click the double right arrow ( >> ) 
under the Available Skillsets list.

All the skillsets move to the Selected Skillsets list.

Activity codes

April 2024 Administering Avaya Contact Center Select 122
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AdministeringAvayaContactCenterSelect&p3=33


12. Click Save.

Variable definitions
Name Description
Name The name assigned to the activity code.

Valid values: Maximum 30 characters (no special 
characters).

Number The number assigned to the activity code. Agents 
enter this number on their phones to assign the 
activity code to a contact.

Valid values: Maximum 32 digits.

Important:

You cannot change the activity code number 
once you save the activity code. To change the 
activity code number, delete the activity code, 
and create a new activity code.

Display Name The description that corresponds to the activity 
code. This description appears in custom private 
real-time displays when agents enters an activity on 
their phone.

Valid values: Maximum 30 characters.
Type The type of activity code. You can choose from the 

following:

• Not Ready Reason

• Activity Code

• After Call Work Item

• All — This type appears after migrations. It is not 
possible to create a new code of type 'All'. For 
migrated data, the type of 'All' is displayed and 
must be changed.

Editing an activity code
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

Editing an activity code
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About this task
Edit an activity code to change the name or display name. If the activity code is of the type 
Activity Code, you can also change the contact type and skillset that corresponds to the activity 
code.
You cannot change the activity code number or type. To change an activity code number or type, 
you must delete the activity code and create a new activity code with the new number or type.

Note:
You cannot edit the default activity codes.

Procedure
1. In the left pane, expand the server that contains the activity code to change.

The server displays the server resources.

2. Select the Activity Codes folder.

3. In the right pane, highlight the activity code to change.

4. In the Name field, type the new name of the activity code.

5. In the Display Name field, type the new name that of the activity code the system displays 
in reports.

6. If you are editing an activity code of type Activity Code, you can change the contacts 
types that correspond to the activity code by clicking the right arrow ( > ) or left arrow ( < ) 
under the Available Contact Types list.

If you click the right arrow ( > ) the contact type moves to the Selected Contact Types list.

If you click the left arrow ( < ) the contact type moves to the Available Contact Types list.

7. If you are editing an activity code of type Activity Code, you can change the skillsets that 
correspond to the activity code by clicking the right arrow ( > ) or left arrow ( < ) under the 
Available Skillsets list.

If you click the right arrow ( > ) the contact type moves to the Selected Skillsets list.

If you click the left arrow ( < ) the contact type moves to the Available Skillsets list.

8. Click Save.

Deleting an activity code
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
Delete an activity code that you no longer require.

Activity codes
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Note:
You cannot delete any of the default activity codes.

Procedure
1. In the system tree, expand the server that contains the activity code to delete.

The server displays the server resources.

2. Select the Activity Codes folder.

3. In the right pane, highlight the activity code to delete.

4. Click Delete.

5. Click OK to confirm the deletion.

Searching for an activity code
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
You can search for activity codes based on the name or type of the activity code.

Procedure
1. In the system tree, expand the server that contains the activity codes.

The server displays the server resources.

2. Select the Activity Codes folder.

3. In the right pane of the Activity Codes section, under the Search area, in the Name field, 
type the name of the activity code to search.

Or

From the Type drop-down list, select the type of activity code to search. You can choose 
from the following:

• Not Ready Reason
• Activity Code
• After Call Work Item
• All

To list all your activity codes, click List All.
4. Click Search.

Searching for an activity code
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The system displays the activity codes that match your criteria.

Activity codes
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Chapter 16: Contact types

Contact types are the media types by which (inbound) contacts arrive into a contact center and by 
which a contact center sends (outbound) contacts.

A contact type determines how a contact center handles contacts. An example is email: when a 
contact center customer sends an email message, the contact center receives the message, and 
routes the message according to various email-specific rules. If required, an agent with email ability 
processes the email message.

The following table lists the default supported contact types for Avaya Contact Center Select.

Table 1: Contact types

Default contact type Skillset prefix Description
Voice None Default Voice Contact Type
Email EM_ Default CCMM email Contact Type
Fax message FX_ Default CCMM Fax message Contact Type
Scanned Document message SD_ Default CCMM Scanned Document message 

Contact Type
SMS Text message SM_ Default CCMM SMS Text message Contact 

Type
Voice Mail message VM_ Default CCMM Voice Mail message Contact 

Type
Web_Communications WC_ Default CCMM Web communication Contact 

Type
Outbound OB_ Default CCMM Outbound Contact Type

Editing a contact type
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.
• Note the following:

- You cannot delete a default contact type.
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- You cannot edit the contact type name or the skillset prefix.

About this task
Edit a contact type to change the description of the contact type or to change the default skillset 
assigned to that contact type.

Procedure
1. In the system tree, expand the server on which you need to edit the contact type.

The server displays the server resources.

2. Select the Contact Types folder.

3. In the right pane, select the Contact Type to edit.

4. To sort the contact types, click a column header.

For example, if you click the Name column header, the contact types are sorted 
alphabetically according to Contact Type name.

5. From the Default Skillset list, select a new default skillset, and then press Tab.

6. In the Description box, type a new description for the contact type.

7. Click any other row in the grid to save your changes.

Variable definitions
Name Description
Name The name of the contact type.

Important:

You cannot modify contact type names.
Skillset Prefix The prefix that identifies the default skillset that 

handles contacts of this contact type. There is no 
skillset prefix for the default contact type, voice. 
Skillsets without a skillset prefix default to the voice 
contact type.

Valid value: 3-character maximum, the last of which 
must be an underscore (_) (no special characters, 
must be unique)

Important:

You cannot modify a skillset prefix for a default 
contact type.

Table continues…

Contact types
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Name Description
Default Skillset Select the skillset to which contacts route for 

processing when they are not handled in a script.

Valid values: 30-character maximum, no special 
characters allowed.

Important:

You must first configure the default skillset in 
Contact Center Manager Administration. The 
default skillset must have the same skillset 
prefix as the contact type.

Description The description for the contact type.

Valid value: Maximum 60 characters (optional, can 
be updated, special characters are allowed).

Editing a contact type
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Chapter 17: Skillsets

A skillset is a group of abilities necessary to answer a specific type of contact. Skillsets are the basic 
building blocks of skill-based routing.

Viewing skillsets
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
A skillset is the ability or group of abilities necessary to answer a specific type of contact. Skillsets 
are the basic building blocks of skill-based routing. Skillsets are used to match callers with the 
agents who can best meet the callers' needs.
As a supervisor, you can view the skillsets currently configured on the Contact Center server.

Procedure
1. In the left pane, expand the CC server.

2. Select the Skillsets folder.

3. View the skillsets and the associated Contact Types, Activity Codes, and Threshold 
Classes.

April 2024 Administering Avaya Contact Center Select 130
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AdministeringAvayaContactCenterSelect&p3=33


Chapter 18: Threshold classes

A threshold class is a set of options that determines how statistics are treated in reports and 
real-time displays. The administrator assigns an agent threshold class to each agent and assigns a 
skillset threshold class to each skillset.

As a supervisor, you can view the threshold classes currently configured on the Contact Center 
server.

Viewing threshold classes
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
Threshold classes define how statistics are treated in reports and real-time displays. Threshold 
classes can distinguish between types of information that the system collects. For example, the 
administrator can create different agent threshold classes for customer service trainees and for 
senior customer service representatives.
As a supervisor, you can view the threshold classes currently configured on the Contact Center 
server.

Procedure
1. In the left pane, expand the CC server.

2. Select the Threshold Classes folder.

3. View the threshold classes and the associated thresholds.
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Part 2: Administrator users

This part of the guide describes all of the tasks that the Avaya Contact Center Select administrator 
can perform in Contact Center Manager Administration.

Related links
Configuration Tool spreadsheet on page 222
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Chapter 19: Contact Center Configuration 
fundamentals

Use the Contact Center Manager Administration Configuration component to configure and 
administer your contact center resources.

Use the Configuration component to configure the following resource types:

• activity codes

• call presentation classes

• CDN’s (Route Points)

• contact types

• dialed number identification services (DNIS)

• formulas

• global settings

• historical statistics

• media servers

• multiplicity presentation classes

• real-time statistics

• routes

• skillsets

• threshold classes

You can also manually synchronize data from Avaya Contact Center Select to IP Office using the 
Configuration component.

Synchronizing data to IP Office manually
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.
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About this task
You can manually synchronize data from Avaya Contact Center Select to IP Office using 
the Configuration component in Contact Center Manager Administration. When you manually 
synchronize data, Avaya Contact Center Select synchronizes agent and agent-supervisor details 
to IP Office.

Procedure
1. In the left pane, click IPOFFICE.

You need not enter your IP Office server credentials to synchronize data. If you want to 
change your IP Office server credentials, then on the IP Office, right-click IPOFFICE and 
select Edit Properties . Enter your new credentials and click Submit.

2. In the right pane, click Synchronize.

Avaya Contact Center Select synchronizes agent and supervisor details to IP Office.

Next steps
On IP Office, verify that the data synchronized successfully.

Editing a server
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
Edit server properties, such as display name, server name, or IP address.

Important:
Ensure that all server details are correct before submitting any changes.

Procedure
1. In the left pane, right-click on the server to edit and select Edit Properties.

2. Make the required changes.

3. Click Submit.

Refreshing your servers
Before you begin

• Log on to Contact Center Manager Administration.

Contact Center Configuration fundamentals
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• Open the Configuration component.

About this task
Refresh your servers after you:

• Upgrade your server.
• Enable a licensed feature.
• Update the license file on your server.
• Change the Contact Center Manager Server (CCMS) sysadmin password.

Procedure
1. In the left pane, right-click on the server to refresh and click Refresh Server.
2. In the confirmation window, click Yes.

A message box appears stating that you must refresh all browsers attached to CCMA. If 
an Avaya Contact Center Select feature changes, that change is reflected in the browsers 
only when you refresh them.

3. Click Yes to refresh the server.

After the Refresh is complete, CCMA displays a message informing you that the operation 
was successful.

Refreshing your servers
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Chapter 20: Skillsets

A skillset is a group of abilities necessary to answer a specific type of contact. Skillsets are the basic 
building blocks of skill-based routing.

Skill-based routing
Skill-based routing uses skillsets to match callers with the agents who can best meet their needs.

Out of service skillsets
Skillsets automatically go out of service when all agents log off, or when a supervisor or an 
administrator changes the Out Of Service Mode in the Skillsets window of the Configuration 
component.

Two out of service modes are available:

• Transition mode: Transition mode means that agents can answer queued contacts but the 
skillset accepts no new incoming contacts. New contacts receive night service treatments 
defined in the script or the default skillset. You must initiate Transition mode manually 
by selecting Transition from the Out of Service Mode list in the Skillset window of the 
Configuration component. After all existing queued contacts for a skillset in Transition mode 
are answered or abandoned, the skillset automatically enters into Night mode. A skillset 
manually placed in Transition mode that goes into Night mode remains in this state until it is 
cancelled by selecting N/A from the Out of Service Mode list.

• Night mode: Night mode means that the agents in a particular skillset no longer answer 
queued contacts and the skillset accepts no new contacts. New contacts or queued contacts 
receive treatments defined in the script or the default skillset. You can initiate Night mode 
manually in the Skillset window of the Configuration component, or automatically if all agents 
belonging to that skillset log off. When you manually place a skillset in Night mode, the 
skillset remains in this state until you cancel the state by selecting N/A from the Out of 
Service Mode list in the Skillset window of the Configuration component. Canceling Night 
mode returns the skillset to In-service mode.

April 2024 Administering Avaya Contact Center Select 136
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AdministeringAvayaContactCenterSelect&p3=33


Contacts in queue
Contact Center Manager Server must determine the following to present contacts:

• If multiple agents are available, to which agent does it present the contact?

• If multiple contacts are waiting, which contact does it present first?

Agent selection
If two agents are available to answer an incoming contact, Contact Center Manager Server 
presents the contact to the agent with the highest priority level for the skillset to which the contact 
is queued. A supervisor bases the priority level of a skillset on the agent's skill level for that 
particular skillset. You typically assign a higher priority level to a skillset assigned to an agent with 
a higher skill level, and assign a lower priority level to a skillset assigned to an agent with a lower 
skill level. Priority levels range from 1 to 48, with 1 being the highest priority.

To use the enhanced Service Level Routing and Service Level Management, you can set a target 
service level and assign a standby priority to an agent. When the target service level is achieved, 
an agent with the highest standby priority is able to handle the contact. Standby priority levels 
range from 1 to 48, with 1 being the highest priority.

If more than one agent has the same priority, the server presents the contact to an agent based 
on the Agent Order Preference idle time setting. Your administrator can configure the Agent Order 
Preference setting in the Global Settings area of the Configuration component of Contact Center 
Manager Server to base idle time on one of the following:

• longest total time in Idle state since logon

• longest time in Idle state since last status change

• longest total time since last CDN/ACD call or contact

Contact selection
If two contacts are waiting in a skillset queue when an agent for that skillset becomes available, 
Contact Center Manager Server uses the following criteria (in the order shown) to determine which 
contact to present first:

• Call priority—This is a numeric value assigned in a script that defines the relative importance 
of a contact. All priority 1 contacts are always answered before contacts of priority 2 or 
greater.

• Call age preference—The administrator specifies incoming contact position in the pending 
request queue based on the age of the contact. For each skillset, the administrator can 

Contacts in queue
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specify Oldest or First in Queue as the call age preference. The two age preferences differ as 
follows:

- Oldest—Each contact enters the queue according to the time elapsed since entering the 
Master script for Contact Center Manager Administration. When the contact enters the 
pending request queue, the time associated with the age of the contact starts when the 
contact enters the Master script. The older the contact is, the further toward the front of 
the queue the contact is inserted. The system orders queue requests in a front-to-back 
sequence.

- First in Queue—Represents the age of the contact since it was queued to the skillset. For 
First in Queue order, the contact enters at the back of the queue, regardless of its age 
relation to other contacts. For example, if a contact was queued 10 seconds ago, its First 
in Queue age is 10 seconds. Any contact entering the queue after this contact enters at 
the back of the queue and is considered the youngest contact in the queue. The time 
associated with the age of the contact starts when it enters the pending request queue.

To queue to a default skillset
Your administrator can define a default skillset. Any contacts not queued by the end of script 
execution automatically queue to this skillset.

Activity codes
Agents can assign activity codes to the contacts they answer. The system uses activity codes to 
track the amount of time spent on the various types of incoming contacts. To generate reports 
with meaningful activity code names, the administrator must define these activity codes in Contact 
Center Manager Administration.

Adding a skillset
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.
• Define the activity code to be assigned as the default activity code for the skillset if you do not 

want to use a system-defined default.
• Define the threshold class to assign to this skillset if you do not want to use a default 

threshold class.

About this task
A skillset is the ability or group of abilities necessary to answer a specific type of contact. Skillsets 
are the basic building blocks of skill-based routing. Skillsets are used to match callers with the 
agents who can best meet the callers' needs.

Skillsets
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Important:
When you add a skillset, you must ensure the skillset name does not begin with two letters 
and an underscore. This avoids a potential conflict with the prefix of any future contact types.

If you want to add one or more skillsets quickly, you can use the Contact Center Management 
component. If you have sufficient access levels, in the left pane you can right-click a server to 
which to add the skillset and click Add Skillset. Specify the Contact Type and Skillset Name. 
However, to add all the other attributes of the skillset, you must edit the skillset as outlined in this 
procedure.

Procedure
1. In the left pane, expand the server to which to add the skillset.

2. Select the Skillsets folder.

3. Assign a contact type to the skillset. Select a value from the Contact Type drop-down list. 
CCMA automatically populates the Prefix field with the appropriate skillset name prefix. If 
you do not select a type, the skillset defaults to the Voice type.

4. In the Skillset Name box, type a name for the skillset.

Note:

The maximum length of a skillset name allowed, including the prefix, is 30 characters. 
The name must not have a numeral as the first character, and not use spaces, special 
characters, or languages other than English. While skillsets and applications can share 
the same name without affecting pegging, to help distinguish skillset names from 
application names, you can add _SK to the end of the name. For example, Sales_SK 
or Service_SK.

5. From the Default Activity Code list, select the activity code that is registered whenever 
this skillset is used.

6. From the Threshold Class list, select the threshold class associated with this skillset.

7. From the Call Age Preference list, select the method to configure the order of contacts in 
the queue. If you want priority given to the oldest contact in the system, select Oldest. If 
you want to give priority to the first contact in the queue, select First In Queue.

8. From the Out Of Service Mode list, select a value to take the skillset offline and specify 
the service mode for the manual night service platform.

9. Optionally, if you want to enable Service Level Routing, Service Level Management 
enhancement or both, perform steps 10 and 11 otherwise skip to step 12.

10. In the Target Service level field, enter target service level threshold value in seconds.

11. Select the Service Level Routing check box.

You can enable Service Level Routing enhancement by selecting the Service Level 
Routing check box and setting a valid Target Service Level value.

Adding a skillset
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Important:

At least one agent within the range of normal priorities and one agent within the range 
of standby priorities must be assigned to the skillset in order to enable Service Level 
Management enhancement.

12. Optionally, in the Comment box, type any comments you have about the skillset.

13. Click any other row in the grid to save your changes.

Skillsets
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Chapter 21: CDNs (Route Points)

Use a controlled directory number (CDNs) or a Route Point to treat contacts in Contact Center 
and to route the contact to an agent. You must configure a short code on IP Office that maps to a 
telephone number. IP Office forwards all calls made to this telephone number to the corresponding 
short code, which in turn routes the call to Contact Center. If the telephone number matches the 
number of a configured Contact Center Route Point, Contact Center treats the call and routes the 
call to an agent. For more information, see Avaya Contact Center Select Solution Description.

Configuring and acquiring a CDN (route point)
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
Complete this procedure to configure a Contact Center Route Point.

Procedure
1. In the system tree, expand the server on which you need to add the route point.

The server displays the server resources.

2. Select the CDNs (Route Points) folder.

3. In the right pane, in the Name box, type the name of the CDN (Route Point) as you want it 
to appear in reports.

4. In the Number box, type the CDN (Route Point) number.

5. In the URI box, type a value for the Universal Resource Indicator (URI) of the CDN (Route 
Point).

6. From the Call Type list, select Local.
7. Click any other row of the table to add the CDN (Route Point).

Not Acquired appears in the Status column.

8. Select the Acquired? check box for the CDN (Route Point).

9. Click any other row of the table to acquire the CDN (Route Point).
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10. Click Refresh Status to view the current status.

Variable definitions
Name Description
Name The name of the CDN (Route Point) as you want it 

to appear in reports.

Valid values: Any freeform string that describes the 
route point, type, or function.

Number The number assigned to the CDN (Route Point).

This number must match the number configured on 
IP Office that maps to a short code.

Important:

You cannot change a saved CDN (Route 
Point) number. You must delete the CDN and 
then recreate it.

Valid values: 15-digit maximum
URI The Universal Resource Identifier (URI) of the CDN 

(Route Point). The URI must equate to the fully 
qualified SIP address for the CDN (Route Point).

Valid values: maximum 255 characters, including 
numbers, English characters, periods, ‘@’ symbol, 
underscores, and dashes.

This field is mandatory. You cannot modify the URI 
of a saved CDN (Route Point). The URI must be 
unique to URIs currently assigned to other CDNs or 
agents.

Call Type Select Local.
Acquired? Important:

Select the Acquired? check box to acquire or 
deacquire the CDN (Route Point) and then 
click Refresh Status to refresh the Status 
column.

If the acquisition is successful, Acquired 
appears in the Status column. When you 
successfully deacquire the CDN (Route Point), 
Not Acquired appears in the Status column.

Table continues…

CDNs (Route Points)
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Name Description
Status The Status column displays the acquisition status of 

the CDN (Route Point) or Open Queue CDN (Route 
Point).

When you deacquire the CDN (Route Point), the 
value Not Acquired appears in this column.

Valid values:

• Not Acquired

• Acquire Pending

• Acquired

• Acquire Failed

• Deacquire Failed

• Deacquire Pending

The data is read-only.
Refresh Status Click Refresh Status to refresh the status of the 

resources that you acquire or deacquire. The 
current status appears in the Status column.

Configuring and acquiring an Open Queue CDN (route 
point)

Before you begin
• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
Complete this procedure to configure and acquire an Open Queue CDN (route point) for 
multimedia contacts.
A multimedia route point is an address that enables incoming multimedia contacts to be treated by 
Contact Center.

Procedure
1. In the system tree, expand the server on which you need to add the route point.

The server displays the server resources.

2. Select the CDNs (Route Points) folder.

3. In the right pane, select the OpenQueue tab.

Configuring and acquiring an Open Queue CDN (route point)
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4. In the Name box, type the name of the Open Queue CDN (Route Point) as you want it to 
appear in reports.

5. From the Call Type list select Open Queue Local.
6. Click any other row of the table to add the Open Queue CDN (Route Point).

Not Acquired appears in the Status column.

7. Select the Acquired? check box for the Open Queue CDN (Route Point).

8. Click any other row of the table to acquire the Open Queue CDN (Route Point).

9. Click Refresh Status to view the current status.

Variable definitions
Name Description
Name The name of the CDN (Route Point) as you want it 

to appear in reports.

Valid value: 30-character maximum (no special 
characters)

Call Type Select Open Queue Local.
Acquired? Select the Acquired? check box to acquire or 

deacquire the CDN (Route Point) and then click 
Refresh Status to refresh the Status column.

If the acquisition is successful, Acquired appears 
in the Status column. When you successfully 
deacquire the CDN (Route Point), Not Acquired 
appears in the Status column.

Status The Status column displays the acquisition status of 
the CDN (Route Point) or Open Queue CDN (Route 
Point).

When you deacquire the CDN (Route Point), the 
value Not Acquired appears in this column.

Valid values:

• Not Acquired

• Acquire Pending

• Acquired

• Acquire Failed

• Deacquire Failed

• Deacquire Pending

The data is read-only.

Table continues…

CDNs (Route Points)
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Name Description
Refresh Status Refresh the status of the resources that you acquire 

or deacquire. The current status appears in the 
Status column.

Acquiring multiple configured CDNs (Route Points)
About this task
Follow this procedure to acquire a large number of CDNs (Route Points). You can do this, for 
example, to acquire a number of CDNs (Route Points) imported into CCMA using a bulk import. If 
you have a large number of CDNs (Route Points) to acquire, this operation can take some time.

Procedure
1. In the left pane, expand the Contact Center Manager Server on which you want to acquire 

multiple CDNs (Route Points).

2. Select the CDNs (Route Points) folder.

3. Click Acquire All CDNs.

4. On the Acquire Confirmation dialog, click Yes.

Contact Center acquires all the CDNs (Route Points) that are not in the Acquired state. 
Depending on the number of CDNs that are not in the Acquired state, this can take some 
time.

5. When Contact Center finishes acquiring the CDNs (Route Points), click Refresh Status 
and check the status of all the CDNs (Route Points).

Deacquiring a CDN (route point)
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
Deacquire a CDN (route point) to stop the system from tracking calls terminated on it. Before you 
can delete a CDN (route point), you must deacquire it.

Procedure
1. In the system tree, expand the server on which you need to deacquire the route point.

The server displays the server resources.

Acquiring multiple configured CDNs (Route Points)
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2. Select the CDNs (Route Points) folder.

3. In the right pane, select the applicable tab.

For example, to deacquire an Open Queue CDN (Route Point) select the OpenQueue tab.

4. Clear the Acquired? check box for the CDN (Route Point) to deacquire.

5. Click any other row in the table to deacquire the CDN (Route Point).

The status appears in the Status column.

6. To view the current status, click Refresh Status.

Deleting a CDN (route point)
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.
• Deacquire the CDN. See Deacquiring a CDN (route point) on page 145.

About this task
When you delete a CDN (Route Point) in Contact Center Manager Administration, the 
corresponding number on IP Office is unaffected.

Procedure
1. In the system tree, expand the server on which you need to delete the route point.

The server displays the server resources.

2. Select the CDNs (Route Points) folder.

3. In the right pane, select the applicable tab.

For example, to delete an Open Queue CDN (Route Point) select the OpenQueue tab.

4. Select the CDN (Route Point) to delete.

5. Press Delete.

6. In the Confirm Delete message box, click Yes to delete the CDN (Route Point) from the 
server.

CDNs (Route Points)
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Deacquiring all CDNs (Route Points)
Before you begin

• Caution:
Ensure your contact center is not actively processing customer contacts. Deacquiring all 
CDNs (Route Points) stops all call processing in Contact Center.

About this task
Follow this procedure to deacquire all the CDNs (Route Points) that are in the Acquired 
state. Deacquire all the CDNs (Route Points) only in exceptional circumstances, such as 
troubleshooting. Deacquiring all CDNs (Route Points) stops all call processing in Contact Center.

Procedure
1. In the left pane, expand the Contact Center Manager Server on which you want to 

deacquire multiple CDNs (Route Points).

2. Select the CDNs (Route Points) folder.

3. Click De-acquire All CDNs.

4. On the De-acquire Confirmation dialog, click Yes.

Contact Center deacquires all the CDNs (Route Points) that are in the Acquired state. 
Depending on the number of CDNs that are in the Acquired state, this can take some time.

5. When Contact Center finishes deacquiring the CDNs (Route Points), click Refresh Status 
and check the status of all the CDNs (Route Points).

Deacquiring all CDNs (Route Points)

April 2024 Administering Avaya Contact Center Select 147
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AdministeringAvayaContactCenterSelect&p3=33


Chapter 22: Activity codes

An activity code is a number that an agent can enter on Agent Desktop to track time spent on 
activities and service areas, not ready reasons, and after call work.
Activity codes are of the following three types:

• Activity codes
• Not Ready Reason codes
• After Call Work Item (ACW) codes

You configure activity codes that correspond to a contact type and a skillset. Therefore, activity 
codes are filtered on a contact type and skillset basis. Agent Desktop displays the activity codes 
list based on either the contact skillset or the contact type. For example, if you are handling email 
contacts, Agent Desktop populates the Activity Code list both with activity codes that correspond to 
the email contact type and with activity codes that map to the skillset.

Activity codes
An agent can enter Activity codes when they are on a Contact Center call.
If an agent does not enter an activity code, Contact Center assigns a default activity code to the 
contact.

• System default activity code—If an agent does not enter an activity code while working on a 
contact, and if the contact is not queued to a skillset, the system assigns the System default 
activity code to the contact.

• Skillset default activity code—If an agent clicks on the activity code key twice during a contact 
without entering an activity code, the system assigns the Skillset default activity code to the 
contact.

Not Ready Reason codes
An agent can enter Not Ready Reason codes when they are on a Contact Center call or when they 
are idle. If an agent enters a Not Ready Reason code while on a call, then the agent transitions to 
the Not Ready state immediately following the call. If an agent enters a Not Ready Reason code 
when idle, the agent transitions to the Not Ready state. When the agent is Not Ready and wants 
to change the reason for being in the Not Ready state, the agent can enter a different Not Ready 
Reason code. Some examples of Not Ready Reason codes are Lunch or Tea Break.

After Call Work Item codes
An agent can use Agent Desktop to enter an After Call Work Item (ACW) code either while working 
on a contact, or immediately after releasing the contact.
Agents must enter ACW codes when they perform post call processing work, such as adding 
contact information to a Customer Relationship Management (CRM) system. Agents can enter ACW 
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codes only for post call processing work related to the contact that the they just released. In a 
multiplicity environment, the ACW code applies to the last contact that you release.
Agents can enter ACW codes:

• while working on a contact, which prevents Agent Desktop from presenting new contacts to the 
agent

• after releasing the contact, and before Agent Desktop presents a new contact to the agent or 
the agent goes into the Not Ready state.

The After Call Work Item codes are unavailable when:
• the agent first logs on to Agent Desktop
• when the agent has gone into the Not Ready state after a call and then returned to an Idle state

Configuring activity codes
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
Configure activity codes that agents can enter on a phone or on Agent Desktop to track time 
agents spend on activities and service areas, Not Ready reasons and After Call Work Item (ACW) 
items.
You can configure activity codes that correspond to a type and to a skillset. Therefore, activity 
codes are filtered on contact type or skillset basis, or both. Agent Desktop displays the activity 
codes list based on either the skillset of the call or the contact type of the call.
You cannot overwrite the following default activity codes:

• activity code 00000 (Default_ACW)
• activity code 0000 (NotRdy_Pull_Mode_Default_Code)
• activity code 000 (Not_Ready_Default_Reason_Code)
• activity code 00 (Skillset_Default_Activity_Code)
• activity code 0 (System_Default_Activity_Code)

You can add Not Ready Reason codes and After Call Work Item codes in the same way that you 
add activity codes. Use unique numbers for Not Ready Reason codes, Activity codes, and After 
Call Work Item codes. Agent Desktop displays a maximum of 16 digits for Not Ready Reason 
codes, Activity codes, and After Call Work Item codes.

Note:
If you associate an activity code with both contact types and skillsets, the activity codes 
appears on Agent Desktop for all of the skillsets of the selected contact type and for all of the 
skillsets individually selected.

Configuring activity codes
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Procedure
1. In the system tree, expand the server on which you need to add the activity code.

The server displays the server resources.

2. Select the Activity Codes folder.

3. In the right pane of the Activity Codes section, click New.

4. In the Name field, type the name of the new activity code.

5. In the Number field, type the number of the new activity code.

6. In the Display Name field, type the name of the new activity code that the system displays 
in reports.

7. From the Type drop-down list, select the type of the new activity code. You can choose 
from the following:

• Not Ready Reason
• Activity Code
• After Call Work Item

Note:

You cannot change the code type once the code is created.

8. If you are creating an activity code of type Activity Code that applies to all of the skillsets 
of a particular contact type, select the contact type that corresponds to the activity code 
by clicking the right arrow ( > ) under the Available Contact Types list. If the activity code 
applies only to a limited number of skillsets, skip to step 10.

The contact type moves to the Selected Contact Types list.

Note:

Assigning both contact types and skillsets to activity codes is not required. You must 
map skillsets to an activity code only if the activity code is applicable to specific set of 
skillsets.

9. (Optional) To associate all the contact types with an activity, click the double right arrow 
( >> ) under the Available Contact Types list.

All the contact types move to the Selected Contact Types list.

10. (Optional) If you are creating an activity code of type Activity Code, select the skillsets 
that correspond to the activity code by clicking the right arrow ( > ) under the Available 
Skillsets list.

This skillset moves to the Selected Skillsets list.

11. (Optional) To associate all the skillsets with an activity, click the double right arrow ( >> ) 
under the Available Skillsets list.

All the skillsets move to the Selected Skillsets list.

Activity codes
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12. Click Save.

Variable definitions
Name Description
Name The name assigned to the activity code.

Valid values: Maximum 30 characters (no special 
characters).

Number The number assigned to the activity code. Agents 
enter this number on their phones to assign the 
activity code to a contact.

Valid values: Maximum 32 digits.

Important:

You cannot change the activity code number 
once you save the activity code. To change the 
activity code number, delete the activity code, 
and create a new activity code.

Display Name The description that corresponds to the activity 
code. This description appears in custom private 
real-time displays when agents enters an activity on 
their phone.

Valid values: Maximum 30 characters.
Type The type of activity code. You can choose from the 

following:

• Not Ready Reason

• Activity Code

• After Call Work Item

• All — This type appears after migrations. It is not 
possible to create a new code of type 'All'. For 
migrated data, the type of 'All' is displayed and 
must be changed.

Editing an activity code
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

Editing an activity code
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About this task
Edit an activity code to change the name or display name. If the activity code is of the type 
Activity Code, you can also change the contact type and skillset that corresponds to the activity 
code.
You cannot change the activity code number or type. To change an activity code number or type, 
you must delete the activity code and create a new activity code with the new number or type.

Note:
You cannot edit the default activity codes.

Procedure
1. In the left pane, expand the server that contains the activity code to change.

The server displays the server resources.

2. Select the Activity Codes folder.

3. In the right pane, highlight the activity code to change.

4. In the Name field, type the new name of the activity code.

5. In the Display Name field, type the new name that of the activity code the system displays 
in reports.

6. If you are editing an activity code of type Activity Code, you can change the contacts 
types that correspond to the activity code by clicking the right arrow ( > ) or left arrow ( < ) 
under the Available Contact Types list.

If you click the right arrow ( > ) the contact type moves to the Selected Contact Types list.

If you click the left arrow ( < ) the contact type moves to the Available Contact Types list.

7. If you are editing an activity code of type Activity Code, you can change the skillsets that 
correspond to the activity code by clicking the right arrow ( > ) or left arrow ( < ) under the 
Available Skillsets list.

If you click the right arrow ( > ) the contact type moves to the Selected Skillsets list.

If you click the left arrow ( < ) the contact type moves to the Available Skillsets list.

8. Click Save.

Deleting an activity code
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
Delete an activity code that you no longer require.

Activity codes
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Note:
You cannot delete any of the default activity codes.

Procedure
1. In the system tree, expand the server that contains the activity code to delete.

The server displays the server resources.

2. Select the Activity Codes folder.

3. In the right pane, highlight the activity code to delete.

4. Click Delete.

5. Click OK to confirm the deletion.

Searching for an activity code
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
You can search for activity codes based on the name or type of the activity code.

Procedure
1. In the system tree, expand the server that contains the activity codes.

The server displays the server resources.

2. Select the Activity Codes folder.

3. In the right pane of the Activity Codes section, under the Search area, in the Name field, 
type the name of the activity code to search.

Or

From the Type drop-down list, select the type of activity code to search. You can choose 
from the following:

• Not Ready Reason
• Activity Code
• After Call Work Item
• All

To list all your activity codes, click List All.
4. Click Search.

Searching for an activity code
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The system displays the activity codes that match your criteria.

Activity codes
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Chapter 23: Call presentation classes

A call presentation class is a collection of preferences that determines how contacts are presented 
to an agent. A call presentation class specifies whether a break time between contacts is permitted, 
and whether agents must accept calls.

Call Force Answer Zip Tone and Whisper Skillset
In a SIP-enabled solution, Contact Center supports an optional configuration to give Call 
Force Answer (CFA) Zip Tone to agents. This is configurable for all agents assigned to a call 
presentation class where the Call Force Delay or Return to Queue option is selected. A zip tone 
is a tone or beep that a contact center agent hears before they are connected to a customer 
call. You can also configure a silence period to fall after the zip tone, and before the agent and 
customer are connected on a call.
This feature presents the customer call to the agent while the agent is still hearing the zip tone 
and the silence that follows. The agent is connected for the duration of this time. This causes the 
CCMA reports for the Call Delay Time and Active fields to be inaccurate by the length of time of 
the zip tone and the Call Force Answer Delay Timer setting.
Contact Center supplies a default zip tone. You can replace this default zip tone with a different 
one. If you want to play zip tones for individual skillsets or call presentation classes, configure 
Whisper Skillset as the custom zip tone. Additional zip tones, if provisioned, are played on a 
customer call in the following order of priority:

• skillset
• call presentation class
• default tone

Note:
Only one of the zip tones above is played.

Contact Center also supports an optional configuration to provide Whisper Skillset to agents. 
The Whisper Skillset feature allows a brief skillset-specific announcement to be played to agents 
before they are connected to a customer call. This is configurable for all agents assigned to a call 
presentation class.
Whisper Skillset configuration and functionality is similar to Call Force Answer Zip Tone. The 
Whisper Skillset feature uses the same source location for skillset-specific announcements as 
CFA Zip Tone.
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Creating a call presentation class
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
Create a call presentation class to determine how contacts are presented to an agent's phone. 
You can choose the following presentation methods:

• Automatically answer the contact at the agent's phone.
• Return the contact to the queue if the contact is not answered within a specified period.

In addition, you can choose whether to allow the agent time to wrap up a contact after it ends.

Procedure
1. In the system tree, expand the server on which to add the call presentation class.

The server shows its resources.

2. Select the Call Presentation Classes folder.

3. In the right pane, in the Name box, type the name of the call presentation class as it 
appears in reports.

4. From the Presentation Option list, select the one of the following call presentation 
options:

• Return to Queue

• Call Force Delay

5. If you select the Call Force Delay presentation option, in the Call Force Delay Timer 
box, type the number of seconds after which the contact is automatically answered at the 
agent's phone and proceed to step 8.

Note:

You can configure the Call Force Answer Zip Tone feature for your solution. If this is 
configured in a contact center where the Agent’s phone ringer is disabled, in order to 
reduce customer wait time, Avaya recommends setting the Call Force Delay Timer to 
zero seconds.

6. In the Return to Queue After N Seconds box, type the time after which the contact 
returns to the queue if not answered.

7. From the After Return to Queue, Make Phoneset list, select the mode in which the 
phone is placed after the contact returns to the queue.

8. In the After Call, Break for N Seconds box, type the amount of time that the agent is in 
break state after a call ends.

Call presentation classes
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9. From the Prompt On Answer list, select one of the following:

• None

• ZIP Tone

• Whisper Skillset

Note:

If you want to play zip tones for individual skillsets or call presentation classes, select 
Whisper Skillset and upload the custom zip tone as a Whisper Skillset announcement 
file.

10. In the Prompt On Answer Silence Timer box, type the amount of time to pass after the 
Zip tone is played and before the agent and customer are connected on a call.

11. Click any other row in the grid to submit your changes and to save the call presentation 
class.

Variable definitions
Name Description
Name The name assigned to the call presentation class.

Valid values: 30-character maximum (no special 
characters, no spaces)

Presentation Option Select one of the following call presentation options 
for the call presentation class:

• Call Force Delay—Choose this option to force a 
call on an agent if the agent does not answer 
the call within the specified amount of time. If you 
select this option, you must specify the time delay 
in seconds in the Call Force Delay Timer box.

• Return to Queue—Choose this option to return a 
call to the queue if the agent does not answer the 
call within the specified amount of time.

Call Force Delay Timer If you select Call Force Delay from the Presentation 
Option list, in the Call Force Delay Timer box, type 
the time delay in seconds.

Note:

You can configure the Call Force Answer 
Zip Tone feature for your solution. If this 
is configured in a contact center where 
the Agent’s phone ringer is disabled, in 
order to reduce customer wait time, Avaya 
recommends setting the Call Force Delay 
Timer to zero seconds.

Table continues…

Creating a call presentation class
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Name Description
Return to Queue After N Seconds If you select Return To Queue from the Presentation 

Option list, in the Return To Queue After N Seconds 
box, type the wait interval in seconds.

If you do not select Return to Queue as the 
presentation option, the value is N/A.

Valid values: 1 — 300 (seconds)

Note:

Voice contacts return to the queue after 30 
seconds, regardless of the specified amount of 
time set.

After Return to Queue, Make Phoneset If you select Return To Queue from the Presentation 
Option list, from the After Return To Queue, Make 
Phoneset list, select one of the following values:

• Logout

• Not Ready

• N/A
After Call, Break for N Seconds The amount of time, in seconds, that an agent is 

in break state at the end of a call and before the 
next call. The agent can use this time to complete 
processing related to the finished call.

This applies to Contact Center calls only.

Important:

After an agent completes a blind transfer of 
a Contact Center call, the agent is available 
to receive another voice contact. To avoid the 
transferred call being returned to the same 
agent, configure a break time.

Valid values: 0–300 (seconds)

Table continues…
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Name Description
Prompt On Answer • None—Do not play a Zip Tone or Whisper Skillset 

announcement.

• ZIP Tone—Play the default Zip Tone.

• Whisper Skillset—Play a Whisper Skillset 
announcement or custom zip tone. If there is an 
announcement file matching the skillset name for 
the call then play this otherwise play the default 
announcement.

Note:

If you want to play zip tones for specific 
skillsets or call presentation classes, select 
Whisper Skillset and upload the custom zip 
tone as a Whisper Skillset announcement 
file.

Prompt On Answer Silence Timer The amount of time to pass after the zip tone is 
played and before the agent and customer are 
connected on a call.

Valid values: 0 — 5 (seconds)

Deleting a call presentation class
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.
• Ensure that the call presentation class is not assigned to an agent.

About this task
Delete a call presentation class that is no longer required to save room in your database.

Procedure
1. In the left pane, expand the server from which to delete the call presentation class.

2. Select the Call Presentation Classes folder.

3. In the right pane, in the table, highlight the row containing the call presentation class to 
delete.

4. Press Delete.

5. On the Confirm Delete message box, click Yes to delete the call presentation class.

Deleting a call presentation class
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Chapter 24: Threshold classes

A threshold class is a set of options that determines how statistics are treated in reports and 
real-time displays. You must assign an agent threshold class to each agent; you must assign a 
skillset threshold class to each skillset.

Because you can define multiple threshold classes of each type, you can treat statistics differently 
for different agents and skillsets.

• Display thresholds

• Pegging thresholds

Display thresholds
A display threshold is used in real-time displays to determine the lower and upper end of the 
normal range for a statistic. In your real-time display, you can assign different colors for statistics 
below the normal range, in the normal range, or above the normal range.

Pegging thresholds
Pegging thresholds are used to define a cut-off value for a statistic such as Short Call, Delay 
Before Answer, or Abandon.

For example, you can set the Short Call length to 10 seconds in a skillset threshold class. If a 
contact to a skillset with that threshold class lasts less than 10 seconds while connected to an 
agent, the contact is pegged as a Short Call.

Editing a threshold class
Before you begin

• You must define two values for display thresholds—the low end and the high end of the 
normal range.
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• For pegging thresholds, define only the cut-off limit for statistics.
• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
Modify a threshold class to change how statistics are treated in reports and real-time displays. You 
can edit threshold classes to distinguish between types of information that the system collects.
For example, you can create different agent threshold classes for customer service trainees and 
for senior customer service representatives.

Procedure
1. In the left pane, expand the server on which to create the threshold class.

2. Select the Threshold Classes folder.

3. In the right pane, select the name of the threshold class you want to edit.

4. In the Enabled box of the Thresholds table, select the check box for each statistic for 
which to define thresholds.

5. In the Level 1 box, type the value for the low end of the normal range for display 
thresholds.

6. For display thresholds only, in the Level 2 box, type the value for the high end of the 
normal range.

7. Click any other row in the grid to submit your changes.

Editing a threshold class
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Variable definitions
Name Description
Level 1 The low end of the normal range for display 

thresholds. For pegging thresholds, enter the cut-off 
value for this statistic.

You must define the service level threshold for 
both Application and Skillset statistics. However, the 
values for each type of statistic can be different.

The Calls Answered After Threshold value for 
Skillset statistics is the number of local incoming 
skillset calls answered after a delay greater than 
or equal to the service-level threshold for this 
skillset. Delays are calculated from the time the 
call is queued at the skillset to the time the call is 
answered.

Dropping below this level can mean normal contact 
center operation and no action required (that is, 
the lower the number of calls waiting, the better). 
However, it can also signify an alert situation that 
requires attention (that is, the lower the service level 
percentage, the worse the situation).

Level 2 The high end of the normal range for display 
thresholds. This value does not apply to pegging 
thresholds.

Exceeding this level can mean normal contact 
center operation and no action required (that is, 
the higher the service level percentage, the better). 
However, it can also signify an alert situation that 
requires attention (that is, the greater the number of 
calls waiting, the worse the situation).

Enabled Select to enable a particular threshold.

Threshold classes
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Chapter 25: Routes

Routes link announcements and music provided by the Avaya Aura® Media Server to the RAN block 
configured in an Orchestration Designer (OD) script.

The Route Name is a string that must be identical to the announcement (WAV) file name or music 
content group (for example, classical, jazz, easy listening) stored on the Avaya Aura® Media Server. 
For announcements the Route Name must be identical to the announcement (WAV) file name under 
the locale content group on the Avaya Aura® Media Server.

The OD script uses the Route Number mapping to invoke this file for playback. This configuration 
allows the announcement file name and music content group to appear on the generated RAN and 
MUSIC reports.

Configuring and acquiring routes
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
Use this procedure to create Recorded Announcement (RAN) routes for your Contact Center.
The Route Name must be identical to the announcement file name or music content group 
configured on the Avaya Aura® Media Server. The Route Number can be arbitrary (though it must 
be unique), and the RAN block in Orchestration Designer uses this number to identify the file to 
play.
You cannot modify a saved route. You can delete a saved route and add a new route.

Procedure
1. In the left pane, expand the server to which to add the route.

2. Select the Routes folder.

3. In the right pane, in the Name box, type the name of the route as you want it to appear in 
reports.

4. In the Number box, type the route number.

5. From the Threshold Class list, select the threshold class assigned to this route.
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6. Click any other row of the table to add the route.

Not Acquired appears in the Status column.

7. Select the Acquired? check box.

8. Click any other row of the table to acquire the route.

Variable definitions
Name Description
Name The name assigned to the route.

The Route Name is a string which must be identical 
to the announcement filename or music content 
group configured on the Avaya Aura® Media Server.

For announcements the Route Name must be 
identical to the announcement (WAV) file name 
under the locale content group on the Avaya Aura®

Media Server.

Valid value: 30-character maximum (no special 
characters)

Number The number of the route. You cannot change a 
route number once you save it; you can only delete 
it and create a new one.

The value is arbitrary but must be unique.

Valid value: 3-digit maximum; External route: 1–511
Threshold Class The name of the threshold class assigned to this 

route.

Valid values: 30-character maximum (no spaces or 
special characters)

Refresh Status Refresh the status of the resources that you acquire 
or deacquire.

Routes
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Chapter 26: Multiplicity presentation 
classes

A multiplicity presentation class is a collection of preferences that determines the number and types 
of contacts that Contact Center presents to a multiplicity-enabled agent. A multiplicity presentation 
class specifies the minimum time between contacts being presented on Agent Desktop, the skillsets 
or types of Multimedia contacts, and the number of concurrent contacts the agent can receive.

Note:

You cannot select Voice or Voice Mail contact types when creating a Multiplicity Presentation 
Class (MPC). By default, each MPC has one Voice and one Voice Mail contact type.

Creating a multiplicity presentation class
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
Create a multiplicity presentation class (MPC) to determine how an agent using Agent Desktop 
can work with multiple contacts at one time. Use a multiplicity presentation class to specify the 
following:

• which contact types to present to the agents
• the maximum number of active contacts an agent has at one time by contact type or skillsets
• whether voice contacts can interrupt Multimedia contacts
• whether Multimedia contacts are presented while agent is on a voice call

Procedure
1. In the system tree, expand the server on which to add the multiplicity presentation class.

The server shows its resources.

2. Select the Multiplicity Presentation Classes folder.

3. In the right pane, click Create New.
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4. In the Name box, type the name of the new multiplicity presentation class.

5. From the Value list, select the maximum number of multimedia contacts that an agent 
using this MPC is allowed to have active at one time.

6. In the Delay box, type a delay in seconds that occurs between each contact presented to 
the agent.

7. To allow agents using this MPC to receive multimedia contacts while they are active 
on voice contacts, select Agent will remain in a Ready state when a voice call is 
answered.

8. To allow agents using this MPC to receive voice contacts while they have active 
multimedia contacts, select Agent will remain in a Ready state when a multimedia 
contact is answered or presenting for more than 10 seconds.

9. Select Place active contact on hold when voice call becomes active to set the active 
multimedia contact on hold when the agent accepts a presenting voice contact.

10. In the Assigned Contact Types list, use the Value list for each contact type to specify the 
maximum number of contacts from each contact type that the agent can have active at one 
time.

11. Click Unassigned Skillsets.

12. Use the Skillset name search fields to search for a specific list of skillsets, or click List All 
to list all the skillsets configured in the Contact Center.

13. Check the Assign check box for any skillset that you want to assign to this MPC. You can 
only assign skillsets if the corresponding contact type has a zero value in its Value list in 
Assigned Contact Types.

14. Click Submit.

The skillset becomes available in the Assigned Skillsets list, with the default value of 1.

15. In the Assigned Skillsets list, use the Value list for each skillset to specify the maximum 
number of contacts from that skillset that the agent can have active at one time.

16. Click Submit to submit your changes and to save the multiplicity call presentation class.

Variable definitions
Name Description
Name The name assigned to the multiplicity presentation 

class.

Valid value: 30-character maximum

Table continues…
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Name Description
Value Select the maximum number of multimedia contacts 

that an agent can keep active at one time on 
Agent Desktop. When the agent reaches this limit, 
the Contact Center does not present any more 
multimedia contacts to the agent until the agent 
closes a multimedia contact.

Delay The time that the Contact Center waits between 
sending contacts to the agent. This prevents 
the agent from receiving multiple simultaneous 
contacts.

If an agent configured with this MPC also has a 
call presentation class with a value for After Call 
Break for N Seconds, Contact Center Manager 
Server uses the greater of the two values between 
contacts.

Valid values: 10-300 (seconds)
Agent will remain in a Ready state when a voice call 
is answered

Select to allow the agent to receive multimedia 
contacts while they are on a voice call.

Agent will remain in a Ready state when a 
multimedia contact is answered or presenting for 
more than 10 seconds

Select to allow the agent to receive a voice call 
while they are working on a Multimedia contact.

Place active contact on hold when voice call 
becomes active

Select to set the active multimedia contact on hold 
when the agent accepts a presenting voice call, 
allowing the agent to focus on the voice contact.

Assigned Contact Types List the contact types that you can include in the 
multiplicity presentation class.

Assigned Contact Types–Value Select the maximum number of contacts of this 
contact type that the agent can have active on 
Agent Desktop.

These lists automatically have a maximum value 
equal to the number set in the Value field.

The cumulative total of the values you select for all 
contact types does not impact the overall maximum 
number of contacts as set in the Value field.

Assigned Skillsets Display skillsets selected for this multiplicity 
presentation class.

Table continues…

Creating a multiplicity presentation class
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Name Description
Assigned Skillsets –Value Select the maximum number of contacts from this 

skillset that the agent can have active on Agent 
Desktop.

These lists automatically have a maximum value 
equal to the number set in the Value field.

The cumulative total of the values you select for all 
contact types does not impact the overall maximum 
number of contacts as set in the Value field.

Unassigned Skillsets Allows you to search for and select skillsets to 
assign to this multiplicity presentation class.

You can select skillsets only if there is a zero value 
for their corresponding contact type in the Assigned 
Contact Types list.

The skillsets you select appear in the Assigned 
Skillset list when you click Submit.

Skillset name The drop down list allows you to specify a search 
option. The text box allows you to specify the text 
for which to search the CCMS skillsets.

Search Initiate a search of the CCMS skillset list using 
the criteria in the Skillset Name fields. Matching 
skillsets display in a list below.

You can only select skillsets if there is a zero value 
for their corresponding contact type in the Assigned 
Contact Types list.

List All Display the complete CCMS skillset list.

You can only select skillsets if there is a zero value 
for their corresponding contact type in the Assigned 
Contact Types list.

Delete Delete the selected multiplicity presentation class.

You can delete only an updated or completed 
multiplicity presentation class.

Create New Create a new multiplicity presentation class.
Submit Save changes to the selected multiplicity 

presentation class.

Deleting a multiplicity presentation class
Before you begin

• Log on to Contact Center Manager Administration.

Multiplicity presentation classes
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• Open the Configuration component.
• Ensure that the multiplicity presentation class is not assigned to an agent.

About this task
Delete a multiplicity presentation class that is no longer required to save room in your database.

Procedure
1. In the left pane, expand the server from which to delete the multiplicity presentation class.

2. Select the Multiplicity Presentation Classes folder.

3. In the right pane, in the MPC List list, select the multiplicity presentation class to delete.

4. Press Delete.

5. On the Confirm Delete message box, click Yes to delete the multiplicity presentation 
class.

Deleting a multiplicity presentation class
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Chapter 27: Contact types

Contact types are the media types by which (inbound) contacts arrive into a contact center and by 
which a contact center sends (outbound) contacts.

A contact type determines how a contact center handles contacts. An example is email: when a 
contact center customer sends an email message, the contact center receives the message, and 
routes the message according to various email-specific rules. If required, an agent with email ability 
processes the email message.

The following table lists the default supported contact types for Avaya Contact Center Select.

Table 2: Contact types

Default contact type Skillset prefix Description
Voice None Default Voice Contact Type
Email EM_ Default CCMM email Contact Type
Fax message FX_ Default CCMM Fax message Contact Type
Scanned Document message SD_ Default CCMM Scanned Document message 

Contact Type
SMS Text message SM_ Default CCMM SMS Text message Contact 

Type
Voice Mail message VM_ Default CCMM Voice Mail message Contact 

Type
Web_Communications WC_ Default CCMM Web communication Contact 

Type
Outbound OB_ Default CCMM Outbound Contact Type

Editing a contact type
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.
• Note the following:

- You cannot delete a default contact type.
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- You cannot edit the contact type name or the skillset prefix.

About this task
Edit a contact type to change the description of the contact type or to change the default skillset 
assigned to that contact type.

Procedure
1. In the system tree, expand the server on which you need to edit the contact type.

The server displays the server resources.

2. Select the Contact Types folder.

3. In the right pane, select the Contact Type to edit.

4. To sort the contact types, click a column header.

For example, if you click the Name column header, the contact types are sorted 
alphabetically according to Contact Type name.

5. From the Default Skillset list, select a new default skillset, and then press Tab.

6. In the Description box, type a new description for the contact type.

7. Click any other row in the grid to save your changes.

Variable definitions
Name Description
Name The name of the contact type.

Important:

You cannot modify contact type names.
Skillset Prefix The prefix that identifies the default skillset that 

handles contacts of this contact type. There is no 
skillset prefix for the default contact type, voice. 
Skillsets without a skillset prefix default to the voice 
contact type.

Valid value: 3-character maximum, the last of which 
must be an underscore (_) (no special characters, 
must be unique)

Important:

You cannot modify a skillset prefix for a default 
contact type.

Table continues…

Editing a contact type

April 2024 Administering Avaya Contact Center Select 171
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AdministeringAvayaContactCenterSelect&p3=33


Name Description
Default Skillset Select the skillset to which contacts route for 

processing when they are not handled in a script.

Valid values: 30-character maximum, no special 
characters allowed.

Important:

You must first configure the default skillset in 
Contact Center Manager Administration. The 
default skillset must have the same skillset 
prefix as the contact type.

Description The description for the contact type.

Valid value: Maximum 60 characters (optional, can 
be updated, special characters are allowed).

Contact types
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Chapter 28: Global settings

In the Global Settings window, you can configure the global values on the Contact Center server, 
which include Agent Order preference, default DN, and the Expected Wait Time algorithm. You can 
also configure Toll Free Queuing.

Configuring Global Settings Common Settings
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
In the Global Settings window, you can set the global values on the Contact Center server.
The Redirection Settings tab allows you to configure global settings for call redirection. How your 
contact center handles redirected calls depends on your solution and your solution’s available 
routing options. For more information about call redirection, see “Call Redirection with AACC 
Application Note” available at http://support.avaya.com.

Procedure
1. In the left pane, expand the server on which to configure global settings.

2. Select the Global Settings folder.

3. Select Common Settings.

4. Configure the global settings for your system based on the fields listed in the Global 
Settings window.

5. Click Submit.
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Variable definitions
Name Description
Agent Order Preference Choose how to present contacts to agents based on 

their idle time.

Valid values:

• Longest total time in idle state since login—
Choose this option to present contacts to the 
agent who accumulated the most idle time since 
logging on.

Contact Center calculates this time differently for 
an agent with a Multiplicity Presentation Class 
(MPC) who has one or more open contacts. In 
this case Contact Center uses the time since the 
agent last opened a contact, minus the Delay 
value in the MPC.

• Longest time in idle state since last status change
—Choose this option to present contacts to the 
agent who accumulated the most idle time since 
the last status change for that agent (this is the 
system default setting).

• Longest total time since last CDN/ACD call or 
contact—Choose this option to present contacts 
to the agent with the longest elapsed time since 
handling a CDN/ACD call.

Important:

The system does not reset the timer when 
the agent switches to the Not Ready state.

Default DN The default DN to use when a script defaults or a 
treated call is not answered. Avaya recommends 
that you configure an attendant as the Default DN.

Note:

By default, the Default DN is configured as 
the first sample supervisor. If a call cannot be 
routed to a skillset, Contact Center presents 
the call to the sample supervisor.

Table continues…

Global settings
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Name Description
Expected Wait time (EWT) Algorithm Select either NES EWT or Enhanced EWT as 

required.

Valid values:

• NES EWT—This is a legacy algorithm for 
calculating the expected wait time using real 
data available in the system. (Actual wait time of 
previously serviced contacts.)

• Enhanced EWT—This is a new algorithm, which 
is more accurate than the NES EWT. This also 
uses actual wait time data available in the system.

Toll Free Queuing Select to enable Toll Free Queuing.
Maximum time to delay call establish Enter the number of seconds that Contact Center 

waits before sending a call connect message to the 
IP Office platform.

Enter ACW using Not Ready without Reason Code When you select Enter ACW using Not Ready 
without Reason Code, agents who do not 
specifically enter an After Call Work Item (ACW) 
code prior to the end of their current call are put into 
the ACW state automatically by the system using 
the default ACW code “00000” immediately upon 
completion of the call.

Post Call Processing (PCP) time starts to peg 
against the default ACW code “00000” immediately 
after agents completes the contact.

Configuring Media Settings
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
Contact Center provides observe, barge-in, and whisper coach features for voice contacts. These 
actions are performed by agent-supervisors on Agent Desktop.
If you want to enable agent-supervisors to silently observe and barge-in on voice contacts, 
mute the observation and barge-in tones. Note that many jurisdictions have legal requirements 
concerning observing calls: ensure your configuration is compliant with relevant national and local 
legislation.
By default, the agent and the customer on the voice contact hear the observation tone when an 
agent-supervisor joins or leaves the voice contact. They also hear the observation tone repeatedly 
at regular intervals during the voice contact.

Configuring Media Settings

April 2024 Administering Avaya Contact Center Select 175
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AdministeringAvayaContactCenterSelect&p3=33


Procedure
1. In the left pane, expand the server on which to configure global settings.

2. Click Configuration.

3. Select the Global Settings folder.

4. Select Media Settings.

5. Select Barge In Tone to enable the barge-in tone for voice contacts. Clear the Barge In 
Tone check box, to disable the barge-in tone for voice contacts.

6. Select Observation Tone to enable the observation for voice contacts. Clear the 
Observation Tone check box, to disable the observation tone for voice contacts.

7. In the Observation Tone Timer (sec) box, type the number of seconds between 
observation tones. This configures the observation tone interval for voice contacts.

8. Select Record Tone to enable the record tone for voice contacts. Clear the Record Tone 
check box, to disable the record tone for voice contacts.

9. In the Record Tone Timer (sec) box, type the number of seconds between record tones. 
This configures the record tone interval on voice contacts.

10. Click Save.

Global settings
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Chapter 29: Historical statistics

To use the Historical Reporting component, you must first collect historical statistics. You can 
configure the following historical statistics collection options:

• The general system parameter values, such as the number of skillsets

• The type of call flow, agent, and IVR historical statistics to collect

• The applications for which call-by-call data is collected

• The length of time that historical statistics are stored on Contact Center Manager Server

You can calculate the amount of disk space required to run your selected configuration and specify 
the first business day of the week. The database size calculation depends on parameters, duration, 
call center busy count (CBC), and statistic values. These statistics are used to generate tabular and 
graphical historical reports. For more information about historical reporting, see Using Avaya Aura®

Contact Center Reports and Displays.

Integrated Reporting
An integrated report simplifies the comparison of reports on call statistics data by combining data 
from the Avaya Aura® Media Server/CCMS(Avaya Aura® Media Server/CSR report) and CCMS/
Multimedia server. Combined reporting views are available for:

• CCMM—CSR Statistics

• Avaya Aura® Media Server—CSR Statistics

Configuring Historical statistics
About this task
Configure historical statistics to configure the following collection options:

• The general system parameter values, such as the number of skillsets
• The type of call flow, agent, and IVR historical statistics to be collected
• The applications for which call-by-call data is collected
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• The length of time that historical statistics are stored on Contact Center Manager Server

Before you begin
• Log in to Contact Center Manager Administration.
• Open the Configuration component.

Procedure
1. In the left pane, select the Historical Statistics folder.

2. In the right pane, enter your configuration data in the following tables:

• Parameters table: For each parameter, enter a value that is less than or equal to the 
purchased value, and greater than or equal to the measured value. When choosing a 
value, remember to allow for future growth.

• Collect the following statistics table: For each statistic type, in the Collect column, 
select the check box beside the statistics to collect, or clear the check box beside the 
statistics not to collect.

• Call-by-Call table: For each application, from the Statistics Collection Method list, select 
the type of contacts for which to collect call-by-call statistics.

• Duration table: Enter the amount of time the statistic is stored on the server. The time 
units vary depending on the statistic. The limit for each statistic, with the exception of the 
Length of Business day and Business week contains statistics, is 1825 time units 
(days, weeks, or months).

To reduce the duration of a statistic, Contact Center purges all data for a statistic that is 
older than the new specified duration.

3. From the Business week starts list, select the day to start accumulating weekly statistics.

4. Click Calculate to determine if sufficient disk space is available for the selected historical 
statistics collection configuration.

The Call-by-Call Database and System Database Required fields display the disk space 
requirements for the selected configuration. The Call-by-Call Database and System 
Database Actual fields display the available disk space.

Important:

If the disk space required is greater than the disk space available, reduce the number 
of days the data is stored or change the number of estimated contacts per hour until 
sufficient disk space is available for your configuration.

5. Click Submit to save your changes.

Historical statistics
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Chapter 30: Real-time statistics

The Contact Center Manager Administration Real-Time Reporting displays provide up-to-date 
statistics for your Contact Center and its resources. With access to statistics that update in real 
time, such as the number of contacts waiting to be answered, the number of agents assigned to 
each skillset, and the number of abandoned calls, you can view changes in contact activity as they 
occur.

To use the Real-Time Reporting feature, you must first configure Contact Center Manager Server 
to collect the types of statistics to see in the Real-Time Reporting displays. You can configure the 
following seven types of real-time statistics:

• skillset statistics (mandatory)

• nodal statistics (mandatory)

• application statistics

• IVR statistics

• route statistics

• agent statistics

• network statistics

For each type of real-time statistics you must indicate the viewing mode (moving window or interval-
to-date). The interval-to-date settings that you choose start immediately and apply to all real-time 
displays at all sites on your network that use the interval-to-date mode.

Configuring real-time statistics collection
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
Configure real-time statistics collection to provide information for real-time displays with access to 
statistics that update in real time. You can configure the following types of real-time statistics:

• skillset statistics (mandatory)
• nodal statistics (mandatory)
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• application statistics
• IVR statistics
• route statistics
• agent statistics
• network statistics

For each of these real-time statistics, you must indicate the viewing mode (moving window or 
interval-to-date). The interval-to-date settings that you choose start immediately and apply to all 
real-time displays at all sites on your network that use the interval-to-date mode.
When you configure the interval-to-date real time statistics display, there are two required fields: 
Data Collection Interval and One of the intervals starts at.
The interval statistics reset after the Data Collection Interval. The One of the intervals starts at 
option is used to synchronize the initial interval. For example, if you configure the real-time data at 
1 p.m. on April 2, and the Data Collection Interval is 15 hours, and the One of the intervals starts 
at 8 a.m., the real time statistics are reset and the system starts collecting interval data at 11 p. m. 
(08:00 + 15:00). The statistics are next reset at 2 p.m. (15 hours later) on April 3. The statistics do 
not reset at 8 a.m. on April 3 unless you designate an appropriate interval.

Procedure
1. In the left pane, expand the server on which to configure the real-time statistics.

2. Click the Real-time Statistics folder.

3. In the right pane, select the viewing mode for the following statistics:

• Skillset Statistics—You must select a viewing mode value for this statistic. The system 
automatically collects this statistic because it is required for intrinsics in writing scripts.

• Nodal—You must select a viewing mode for this statistic. The system automatically 
collects this statistic because it is required for intrinsics in writing scripts.

• Application Statistics—Optional

• IVR Statistics—Optional

• Route Statistics—Optional

• Agent Statistics—Optional

• Network Statistics—Optional

4. In the Data Collection Interval boxes, type the interval duration to use in the interval-to-
date data collection mode.

5. In the One of the intervals starts at box, type the start time for statistics collection in the 
interval-to-date collection mode.

The system calculates and synchronizes the days remaining intervals based on the time 
that you specify. Your changes take effect immediately.

6. Under Minimum Refresh rates, in the Agent Real-time Displays box, type the minimum 
refresh rate in seconds for Agent Real-time Displays.

Real-time statistics
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7. In the Other Real-time Displays box, type the minimum refresh rate in seconds for all 
other Real-time Displays.

8. Click Submit to save your changes.

Configuring real-time statistics collection
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Chapter 31: Dialed number identification 
services

A dialed number identification service (DNIS) is an optional service that allows Avaya Contact 
Center Select to identify the phone number dialed by the incoming caller, and then use the dialed 
number to route the call to an appropriate skillset. An agent can receive calls from customers calling 
in to different DNISs and can prepare a response according to the DNIS.

Avaya Contact Center Select uses direct dial-in (DDI) information it receives from IP Office to route 
calls to appropriate skillsets or agents based on DNIS numbers.

Configuring a DNIS
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.
• Configure your DNIS numbers on IP Office. You must add DNIS numbers as Incoming Call 

Route numbers on IP Office and add an IP Office short code (Contact Center Route Point 
or CDN) as a destination for each Incoming Call Route number that you configure. For more 
information about configuring DNIS numbers on IP Office, see Avaya Contact Center Select 
Advanced Administration.

About this task
A Dialed Number Identification Service (DNIS) is a method by which the system recognizes 
the phone number that a caller dials. Agents can receive contacts from customers calling in on 
different DNISs and customize their response according to the DNIS. Based on the DNIS, the 
system can direct contacts to a controlled CDN and supply different treatments.
You cannot modify a saved DNIS. You can delete a saved DNIS and add a new DNIS.

Procedure
1. In the left pane, expand the server on which to add the DNIS.

2. Select the DNISs folder.

3. In Name box, type the name of the new DNIS as you want it to appear in reports.

4. In the Number box, type the DNIS number.
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5. In the URI box, type a URI for the DNIS and press Tab.

Important:

The URI must be unique to URIs currently assigned to other DNISs, CDNs, or agents 
and must not begin with SIP.

6. In the Service Level Threshold box, type the time in seconds within which all contacts 
coming in on this DNIS must be answered or abandoned. The threshold value is used for 
historical reporting.

7. In the Description box, type the description of the DNIS. For example, type the DNIS 
prefix. You can use the description to sort, filter, and group individual DNIS numbers in 
user-created, custom historical reports.

8. Click any other row in the grid to save the DNIS.

Variable definitions
Name Description
Name The name of the DNIS as you want it to appear in 

reports.

Valid values: 30-character maximum (no special 
characters)

Number The number assigned to the DNIS. This is the 
directory number at which the contact arrives at the 
switch.

Important:

You cannot change a saved DNIS. You must 
delete the DNIS and then recreate it.

Valid values: 31-digit maximum. Avaya 
recommends that you enter only 30 digits, as callers 
can use the pound sign (#) as a delimiter, and this 
counts towards the 31-digit limit.

URI In the URI box, type the Universal Resource 
Identifier (URI) of the DNIS.

Valid values: maximum 255 characters, including 
numbers, English characters, /, \, ?, &, periods, ‘@’ 
symbol, underscores, and dashes.

This field is mandatory. Once you save the URI, 
you cannot modify it. The URI must be unique to 
URIs assigned to other DNISs, CDNs, or agents 
and must not begin with SIP.

Table continues…

Configuring a DNIS
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Name Description
Service Level Threshold The service level threshold assigned to the DNIS. 

This is the time, in seconds, in which all contacts 
coming through on this DNIS are to be answered or 
abandoned.

Valid values: 4-digit maximum
Description The description of the DNIS number. For example, 

type a DNIS prefix, such as 1-800. You can use this 
description to sort, to filter and to group individual 
DNIS numbers in user-created custom reports.

Valid values: maximum 16 characters

Dialed number identification services
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Chapter 32: Formulas

Use the Formulas window to create custom real-time statistics fields by combining existing statistics 
fields with mathematical operators. You can save these custom statistics fields as formulas and use 
them in your private Real-Time Reporting displays. For example, you can create a custom formula 
to calculate the service level.

Creating a custom formula
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Configuration component.

About this task
Create a custom formula to create custom real-time statistics fields by combining existing statistics 
fields with mathematical operators. You can then save these custom statistics fields as formulas 
and use the formulas in your private Real-Time Reporting displays.

Procedure
1. In the left pane, expand the server on which to create the formula.

2. Select the Formulas folder.

3. In the right pane, in the Available Formulas box, type the name of the new formula, and 
then press Tab.

4. From the Statistics Group list, select the statistics group that contains the statistics field to 
include in your formula.

5. Press Tab or Enter to display the Formula Editor.
6. In the Formula Editor, in the Comment box, type information about the formula (optional).

7. From the Variables list, select the variable to use in the formula.

Important:

When you select a variable, it appears in the Formula box with a percent symbol (%) 
preceding it. The percent symbol identifies it as a variable; it is not a mathematical 
operator.
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8. From the numeric keypad, select any numeric input to apply to the formula.

9. After you select a mathematical operator, you can select another variable to add to the 
formula. For example a formula for service level is Calls Answered – Calls Answered Aft 
Threshold / Calls Answered. The formula can be up to 250 characters.

10. To use the higher or lower of two values in your formula, click Max or Min.

11. After you finish creating the formula, click Save.

12. Click Close to return to the Formulas window.

Variable definitions
Name Description
Available Formulas Type a name for the custom formula and then press 

Tab to select the Statistics Group for the formula.

To edit an existing formula, double-click the 
formula name in the Available Formulas column. 
The Formula Editor appears, listing the Formula 
components.

Statistics Group Select the statistic group for the formula. Statistics 
groups are sets of related statistics defined in 
the database, such as agent statistics or skillset 
statistics.

After you select the statistics group, press Enter or 
Tab. The Formula Editor appears, in which you can 
create your custom formula.

Formula Name The name of the formula, as you entered it in the 
Available Formulas box in the Formulas window. 
You can change formula name in the Formula 
Editor.

Comment Type any additional information about your custom 
formula.

Formula The variables and mathematical operators that you 
choose for your custom formula. You can add new 
variables and operators, or edit the existing ones.

Table continues…

Formulas
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Name Description
Variables The existing statistics fields that you can combine to 

create custom formulas. After you create a formula, 
you can apply it to your private Real-Time Reporting 
displays to control the type of data that you see.

From the Variables list, select the variables to add 
to your custom formula. After you select a variable, 
you must choose a mathematical operator (/, *, -, or 
+) before you can select another variable, or before 
you can enter any numeric values.

When you select a variable, it appears in the 
Formula box with a percent symbol (%) preceding 
it. The percent symbol identifies it as a variable; it is 
not a mathematical operator.

Numeric keypad Important:

After each variable, you must select a 
mathematical operator before you can select 
another variable.

• Back Space — Removes the last item that 
you enter in your formula. To remove more 
items, you must click C to clear the entire 
formula.

• C — Clears the entire formula from the 
Formula box.

• / — Divides the variables in the formula.

• * — Multiplies the variables in the formula.

• - — Subtracts the variables in the formula.

• + — Adds the variables in the formula.

• , — Separates the Max and Min variables in 
the formula.

Table continues…

Creating a custom formula
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Name Description
Max and Min Use the Max and Min buttons to use the higher of 

two values (Max), or the lower of two values (Min) in 
your formula.

When you click Max or Min, a set of brackets 
appears in the Formula box. In these brackets, add 
the two values to compare, separated by a comma.

The format must be as follows: Max[a,b], where a 
can be one variable, or two variables separated 
by an operator, and b can be one variable, or two 
variables separated by an operator.

For example, if you 
specify Max[Agent_Available+Agent_Not_Ready, 
Agent_In_Service+Agent_On_This_Skillset_Call], 
the system calculates the values for 
Agent_Available+Agent_Not_Ready and for 
Agent_In_Service+Agent_On_This_Skillset_Call, 
and uses the higher of the two values in the 
formula. If you use Min in this example, the system 
calculates the lower of the two values.

Save Save changes you make in the Formula Editor.
Close Exit the Formula Editor.

Editing or viewing formulas
Before you begin

• Create at least one custom formula.

About this task
You cannot edit standard formulas; you can edit only custom formulas.

Procedure
1. In the left pane, expand the server containing the formula you want to edit.

2. Select the Formulas folder.

3. In the right pane, in the Available Formulas column, double-click the name of the formula 
to edit.

4. In the Formula Editor, you can modify the formula name, the formula comment, and the 
formula.

5. To add a new variable to an existing formula, you must click an operator (/, *, −, +) to add it 
to the end of the formula, and then select the new variable from the Variables list.

Formulas
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6. To delete elements from the formula, in the Formula box, select the elements, and then 
press Delete.

7. After you finish your changes, click Save to save the formula.

8. Click Close to close the Formula Editor.

Editing or viewing formulas
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Chapter 33: Media servers

Contact Center uses Avaya Aura® Media Server media processing capabilities to support 
announcements and dialogs. Avaya Aura® Media Server is automatically configured in Contact 
Center Manager Administration as a Media Server. Avaya Aura® Media Server provides some 
default media for standard ringback and busy tones. Additional media for recorded announcements 
(RAN) and music on hold must be provisioned in order for Avaya Aura® Media Server to provide 
meaningful media to the customer.

Verifying the media server details
Before you begin

• Log on to Contact Center Manager Administration (CCMA).
• Open the Configuration component.

About this task
Contact Center uses Avaya Aura® Media Server (Avaya Aura® MS) media processing capabilities. 
Contact Center automatically configures each Avaya Aura® MS in a Contact Center as a Media 
Server. Contact Center automatically populates the Avaya Aura® MS server details, such as the 
server name and IP address, in CCMA.
Verify the media server details in CCMA are correct.

Procedure
1. In the left pane, expand the server on which to view your Media Server.

The server expands to show its resources.

2. Select the Media Servers folder.

3. In the right pane, verify the media server details are correct.

If the Avaya Aura® MS server details are incorrect, update the Avaya Aura® MS server 
details.

Note:

The default port number is 5060.

4. If this Avaya Aura® Media Server is going to manage prompts, ensure that the Master 
Content Store checkbox is selected. If your solution implements Business Continuity, 
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select the Master Content Store checkbox for the Avaya Aura® Media Server of the active 
server. Avaya Contact Center Select supports only one Master Content Store. When you 
select the Avaya Aura® Media Server Master Content Store, CCMA Prompt Management 
deploys media to that Avaya Aura® Media Server.

Verifying the media server details
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Chapter 34: Contact Center Management 
fundamentals

Contact Center Management contains the following main data views:

• Supervisors view

• Agents view

• Skillsets view

• Assignments view

You can use Contact Center Management to perform the following tasks:

• Add, edit, view, or delete users defined in Contact Center Manager Server.

• Add, edit, view, or delete agent-to-supervisor assignments.

• Add, edit, view, or delete agent-to-skillset assignments.

• View the schedule of all agent-to-skillset and agent-to-supervisor assignments.

• Run user-defined assignments on an ad hoc basis.

• Apply assignment changes to multiple agents simultaneously.

• Display agent logon status in Agents, Supervisors, Skillsets and Assignments and Agent 
Details views.

• Search by agent logged in or logged out status.

• Assign an agent to default queue management.

• Use Contact Center Management to quickly assign agents to existing partitions instead of 
opening the Access and Partition Management component.

To add a user (agent or supervisor/agent), you must use the Contact Center Management 
component or the Configuration Tool spreadsheet in the Configuration component. Supervisor/
agents can also be Contact Center Manager Administration (CCMA) users and can have a CCMA 
user ID and password to access the CCMA client application; however, many supervisor/agent 
users do not use CCMA.
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Force Agent Log out and Change Agent Status
The Force Agent Log out feature allows a supervisor to remotely log an agent out of Contact 
Center from the Contact Center Manager Administration (CCMA) user interface. This allows 
supervisors to log out agents who forget to log out or to go not-ready at the end of their shift.

Important:

Use the option to log out an agent only in exceptional circumstances, where there is no other 
option. If an agent has active contacts and a supervisor forces them to log out, Agent Desktop 
shuts down: in certain scenarios this leaves their active contacts in an incorrect state. The 
following use cases indicate situations in which a supervisor can use the force log out feature:

• An agent falls sick at work, and transfers their current contacts, but leaves their desk 
without logging off. A locked screensaver prevents anyone accessing their desktop to 
close Agent Desktop. The supervisor forces this agent to log off, and there is no impact 
to customer contacts.

The supervisor can also force an agent state change to toggle it between Ready or Not Ready. 
When they force an agent into the Not Ready state, supervisors have the option to enter a 
Not Ready Reason code for the agent. The following use cases indicate situations in which a 
supervisor chooses to force an agent state change:

• A trainee agent goes Not Ready, entering a reason code of At_Lunch. They return from lunch 
but forget to reset their status to Ready. Their supervisor can see that they are at their desk, 
and also that they show Not Ready on the Real time Display (RTD). The supervisor uses the 
Change State button to make the agent Ready.

• A trainee agent leaves their desk for lunch, but forgets to set their status to Not Ready. 
Contacts continue to alert on their Agent Desktop. The supervisor notices that the agent is 
not at their desk, and that they show Ready on the RTD. The supervisor uses the Change 
State button to make the agent Not Ready.

When a supervisor logs out an agent, or changes the agent’s status, the agent receives a 
notification in Agent Desktop. With normal usage of the Force Agent Log out option, this 
is not required, because the agent is not present at their desktop. However, if a supervisor 
accidentally selects the wrong agent to log out, this notification gives the agent a time period in 
which to gracefully complete their active contacts. This time period is configurable in Multimedia 
Administration. If the agent has an active voice contact, they are able to continue the call on 
their physical phoneset after Agent Desktop closes; where the agent is using the Agent Desktop 
softphone, this is not possible and the voice contact drops.

Administrators can use a new Access and Partition management setting to restrict access to the 
Force Agent Log out feature. A new Force Agent State Change access privilege controls access 
to Force Agent Log out and Change Agent State. Only supervisors who have the Force Agent 
State Change privilege can use the feature, and supervisors can log out or change the state of 
only those agents that they can see in their partition.

Supervisors access the Force Agent Log out feature either from an agent Real-Time Display 
(RTD) or from the Contact Center Management user interface. From the CCM interface, Force 

Force Agent Log out and Change Agent Status
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Agent Log out enables a supervisor to log out a single agent or a group of agents. Changing an 
agent’s ready state is possible only from a Real Time Display (RTD).

The columns that display the Force Agent Log out and Change State buttons on an RTD are 
optional, and are not available on the standard RTDs. To use the buttons, supervisors must create 
a private RTD with the Change State and Logout columns included. While a supervisor can make 
public an RTD with these columns, supervisors viewing the public RTD cannot use the buttons if 
they do not have the “Force Agent State Change” access privilege.

The CCMA audit trail records both the force logout and the force state change events. The audit 
details the time at which the event happened, the agent that the supervisor modified, and the 
CCMA user id of the supervisor who carried out the action.

Contact Center Management fundamentals
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Chapter 35: Agents

In the Agents view, you can search for particular agents or list all agents on a server. You can also 
use the agents view to

• view and edit the agents' properties, including the skillsets and partitions to which the agents 
are assigned

• delete the agents from the server one at a time or in bulk

• quickly create a new agent by copying an agent's properties

• log out an agent or multiple agents

Partly configured agents appear in the Contact Center Management Agents list with a grey agent 
icon. You can only delete these agents.

Two types of agents are available in Contact Center Management:

• Agents

• Supervisor/agents

Important:

After you add agents, ensure that you synchronize the updated data to IP Office. For more 
information, see Synchronizing data to IP Office manually on page 118.

Adding an agent
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.
• If you want to associate an agent with a domain account, you must first add the server to a 

domain.

About this task
Complete this procedure to add an agent in Contact Center Management.
If you click Create Copy while viewing an existing agent, the window appears and the User Details 
and User Information sections expand and contain some information from the copied agent profile.
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Procedure
1. In the left pane, click the CC server.

2. From the Add menu, select Agent.
3. In the New Agent Details window, enter the following mandatory information about the 

agent:

• First name

• Last name

• Login ID

• Call presentation class

• Multiplicity presentation class

• Threshold

• Primary supervisor

4. Enter any optional information about the agent (for example, Call Presentation Class, 
Threshold, Title, Department, or Comments).

5. Under Windows User Account Details, select Workgroup or Domain. If your solution 
implements the Business Continuity feature, the Domain option is available only. Avaya 
Workspaces agents must each have an associated Windows domain user account.

6. If you select Workgroup:

a. In the Password box, type the password for the new local Windows user account 
associated with this agent.

b. In the Confirm Password box, retype the password.

7. If you select Domain:

In the User name box, type the name of the agent’s domain user account in the 
format DomainName\UserAccountName. This domain account is associated with the 
agent.

Important:

You must ensure that you associate the agent with a correct and valid domain 
user account.

8. If this agent uses the multiplicity feature on Agent Desktop, select a multiplicity 
presentation class from the Multiplicity Presentation Class list.

If multiplicity is not enabled, the Multiplicity Presentation Class list does not appear.

9. Click the Offsite Agent heading, if you want to allow the agent to log on to Agent Desktop 
in Other Phone mode.

Agents
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Note:

If Offsite Agent is not enabled, the Offsite Agent heading does not appear. For 
more information about enabling licensed features, see Avaya Contact Center Select 
Advanced Administration.

10. To enable Offsite Agent, from the Offsite Agent Allowed list, select Optional or 
Mandatory and complete the related Offsite Agent fields.

11. Click the Contact Types heading.

12. Select the check box beside each Contact Type to assign to the agent.

13. Click the Skillsets heading.

14. In the Skillsets area, click List All to list all skillsets configured on the server.

15. From the Priority list for each skillset to assign to the agent, select the priority level or 
select Standby to put the agent in standby mode for this skillset.

Priority levels range from 1 to 48 and from Standby (1) to Standby (48), with 1 being the 
highest priority for the skillset.

Important:

You can only assign skillsets to an agent that belongs to the same contact type.

16. Click the Partitions heading.

The list of partitions configured on the server appears.

17. Select the check boxes beside the partitions to which to add the new agent.

18. Click Submit to save your changes.

Variable definitions
Name Description
First Name The first name of the user. The first name is 

mandatory for all users and can be a maximum of 
30 characters long.

Last Name The last name of the user. The last name is 
mandatory for all users and can be a maximum of 
30 characters long.

Title The title for the user. The title is optional and can be 
up to 40 characters long.

Department The user's department. The department is optional 
and can be up to 40 characters long.

Language Select the language preference for the user. 
Language selection is mandatory for all users.

Table continues…

Adding an agent
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Name Description
Comment Comments you have about the user. Comments are 

optional and can be up to 127 ASCII characters in 
length. The 127 character limit can be less if you 
use non-ASCII characters.

User Type Select the user type. This value is mandatory. 
Select the agent user type.

Agents are users who are assigned skillsets and 
who answer contacts in the Contact Center. All 
agents must be assigned to a supervisor.

Login ID The number that the user enters to log on to the 
phone. This value is mandatory for all users.

Voice URI A unique identifier used to identify each user in 
the contact center, in the format <Login ID>:<SIP 
domain name>. This field is automatically populated 
and is read-only.

Windows User Account Details — Password 
(Workgroup only)

The password for the local Windows user account 
created on the server when you add an agent. The 
account is automatically associated with the agent.

Windows User Account Details — User name 
(Domain only)

The domain user account to associate 
with the agent, in the format 
DomainName\UserAccountName. You can not use 
the following characters in a username: ",", "+", """, 
"\", "<", ">" or ";".

Important:

The account details must be correct. Agents 
cannot log on to Agent Desktop or Avaya 
Workspaces if you type the account details 
incorrectly.

Primary Supervisor The agent's supervisor. You can choose from all 
supervisors configured on the server to which you 
are currently logged on.

Call Presentation The call presentation class to assign to this agent. 
The call presentation class determines whether the 
agent can take a break between calls, or whether 
the agent can put DN calls on hold for incoming 
routed calls.

Call Presentation is mandatory for all users with 
agent and supervisor/agent capability.

Multiplicity Presentation Class The multiplicity presentation class to assign to 
this agent. The multiplicity presentation class 
determines the type and number of Multimedia 
contacts an agent can have open simultaneously on 
Agent Desktop.

Table continues…

Agents
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Name Description
Threshold The threshold class to assign to this user.

The threshold class is mandatory for all users with 
agent and supervisor/agent capability.

Offsite Agent Allowed Select one of the following options:

• Disabled: This option disables Offsite Agent for 
this agent.

• Optional: This option allows the agent to log on 
to Agent Desktop in Deskphone mode or in Other 
Phone mode.

• Mandatory: This option forces the agent to log on 
to Agent Desktop in Other Phone mode.

Phone 1 The primary telephone number at which this agent 
receives calls from Contact Center when logged on 
to Agent Desktop in Other Phone mode.

The phone number has a maximum of 15 digits.
Phone 2 The secondary telephone number at which this 

agent receives calls from Contact Center when 
logged on to Agent Desktop in Other Phone mode.

The phone number has a maximum of 15 digits.
Allow agent to enter an alternate phone Select to allow the agent to enter an alternate 

number to the numbers configured as Phone 1 or 
Phone 2. The agent can enter a different number 
when they log on to Agent Desktop in Other Phone 
mode.

Adding a Supervisor/Agent
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.
• If you want to associate a Supervisor/Agent with a domain account, you must first add the 

server to a domain.

About this task
A user with Supervisor/Agent capabilities is assigned skillsets and can answer contacts in Contact 
Center. A Supervisor/Agent can perform some of the duties of a regular supervisor, such as 
monitor real-time displays in Contact Center Manager Administration, and answer agent queries. 
All Supervisor/Agents must be assigned to a supervisor. If the supervisor/agent is going to use 
CCMA, you must also assign a Contact Center Manager Administration user ID and password to 
this user.

Adding a Supervisor/Agent
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Procedure
1. In the left pane, click the CC server.

2. From the Add menu, select Supervisor/Agent.
3. In the New Supervisor/Agent Details window, enter the following mandatory information 

about the supervisor/agent:

• First name

• Last name

• Login ID

• Call presentation class

• Multiplicity presentation class

• Threshold

• Primary supervisor

4. Enter any optional information about the supervisor/agent (for example, Title or 
Department).

5. If the supervisor/agent is going to use CCMA, under CCMA Login Account Details, type 
the account name used to log on to CCMA in the User ID box.

6. In the Password box, type the password for the account.

Passwords must fulfill the following complexity criteria:

• Must be between 8 to 20 characters

• Must contain a number

• Must contain at least one uppercase letter and at least one lowercase letter

• Must not contain spaces

• Must not contain any of these characters: \ & : < > |

7. Under Windows User Account Details, select Workgroup or Domain. If your solution 
implements the Business Continuity feature, the Domain option is available only.

8. If you select Workgroup:

a. In the Password box, type the password for the new local Windows user account 
associated with this Supervisor/Agent.

b. In the Confirm Password box, retype the password.

9. If you select Domain:

In the User name box, type the name of the agent’s domain user account in the 
format DomainName\UserAccountName. This domain account is associated with the 
Supervisor/Agent.

Agents
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Important:

You must ensure that you associate the Supervisor/Agent with a correct and valid 
domain user account.

10. Click the Offsite Agent heading, if you want to allow the agent to log on to Agent Desktop 
in Other Phone mode.

Note:

If Offsite Agent is not enabled, the Offsite Agent heading does not appear. For 
more information about enabling licensed features, see Avaya Contact Center Select 
Advanced Administration.

11. To enable Offsite Agent, from the Offsite Agent Allowed list, select Optional or 
Mandatory and complete the related Offsite Agent fields.

12. Click the Contact Types heading.

13. Select the check box beside each Contact Type to assign to the agent.

14. Click the Skillsets heading.

15. In the Skillsets area, click List All to list all skillsets configured on the server.

16. In the table listing all skillsets, select the priority numbers beside the skillsets to which 
you want to assign the supervisor/agent, or select Standby to put the supervisor/agent in 
standby mode for this skillset.

Skillset priority can range from 1 to 48 and from Standby (1) to Standby (48), with 1 being 
the highest priority for this skillset.

17. Click the Partitions heading.

The list of user-defined partitions configured on the server appears.

18. Select the check box for each partition to which you want to add the new supervisor/agent.

19. Click Submit to save the new user profile.

Creating an agent/supervisor assignment
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.
• Ensure that you have access to the New Agent to Supervisor Assignment window.
• Ensure that you understand reset assignments. For information, see Creating a reset 

assignment on page 214.

Creating an agent/supervisor assignment
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About this task
Create agent-to-supervisor assignments to temporarily assign multiple agents to a different 
supervisor when supervisors are on breaks, are sick, are on vacation, or are taking a course.

Procedure
1. In Contact Center Management, on the menu, choose View/Edit > Assignments.

2. In the left pane of the Assignments view, expand the server on which to assign agents to 
skillsets.

The server shows the assignment folders.

3. Right-click the Agent Supervisor Assignments folder, and then click Add Assignment.
4. In the New Agent to Supervisor Assignment window, in the Assignment Details area, click 

the List Available Agents heading to search for agents to add to the assignment.

The heading expands to show the agent search boxes.

You can search for agents by first name, last name, department, comment, or login ID. You 
can also search by the current agent login status (Logged In or Logged Out).

5. Enter your search details up to a maximum of five different criteria.

6. Click Search.

The agents that match your criteria appear in a table.

If you search by login status, you can search by this one criterion only.

7. To list all agents configured on the server (your partitioned agents and any agents in the 
reporting agent combinations assigned to you), click List All.

8. In the Available Agents table, note the agents logged on, and then select the check box 
for each agent to include in the assignment.

9. Click Update Table.

The agents with their currently assigned skillsets appear in the Assignment Details table.

10. Click the Save/Schedule Assignments heading.

11. In the Save Assignment As box, type a unique name for the assignment.

12. Select the Create Reset Assignment check box to create a reset assignment.

13. Click Save to save the reset assignment before altering the original assignment.

14. Click Save Assignment to save the assignment in the Assignments folder.

Deleting an agent
Before you begin

• Ensure that the agent is logged out.

Agents
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• Ensure the agent is not referred to in scripts.
• Log on to CCMA.
• Open the Contact Center Management component.

About this task
Several options are available to delete an agent or a supervisor/agent. This procedure lists one 
possible way.

Note:
After you delete an agent, Agent Desktop displays the agent’s logon ID against historical 
actions for a contact instead of displaying the agent name.

Procedure
1. From the View/Edit menu, select Supervisors.

2. In the left pane, click the server containing the agent to delete.

3. Click the agent's primary supervisor.

All agents assigned to the supervisor appear.

4. Right-click the agent to delete, and then click Delete Agent.
5. In the message box that appears asking you to confirm your choice, click Yes.

Logging out multiple agents from the Agents list
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.

About this task
Use this procedure to force log out multiple agents.

Important:
Forcing multiple agents to log out can have a detrimental effect to contact center operation. 
Consider this option only in exceptional circumstances where there is no alternative method of 
logging out these agents. If an agent has active contacts and you force them to log out, Agent 
Desktop closes, and this can leave their active contacts in an incorrect state.

Procedure
1. From the View/Edit menu, select Agents.

2. In the left pane, click the CC server.

3. In the list of agents, select each agent that you want to log off.

4. Click Logout.

Logging out multiple agents from the Agents list
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5. On the Message from Webpage dialog box, click OK.

Contact Center logs out the agents, and displays a message on the agents’ Agent Desktop 
interfaces informing them that a supervisor has logged them out.

Logging out an agent from the Agent Details screen
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.

About this task
Use this procedure to force log out a single agent.

Important:
Use Force Agent Log out only in exceptional circumstances, where there is no other option to 
log out an agent. If an agent has active contacts and you force them to log out, Agent Desktop 
closes, and this can leave their active contacts in an incorrect state.

Procedure
1. From the View/Edit menu, select Agents.

2. In the left pane, click the CC server.

3. In the list of agents, double click the agent that you want to log off.

CCMA displays the Agent Details screen.

4. On the Agent Details window, in the Agent Information section, check the status of the 
agent in the Login Status field.

5. Click the Logout Agent.
6. On the confirmation dialog box, click Yes.

Contact Center logs out the agent, and displays a message on the agent’s Agent Desktop 
interface informing them that a supervisor has logged them out.

Modifying agent details
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.

About this task
Complete this procedure to edit the details of an agent or supervisor/agent.

Agents
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Procedure
1. From the View/Edit menu, select Supervisors.

2. In the left pane, click the CC server.

The list of supervisors configured on the server appears.

3. Click the supervisor to whom the agent is assigned.

The tree expands to show the list of agents assigned to this supervisor.

4. Right-click the agent whose profile you want to edit, and then select View Agent Details.

5. On the Agent Details window, in the User Details and Agent Information sections, you 
can change agent details, such as first name, last name, User Type, login ID, primary 
supervisor, call presentation, multiplicity presentation class, threshold, title, department, or 
comments.

6. If you change the User Type from Agent to Supervisor/Agent, you can enter a Contact 
Center Manager Administration user ID and password for the supervisor/agent.

The supervisor/agent can now log on to Contact Center Manager Administration using this 
account.

7. To change the current skillset assignment or assign the agent to new skillsets, click the 
Skillsets heading.

The list of currently assigned skillsets appears.

8. To change the priority level for a skillset, in the table of assigned skillsets, from the Priority 
list, select a new priority level.

9. To assign the agent to new skillsets, click List All to list all skillsets configured on the 
server.

10. In the table listing all skillsets, from the Priority list, select the priority level for each 
skillsets to which you want to assign the agent.

OR

Select Standby to put the agent in standby mode for this skillset.

Skillset priority levels range from 1 to 48 and from Standby (1) to Standby (48), with 1 
being the highest priority for this skillset.

11. To remove the skillset from the agent, select Unassigned.

12. If you have administrator privileges and you reassigned this agent to a new supervisor, you 
can now add this agent to the user-defined partitions assigned to the agent's supervisor 
(instead of having to do so in Access and Partition Management). Click the Partitions 
heading.

The list of user-defined partitions configured on the server appears.

13. Select the check box for each partition to which you want to add the agent.

14. Click Submit to save your changes.
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Copying agent properties
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.

About this task
There are several ways to copy an agent's properties. This procedure lists one possible way. 
You can also right-click an agent name in the system tree, and then click Create Copy from the 
resulting pop-up menu.
You can create new agents quickly by copying the properties of existing agents. New agents 
assume the following properties from the existing agent:

• Skillset assignment
• Department
• User type
• Language
• Comment
• Supervisor
• Call presentation
• Threshold
• Contact type

When you copy an agent's properties, you must type in the new agent's name and login ID.

Procedure
1. From the View/Edit menu, select Supervisors.

2. In the left pane, click the CC server.

3. In the left pane, click the agent's supervisor.

The Supervisor window appears in the right pane, listing the assigned agents in a table.

4. In the table, right-click the agent to copy, and then select Copy Agent Properties.

The agent's properties appear in the New Agent Details window.

5. In the User Details section, type the new agent's name and login ID.

6. Optionally, type any comments you have about the agent. You can also change any of the 
copied properties. For example, you can assign the agent to new skillsets or partitions in 
the appropriate areas of this window.

7. After you configure the new agent, click Submit to save the agent under the specified 
supervisor.

The agent's icon appears in the system tree.
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Searching for agents
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.

About this task
You can use the agent search feature in each of the four data views in Contact Center 
Management: Supervisor, Agent, Skillset, and Assignment.
In supervisor view, you can search for agents to assign to the currently selected supervisor.
In agent view, you can search for specific agents on a particular server. When you find the 
agents, you can view or change their properties, delete their profiles from the server, or copy their 
properties and create new agents.
In skillset view, you can search for agents to immediately assign to the currently selected skillset 
(ad hoc assignment).
In assignment view, you can search for new agents to add to saved agent to supervisor and agent 
to skillset assignments (and then you can schedule these assignments).
You can search by first name, last name, department, comment, login ID, logged in/logged out 
status or a combination of all of these criteria (up to a maximum of five levels). You cannot use the 
wildcard symbol (*) in your search.
You can search only among the agents included in the partition assigned to you, and in any 
supervisor/reporting agent combinations assigned to you.

Procedure
1. From the first list, select the criterion by which you want to search.

2. From the second list, select Starts With, Contains, or Equals.

3. In the third box, type the value you want to search for, or type a partial value.

For example, to search for agents with the first name of either Frank, Francis, or Francisco, 
you can type Fran. You cannot use the wildcard symbol (*) in your search.

4. Optionally, from the fourth list, select and to search by two criteria. Select or to search by 
either one criterion or another.

A second row of lists appears from which you can select the second criterion.

You can continue to refine your search this way, entering a maximum of up to five criteria.

5. When you finish, click Search. Your search results appear in the agents table.

6. If you are not satisfied with the search results, or if you want to start a new search, from 
the fourth list in the first search row, select the blank value to clear all entered search 
criteria.
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Searching for agents by skillset
Before you begin

Important:
You can specify a maximum of five skillsets to search for an agent. You can search only 
among those skillsets in the partitions assigned to you.

• Log on to CCMA.
• Open the Contact Center Management component.

About this task
When you need to quickly locate all agents on a server either assigned to a skillset, in Standby 
for a skillset, or not assigned to a particular skillset, you can use the skillset search feature of 
Contact Center Management. You can use this feature in the Agent to Skillset Assignment window 
in Assignment view of Contact Center Management. This feature is particularly useful when you 
notice high contact volume for a skillset. You can locate all agents who are in Standby mode for 
the skillset so that you can assign them to handle the excess contacts.

Procedure
1. In the Agent to Skillset Assignment window, click Skillset Search.

2. From the search boxes, choose the skillsets that you want to search for, up to a maximum 
of five.

3. After you choose your criteria, click Search.

The agents that match your search criteria appear in a new table.

4. Note the Logged In agents, and then select the check box for each agent to add to the 
assignment.

5. Click Update Table.

The agents appear in the Assignment Details table.

6. To search for agents by more than one skillset, from the last list, select and, select the new 
skillset and skillset status, and then click Search.

Agents assigned to all of the specified skillsets appear in a new table.

7. To search for agents by one skillset out of a number of skillsets that you specify, from the 
last list, select or, select the new skillset and skillset status, and then click Search.

Agents assigned to at least one of the specified skillsets appear in a new table.

8. To search for agents who are either in Standby mode for a skillset or not assigned to the 
skillset, from the first list, select the skillset, from the second list, select Standby, and from 
the last list, select or. From the first list in the second row, select the same skillset, from the 
second list, select Not Assigned, and then click Search.

Agents who are either in Standby mode or not assigned to the skillset appear in a new 
table.
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Chapter 36: Skillset assignments

A skillset is a group of abilities necessary to answer a specific type of contact. Skillsets are the basic 
building blocks of skill-based routing. Use skillsets to match a caller with the agent who can best 
meet the caller's needs.

In the Skillsets view, you can create new ad-hoc agent-to-skillset assignments and change the 
priority of skillsets already assigned to agents. Click View/Edit, Skillsets to change the system tree 
to the skillset view. Select a server in the system tree to log on to the server and work with the 
configured skillsets and agents.

When you click a skillset in the system tree, the Skillsets window appears, listing the agents who are 
currently assigned to the skillset and the priority for that skillset.

You can use this window to quickly assign new agents to the currently selected skillset (only those 
agents in your partition, and your reporting agents), or to change the priority of agents assigned 
to this skillset. You can use the search feature in this window to find new agents to assign to the 
skillset.

Creating a skillset assignment
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.
• Ensure that you understand Reset Assignments. For information, see Creating a reset 

assignment on page 214.

About this task
Create agent-to-skillset assignments to temporarily assign agents to different skillsets when 
agents are on breaks, are sick, are on vacation, or are on a course and to schedule future contact 
center configurations (for example, in response to planning through a work force management 
tool).

Procedure
1. In the Contact Center Management window, on the menu, choose View/Edit > 

Assignments.

2. In the left pane, expand the CC server.
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3. Right-click the Agent Skillset Assignments folder, and then click Add Assignment.
4. In the New Agent to Skillset Assignment window, in the Assignment Details area, click 

the List Available Agents heading to search for agents to add to the assignment.

You can search for agents by first name, last name, department, comment, or login ID. You 
can also search by the current agent login status (Logged In or Logged Out).

5. Enter your search details up to a maximum of five different criteria.

6. Click Search. The agents that match your criteria appear in a table. If you search by login 
status, you can search by this one criterion only.

7. To list all agents configured on the server (your partitioned agents and any agents in the 
reporting agent combinations assigned to you), click List All.

8. In the Available Agents table, note the agents logged on, and then select the check box 
for each agent to include in the assignment.

9. Click Update Table.

The agents with their currently assigned skillsets appear in the Assignment Details table.

10. To remove an agent from the Assignment Details table, select the agent to remove and 
click Remove Agent.

11. To reset the Assignment Details table to the last saved configuration, click Reset 
Assignment Details.

12. To add new skillsets to the table, click the List Available Skillsets heading.

Important:

You can use this function to change only those skillsets that currently have priority 
values assigned, or all skillsets if that option is selected.

13. In the Available Skillsets table, select the check box for each skillset to add to the 
assignment.

14. Click Update Table.

The skillsets appear in the Assignment Details table.

15. To add agents assigned to a particular skillset to the assignment, click Skillset Search. 
The heading expands to show a series of search boxes.

16. From the boxes, choose the skillsets to search for, up to a maximum of five levels.

17. Click Search. The agents that match your search criteria appear in a table.

18. Select the check box for each agent to add to the assignment, and then click Update 
Table.

The agents appear in the Assignment Details table.

19. In the Assignment Details table, from the skillset lists, select the skillset priority level. You 
can choose from 1 to 48 and from Standby (1) to Standby (48). Press Tab.

20. Click the Save/Schedule Assignments heading.
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The heading expands to show a series of boxes.

21. In the Skillset Search box, type a unique name for the assignment.

22. To create a reset assignment, select the Create Reset Assignment check box.

23. Click Save to save the reset assignment before altering the original assignment.

24. Click Save Assignment to save the assignment in the Assignments folder.

Creating a skillset assignment
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Chapter 37: Assignments

In the Assignments view of Contact Center Management, you can create, view, and edit 
agent-to-skillset and agent-to-supervisor assignments. To run saved and scheduled assignments 
immediately, use the Run Now feature.

Assignment types
You can create two types of assignments in Contact Center Management:

• agent-to-supervisor assignments

• agent-to-skillset assignments

Agent-to-supervisor assignments
You can create agent-to-supervisor assignments to temporarily assign multiple agents to a 
different supervisor when supervisors are on breaks, are sick, are on vacation, or are taking a 
course.

Agent-to-skillset assignments
You can create agent-to-skillset assignments to temporarily assign agents to different skillsets 
when agents are on breaks, are sick, are on vacation, or are on a course.

Reset assignments
When you create a scheduled agent-to-supervisor assignment or an agent-to-skillset assignment 
in the Assignments view, you can create a reset assignment. A reset assignment is a record of the 
original data that existed at the time you created the assignment. For example, it contains a record 
of the original list of agents assigned to a supervisor before you modify an agent-to-supervisor 
assignment.
You can use a reset assignment to change and run the assignment as many times as you require, 
and then run the reset assignment to return conditions to their original state. This feature is 
particularly useful when you create an assignment to cover agent or supervisor breaks, and then 
want to return conditions to their normal state when the agent or supervisor returns to work.
You can modify a reset assignment just as you modify any other assignment.

Saving assignments
You cannot save multiple assignments simultaneously. If another user is saving an Agent-
to-Supervisor or Agent-to-Skillset assignment, you cannot run your assignment save. If an 
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assignment save is attempted while another assignment save is in progress, an error message is 
displayed on CCMA informing the user that another save is in progress and to try again soon.

Agent-to-supervisor assignment scenarios
The following scenarios provide some examples of when to create agent-to-supervisor 
assignments.

Example 1: Supervisor is sick
Pat Wilson, one of Best Air's supervisors, calls in sick for the day. The contact center manager 
creates and saves an agent-to-supervisor assignment and a reset assignment that lists all of the 
agents assigned to Pat. The manager schedules the reset assignment to run the following day. 
The manager then modifies the agent-to-supervisor assignment to assign half of Pat's agents 
to Chris Konings, and the other half to Cindy Wong. The manager applies the assignment 
immediately, which assigns all agents to their temporary supervisors for the day. When the reset 
assignment runs, the system reassigns all agents back to Pat.

Example 2: Supervisor is on vacation
Pat booked vacation from August 17-28. The contact center manager creates and saves an 
agent-to-supervisor assignment and reset assignment that lists all of the agents assigned to Pat. 
The manager schedules the reset assignment to run August 28 at 5:00 p.m. The manager then 
modifies the agent-to-supervisor assignment to reassign Pat's agents and schedules it to run 
August 17. When the reset assignment runs, the system reassigns the agents back to Pat.

Example 3: Supervisor is on regularly scheduled training
At Best Air, all supervisors must participate in regular upgrading. Every four weeks, the supervisor 
must spend half a day in training. Training sessions are staggered to ensure adequate supervision 
of the contact center. Pat's training occurs every third Thursday of the month. The contact center 
manager sets up an agent-to-supervisor assignment that automatically reassigns Pat's agents for 
that time.

Agent-to-skillset assignment scenarios
The following scenarios provide some examples of when you create agent-to-skillset assignments.

Example 1: Agents are sick
Mark Schultz, an agent in Best Air's Cargo Tracing skillset, is sick and absent from work today. 
This leaves the Cargo Tracing skillset understaffed, particularly for the period from 10:00 a.m. 
to 4:00 p.m., the skillset's busiest time. The contact center manager creates and saves an 
agent-to-skillset assignment and reset assignment that lists Rose Stefanopolis as one of the 
agents. The manager then modifies the agent-to-skillset assignment to assign Rose Stefanopolis 
(an agent who worked in this skillset before) to the Cargo Tracing skillset. The manager runs 
the agent-to-skillset assignment immediately, and Rose is automatically reassigned. When Mark 
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returns to work the following day, the manager runs the reset assignment to reassign Rose to her 
normal skillset.

Example 2: Shifts
During the early morning and evening periods, few agents are available. As a result, many 
skillsets are understaffed. Others, such as the Cargo Tracing skillset, do not go into service until 
9:00 A.M., and go out of service at 5:00 p.m. Best Air's contact center manager creates and saves 
an agent-to-skillset assignment and reset assignment that lists all agents that are assigned to 
the Cargo Tracing skillset. The manager modifies the agent-to-skillset assignment to assign the 
agents to Bookings and schedules it to run during early morning and evening periods.

Canceling a scheduled assignment
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.

About this task
You can cancel a scheduled agent to skillset assignment or a scheduled agent to supervisor 
assignment. When you cancel the schedule, the assignment is still saved for future reference.

Procedure
1. From the View/Edit menu, choose Assignments.

2. In the left pane, click the server containing the scheduled assignment to cancel.

3. Select the Agent Skillset Assignments folder or the Agent Supervisor Assignments 
folder.

The list of assignments appears.

4. Click the scheduled assignment to cancel.

5. In the Save/Schedule Assignments section, from the Schedule Type list, select Not 
Scheduled.

6. Click Schedule to cancel the schedule.

The assignment is cancelled and remains in the Assignments folder.

Creating a reset assignment
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.

Assignments
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About this task
When you create a scheduled agent-to-supervisor assignment or an agent-to-skillset assignment 
in the Assignments view, you can create a reset assignment. A reset assignment is a record of the 
original data that existed at the time you created the assignment. For example, it contains a record 
of the original list of agents assigned to a supervisor before you modify an agent-to-supervisor 
assignment.
You can use a reset assignment to change and run the assignment as many times as you require, 
and then run the reset assignment to return conditions to their original state. This feature is 
particularly useful when you create an assignment to cover agent or supervisor breaks, and then 
want to return conditions to their normal state when the agent or supervisor returns to work.
Example:
Supervisor Pat Jones takes a lunch break every day from 12:00 p.m. to 1:00 p.m. You want to 
reassign Pat's agents to Mike Smith every day from 12:00 p.m. to 1:00 p.m. To do so, follow these 
steps:

Important:
If you delete the assignment, the system deletes the corresponding reset assignment.

Procedure
1. Create an agent-to-supervisor assignment that lists all of the agents assigned to Pat.

2. Enter a name for the assignment, such as Lunchbox.

3. Select the Create Reset Assignment check box, and then click Save Assignment. When 
you create a reset assignment, the system saves it with the same name as the original 
assignment, but adds two underscores (__) at the end of the name. If you save the 
assignment as Lunchbox, the reset assignment name is Lunchbox__.

4. Modify the Lunchbox assignment to reassign Pat's agents to Mike and schedule it to run at 
12 noon every day.

5. Schedule the Lunchbox__ reset assignment to run every day at 1:00 p.m., thereby 
reassigning all Pat's agents back to Pat when she returns from her lunch break.

Creating a supervisor assignment
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.
• Ensure that you understand Reset Assignments. See Creating a reset assignment on 

page 214.

About this task
You can schedule a supervisor assignment to reassign agents when supervisors are unavailable 
for some reason, for example break time or vacation.

Creating a supervisor assignment
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Procedure
1. In the Contact Center Management window, on the menu, choose View/Edit > 

Assignments.

2. In the left pane, expand the server on which to assign agents to skillsets.

3. Right-click the Agent Supervisor Assignments folder, and then click Add Assignment.
4. In the New Agent to Supervisor Assignment window, in the Assignment Details area, click 

the List Available Agents heading to search for agents to add to the assignment.

The heading expands to show the agent search boxes.

You can search for agents by first name, last name, department, comment, or login ID. You 
can also search by the current agent login status (Logged In or Logged Out).

5. Enter your search details up to a maximum of five different criteria.

6. Click Search.

The agents that match your criteria appear in a table.

If you search by login status, you can search by this one criterion only.

7. To list all agents configured on the server (your partitioned agents and any agents in the 
reporting agent combinations assigned to you), click List All.

8. In the Available Agents table, note the agents logged on, and then select the check box 
for each agent to include in the assignment.

9. Click Update Table.

The agents with their currently assigned supervisors appear in the Assignment Details 
table.

10. Click the Save/Schedule Assignments heading.

11. In the Save Assignment as box, type a unique name for the assignment.

12. Select the Create Reset Assignment check box to create a reset assignment.

13. Click Save to save the reset assignment before altering the original assignment.

14. Click Save Assignment to save the assignment in the Assignments folder.

Running an assignment immediately
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.
• Create at least one skillset or supervisor assignment.

Assignments
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About this task
When you create and save an agent to skillset or agent to supervisor assignment in Contact 
Center Management, you can run it immediately by using the Run Now option. You can use this 
option to run saved assignments or scheduled assignments immediately.
You cannot run the same agent skillset assignment concurrently. You must wait until the 
assignment completes before you run it again. This prevents a potential CCMA performance 
impact.
When you click Run Now to run a scheduled assignment immediately, the schedule still applies 
and the assignment is still run at the scheduled time.
If you make any changes to the assignment, you must first click Save Assignment before clicking 
Run Now. If you do not click Save Assignment, then the assignment runs without the changes you 
have made.
When you run an assignment immediately, the Run Now button is temporarily disabled while 
the assignment runs. CCMA displays a message while the assignment is running, and when it 
completes.

Procedure
1. In Contact Center Management, on the menu, choose View/Edit > Assignments.

2. In the left pane, click the server containing the assignment that you want to run.

3. Select the folder containing the saved or scheduled assignment that you want to run.

4. If you do not want to review the assignment details before running it, and you are sure of 
the assignment name, in the left pane, right-click the assignment name, and then click Run 
Now.

The assignment runs immediately.

OR

Click the assignment.

The assignment details appears in the right pane.

5. Review the assignment details in the assignment table and make any changes, if 
necessary.

6. If you make any changes to the saved or scheduled assignment, or if you schedule the 
assignment, click Save Assignment.

7. Click Run Now.

The assignment runs immediately.

Running an assignment immediately
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Assigning agents to skillsets
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.

About this task
When you immediately assign one or more agents to a skillset without scheduling the assignment, 
you create an ad hoc assignment. Before you can assign an agent to a skillset, the agent's profile 
must exist on the server. The maximum number of skillsets you can assign to an agent is 150. For 
more information about adding new agents, see Adding an agent on page 195.

Note:
If you unassign all agents from a skillset, the skillset is taken out of service.

Procedure
1. In Contact Center Management, on the menu, choose View/Edit > Skillsets.

2. In the left pane, click the server on which to work with agents and skillsets.

3. Select a skillset.

A list of agents assigned to the skillset appear in the right pane.

4. From the Priority list, select the new priority level.

5. To remove the skillset from the agent, select Unassigned.

6. To put the agent in Standby mode for this skillset, select Standby.

7. Click the Assign Agents heading to assign a new agent to this skillset.

The search feature appears.

8. To list all agents configured on the selected server (only those agents in your partition and 
your reporting agents), click List All.

9. From the search lists, choose the criteria for your search.

You can search for agents by first name, last name, department, comment, login ID, or a 
combination of any of these criteria. You can also search by current login status (either 
Logged In or Logged Out).

10. Click Search to return agents matching your criteria in a table.

Only agents having the correct contact type for the skillset selected are returned.

11. From the Priority list, select the priority level for each agent to assign to this skillset.

12. To assign multiple agents to the same skillset priority at once, from the Set all Skillsets by 
priority list, select the priority level, and then click Apply.

13. Click Submit to assign the agents to the skillset.

The agents appear in the Assigned Agents table.
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Assigning agents to supervisors
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.

About this task
To reassign agents when supervisors go on break or on vacation, you can immediately assign 
agents to new supervisors.

Procedure
1. On the menu, choose View/Edit > Supervisors.

2. In the left pane, click the server on which you want to work with supervisors and agents.

3. Click the supervisor to whom the agent is currently assigned.

The supervisor icon expands to show all the assigned agents.

4. From the list of agents, left-click the agent who you want to reassign to another supervisor 
and, without releasing the mouse button, drag the agent icon over the new supervisor icon 
until the supervisor icon changes color.

5. Release the left mouse button to reassign the agent to the new supervisor.

Copying an assignment
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.
• Ensure that you understand Reset Assignments. See Creating a reset assignment on 

page 214.

About this task
To copy an existing assignment that you have created and saved in the Assignments folder, you 
must type a new assignment name and save the assignment.
If the assignment is scheduled, you must also click Schedule to activate the new schedule for the 
assignment.

Procedure
1. From the View/Edit menu, select Assignments.

2. In the left pane, click the server containing the assignment to copy.

3. Select the Agent Skillset Assignments folder.

OR

Assigning agents to supervisors
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Select the Agent Supervisor Assignments folder.

The list of assignments appears.

4. Click the assignment to copy.

5. In the Save/Schedule Assignments section, in the Save Assignment As box, type the 
new name of the assignment.

Important:

This name must be unique.

6. To create a reset assignment, select the Create Reset Assignment check box.

7. Click Save Assignment to save the assignment.

A copy of the assignment appears in the Assignments folder. A message appears, 
notifying you that the assignment successfully saved.

8. If you scheduled the assignment, click Schedule to activate the scheduled assignment.

Deleting an assignment
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.

Important:
When you delete an assignment, the system deletes the corresponding reset 
assignment. You can, however, delete a reset assignment and keep the original 
assignment. You cannot retrieve an assignment once it is deleted. Instead, you must 
create the assignment again.

About this task
You can delete agent to skillset assignments and agent to supervisor assignments.

Procedure
1. In the Contact Center Management window, on the menu, choose View/Edit > 

Assignments.

2. In the left pane, click the server containing the assignment to delete.

3. Select the Agent Skillset Assignment folder.

OR

Select the Agent Supervisor Assignment folder.

The list of assignments appears.

Assignments

April 2024 Administering Avaya Contact Center Select 220
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AdministeringAvayaContactCenterSelect&p3=33


4. In the left pane, right-click the assignment to delete, and then click Delete Assignment.
5. In the message box that appears asking you to confirm your choice, click Yes.

The system deletes the assignment and the corresponding reset assignment.

Viewing a scheduled assignment
Before you begin

• Log on to CCMA.
• Open the Contact Center Management component.

About this task
Based on the access class that you have for assignments, and the servers upon which your 
access class is configured, in this window, you can view the schedules of agent-to-skillset and 
agent-to-supervisor assignments created and saved by all users across all servers in the network. 
You can also view details about the scheduled assignment, such as the name, type, the server on 
which it is run, and details about the schedule time.
You must have View Assignments access for both agent-to-skillset assignments and agent-to-
supervisor assignments to see both of these types of assignments in this window. If you have 
access to only one of these types of assignments, then you can only see the schedules for this 
type of assignment. Likewise, you can see only those assignments scheduled on the servers on 
which your access class is configured.
With Schedule Assignments access, however, you can also use this window to delete the 
schedules of the assignments listed, leaving the assignments intact on the server. If you have 
the View Assignments access or less, however, you cannot delete schedules, you can only view 
the assignments.

Procedure
1. On the menu, choose View/Edit > Assignments.

2. In the left pane, click the Scheduled Events folder.

The Scheduled Events window opens, listing all scheduled assignments to which you have 
access on the servers included in your access class.

Viewing a scheduled assignment
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Chapter 38: Configuration Tool spreadsheet

Use the Configuration Tool spreadsheet to save time when configuring a new Contact Center. You 
can upload data that you want to transfer from the spreadsheet to Contact Center, and download 
data from Contact Center to the spreadsheet. Instead of entering data for each resource individually, 
you can simultaneously upload all configuration data that you entered in the spreadsheet. When you 
upload the data from the spreadsheet, you can choose to upload all configuration items at once or 
only a portion.

You normally only use the Configuration Tool to add or download data, but you can also use it to edit 
certain configuration details. For example, you can use the Configuration Tool to bulk change your 
agent account mappings. The Configuration Tool spreadsheet does not enable you to edit all fields 
on every tab. You must use the Configuration component in Contact Center Manager Administration 
to modify or delete data that cannot be edited in the Configuration Tool spreadsheet.

Prerequisites for Configuration Tool procedures
• Ensure that you are logged in to Contact Center Manager Administration as an administrator.

• You must have Microsoft Excel.

Note that the procedures in this chapter are intended as a guideline, but the exact steps 
might vary depending on the version of Microsoft Excel you are using

Downloading the Configuration Tool spreadsheet
About this task
You can use the Configuration Tool spreadsheet to add configuration data for all resources at 
once. You must download the formatted Contact Center Manager Configuration Tool spreadsheet 
from the Configuration window.

Important:
You cannot delete data in the Configuration Tool. If you need to delete data, use the 
Configuration component in Contact Center Manager Administration.
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Procedure
1. From the Configuration component of Contact Center Manager Administration, click 

Download > Configuration Tool.
2. Click Run.

3. In the WinZip Self-Extractor window, do one of the following:

• Click Unzip to extract the spreadsheet and its associated files to the default directory.

• To navigate to another directory of your choice, click Browse.

Important:

The validation template file and the Online Help file must be in 
the same folder as the spreadsheet. The naming convention for these 
files is Consolidated_ConfigurationTool.chm for Help files and 
Consolidated_Validation.xml for validation files.

4. Click OK.

Entering data in the Configuration Tool spreadsheet
About this task
You can enter Contact Center configuration data in the Configuration Tool spreadsheet and 
then transfer the data to Contact Center Manager Server. The spreadsheet includes a separate 
worksheet for each configuration item.

Important:
You must use the Configuration component in Contact Center Manager Administration to 
modify or delete data that cannot be edited in the Configuration Tool spreadsheet.

Before you begin
Download the Configuration Tool spreadsheet from Contact Center Manager Administration.

Procedure
1. Open the Configuration Tool spreadsheet.

2. If prompted, click Enable Macros.

3. Click the tab for the content you want to configure.

For example, click the Users tab in the spreadsheet to configure user data.

4. Enter the configuration data.

5. (Optional) If you need help with entering data in the Configuration Tool spreadsheet:

a. Place your cursor in the column heading to display a comment.

Entering data in the Configuration Tool spreadsheet
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The comment indicates the types of values you can enter and whether the data is 
mandatory or optional.

b. If you need more detailed information, click the Add-ins tab in the spreadsheet and 
then click Configuration Tool Help.

6. Save your entries.

Validating data in the Configuration Tool spreadsheet
About this task
To reduce upload time, the Configuration Tool spreadsheet includes a Validation feature. Use this 
feature to identify and correct any invalid entries you made in the spreadsheet before uploading 
data.

Before you begin
Enter data in the Configuration Tool spreadsheet.

Procedure
1. Open the Configuration Tool spreadsheet with the data you want to validate and enable 

macros if prompted.

2. Verify that the validation template file is in the same folder as the spreadsheet.

If this file is not in the same folder, navigate to it and place a copy of it in the spreadsheet 
folder.

3. In the Configuration Tool spreadsheet, click the Add-ins tab.

4. Click Data Validation.

5. In the Data Validation - Configuration Tool window, select the data to validate.

You can validate all the data you entered or a portion of it.

6. Click OK.

The validation tool highlights incorrectly-formatted values and mandatory cells with missing 
information. An error message is displayed in any row containing an error.

Configuration Tool spreadsheet
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Correcting invalid entries in the Configuration Tool 
spreadsheet

About this task
Invalid data entries in the Configuration Tool spreadsheet are identified during the data validation 
or upload process. You see an error message in the Status Message column in the row containing 
the invalid data. After you locate and correct the errors, validate the data again.

Before you begin
Validate the data entries in the Configuration Tool spreadsheet.

Procedure
1. In the Configuration Tool spreadsheet, click the tab containing the invalid configuration 

data.

2. In the Status Message column, locate the error message and the cells that contain errors.

Cells containing errors are highlighted in yellow.

3. Enter the correct data.

4. Save the spreadsheet.

Uploading data from the Configuration Tool spreadsheet
About this task
After you enter and validate the Contact Center configuration data in the Configuration Tool 
spreadsheet, you can use the Upload feature in the spreadsheet to transfer data to Contact 
Center Manager Server.

Procedure
1. Open the Configuration Tool spreadsheet you want to upload and enable macros if 

prompted.

2. Verify that the validation template file is located in the same folder as the spreadsheet.

If this file is not in the same folder, navigate to it and place a copy of it in the spreadsheet 
folder.

3. Click the Add-ins tab in the spreadsheet.

4. Click Data Upload.

5. Under CCMA Server Login, in the Server Name field, type the name or IP address of the 
Contact Center server.

6. Enter the Administrator user ID and password for Contact Center Manager Administration.

7. If security is enabled on the Contact Center server, click Use SSL.

Correcting invalid entries in the Configuration Tool spreadsheet
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8. Click Login.

The Data Upload - Configuration Tool window is displayed,

9. From the Available Servers list, select the Contact Center server to which data will be 
uploaded.

10. Select the type of configuration data to upload.

11. Click OK.

The system displays the Upload Status - Configuration Tool dialog box.

As your data uploads, the upload status is displayed. The current status information lists 
the records that are read. After the upload process is complete, the summary status lists 
the data that was successfully uploaded, as well as any errors that occurred. If there are 
any errors, they are also displayed in the Status Message column of the spreadsheet.

Recording the upload results
About this task
Upload results are displayed as configuration data is uploaded from the Configuration Tool. To 
record the upload results for future reference, you can copy them to a text file and save the file on 
your computer.

Before you begin
Upload configuration data from the Configuration Tool spreadsheet to Contact Center Manager 
Server.

Procedure
1. In the Upload Status - Configuration Tool window, place your cursor in the Summary 

Status box.

2. Press Ctrl+A to select all the text

3. Press Ctrl+C to copy the selected text.

4. Open a text editor, such as Notepad, and paste the text you copied.

5. Save the file.

Downloading data to your Configuration Tool spreadsheet
About this task
You can transfer existing configuration data from the Contact Center server to the Configuration 
Tool spreadsheet.

Configuration Tool spreadsheet
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About this task
Ensure that you know which Contact Center server has the data you want to download to the 
Configuration Tool spreadsheet.

Procedure
1. Open the Configuration Tool spreadsheet and enable macros if prompted.

2. Click the Add-ins tab in the spreadsheet.

3. Click Data Download.

4. If prompted, log in to Contact Center Manager Administration from the Configuration Tool 
spreadsheet:

a. In the Server Name field, type the name or IP address of the Contact Center server.

b. Enter the Administrator user ID and password for Contact Center Manager 
Administration.

c. If security is enabled on the Contact Center server, click Use SSL.

d. Click Login.

5. In the Data Download - Configuration Tool window, from the Available Servers list, select 
the Contact Center server from which to download data.

6. Select the type of data to download.

If a user ID and password were not provided when the server was added to the system, 
you are prompted to enter this information in a login window

7. Click OK.

8. In the Save As window, type a name for the spreadsheet.

Important:

If you do not enter a different name for the spreadsheet, you overwrite the existing 
spreadsheet. If you do not want to change the spreadsheet name but want to maintain 
an archive of spreadsheets, save the spreadsheet in a different directory.

9. Navigate to the directory where the validation template file and the Online Help file are 
located.

If you saved the new spreadsheet in a different folder, you must place a copy of the 
validation template file and the Online Help file in the same folder.

10. Click Save.

The system saves the current spreadsheet and opens the new one. The Download Status 
- Configuration Tool window is displayed. As your data is downloaded, the current status 
information lists the records that are being read. After the download process is complete, 
the summary status lists the data that was successfully downloaded, as well as any errors 
that occurred.

Downloading data to your Configuration Tool spreadsheet
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Use cases: Adding and updating agents in the 
Configuration Tool

The following procedures briefly outline how to add or update agents and supervisor/agents with 
the Workgroup and Domain configuration options. You can configure agent data on the Users tab 
in the Configuration Tool spreadsheet. The data you enter in the Configuration Tool spreadsheet 
varies depending on whether your Contact Center uses the Workgroup or Domain configuration 
option. If your Contact Center is deployed in a Business Continuity environment, you must use the 
Domain configuration option. The Workgroup configuration option is ideal for a smaller network.

Before updating agent data, you must first download the existing data from the Contact Center 
server to the Configuration Tool spreadsheet. After you finish entering and validating the relevant 
data in the Configuration Tool spreadsheet, upload the data to Contact Center Manager Server.

Related links
Adding an agent on page 195
Adding a Supervisor/Agent on page 199
Entering data in the Configuration Tool spreadsheet on page 223
Uploading data from the Configuration Tool spreadsheet on page 225

Adding new agents with the Workgroup configuration option
About this task
You can use the Configuration Tool spreadsheet to add new agents or supervisor/agents with 
the Workgroup configuration option. With this configuration option, do not configure a domain or 
domain username.

Tip:
If you need help with entering data in the Configuration Tool spreadsheet, hover over each 
column to view a comment with additional information, such as the types of values you can 
configure.

Procedure
1. Navigate to the Users tab in the Configuration Tool spreadsheet.

2. Leave the Domain and Domain Username columns empty.

3. In the Windows Password column, enter a password that will be associated with the 
Windows workgroup account for each agent.

4. Use the other columns to enter additional data for each agent.

For example, you can configure the agent's first and last name, user type, title, department, 
and so on. You can also add an optional comment.

5. From the Add-ins tab in the spreadsheet, click Data Upload to upload the data to Contact 
Center Manager Server.
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Result
Ensure that the upload is successful. The next time you download data to the Configuration Tool 
spreadsheet, the record shows that the Domain column is set to the Contact Center Manager 
Administration server hostname and the Domain Username column is set to the login ID value. 
The login ID value is automatically used to create the workgroup username.

Updating existing agents with the Workgroup configuration 
option

About this task
You can update existing agent and supervisor/agent data for the Workgroup option in the 
Configuration Tool spreadsheet. Download the existing workgroup agent data from the Contact 
Center server to the Configuration Tool spreadsheet. After the agent data is successfully 
downloaded, the Domain column in the spreadsheet shows the CCMA server hostname.

Before you begin
From the Add-ins tab in the Configuration Tool spreadsheet, click Download Data to download 
existing data from the Contact Center server.

Procedure
1. Navigate to the Users tab in the Configuration Tool spreadsheet.

2. Ensure that the Domain and Domain Username columns remain empty.

3. Update other values as required.

Some values cannot be updated in the Configuration Tool spreadsheet. Use CCMA to 
modify data that cannot be updated in the Configuration Tool spreadsheet.

4. From the Add-ins tab in the spreadsheet, click Data Upload to upload the revised data to 
Contact Center Manager Server.

Related links
Downloading data to your Configuration Tool spreadsheet on page 226
Adding new agents with the Workgroup configuration option on page 228

Adding agents with the Domain configuration option
About this task
You can use the Configuration Tool spreadsheet to add new agents or supervisor/agents with 
the Domain configuration option. This configuration option involves associating each agent with a 
domain account. The domain user account details must be correct to enable authentication with 
the Communication Control Toolkit (CCT) server so agents can access applications such as Agent 
Desktop and Avaya Workspaces.

Tip:
If you need help with entering data in the Configuration Tool spreadsheet, hover over each 
column to view a comment with additional information, such as the types of values you can 
configure.

Use cases: Adding and updating agents in the Configuration Tool
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Procedure
1. Navigate to the Users tab in the Configuration Tool spreadsheet.

2. Leave the Windows Password column empty.

3. In the Domain column, enter the domain name.

Do not enter the FQDN. For example, if the domain is capital.org, enter capital only.

4. In the Domain Username column, enter a valid domain account name for the agent.

The domain user account details must be correct. Otherwise, the agent cannot log in to 
CCT applications.

5. Use the other columns to enter additional data for each agent.

For example, you can configure the agent's first and last name, user type, title, department, 
and so on. You can also add an optional comment.

6. From the Add-ins tab in the spreadsheet, click Data Upload to upload the data to Contact 
Center Manager Server.

Result
Ensure that the upload is successful. The record shows the domain and domain username. Unlike 
the workgroup configuration option, the CCMA server hostname is not displayed.

Updating existing agents with the Domain configuration option
About this task
You can update existing agent and supervisor/agent data for the Domain option in the 
Configuration Tool spreadsheet. Download the existing domain agent data from the Contact 
Center server to the Configuration Tool spreadsheet. If you change the existing domain 
information while updating the spreadsheet, ensure that you use valid domain account details 
so the agent can authenticate with the CCT server to access applications such as Agent Desktop 
and Avaya Workspaces.

Before you begin
From the Add-ins tab in the Configuration Tool spreadsheet, click Download Data to download 
existing data from the Contact Center server.

Procedure
1. Navigate to the Users tab in the Configuration Tool spreadsheet.

2. Leave the Windows Password column empty.

3. (Optional) Update the domain and domain username information for the agent.

a. In the Domain column, update the domain name.

Enter the domain only, not the FQDN.

b. In the Domain Username column, update the domain account name for the agent.

The domain account details must be valid for the domain specified.

Configuration Tool spreadsheet
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4. Update other values as required.

Some values cannot be updated in the Configuration Tool spreadsheet. Use CCMA to 
modify data that cannot be updated in the Configuration Tool spreadsheet.

5. From the Add-ins tab in the spreadsheet, click Data Upload to upload the revised data to 
Contact Center Manager Server.

Related links
Downloading data to your Configuration Tool spreadsheet on page 226
Adding agents with the Domain configuration option on page 229

Use cases: Adding and updating agents in the Configuration Tool
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Chapter 39: Prompt Management 

CCMA Prompt Management allows the administrator to add and update prompts on the Avaya 
Aura® Media Server (Avaya Aura® MS).

In the Prompt Management component, the system displays the CC server and the associated 
Avaya Aura® MS server. When you select the CC server, CCMA retrieves content groups contained 
within the contact center namespace on the associated Avaya Aura® MS server. You cannot use 
CCMA to add a new namespace to the media server. The content groups contain the media 
prompts. CCMA supports single-level content groups at the namespace level. You cannot create 
nested content groups in CCMA.

By default, Avaya Contact Center Select creates a content group that matches the Avaya Aura® MS 
locale name. The default content group includes a number of sample prompts and music. You can 
use these sample prompts in your Orchestration Designer flow applications to treat Contact Center 
calls. Contact Center also provides sample Orchestration Designer flow applications that use the 
sample prompts and music provided.

Contact Center provides a number of sample prompts and sample music that you can use in your 
Orchestration Designer flow applications to treat Contact Center calls. Contact Center also provides 
sample Orchestration Designer flow applications that use the sample prompts and music provided. 
All of the sample prompts have an associating variable that exists in Orchestration Designer. 
This allows the administrator to modify the prompts within the flow applications without opening 
Orchestration Designer.

If you want to change a sample prompt to suit the requirements of your Contact Center, you can 
overwrite the existing sample prompt while continuing to use the default sample Orchestration 
Designer flow applications.

Prompts and Music media files
Prompt Management supports media files for prompts and music. The media files for prompts are 
stored in a Prompts Content Group in the ACCS SIP domain namespace. The media files for music 
are stored in a Music Content Group in the streamsource namespace.

Note:
When you upload files to the streamsource namespace, it can take up to 15 minutes before 
they become available for use on Avaya Aura® Media Server. If you restart Avaya Aura® Media 
Server, the files become available immediately.

Media file formats
Avaya Aura® Media Server provides optimum playback performance with .WAV files encoded as 
Linear 16-bit PCM, 8KHz Mono with a sampling rate of 128kbits/sec. Create your media files with 
this encoding.
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Prompt Management in a geographic redundancy environment
If a failover occurs to the Remote Geographic Node (RGN) site, you must update the Master 
Content Store setting to point to your local Master Content Store node at the RGN site. When you 
update this setting, you can use Contact Center Manager Administration for prompt management at 
the RGN site.
After a failover, the user-defined partitions applied to prompts do not apply on the RGN server. 
Users with access to Prompt Management can access all prompts on an RGN server. If necessary, 
an administrator must reconfigure user-defined prompt partitions on the RGN server. If an 
administrator makes prompt changes to new or existing user-defined partitions on the RGN server, 
these prompt changes are not replicated on the servers at the campus site and do not apply when 
campus Business Continuity is reinstated.

Adding a new Prompts Content Group
Before you begin

• Log on to CCMA.
• Open the Prompt Management component.

About this task
You can create content groups to store media prompts. By default, a content group exists that 
matches the Avaya Aura® MS locale name. You can use this content group to add new prompts or 
overwrite existing prompts.

Procedure
1. From the left-hand pane, right-click the CC server and select Add new prompts content 

group.

2. In the Content Group box, type the name of the content group. You must use US ASCII 
characters only.

3. Click Add Content Group.

4. Click Save.

The system creates the new prompts content group in the ACCS SIP domain Namespace.

Adding or updating a Media Prompt
Before you begin

• Upload the prompt .WAV file, encoded as Linear 16-bit PCM, 8KHz Mono with a sampling 
rate of 128kbits/sec, to a location accessible from the Contact Center server.

• Log on to CCMA.

Adding a new Prompts Content Group
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• Open the Prompt Management component.

About this task
Add new media prompts, or overwrite existing media prompts with your own recordings. To update 
and overwrite an existing media prompt, the Media Name of the new file must match the Media 
Name of the file you are overwriting.

Procedure
1. From the left-hand pane, click the CC server.

The system displays the content groups available.

2. Click the prompts content group in which you want to add media prompts.

The system displays a new page that lists all the prompts stored under that content group.

3. To add or update a media prompt, click Add Media.

4. Under Add Media, click Select to navigate to the location of the new media file.

5. To provide a new name for the media prompt file, type the new name in the Media Name 
field.

Important:

If you want to update and overwrite an existing media prompt, this name must match 
the Media Name of the file you are overwriting.

6. To assign the prompt to any or all user-defined partitions, under User Defined Partitions, 
select the user-defined partitions to assign the media prompt to.

7. Click Save.

The system uploads prompt to the media server and adds the new prompt to the grid.

Variable definitions
Name Description
Add Media Click Add Media to upload a new media prompt to 

the media server, or to overwrite an existing prompt.
Save Click Save to save your current actions.
Download Media Click Download Media to download the selected 

media prompt.
Delete Media Click Delete Media to delete the selected media 

prompt.
Delete Content Group Click Delete Content Group to delete the selected 

content group.
Rename Content Group Click Rename Content Group to rename the 

selected content group.
Cancel Click Cancel to cancel your current actions.

Prompt Management 
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Adding a new Music Content Group
Before you begin

• Log on to CCMA.
• Open the Prompt Management component.

About this task
Add a music content group to store music media files.

Procedure
1. From the left-hand pane, right-click the CC server and select Add new music content 

group.

2. In the Content Group box, type the name of the music content group. You must use US 
ASCII characters only.

3. Click Add Content Group.

4. Click Save.

The system creates the new music content group in the streamsource Namespace.

Adding a music media file
Before you begin

• Upload the music .WAV file, encoded as Linear 16-bit PCM, 8KHz Mono with a sampling rate 
of 128kbits/sec, to a location accessible from the Contact Center server.

• Log on to CCMA.
• Open the Prompt Management component.

About this task
Add new music media files, or overwrite existing media files with your own files. To update and 
overwrite an existing media file, the Media Name of the new file must match the Media Name of 
the file you are overwriting.

Procedure
1. From the left-hand pane, click the CC server.

The system displays the content groups available.

2. Click the music content group in which you want to add media prompts.

The system displays a new page that lists all the music stored under that content group.

3. To add or update a music media file, click Add Media.

4. Under Add Media, click Select to navigate to the location of the new media file.

Adding a new Music Content Group
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5. To provide a new name for the media file, type the new name in the Media Name field.

Important:

If you want to update and overwrite an existing media file, this name must match the 
Media Name of the file you are overwriting.

6. Click Save.

The system uploads music to the media server and adds the new music file to the grid.

Configuring Whisper Skillset announcement files
Before you begin

• Generate or obtain a Whisper Skillset announcement .WAV file, encoded as Linear 16-bit 
PCM, 8KHz Mono with a sampling rate of 128kbits/sec. The .WAV file must be a minimum of 
one second long.

Important:
- The Whisper Skillset .WAV file must be named WSP_<SkillsetName> where 

<SkillsetName> is the name of the skillset for which you are provisioning the Whisper 
Skillset announcement file.

- If you want to provision a zip tone for a specific skillset, the zip tone .WAV file must 
be named WSP_<SkillsetName> where <SkillsetName> is the name of the skillset for 
which you are provisioning the custom zip tone.

- If you want to provision a zip tone for a specific call presentation class, the 
zip tone .WAV file must be named WSP_<CallPresentationClassName> where 
<CallPresentationClassName> is the name of the call presentation class for which 
you are provisioning the custom zip tone.

The file names are case sensitive.
• Ensure that you are assigned an access class of Read Update Create/Delete. For more 

information, see Access classes on page 324.
• Ensure that you have associated the media server with the CCMS server.
• Log on to CCMA.
• From the Launchpad, select the Prompt Management component.

About this task
Contact Center supports an optional configuration to provide Whisper Skillset or Call Force 
Answer (CFA) Zip Tone to agents.
The Whisper Skillset feature allows a brief skillset-specific announcement to be played to agents 
before they are connected to a customer call. Provision a Whisper Skillset announcement file to 
support the playing of this skillset-specific announcement.

Prompt Management 
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CFA Zip Tone provides a zip tone to agents who answer a voice call. The zip tone that the 
agents hear is a default tone. You can provision additional zip tones for individual skillsets or call 
presentation classes. This file name is case sensitive.

Procedure
1. From the left-hand pane, click the CCMS server in which you want to add the media 

prompt.

The system displays the content groups associated with that namespace.

2. Click the content group in which you want to add media prompts.

The system displays a new page that lists all the prompts stored under that content group.

3. In the left pane, right-click tones and select Add Media.

CCMA displays an Add Media section.

4. In the Add Media section, click Select and navigate to the Whisper Skillset announcement 
or zip tone WAV file.

5. In the Media Name box, type the wav file name.

6. To assign the announcement to any or all user-defined partitions, select the user-defined 
partitions from the User Defined Partitions section.

7. Click Save.

The system uploads the announcement to the media server and adds the new 
announcement to the grid.

Configuring Whisper Skillset announcement files
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Chapter 40: Real-time reporting

The Contact Center Manager Administration (CCMA) Real-Time Reporting displays provide up-to-
date statistics for your contact center and resources. With access to statistics that update in real-
time, such as the number of contacts waiting to be answered, the number of agents assigned to 
each skillset, and the number of abandoned calls, you can view changes in contact activity as they 
occur.

Contact Center can present real-time data in the most appropriate format - graphical, tabular, or a 
combination of both. This allows supervisors to react immediately to changing circumstances, adjust 
skillsets and staffing levels, or reroute calls to other resources. Real-Time Reporting displays make 
it easy to monitor peak periods and adjust staffing levels as appropriate to maintain the highest 
levels of customer service.

Launching the Contact Center Status real-time display
About this task
Access Avaya Contact Center Select Real-Time Reporting and launch the Contact Center Status 
real-time display. Use the displays to monitor the performance of the contact center in near 
real-time.
Avaya Contact Center Select offers a number of sample public real-time displays. Create a private 
copy of these displays and experiment with them to create displays that meet the day-to-day 
requirements of your solution.
For example, the CC Status public graphical display has the following panels:

Panel Type Description
CC_Standard_Agent_Display (CC) Tabular This tabular panel displays the agent 

status and time in current state. Use this 
panel to monitor individual agent activity.

CC_Contacts_Wait Chart This pie chart displays the number of 
contact waiting for each skillset.

CC_Standard_Application_Display Tabular This tabular panel displays the maximum 
wait times, and the number of contacts 
offered, waiting, answered, or abandoned.

CC_Sample_Skills Chart This panel displays the service level for 
each skillset.
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This combined display provides a real-time status report about important Avaya Contact Center 
Select performance parameters.

Procedure
1. Log on to Contact Center Manager Administration.

2. On the Contact Center Manager Administration Launchpad, click Real-Time Reporting.

3. In the left pane, select the Public Graphical Displays folder.

4. In the left pane, from the list of displays, select CC_Status.

5. On the Public Collection properties tab, select the default display options for CC Status. 
These standard displays combine to form an effective Real-Time Reporting graphical 
display.

6. Click Launch.

The Contact Center Status real-time display appears.

7. Use the display to monitor contact center performance in near real-time.

8. Experiment with Real-Time Reporting to find, copy, or create a set of displays that meets 
your solution requirements.

Example of the Contact Center Status real-time display

Launching the Contact Center Status real-time display
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Creating a private real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
Create a private real-time display to customize real-time displays.

Procedure
1. In the left pane, select the Public Tabular Displays folder under the CC server.

2. From the expanded Public Tabular Displays folder, select the display to copy.

3. In the Public Display window, type the name of your new private display. You can use only 
alphanumeric characters in the display name; do not use special characters.

When you copy a display, the system gives the new display a default name in the format 
[server name]_[display name]. Since each private display must have a unique 
name, you must type a new name, if you save a public display with the same default name. 
If you do not type a new name, the system overwrites the existing display.

4. To save the display in the Private Tabular Displays folder, click Make Private Copy.

5. On the Properties page, you can change the colors, font size, and the refresh rate.

Making a public copy of a private real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
After you customize a real-time display and save it in your Private Tabular Displays folder, you 
can share the display with other users by making a public copy. You can copy the display to 
the Public Tabular Displays folder on the currently selected server or across all servers on the 
network to which you have access.

Important:
Contact Center saves filters only for private real-time display. Contact Center removes all 
filters from public copies of your private real-time displays. Supervisors and agents using 
public copies can apply filters after they launch the displays.

Procedure
1. In the left pane, select the Private Tabular Displays folder under the CC server.

2. From the expanded Private Tabular Displays folder, select the display to copy.

Real-time reporting
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3. At the bottom of the Properties page, type the name of the display as you want it to appear 
in the Public Tabular Displays folder.

Note:

You can use only alphanumeric characters in the display name; do not use special 
characters. You cannot type the same name used by one of the Standard Public 
displays as you cannot overwrite these displays. If you type the same name as an 
existing copied display, then you overwrite the existing display.

4. Select This Server Only.

5. Click Make Public Copy to save the private display in the Public Tabular Displays folder.

6. In the Public Display window, you can view the public display or make a new private copy 
of it.

Applying custom formulas to real-time displays
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
After you create custom formulas in the Formula Editor, apply them to your private real-time 
displays in the Real-Time Reporting component.
You can customize only the columns in private displays. If you choose a public display, you must 
first copy and save it in your Private Displays folder before you can customize the columns.
For more information about custom formulas, see Formulas on page 185.

Procedure
1. Select the Private Tabular Displays folder under the CC server.

2. Click the display to customize.

3. Click the Columns tab.

4. From the Available Fields list, select the formula to add to the real-time display.

5. Click Add Field.

6. Click Submit to save your changes.

7. Click Launch Display to view your changes.

Applying custom formulas to real-time displays
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Printing a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
If you require a hard copy, you can print a real-time display.

Procedure
1. In the left pane, navigate to the real-time display that you want to print.

2. Click Launch Display.

3. On the real-time display window, click Print.
4. In the Print dialog box, from the Printer Name list, select the desired printer.

5. Click Print.

Deleting a private display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• At least one private display must exist.

About this task
Delete private tabular displays and private graphical displays.

Note:
Once you delete a display, you cannot recover it.

Procedure
1. In the left pane, select the CC server.

2. Click the Private Tabular Displays folder to delete a private tabular display.

OR

Click the Private Graphical Displays folder to delete a private graphical display.

3. In the selected folder, click the private display to delete.

4. In the right pane, click Remove Private Display to delete a private tabular display.

OR

Click Remove Display to delete a private graphical display.

5. In the Confirmation dialog box, click OK.

Real-time reporting
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The system permanently deletes the display.

Logging out an agent from a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Customize a private real-time display to include the Logout column, or select a previously 

customized display.

About this task
Use this procedure to log out an agent from a real-time display.

Procedure
1. In the left pane, select an Agent Display that has the Logout column and shows the agent 

you want to log out.

2. In the right pane, click Launch Display.

CCMA opens the real-time display window.

3. Scroll to the agent that you want to log out.

4. Click the Force Log out button ( ).

5. On the Logout Confirmation dialog, click Yes.

Contact Center logs out the agent, and displays a message on the agent’s Agent Desktop 
interface informing them that a supervisor has logged them out.

Changing an agent’s Ready status from a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Customize a private real-time display to include the Change State column, or select a 

previously customized display. For more information, see Real-time report customization on 
page 83.

About this task
Use this procedure to change an agent’s status from a real-time display.

Procedure
1. In the left pane, select an Agent Display that has the Change State column and shows the 

agent whose status you want to change.

Logging out an agent from a real-time display
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2. In the right pane, click Launch Display.

CCMA opens the real-time display window.

3. Scroll to the agent for whom you want to change the ready status.

4. Click the Change State button ( / ).

CCMA displays the Change Agent State Confirmation dialog.

5. If you changed the agent’s status from Ready to Not Ready, on the Change Agent State 
Confirmation dialog, enter a Not Ready Reason code, and click Yes.

Contact Center displays a message on the agent’s Agent Desktop interface informing them 
of the state change.

6. If you changed the agent’s status from Not Ready to Ready, on the Change Agent State 
Confirmation dialog click Yes.

Contact Center displays a message on the agent’s Agent Desktop interface informing them 
of the state change.

Viewing the non-staffed skillsets
About this task
Use the Non-Staffed Skillsets window to view a list of all the skillsets within your partition, without 
logged-on agents. The list of non-staffed skillsets automatically refreshes every 20 seconds with 
the most recent information.

Procedure
1. Log on to the Real-Time Reporting component.

2. In the left pane, click the relevant server and then click the folder that contains the skillset 
display.

3. Click the skillset display that you want to launch.

4. In the right pane click Launch Display

The display launches.

5. In the display, click Non-Staffed Skillsets.

The Non-Staffed Skillsets window appears, listing all of the skillsets within your partition, 
without logged-on agents.

Real-time reporting
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Chapter 41: Filter management

In Avaya Contact Center Select, you can create skillset, application, and agent filters for real-time 
reporting. You can configure filters with a combination of the three data types.

Use filters to specify the skillset, application, and agent data that you want to see in the realtime 
displays. In the Filters window, configure the filters from all elements in the partition assigned to you. 
After configuring filters, you can assign the filters to your private real-time displays.

The real-time displays show subtotals of data for each filter, which are further divided into subtotals 
for each site that belongs to the filter.

Note:

Some statistical fields cannot be accumulated.

Creating a filter in Real-time reporting
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Ensure that you have access to filters.

About this task
Create filters to specify the skillsets, applications, and agents that you want to see in the real-time 
display grids, and the agents that you want to see in the agent map graphical displays.

Procedure
1. From the Filters menu, select Manage Filters.

2. Right-click on the Filters folder and select Add Filter.
3. In the New Filter Name box, type the name of the filter. You can use only alphanumeric 

characters. Do not use special characters.

4. Click Submit to save the filter.
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Adding skillset elements to a filter
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

About this task
Add skillset elements to a filter to view the required statistics.

Procedure
1. From the Filters menu, select Manage Filters.

2. In the left pane, select the filter to edit.

3. Select the server on which to add the elements.

4. Select the Skillsets tab.

5. Click the Assign Skillsets heading.

6. From the list, select contains, is equal to, or starts with.

7. In the box, type the skillset name.

8. Click Search.

9. In the list of available skillsets, select the check box for each skillset to add to the filter.

OR

To select all available skillsets, select the Select All check box.

10. Click Submit to save your changes.

Adding application elements to a filter
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

About this task
When you select an application element to filter in billboards and charts, your new application 
element appears in the Filter Selection list under Available.

Procedure
1. From the Filters menu, select Manage Filters.

2. In the left pane, select the filter to edit.

3. Select the server on which to add the elements.

Filter management
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4. Select the Application tab.

5. In the list of available applications, select the check box for each application to add to the 
filter.

OR

To choose all available applications, select the Select All check box.

6. Click Submit to save your changes.

Adding agent elements to a filter
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

About this task
Include statistics for specific agents by adding agent elements.
When you select an application element to filter in billboards and charts, the new application 
element appears in the Filter Selection list under Available.

Procedure
1. From the Filters menu, select Manage Filters.

2. In the left pane, select the filter to edit.

3. Select the server on which to add the elements.

4. Select the Agents tab.

5. Click the Assign Agents heading.

6. From the first list, select Last Name, First Name, Department, Comment, or Login ID.

7. From the second list, select contains, is equal to, or starts with.

8. In the box, type a value to search.

You can search for up to five levels by selecting And or Or from the last list.

9. Click Search.

Agents that match your criteria appear in a table.

10. In the list of available agents, select the check box for each agent to add to the filter.

OR

To choose all available agents, select the Select All check box.

11. Click Submit to save your changes.

Adding agent elements to a filter
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Removing elements from a filter
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

About this task
To modify the report display, remove elements from a filter.

Procedure
1. From the Filters menu, select Manage Filters.

2. In the left pane, select the filter from which to remove applications, skillsets, or agents.

3. On the Skillset, Application, and Agent tabs, clear the check boxes for each skillset, 
application, or agent to remove from the filter.

4. Click Submit to save your changes.

Deleting a filter
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

About this task
If you need to rename a filter, you must delete the filter and create a new one with a new name.

Procedure
1. From the Filters menu, select Manage Filters.

2. In the left pane, select the filter to delete.

3. In the right pane, click Delete Filter.
4. On the message box that appears asking you to confirm your choice, click Yes.

Applying filters to real-time tabular displays
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

Filter management
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About this task
Use the Filters page to apply filters to customize your real-time tabular displays. You can apply a 
filter, a supervisor-reporting agent combination, or both.

Procedure
1. In the left pane, under the server containing the real-time display to which to apply filters, 

select the Private Tabular Displays folder.

2. Click the private display to customize.

3. Click the Filters tab.

4. From the list of available filters, select the check box for each filter to assign to the 
real-time display.

OR

To assign all of the available filters (and supervisor-reporting agent combinations listed, if 
you customize the Standard Agent Display), click Select All.

5. Click Submit to save your changes.

6. Click Launch Display to start the display and view your changes

Applying filters to graphical displays
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

About this task
Filters on real-time displays provide a mechanism for a supervisor to group together a number 
of agents, applications, or skillsets. Real-time reporting is capable of providing summary statistics 
for filters when they are added to a display. Filters are available for selection as an alternative to 
skillsets or applications on a number of the real-time reporting billboards and charts. The following 
displays support filters:

• Application Billboards
• Skillset Billboards
• Application Chart (statistics per application)
• Skillset Chart (statistics per skillset)
• Time Line Chart (statistics per skillset)
• Time Line Chart (statistics per application)
• Agent Map

Applying filters to graphical displays
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Note:
Filters are not supported on dashboard displays.

Procedure
1. In the left pane, under the server containing the real-time graphical display to which you 

require to apply filters, select the Private Graphical Displays folder.

2. Click the private display to customize.

3. From the drop-down list of Applications or Skillsets, select the filter to assign to the 
real-time display.

The filters are grouped together at the end of the Applications list or the Skillsets list.

4. Click Submit to save your changes.

5. Click Launch to start the display and view your changes.

Applying supervisor-reporting agent combinations to real-
time displays

About this task
You can apply supervisor-reporting agent combinations to the Standard Agent display.

Before you begin
• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

Procedure
1. In the left pane, select the server containing the Standard Agent real-time display.

2. Select the Private Tabular Displays folder.

3. Click the private agent display to customize.

4. Click the Filters tab.

5. From the list of available supervisor-reporting agent combinations, do one of the following:

• Select the check box for each supervisor you want to assign to the real-time display.

• To assign all available supervisor-reporting agent combinations and filters, select the 
Select All check box.

6. Click Submit to save your changes.

7. Click Launch Display to start the display and view your changes.

Filter management
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Removing filters from a real-time display
About this task
You can remove filters you do not require to modify a real-time display.

Before you begin
• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

Procedure
1. In the left pane, select the server that contains the real-time display.

2. Select the Private Tabular Displays folder.

3. Click the display to customize.

4. Click the Filters tab.

5. From the list of assigned filters, do one of the following:

• Clear the check box for each filter you want to remove from the real-time display.

• To remove all filters, select the Clear All check box.

6. Click Submit to save your changes.

Removing filters from a real-time display
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Chapter 42: Exported displays

The procedures in this section describe how to work with exported real-time displays.

Exporting real-time displays
Before you begin
Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can export real-time displays to open the file in a new browser window. Exporting real-time 
displays creates a snapshot file in HTML format.

Important:
You must carefully manage exported displays. Exported displays consume disk space on the 
Contact Center Manager Administration server.

Procedure
1. In the left pane, double-click the real-time display to export.

2. On the real-time display, click Export.
3. To open the file in a new browser window, click View.

Viewing an exported real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You must view an exported real-time display, to print the display.

Procedure
1. From the Displays menu, select Manage Exported Displays.

2. In the right pane, from the list of HTML files, click the name of the file to view.
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A snapshot of the real-time display grid opens in a new browser window.

3. From the File menu in your browser, click Print to print the exported grid.

4. To view the colored rows of the real-time display, in the Print window, select a color printer.

5. Click Print.

Changing the file name prefix of exported real-time display 
grids

Before you begin
• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can choose the prefix to appear in the file name when you export the real-time display grids 
to the server as HTML files. An example of the prefix for the Consolidated Skillset Display is 
ConsolidatedSkillSet.
The exported file name includes your user name, the prefix that you select, the date 
and time you save the file. For example, if your user name is John, your prefix is 
ConsolidatedSkillSet, and you chose to export the Consolidated Skillset Display as an 
HTML file on April 10, 2000 at 2:45:28 p.m., the system saves it on the server as 
John_ConsolidatedSkillSet_20000410_144528.htm.

Procedure
1. In the left pane, under the CC server, click the Private Tabular Displays folder.

2. Click the display name.

3. On the Properties page, in the Grid export prefix box, type the prefix to appear in the 
HTML file name.

Note:

Do not include spaces in the prefix.

4. Click Submit to save your changes.

Changing the file name prefix of exported real-time display grids
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Chapter 43: Graphical displays

In the Graphical Display window, you can configure one of seven types of graphical displays:

• Billboard displays

• Chart displays

• Time Line displays

• Agent maps

• Collections

• Billboard collections

• Dashboard displays

Adding a graphical display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
Create a graphical display.

Procedure
1. From the Displays menu, select Add Graphical Display.

2. In the Name box, type the name of the new graphical display.

The system displays this name on the system tree.

3. From the Server list, select the CC server.

4. In the Element Type area, select the type of element corresponding to the type of graphical 
display that you want to create, from the following list:

• Agent: Create an agent map.

• Application: Create an application billboard, chart, or time line.

• IVR: Create an IVR billboard, chart, or time line.

• Skillset: Create a skillset billboard, chart, or time line.
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• All: Create a dashboard, a private or public collection, a private billboard or public 
billboard collection.

5. In the Presentation area, select the type of graphical display to create.

The type of chart you can create varies according to the selection you made in the Element 
type area.

6. Click Edit Properties to configure the graphical display.

The system displays the corresponding properties window.

7. Click Submit to save the graphical display.

Opening a graphical display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one graphical display.

About this task
View a graphical display.

Procedure
1. In the left pane, click the folder containing the graphical display to view.

2. Click the graphical display to view.

3. In the right pane, review the current settings for the graphical display.

4. If you change the settings, click Submit to save your changes.

5. Click Launch.

While you view an agent map or billboard graphical display, the display can change color. 
This change alerts you when the statistic values exceed the configured threshold values. 
For agent map displays, text flashes when a threshold value is reached, while you view the 
display in the box view (if you configure the display with this feature).

If you select Pop to front, the display appears in front of all open windows. On each 
refresh, the display continues to pop to the front of all open windows, until the data on the 
display falls below the threshold level.

Opening a graphical display
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Deleting a graphical display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
When you no longer require a graphical display, you can delete the display.

Procedure
1. In the left pane, click the Public Graphical Displays or the Private Graphical Displays 

folder.

Note:

When you delete a graphical display, you cannot restore it. Instead, you must create a 
new graphical display.

2. In the list of displays, click the graphical display to delete.

3. In the right pane, click Remove Display.

4. In the message box that appears asking you to confirm your choice, click OK.

Creating a Real-time Dashboard display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can create a Real-time Dashboard display to provide you with multiple views of up-to-date 
statistics for your contact center and its resources. A real-time dashboard display is click-once 
client application that displays performance related real-time statistics. Contact Center uses Click 
Once Deployment technology to download and install the application from the Contact Center 
server.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new dashboard.

This is the name that appears in the system tree. You can use only alphanumeric 
characters in the collection name, you cannot use special characters.

3. From the Servers list, select the CC server.

4. In the Element Type area, select All.
5. In the Presentation area, select Dashboard.
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6. Click Edit Properties to configure the new collection.

7. The Collection Properties window appears.

8. In the Dashboard title box, accept the default name, or delete the default name and 
type a custom name to appear as the title of the window when the dashboard display is 
launched.

9. The Install button is enabled if the prerequisite software required to run the dashboard is 
not found on your computer. Click the Install button download and install the relevant .Net 
Framework.

10. Click Submit to save your changes.

The new dashboard appears on the system tree under Graphical Displays.

Adding charts to the Real-time Dashboard
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a Real-time Dashboard display.

About this task
You can add charts to the Real-time Dashboard to view them.

Procedure
1. In the left pane, click the Private Graphical Displays folder.

2. Click the Real-time Dashboard display.

3. Click Launch.

4. From the Displays menu, select a display chart.

5. From the display chart menu, select the data to display on the chart.

The data appears on the chart in the Real-time Dashboard display.

Changing chart properties in the Real-time Dashboard 
display

Before you begin
• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a Real-time Dashboard display.
• Add a display chart to the Real-time Dashboard.

Adding charts to the Real-time Dashboard
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About this task
You can change the items that appear on the charts in the Real-time Dashboard to meet your 
requirements.

Procedure
1. Click the Properties tab of the chart to change.

2. Select the skillsets, applications, and statistics to display on the chart.

3. Click the Display tab to display the updated chart.

Note:

If you choose None from the Color Palette drop-down list, in the Display > Options 
menu, the chart is displayed in its default color.

Removing display charts from the Real-time Dashboard 
display

Before you begin
• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a Real-time Dashboard display.
• Add a display chart to the Real-time Dashboard.

About this task
You can remove display charts from the Real-time Dashboard display.

Procedure
1. In the left pane, click the Private Graphical Displays folder.

2. Select the Real-time Dashboard display.

3. Click Launch.

4. Click the X button beside the display to remove the display.

Saving the Real-Time Dashboard display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a Real-time Dashboard display.
• Add a display chart to the Real-time Dashboard.
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About this task
Save the Real-time Dashboard display window size and the following attributes of each Real-time 
Display chart:

• size and position of the window
• display type
• list of selected statistics
• list of selected skillsets or applications

Procedure
Close the Real-time Dashboard display window and select Yes on the Save dialog.

OR

Select Save from the File menu.

Making a public copy of a graphical display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
Make a public copy of a billboard, or chart, or time line graphical display. After you customize the 
display, you can save it in your Private Graphical Displays folder. You can share the display with 
other users by making a public copy of it.

Note:
You can make public copies of all types of graphical displays, except agent maps and Real-
time Dashboard displays.

If you want to modify a public display, you must first make a private copy.

Procedure
1. In the left pane, click the Private Graphical Displays folder.

2. In the list of displays, select the chart or billboard or time line display to copy.

3. At the bottom of the right pane, type the name of the display to appear in the Public 
Graphical Displays folder.

You can only use alphanumeric characters in the display name; do not use special 
characters. If you type the same name as an existing copied display, you overwrite this 
display.

When you copy a private display, the system gives the new display a default name in the 
format [server name]_[private display name]. Since each public display must 
have a unique name, you must type a new name, if you save a public display with the 
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same default name. If you do not type a new name, the system overwrites the existing 
display.

4. Click Make Public Copy to save the private display in the Public Graphical Displays 
folder.

Assigning threshold alerts to a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one private display. You can customize only the columns in private displays. 

If you choose a public display, you must first copy and save it in your Private displays folder 
before you can customize the columns.

About this task
You can use two threshold values, the low value (level 1) and the high value (level 2), to define 
system activity. These values result in three operational levels:

• Below level 1: Based on the type of statistic, this level can mean normal contact center 
operation and no action required (that is, the lower the number of calls waiting, the better), 
or it can signify an alert situation that requires attention (that is, the lower the service level 
percentage, the worse the situation).

• Between level 1 and level 2: This level can indicate a required action to prevent contact 
center performance to move beyond acceptable operating levels.

• Above level 2: Based on the type of statistic, this level can mean normal contact center 
operation and no action required (that is, the higher the service level percentage, the better), 
or it can signify an alert situation that requires attention (that is, the greater the number of 
calls waiting, the worse the situation).

Procedure
1. In the left pane, under the CC server, navigate to the private display.

2. In the right pane, click the Columns tab.

3. From the sample table, select the statistic for which to define the threshold colors.

4. From the threshold colors boxes, select the colors for the statistic if it is below the level 1 
threshold value, if it reaches a value between level 1 and level 2, and if it exceeds level 2.

5. Click Submit to save your changes.
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Configuring a billboard display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can configure a billboard display to select a statistic to monitor closely.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new billboard graphical display. This is the name 
that appears in the system tree. You can use alphanumeric characters only.

3. From the Server list, select the CC server.

4. In the Element Type area, select Application, IVR or Skillset.
5. In the Presentation area, select Billboard.

6. Click Edit Properties to configure the new billboard display.

7. In the Billboard title box, accept the default name provided, or delete the default name 
and type a custom name to appear at the top of the billboard display.

Do not include spaces, special characters, punctuation, or the ampersand (&) in the 
billboard title.

8. From the Data collection mode list, select either Moving window or Interval-to-date.

9. From the Application or Skillset list, select the application or skillset to monitor, or select 
Summary.

10. From the Statistic list, select the statistic to monitor in the billboard. The name of the 
statistic that you monitor appears in the title bar of the billboard display window when you 
activate it.

11. From the Font color boxes, select the color for the statistic.

The background color of the billboard display is black until a threshold value is reached, 
at which time it changes to either of the threshold colors you selected, and the font color 
changes to black.

If you do not use a mouse, press Tab until the status bar indicates that you have the 
selected color. After reaching the desired color, press the Spacebar to select the color.

12. From the Threshold settings boxes, click to select the colors for the thresholds below 
level 1, between level 1 and level 2, and above level 2, or accept the default colors shown.

You can view the current Level 1 and Level 2 threshold values configured for this statistic 
in the Value boxes beside the threshold settings boxes.

13. Select the Pop to front check box to move the activated billboard to the front on your 
desktop when a threshold level is reached.
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The billboard display appears in front of all open windows. On each refresh, the billboard 
display continues to pop to the front of all open windows, until the data on the display falls 
below the threshold level.

14. Click Submit to save your changes.

The new billboard appears in the system tree under Private Graphical Displays.

Configuring a chart display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can configure a chart display for skillsets, applications, or statistics to monitor in a customized 
chart.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new chart graphical display.

This is the name that appears in the system tree. You can use alphanumeric characters 
only.

3. From the Server list, select the CC server.

4. In the Element Type area, select Application, IVR or Skillset.
5. If you select Application, in the Presentation area, select the Chart (choose statistics 

per application) or the Chart (choose applications per statistic).
6. If you select Skillset, in the Presentation area, select the Chart (choose statistics per 

skillset) or the Chart (choose skillsets per statistic).
7. If you select IVR, in the Presentation area, select Chart (choose statistics for IVR 

summary).
8. Click Edit Properties to configure the new chart display.

9. In the Chart title box, accept the default name, or delete the default name and type a 
custom name to appear at the top of the chart display.

10. From the Chart type list, select the type of chart to configure. You can choose from 
Horizontal Bar, Vertical Bar, or Pie.

11. From the Chart fill list, select Color or Pattern (Black & White).
12. If you select Chart (choose applications per statistic), or Chart (choose skillsets per 

statistic) from the Statistics list, select a statistic.
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13. From the Application list, select an application to monitor. Choose Summary to view a 
summary of all applications in your partition.

14. For Chart (choose statistics per skillset), from the Skillset list, select a skillset to 
monitor.

15. Choose Summary to view a summary of all skillsets in your partition.

If you select Summary, the total for statistics such as Agents Staffed, Agents Active, 
Agents Not Ready, or Agents Idle is shown as 0 because one agent is typically assigned to 
more than one skillset, which results in misleading totals.

16. From the Data Collection Mode list, select the Moving window or Interval-to-date.

17. In the Export path box, type the path in which to save a copy of the chart that you export 
as a BMP or JPG file (for example, C:\My Documents). If you leave this field blank, the 
file is exported to your desktop.

18. If you select Chart (choose statistics per application), Chart (choose statistics for 
IVR summary), or Chart (choose statistics per skillset), in the Statistic area, select the 
check box for each statistic to view in the chart display.

19. If you select Chart (choose applications per statistic), in the Applications area, select 
the check box for each application to view in the chart display.

20. If you select Chart (choose skillsets per statistic), in the Skillsets area, select the check 
box for each application to view in the chart display.

21. To select all check boxes, click Select All. To clear all check boxes, click Clear All.
22. Click Submit to save your changes.

The new chart appears in the system tree under Graphical Displays and the Graphical 
Display window refreshes.

23. To create a public copy of your custom display, in the Type in the name of your public 
display box, type a name for the public display, and then click Make Public Copy.

A copy of your display appears in the Public Graphical Displays folder.

Creating a private collection
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can configure and save your favorite combination of data windows.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.
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2. In the Name box, type the name of the new collection.

This is the name that appears on the system tree. You can use only alphanumeric 
characters in the collection name; you cannot use special characters.

3. From the Server list, select the CC server.

4. In the Element Type area, select All.
5. In the Presentation area, select Private Collection.

6. Click Edit Properties to configure the new collection.

The Private Collection Properties window appears.

7. From each display list, select a display to include in this collection.

The display lists include all of the public displays and private displays saved on the server. 
You can choose a maximum of six different displays.

You must configure the graphical displays on the server before you can include them in 
your collection.

8. Click Submit to save your changes.

The new collection appears on the system tree under Private Graphical Displays.

Creating a private billboard collection
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can configure and save your favorite combination of billboards.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new collection or billboard collection.

This is the name that appears on the system tree. You can use only alphanumeric 
characters in the collection name; you cannot use special characters.

3. From the Server list, select the CC server.

4. In the Element Type area, select All.
5. In the Presentation area, select Private Billboard Collection.

6. Click Edit Properties to configure the new collection.

The Private Billboard Collection Properties window appears.
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7. In the Available box, highlight each public or private billboard to include in your billboard 
collection, and then click the right arrow (>) to move the billboard to the Selected box.

Private billboards are marked with an asterisk (*). You can choose from all public or private 
billboards on the server, up to a maximum of 25 billboards.

8. Click Submit to save the private billboard collection.

The new billboard collection appears on the system tree under your Private Graphical 
Displays folder on the currently selected server.

Creating a public collection or public billboard collection
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
When you save a public display, you share it with all users that have access to public graphical 
displays on the selected server.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new collection or billboard collection.

This is the name that appears on the system tree. You can use only alphanumeric 
characters in the collection name; you cannot use special characters.

3. From the Servers list, select the CC server.

4. In the Element Type area, select All.
5. In the Presentation area, select either Public Collection or Public Billboard Collection.

6. Click Edit Properties.

The Public Collection Properties or Public Billboard Collection Properties window appears.

7. If you create a public billboard collection, proceed to step 10 on page 265.

8. From each display list, select a display to include in this collection.

The lists include all the public grid and graphic displays that you save on the server. You 
can choose maximum six different displays.

9. Click Submit to save the public collection.

10. In the Available box, highlight each public billboard to include in your billboard collection, 
and then click the right arrow (>) to move the billboard to the Selected box.

You can choose from all public billboards on the server, up to a maximum of 25 billboards.
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11. Click Submit to save the public billboard collection.

The new collection or billboard collection appears on the system tree under the Public 
Graphical Displays folder.

Configuring a Time Line display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can configure a time line display for skillsets, applications, or IVR statistics to monitor in a 
customized chart.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new time line graphical display.

This is the name that appears in the system tree. You can use alphanumeric characters 
only.

3. From the Servers list, select the CC server.

4. In the Element Type area, select Application, IVR, or Skillset.
5. If you select Application, in the Presentation area, select Time Line (choose statistics 

per application) or Time Line (choose applications per statistic).
6. If you select Skillset, in the Presentation area, select Time Line (choose statistics per 

skillset) or Time Line (choose skillsets per statistic).
7. If you select IVR, in the Presentation area, select Time Line (choose statistics for IVR 

summary).
8. Click the Edit Properties button.

9. In the Chart title box, accept the default name, or delete the default name and type a 
custom name to appear at the top of the time line display.

10. From the Chart fill list, select Color or Pattern (Black & White).
11. If you select Time Line (choose applications per statistic), or Time Line (choose 

skillsets per statistic) from the Statistics list, select a statistic.

12. From the Application list, select an application to monitor.

13. Choose Summary to view a summary of all applications on the server.

14. For Time Line (choose statistics per skillset), from the Skillset list, select a skillset to 
monitor.
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15. Choose Summary to view a summary of all skillsets on the server.

If you select Summary, the total for statistics such as Agents Staffed, Agents Active, 
Agents Not Ready, or Agents Idle is shown as 0 because one agent is typically assigned to 
more than one skillset, which results in misleading totals.

16. From the Data Collection Mode list, select the Moving window or Interval-to-date.

17. From the Refresh Rate (seconds) list, select from the available refresh rates of 1, 5, 10 or 
30 seconds.

18. From the Display History (minutes) list, select from the available history values of 1, 5, 
10 or 30 minutes.

19. In the Export path box, type the path in which to save a copy of the chart that you export 
as a BMP or JPG file (for example, C:\My Documents). If you leave this field blank, the 
file is exported to your desktop.

20. If you select Time Line (choose statistics per application), Time Line (choose 
statistics for IVR summary), or Time Line (choose statistics per skillset), in the 
Statistic area, select the check box for each statistic to view in the chart display.

21. If you select Time Line (choose applications per statistic), in the Applications area, 
select the check box for each application to view in the time line display.

22. If you select Time Line (choose skillsets per statistic), in the Skillsets area, select the 
check box for each application to view in the time line display.

23. To select all check boxes, click Select All. To clear all check boxes, click Clear All.
24. Click Submit to save your changes.

The new chart appears in the system tree under Graphical Displays and the Graphical 
Display window refreshes.

25. To create a public copy of your custom display, in the Type in the name of your public 
display box, type a name for the public display, and then click Make Public Copy.

A copy of your display appears in the Public Graphical Displays folder.
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Chapter 44: Real-time report customization

The procedures in this section describe how to customize your real-time reports. You can customize 
real-time report displays and real-time report summary charts.

Adding a new column to a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
When you customize your private real-time display grids, you can add new columns by choosing 
from a list of available statistics.

Procedure
1. In the left pane, click the Private Tabular Displays folder.

The folder expands to show a list of private displays.

2. Click the display to customize.

3. Click the Columns tab.

4. From the Available Fields list, select the statistic to add to the real-time display.

5. Click Add Field.

The column appears in the sample display table.

6. Click Submit to save your changes.

Customizing display properties
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a private real-time display.
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About this task
You can customize private display properties to meet your requirements.

Procedure
1. In the left pane, click the Private displays folder.

2. Click the real-time display to customize.

3. On the Properties page, select your customized settings.

4. Click Submit to save your changes.

Changing the refresh rate of a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a private real-time display.

About this task
A slight delay occurs between the events in the contact center and the statistics that you see 
in the displays. The length of the delay depends on the refresh rate settings in the Real-time 
Statistics Multicast (RSM) component and on the application server.
The refresh rate that you specify applies to both the private real-time displays and summary 
charts.

Procedure
1. In the left pane, click the Private Tabular Displays folder.

2. Click the display name.

3. In the right pane, click the Properties tab.

4. In the Refresh rate box, type the rate at which to refresh data in the real-time display.

You can specify a minimum value of 0.5 seconds or a number from 1 to 99 (seconds).

5. Click Submit to save your changes.

Changing the font size in a real-time display grid
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a private real-time display.

Changing the refresh rate of a real-time display
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About this task
You can select the font size for the column headings and the column data in your private real-time 
displays.

Procedure
1. In the left pane, click the Private Tabular Displays folder.

2. Click the display name.

3. In the right pane, click the Properties tab.

4. In the Column font size boxes, type the size for the column headings and the column 
data. You can choose a font size from 8 to 14.

If you make no selection, the system applies the default font size of 8.

5. Click Submit to save your changes.

Changing the color settings of a real-time display grid
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can configure the color settings for the data, filter and site subtotals, and the summary rows of 
the real-time display grids. If you choose no custom color, the system applies the default colors to 
each area.

Procedure
1. In the left pane, navigate to the real-time display.

2. In the right pane, on the Properties tab, in the Color settings area, choose the color 
settings to appear in the real-time display grids.

3. Click Submit to save your changes.

Changing column names
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can change the column names of private displays. You can customize the columns of only 
private displays. If you choose a public display, you must first copy it and save it in your Private 
Displays folder before you can customize the columns.
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Procedure
1. In the left pane, navigate to the real-time display to customize.

2. In the right pane, click the Columns tab.

3. To add columns to the display, from the Available Fields list, select a column, and then 
click Add Field.

4. In the Column Name box, type the new name to appear in the real-time display grid, and 
then press Tab.

The new column name appears in the sample table.

You can change as many names as you want.

5. After you change the names, click Submit to save your changes.

6. Click Launch Display to view the real-time display to see your changes.

Changing the column width in a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can customize the columns of only private displays. If you choose a public display, you must 
first copy it and save it in your private folder before you can customize the columns.

Procedure
1. In the left pane, under the server that contains the real-time display to customize, navigate 

to the display.

2. In the right pane, click the Columns tab.

3. Click the name of the column to resize.

4. In the Column width box, type the width of the column in characters.

Note:

You cannot make the column narrower than the column text. To shrink the column to 
the exact width of the column heading text, type a low number of characters in the 
Column width box (for example, type 5).

5. Click Submit to save your changes.

6. Click Launch Display to start the real-time display and to view your changes.
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Rearranging columns in a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can rearrange the columns only of private displays. If you choose a public display, you must 
first copy it and save it in your Private Tabular Displays folder before you can customize the 
columns.
You cannot move the Site, Filter, Skillset, or Application column headings. However, you can 
choose the order in which they appear in the private network-consolidated real-time displays.

Procedure
1. In the left pane, click the Private Tabular Displays folder.

2. Click the private display to customize.

3. In the right pane, click the Columns tab.

4. Click the name of the column to move.

5. Click Move Left or Move Right to move the column heading to the desired position.

6. Click Submit to save your changes.

Changing the data collection mode of a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
Specify the mode in which you want to view collected contact center data.

Procedure
1. In the left pane, click the Private Tabular Displays folder.

2. Click the display name.

3. In the right pane, click the Properties tab.

4. From the Data collection mode list, select the mode in which to view the collected data.

5. Click Submit to save your changes.
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Changing the title of a real-time display grid
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
Select the title to appear at the top of each private real-time display grid.

Procedure
1. In the left pane, click the Private Tabular Displays folder.

2. Click the display name.

3. In the right pane, click the Properties tab.

4. In the Display Title box, type the title to appear at the top of the real-time display.

If you do not type a title, the system applies the default title.

5. Click Submit to save your changes.

Deleting columns from a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• You can customize the columns of only private displays. If you choose a public display, 

you must first copy it and save it in your Private Tabular Displays folder before you can 
customize the columns.

About this task
When you customize your private real-time display grids, you can delete any column except for 
the Site, Filter, Skillset, and Application columns.

Note:
If you delete the Answered Skillset column, the Contact Type icons do not display in the 
Contact Status column.

Procedure
1. In the left pane, navigate to the private display to customize.

2. In the right pane, click the Columns tab.

3. From the sample table, click the statistic to delete from the real-time display.

4. Click Delete.

5. Click Submit to save your changes.
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Moving the chart contents within the window
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can move the summary chart contents within the window frame to concentrate on specific 
areas of the chart.

Procedure
1. While viewing the chart, press Shift.
2. While pressing Shift, hold down both mouse buttons.

3. On the chart, move your mouse to drag the contents to the desired position.

4. Release Shift and the mouse buttons.

5. To restore the chart to the original state, press R on your keyboard.

Rotating a summary chart
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Open a summary chart.

About this task
Rotate a summary chart to view the complete content.

Procedure
1. While viewing the chart, press Shift.
2. While pressing Shift, hold down both mouse buttons.

3. Move your mouse in a circular direction.

The chart contents rotate.

Increasing or decreasing the summary chart size
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Open a summary chart.
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About this task
Customize the size of the chart contents within the chart frame. You cannot increase the size of 
the chart frame.

Procedure
1. While viewing the chart, press Ctrl.
2. While pressing Ctrl, hold down both mouse buttons.

3. On the chart, move your mouse upward to decrease the size of the chart contents or 
downward to increase the size of the chart contents.

4. After you adjust the size appropriately, release Ctrl and the mouse buttons.

5. To restore the chart to the original state, press R on your keyboard.

Zooming in on areas of a summary chart
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Open a summary chart.

About this task
Zoom in on a summary chart to view specific information.

Procedure
1. While viewing the summary chart, press Shift.
2. While pressing Shift, click and drag to select the area of the chart to view more closely.

3. Release Shift and the mouse button.

The area increases in size.

4. To restore the chart to the original state, press R on your keyboard.
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Chapter 45: Historical Reporting

Using the Historical Reporting component, you can run and schedule performance and configuration 
reports. Reports help you monitor system performance by providing information about system 
activity. You can obtain standard reports which provide information about the past performance of 
the Contact Center and Contact Center configuration data. The data for historical reports is gathered 
from the Avaya Contact Center Select server.

Contact Center Manager Administration limits the number of scheduled reports that can run in 
parallel to five. Contact Center Manager Administration queues requests to run additional reports 
and processes these requests once the running report completes.

Note:

Contact Center blocks historical reports that pull more than 50,000 records from the database. 
This maximum limit safeguards the memory and CPU usage on the Contact Center server. 
Avaya recommends that you run reports with selection criteria that reduce the amount of data 
on the report.

Note:

Contact Center limits the number of items shown in the document map of the Report Viewer to 
5000. The document map is the navigation pane that appears on the left side of most reports. 
Once the limit is reached, Contact Center disables the document map and it is no longer visible 
in the Report Viewer. However, if there are multiple levels in the document map of a report, 
Contact Center removes the lowest level first and continues the removal until the number of 
items falls below 5000. For example, the document map for the Agent Performance report 
shows two items: Agent Name & ID, and the Date. If removing the Date from the document map 
reduces the number of items to 5000 or less, the Report Viewer displays the Agent Name & ID 
only. If Contact Center cannot reduce the number of items in the document map to 5000 or less, 
the document map is disabled.

Microsoft SQL Server Reporting Services (SSRS) has limitations when exporting reports. If the 
report exceeds SSRS limits, the export fails. For more information about SSRS limitations when 
exporting to different formats, refer to Microsoft SSRS documentation.
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Logging on to Historical reporting
Before you begin

• Ensure that you have access to Historical reporting.

About this task
To access Historical Reporting, log on to the Historical Reporting component in Contact Center 
Manager Administration.

Procedure
1. Log on to Contact Center Manager Administration.

2. On the Launchpad, click Historical Reporting.

The Historical Reporting window appears.

Opening a public, private, or shared report
Before you begin

• Ensure that you have access to public report groups in Access and Partition Management.
• Log on to Historical Reporting. For information, see Logging on to Historical Reporting on 

page 98.

About this task
Open a public, private, or shared report to view a historical report.

Procedure
1. In the left pane, select the server on which to view the list of reports.

2. Select one of the following folders:

• Public Report Templates: This folder contains the standard report templates available 
in Avaya Contact Center Select. Run public reports on a demand basis, or save them 
in your Group or Private Report Templates folders and schedule the reports to run at 
a defined time. The Public Report Templates folder contains seven template folders 
corresponding to the following types of reports:

- Agent Performance reports

- Call-by-Call reports

- Configuration reports

- Contact Summary reports

- Multimedia reports

- Other reports
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- Outbound reports

• Private Report Templates: This folder contains the report templates that you create 
by modifying an existing public, shared, or private report template, and saving your 
changes in your Private Report Templates folder. You can modify report information, 
schedule the report, and apply filters. For more information about creating private 
reports, see Creating a shared or private report on page 102.

• Group: This folder contains shared report templates. When you customize a public or 
private report template and save it in your Group folder, all other users who have access 
to your group can run and schedule the group report templates.

Note:

In the Group folder, you can modify a report template only if you are the owner of 
the report template.

3. From the expanded list, select a report template to modify or schedule the template, or run 
the report on demand.

The report properties appear in the right pane.

Running an Ad hoc report
Before you begin

• Ensure that you have access to the report folder that contains the report to run.
• Log on to Historical Reporting.

About this task
You can specify the amount of data to include in an Ad hoc report by choosing the data range and 
applying selection criteria. After you customize your report, click Run Now to generate the report 
immediately. In the resulting Ad-hoc Report Viewer window, you can choose to print or save the 
report.
You can select the data range for agent performance and call-by-call reports before you generate 
them. You cannot select the data range for configuration reports.

Procedure
1. In the left pane, select the server that contains the report to run.

2. In the expanded list, select the folder that contains the report template to run.

3. Click the folder containing the report to run.

4. Select the report template to run.

5. To view the current report properties, in the right pane, click the following headings:

• Report Details
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• Selection Criteria
• Data Range
• Schedule
• Output Options: This section applies only if you previously scheduled the report.

6. To run the report with the current properties, proceed to step 8.

Note:

If you do not define the selection criteria, the system enforces partition rules to 
generate the report.

7. To define the selection criteria and the data range, see Defining the selection criteria on 
page 100.

8. To save your properties, in the Save As box, type a report name, choose a save location, 
and then click Save Report.

9. Click Run Now to generate the report.

Defining the selection criteria
Before you begin

• Log on to Historical Reporting.

About this task
You can select the elements to include in your reports by assigning filter elements to your reports. 
For example, in an agent performance report, you can choose the agents for whom to generate 
the report. You can define the selection criteria for public, private, and shared reports that you 
schedule or run on demand.
By default, if you do not define the selection criteria, the system applies partition rules to generate 
the report. However, if you select a filter element, you see only that element in the report. You 
can select a maximum of 300 elements from the available list to run the report. For example, you 
choose a skillset report and see a list of 20 skillsets in the Available filter elements box. If you 
select no skillsets, you see all 20 skillsets in the report, whereas if you select 3 skillsets, you see 
only 3 skillsets in the report. For two table reports, for example, Skillset By Agent Performance 
report, you can select 300 agents and 300 skillsets to run the Skillset by Agent Performance 
report.
The number of elements defined in a users partition profile is an important consideration when 
running historical reports. If the combined number of a particular element is greater than 300, then 
it is necessary for the user to select a subset of 300 elements or less in order to run that report. 
If no selection criteria is selected, all available elements to that user are applied to the report – 
Contact Center supports only 300 elements or less. Consider the following example:
A user is assigned three user defined partitions, configured as follows:
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Partition Name Elements
Sales Agents Contains 200 agents
Support Agents Contains 80 agents
Service Agents Contains 50 agents

If the user runs the standard Agent Performance report, the report fails to run and displays this 
error: “The maximum number of elements supported by the SQL Query is 300. Select up to 300 
elements to save/run this report or leave the selection criteria blank to report on all data.” This 
error appears because the user did not define any selection criteria and the maximum element 
limit is reached. In a user defined partition, the number of elements must not exceed 300. If the 
number of elements exceeds 300, it has the same effect as defining a selection criteria of more 
than 300 elements. To avoid this, assign less partitions to the user or use standard partitions to 
allow reports to be run for all elements.
The filter elements available depend on the type of statistics included in the report. If you select 
multiple filter elements, only those that satisfy all filter criteria appear in the report. For example, 
if you choose to report on five agents and three activity codes, if one agent uses no activity code, 
the agent does not appear in the report.

Procedure
1. In the left pane, click the server that contains the report to define.

2. Expand the folder that contains the report template to use.

3. Click the folder containing the type of report to change.

4. Select the report to use.

5. In the right pane, click the Selection Criteria heading.

6. In the Selection Criteria area, enter information in the following boxes:

• Available heading: Click this heading to view the available filter elements for this report. 
A table appears, listing the available elements. If multiple filters exist for this report, 
more than one Available table appears. Select the check box for each filter element 
to apply to the report, and then click Update Selection Criteria. The selected filter 
elements appear in the Selected table.

• Selected heading: Click this heading to view the filter elements selected for the report. 
A table appears, listing the selected elements. To remove selected filter elements, clear 
the check box for each filter element, and then click Update Selection Criteria. The 
element appears in the Available table.

7. Click Run Now to generate the report.

8. To save your changes, click Report Details, in the Save As box, type a name, choose a 
save location, and then click Save Report.
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Exporting an Ad hoc report
Before you begin

• Log on to Historical Reporting.

About this task
Export a report to convert the visual display to a required format.

Procedure
1. In the left pane, click the server that has the report to print.

2. Double-click the folder with the report to print.

3. From the expanded folder, select the report.

4. In the right pane, click Run Now to generate the report with the specified properties.

The Ad-Hoc Report Viewer appears and displays the generated report.

5. Click the Export drop-down menu and select an export type. Choose from Excel, PDF, or 
Word.

6. After you select the export type, you can choose to open or save the report in the chosen 
exported format.

Creating a shared or private report
Before you begin

• Ensure that you have access to the folder that contains the report to use.
• If you schedule the report, activate the schedule. See Activating a scheduled report on 

page 112.
• Log on to Historical Reporting.

About this task
You can create custom reports if you change existing public, shared, or private report templates to 
suit your needs. Save them in your Group or Private Report Templates folders. When you save a 
report in your Group folder, you save a shared report; that is, you share the report with other users 
who have access to your Group folder.
If you do not want to use an existing report as the basis for your custom report, you must create 
a new report using Microsoft Report Designer and import it into the Contact Center Manager 
Administration Historical Reporting application. See Importing a report on page 105.

Procedure
1. In the left pane, select the server on which to create the report.

2. Navigate to the folder that contains the report template to use.
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3. Click the report to change.

4. In the right pane, click the following headings:

• Selection criteria.

• Data range (not applicable for configuration reports)

• Schedule
5. Click Report Details.

6. In the Report Title box, type the name to appear at the top of the generated report. If 
you do not type a new report title, the default title in this box appears at the top of the 
generated report.

Note:

If you save multiple copies of the same public report in your Group or Private report 
templates folders, change the report title to distinguish between reports when you 
generate them. If you do not change the report title, all copies of the same public report 
have the same standard title when you generate the reports.

7. In the Save As box, type the new report name.

Note:

If you choose a Public report template as the basis for your custom report, and you 
want to save the new properties that you enter, you must type a new name in the 
Save As box and specify whether to save it in your Private or Group folder. If you use 
an existing private or shared template as the basis for your custom report, you can 
choose to make a copy of the report by changing the report name in the Save As 
box, or you can leave the report name and overwrite the existing template with your 
changes.

8. From the Location list, select the save location for your custom report. You can choose 
between your Private and Group folders (if you have access to a group folder).

9. In the Comment box, type comments about the report.

10. From the Time Zone list, select the time zone in which you want to define the data range 
for this report, or accept the default time shown (the system defaults to the client’s time 
zone). The data range depends on Contact Center time since the server stores the data. 
Therefore, the system always converts the data range times that you enter to Contact 
Center time.

11. Click Save Report to save your changes.

The report appears in the Group or Private Report Templates folder on the server that you 
select.
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Defining the report output
Before you begin

• Log on to Historical Reporting.

About this task
You can specify whether to print the scheduled report when it generates, save it as a file, or both. 
You can also specify one or more email addresses where the system can send a notification after 
the report generates.
If you save the report to a file, you must specify a shared folder to which the Contact Center server 
sends the output file. This folder can be on your computer, on another computer in the network, 
or on the application server. To send the file to a folder on a computer in the network, the network 
computer must be accessible from the Contact Center server.

Procedure
1. In the left pane, click the server containing the report whose output options you want to 

define.

The server expands to reveal a choice between Public, Private, and Group folders (if you 
have access to a group folder).

2. Expand the folder containing the report template to use.

3. Navigate to the report to edit.

The report properties appear in the right pane.

4. Click the Report Details heading.

5. In the Report Title box, type the name to appear at the top of the generated report.

If you do not type a new report title, the default title in this box appears at the top of the 
generated report. Do not include apostrophes (’) in the report title.

Note:

If you save multiple copies of the same public report in your Group or Private report 
templates folders, change the report title to distinguish between reports when you 
generate them. If you do not change the report title, all copies of the same public report 
have the same standard title when you generate the reports.

6. In the Save As box, type the new report name.

The name appears in the system tree. This name cannot contain apostrophes (’) and it 
must be unique, if you save the report in the same folder.

7. From the Location list, select the folder in which to save your report. You can choose 
either Private or Group (if you have access to a group folder).

8. From the Time Zone list, select the time zone in which to schedule your report, or accept 
the system default (the system defaults to the client's time zone).
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Note:

When you select the schedule time for your report, the system converts the time that 
you choose to the Contact Center server time, and gives the generated report the 
Contact Center server timestamp (if you choose a time zone other than the one on the 
Contact Center server).

9. Click the Schedule heading.

The heading expands to reveal a series of boxes.

10. In the schedule area, enter the report schedule.

11. Click the Output Options heading.

The heading expands to reveal a series of boxes.

The Output Options heading is disabled until you schedule the report.

12. In the Output Options area, choose the report output type:

• Print: When you select this option, you can choose the printer, or accept the default 
printer shown. You can also select the paper size for the report from the Paper Size list.

• Output to file: When you select this option, you must type the location where the 
report is saved in the Output box in the format \\[computer name]\[shared 
folder name]\[file name]. You can then choose the report file format. Choose 
between .doc, .pdf, or ,xls.

• Email Notification: When you choose this option, you must enter an email address 
in the box provided. The system notifies you by email when the report run is finished 
and report is generated. To enable multiple users to receive notification that a report is 
generated, you can type multiple email addresses in the box, each address is separated 
by a semicolon (;). You can type a maximum of 255 characters in the email address box.

13. Click Save Report to save your changes.

14. To activate the schedule, in the left pane, select the Scheduled Events folder.

15. In the expanded folder, select the report that you just scheduled.

16. Click Activate.

The system activates the schedule and outputs the report to the location that you specify.

Importing a report
Before you begin

• Log on to Historical Reporting.

About this task
You can use the Report Template Importing Wizard to import report templates into Contact Center 
Manager Administration that you create using Microsoft Report Designer. When you import a 
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report template, you save it on the Contact Center server. However, you access the report 
template by opening your Private Report Templates folder.
To share the report template with other users, you must save your private report in your Group 
folder (if you have access to a group folder). For more information, see Creating a shared or 
private report on page 102.
You can import two types of reports: Historical or Configuration.

Note:
For imported reports, characters are limited to the English language and characters supported 
by the server code page only. A code page is an internal table that the operating system 
uses to map symbols (letters, numerals, and punctuation characters) to a number. For more 
information about server code pages and language support for Contact Center Manager 
Administration, see Avaya Contact Center Select Advanced Administration.

Procedure
1. In the left pane, click the server to which to import the new report template.

2. On the Report menu, click Import.

The system displays the Template Importing Wizard dialog box.

3. Click the Browse button next to the Select Your Report template field, and navigate to 
the report.

4. In the Template Name box, type the name of the report to import.

5. From the Report is based on the following data list, select the type of report.

6. If applicable, provide Database alias, timestamp, and report data range details.

7. Optionally, select Synchronize report template from the network drive to ensure the 
server automatically applies any updates made to the imported report.

8. Click Import.

Follow the wizard prompts to import your report template to the server.

Editing a report
Before you begin

• Log on to Historical Reporting.
• Ensure that you are familiar with defining selection criteria. See Defining the selection 

criteria on page 100.
• Ensure that you are familiar with scheduling reports. See Scheduling a report on page 109.
• If you edit a scheduled report, you must deactivate the schedule before you can save your 

changes. See Deactivating a scheduled report on page 112.
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About this task
You can edit the properties of private reports or shared reports that you create and save in 
your Group folder. You can change properties such as the data range, the selection criteria, the 
schedule, and the report title. You must click Save Report to save the new properties.
You can change the properties of a public report template only if you save a copy of the template 
as a shared or private report. See Creating a shared or private report on page 102.

Procedure
1. In the left pane, click the server containing the report to edit.

2. Navigate to the report to edit.

The system loads the report properties, and a series of headings appears in the right pane.

3. Click the Report Details heading.

The heading expands to reveal a series of boxes.

4. In this section, you can change information in the following boxes:

• Report Title: The title that appears at the top of the generated report. Do not include 
apostrophes (’) in the report title.

• Comment: Type comments about the report.

• Save As: The name of the report. All reports saved in the same folder must have unique 
names. This name cannot include apostrophes (’). You must enter a name in this box 
when you save the report in a different folder. If you save the report in the same folder 
and do not change this name, the system overwrites the existing report with your new 
properties.

• Save Location: Select the folder in which to save the custom report. If you select 
Group, all members of your group have access to the report. If you select Private, only 
you have access to the report.

• Time Zone: Select the time zone in which to schedule or define the data range for this 
report, or accept the default time shown (the system defaults to the client's time zone). 
The data range depends on Contact Center Manager Server time since the server 
stores the data. Therefore, the system always converts the data range times that you 
enter to the Contact Center Manager Server time.

5. Click the Selection Criteria heading.

The heading expands to reveal a series of boxes.

6. Specify the information to include in your report by assigning filter elements.

7. Click the Data Range heading.

The heading expands to reveal a series of boxes.

8. Change the time range, during which the data collects, to specify the amount of data to 
include in your report.

If the data range is None and disabled, the report does not require a data range.
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9. Click the Schedule heading.

10. Indicate when and how often to generate your report.

11. Click the Output Options heading (only if you schedule the report). The heading expands 
to reveal a series of boxes.

12. Specify whether to save or print the report.

You can enter email addresses on which the system sends a notification to indicate if the 
report generates successfully.

13. Click Save Report.

Note:

If you click Run Now to generate an on-demand report, property changes are not 
saved.

Printing an Ad hoc report
Before you begin

• Log on to Historical Reporting.

About this task
You can print an on-demand report from the Ad-Hoc Report viewer.
Before you can print the report, you must run it. You can run the report with the current properties, 
or you can define the selection criteria and the data range, and then run the report. See Defining 
the selection criteria on page 100.
By default, if you do not define the selection criteria, all available data is included in the report 
when you run it. When you define the selection criteria, you can choose the data that you want to 
see.
For information about printing scheduled reports, see Defining the report output on page 104.

Procedure
1. In the left pane, click the server containing the report to print.

2. Double-click the folder containing the report to print.

3. From the expanded folder, select the report.

4. In the right pane, click Run Now to generate the report with the properties specified.

The system displays the Ad-Hoc Report Viewer and the generated report.

5. Click the printer icon to print the report to the default printer configured on your computer.
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Scheduling a report
Before you begin

• Log on to Historical Reporting.
• Ensure that you are familiar with defining selection criteria.

About this task
You can schedule reports in your group and private folders to send a report to a file or to print 
a report, or both. You can also specify one or more email addresses where you can receive 
notification that the report generated, or if problems occurred that prevented it from generating 
successfully.
You can change the properties of a public report template only by saving a copy of the template as 
a shared or private report. See Creating a shared or private report on page 102.
If you choose to send the report to a file, you must specify a shared folder where the Contact 
Center server sends the file. This folder can be on your computer, on another computer in the 
network, or on the application server. To send the file to a folder on a computer on the network, the 
network computer must be accessible from the Contact Center server.
Avaya recommends that you select a start time that does not exactly match an interval start time. 
If the scheduled report start time matches the start of an interval, it is possible that the report does 
not contain data for the previous interval. This happens when Contact Center does not complete 
writing interval data to the database before the scheduled report starts. This can occur because 
of, for example, the database size, or the volume of contacts processed in the interval. Avaya 
recommends that you avoid starting reports on the hour, or on fifteen, thirty, or forty-five minutes 
after the hour. Instead, schedule reports five minutes after intervals, for example 07:05 or 16:20.

Note:
The report schedule that you define cannot start in the p.m. range and end in the a.m. range. 
After the system converts your selected time to Contact Center server time, if the converted 
start time is in the p.m. range and the converted end time is in the a.m. range, an error 
message appears. In this case, you must re-enter the schedule start and end times, taking 
into account the time difference with the application server.

Procedure
1. In the left pane, click the server containing the report to schedule.

2. Expand the folder containing the report template to use.

3. Click the folder containing the report type to schedule.

4. In the expanded folder, select the report to schedule.

5. In the right pane, click the Report Details heading.

6. In the Report Title box, type the name to appear at the top of the generated report.

Note:

If you do not type a new report title, the default title in this box appears at the top of the 
generated report. Do not include apostrophes (’) in the report title.
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7. If you save multiple copies of the same public report in your Group or Private report 
templates folders, change the report title to distinguish between reports.

Note:

If you do not change the report title, all copies of the same public report have the same 
standard title when you generate the reports.

8. In the Save As box, type the new report name.

The name appears in the system tree. This name cannot contain apostrophes (’) and it 
must be unique, if you save the report in the same folder.

9. From the Location list, select the folder in which to save the report.

You can choose either Private or Group (if you have access to a group folder).

10. From the Time zone list, select the time zone in which to schedule your report, or accept 
the system default (the system defaults to the client's time zone).

11. Click the Selection Criteria heading.

12. In the Selection Criteria area, click the Available and Selected headings to choose the 
selection criteria for the report.

13. Click the Schedule heading.

14. In the Schedule area, select the report schedule criteria.

Note:

If you select dates for the report to generate, the report generates for the selected 
dates each year for as long as the report is scheduled. For this reason, you cannot 
select to generate the report on February 29 in a leap year, as the following year is not 
a leap year.

15. Click the Output Options heading.

16. In the Output Options area, choose the report output:

• Report output: Choose whether to print the report, send it to a file, or both.
• Printer: Select the printer.
• Paper Size: Choose the paper size.
• Output: Type the path to the shared network folder in which to save the report.
• Format: Select the report format.
• Save the file under different name each time: Save each report with a unique name. 

If you do not choose this option, the system overwrites the existing report.
• Email Notification: Select this option to receive an email notification after the report 

generates, or if the report does not generate successfully. Enter an email address in 
the box provided. The system notifies you by email when the report run is finished and 
the report is generated. To enable multiple users to receive notification that a report 
generated, you can type multiple email addresses in the box, each address is separated 
by a semicolon (;). You can type a maximum of 255 characters in the email address box.
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17. Click Save Report to save your schedule.

18. Click Activate to activate the schedule.

19. To verify that the report schedule is active, select the Scheduled Events folder, and then 
locate the scheduled and activated report to view the status and properties.

Variable definitions
Variable Definition
start time The time in the selected range in which to 

generate a report. If you select the schedule time 
for your report, the system converts the time 
that you choose to the Contact Center Manager 
Administration server time and gives the generated 
report the Contact Center Manager Administration 
server timestamp (if you choose a time zone 
other than the one in the Contact Center Manager 
Administration server).

Avaya recommends that you avoid starting reports 
on the hour, or on fifteen, thirty, or forty-five 
minutes after the hour. Instead, schedule reports 
five minutes after intervals, for example 07:05 or 
16:20.

Printing a report schedule
Before you begin

• Log on to Historical Reporting.

About this task
You can use the Scheduled Events window to print the schedules of all reports scheduled by you.

Procedure
1. In the left pane, click the Scheduled Events folder. The list of your scheduled reports 

appears.

2. In the right pane, select a report, and then click Print.
3. In the message box that appears, select one of the following options:

• Print: Click Print to print the entire list of scheduled reports shown in the window.

• Page Setup: Use the Page Setup option to select the paper size of the printed 
schedules. If you choose A4 or Letter size, the Schedule Type and Status columns 
do not appear on the print preview or the printed copy. If you choose Legal size, you 
can preview and print all the displayed grid columns.
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• Print Preview: You can preview the report schedule.

Activating a scheduled report
Before you begin

• Log on to Historical Reporting.
• Schedule at least one report.

About this task
When you first schedule a report, or when you deactivate a scheduled report, you must activate it 
to schedule the report again. You can activate a report in one of two ways:

• Click Activate in the Report Properties window while you view a saved, scheduled, but 
inactive report.

• Click Activate in the Scheduled Events window.
This procedure shows you how to activate a report from the Scheduled Events window.

Procedure
1. In the left pane, click the Scheduled Events folder.

2. In the right pane, select the report to activate.

3. Click Activate.

The scheduled report activates and runs according to the specified schedule.

Deactivating a scheduled report
Before you begin

• Log on to Historical Reporting.
• Schedule and activate at least one report.

About this task
You must deactivate the report to pause the report run for an active scheduled report.
You must deactivate a report schedule before you change the report properties, or before you 
delete the scheduled report. To resume the report on schedule, you must reactivate the scheduled 
report after you make the changes.
You have two options to deactivate a scheduled report:

• In the Report Properties window while viewing a saved, scheduled, and activated report.
• In the Scheduled Events window.

This procedure shows you how to deactivate a report from the Scheduled Events window.
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Procedure
1. In the left pane, click the Scheduled Events folder.

2. In the right pane, select the scheduled report to deactivate.

3. Click De-Activate.

Running a report from a different time zone
Before you begin

• Log on to Historical Reporting. For information, see Logging on to Historical reporting on 
page 98.

About this task
You can select the time zone to run an on-demand report or schedule a report. The time zone that 
you select applies to the data range of the report and the report schedule. You can choose the 
time zone to appear in:

• the current computer time zone
• the Contact Center (server) time zone
• any other time zone

Procedure
1. In the left pane, select the server that contains the report to run.

2. In the expanded list, double-click the folder that contains the report to run.

3. Select the report to run.

4. In the right pane, click Report Details.
5. In the Time Zone field, select a time zone.

6. Click Run Now to generate the report.

Deleting a report
Before you begin

• Log on to Historical Reporting.
• Deactivate the schedule. See Deactivating a scheduled report on page 112.

About this task
You can delete reports from your private report templates folder and reports in your group folder 
that you create. You cannot delete public reports.
Deletions appear in the in the Audit Trail log.
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Procedure
1. In the left pane, click the server from which to delete the report.

The server appears to reveal a choice of Public, Private, and Group folders (if you have 
access to a group).

2. Navigate to the report to delete.

3. Right-click the report, and then click Delete.

4. In the confirmation dialog box, click Yes.
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Chapter 46: Report Creation Wizard

Report Creation Wizard is a Web-based interface in which you can create and edit reports. You can 
import and schedule the reports in Historical Reporting. You can access the Report Creation Wizard 
from the Historical Reporting component of Contact Center Manager Administration.

Note:

If the Report Creation Wizard window is open and a High Availability switchover occurs, the 
session is not maintained and you must relaunch Report Creation Wizard to continue operation.

Starting Report Creation Wizard
Before you begin

• Ensure that you have a license for Report Creation Wizard.

About this task
To access Report Creation Wizard, start this application.

Procedure
1. Log on to Contact Center Manager Administration.

2. From the Launchpad, click Historical Reporting.

3. In the left pane, click the Contact Center Manager Server on which to create, edit, or view 
the Report Creation Wizard report.

4. From the Report menu, select Report Creation Wizard.

Opening an existing report
Before you begin

• Start Report Creation Wizard. See Starting Report Creation Wizard on page 294.
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About this task
Select the Open Existing Report option to open an existing report. After you select this option, a 
navigation tree appears. Navigate to the report to open. You can choose from previously created 
reports or from a list of sample reports.

Procedure
1. From the Report Type window, select the Open Existing Report option.

2. Click the folder that contains the report to open.

3. From the list of reports, select the report.

4. Click Next.

Creating a simplified report
Before you begin

• Start Report Creation Wizard. See Starting Report Creation Wizard on page 294.

About this task
Select the Create Simplified Report (via Report Definitions) option to use one of the report 
definitions available with Report Creation Wizard.
If you choose to create a simplified report, you can choose from a list of standard report definitions 
in the Data Source window. The Data Source window lists the available report definitions based on 
the server type selected. If the Contact Center is multimedia enabled, multimedia report definitions 
are also available.

Procedure
1. In the Report Type window, select the Create Simplified Report (via Report Definitions) 

option.

2. In the Data Source window, click the Report Definitions folder.

3. Navigate to the folder that contains the report definition to open.

4. Click Next.
5. In the Field Selection window, in the Fields list, double-click a field or formula to add to the 

report.

The selected field or formula is moved from the Fields list to the Fields Selected list.

By default the table name is appended to the field name after you add the field to the 
Fields Selected list. To remove the table name, click the Toggle Table Name icon.

Note:

If you remove a field from the Field Selection page, the field is removed only from the 
Details section, not from any other section.
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6. To change the order of the selected fields, use the up and down arrows.

7. To modify the properties of a selected field, in the Selected Fields list, click a field, and 
then in the Width box, type a new width.

A default width of 80 pixels applies to all selected fields. The Title box is a read-only field.

8. Click Next.
9. To select a field to group by, in the Grouping window, from the Fields list, double-click a 

field or formula.

The selected field or formula moves to the Group by list.

10. To accept the default properties of the selected fields and formulas, proceed to step 23 on 
page 296.

11. To modify the properties of a group field, from the Group by list, select a field.

12. From the Sort Order list, select a sort order.

13. From the The section will be printed list, select a length of time that defines when the 
group changes.

Note:

This option is available only for Date, Time, and DateTime fields. It determines when 
the group prints. For example, selecting for each hour groups records together for 
each hour, and calculates group summaries for each hour.

14. Click Next.
15. In the Summaries window, from the Fields list, select a field.

16. From the Summation Type list, select a summation type.

As you select the fields in the Fields list, the Summation Type list dynamically updates to 
show the types available for the selected field.

17. From the Groups list, select the check box for each report section in which the summary 
appears on the report.

18. Click Add.

The summary appears in the Summary Data list.

19. Click Next.
20. In the Report Layout window, view or modify the report.

21. On the toolbar, click the Save Report icon.

22. In the Save RCW Report dialog box, choose a folder in which to save the report.

23. In the Report Name box, enter a name for the report.

24. Click Save.

You can save the report after you select at least one field.
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Example of creating a sample simplified Agent by Skillset 
Performance report

About this task
You can create various report types, such as an Agent by Skillset Performance report.

Procedure
1. In the Report Type window, select the Create Simplified Report (via Report Definitions) 

option.

2. Click Next.
3. In the Data Source window, under the Report Definitions folder, expand the CS1000 

folder, and then expand the Agent Performance folder.

4. In the Agent Performance folder, select the Agent By Skillset Performance Stats report 
definition.

5. Click Next.
6. In the Field Selection window, from the Fields list, expand the iAgentBySkillsetStat 

heading.

7. From the iAgentBySkilsetStat list, double-click the following fields in the order listed:

• Skillset
• Timestamp
• Time
• AgentLogin

8. From the Fields list, expand the iAgentBySkillsetStat Formulas heading.

9. From the iAgentBySkillsetStat Formulas list, double-click RCW_AgentName.

10. From the iAgentBySkillsetStat Formulas view, double-click CallsAnswered.

11. In the iAgentBySkillsetStat Formulas list, double-click RCW_TalkTime.

Each selected field and formula moves from the Fields list to the Fields Selected list.

12. Change the width for the following selected fields:

Selected field Width
iAgentBySkillsetStat.Skillset 200
iAgentBySkillsetStat.Timestamp 200
iAgentBySkillsetStat.AgentLogin 80
iAgentBySkillsetStat.RCW_AgentName 120
iAgentBySkillsetStat.CallsAnswered 80
iAgentBySkillsetStat.RCW_TalkTime 80

13. Click Next.
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14. In the Grouping window, from the Fields list, expand the iAgentbySkillsetStat heading, 
and then double-click the following fields to group by:

• Skillset
• Timestamp (represents the date and time)

Each selected field moves from the Fields list to the Group by list.

The RCW_TalkTime formula is not available because it is a dynamic formula.

15. From the Group by list, select iAgentbySkillsetStat.Timestamp.

16. From the This section will be printed list, select for each hour.

Note:

This option is available only for Date, Time, and DateTime fields and defines when the 
group changes.

17. Click Next.
18. In the Summaries window, from the Fields list, expand the iAgentBySkillsetStat heading.

19. From the iAgentBySkillsetStat, select CallsAnswered.

20. From the Summation Type list, select Sum.

21. From the Groups list, select the following check boxes:

• Report Footer
• Group Footer #1
• Group Footer #2

22. Click Add.

A CallsAnswered summary for the Report Footer, Group Footer #1, and Group Footer 
#2 appears in the Summary Data list.

Footer 1 generates a total for all data selected, Group Footer 1 generates a total for each 
selected skillset, and Group Footer 2 generates a total for each selected timestamp.

23. From the Fields list, expand the iAgentBySkillsetStat Formulas heading.

24. From the iAgentBySkillsetStat Formulas list, select RCW_TalkTime.

25. From the Groups list, select the following check boxes:

• Report Footer
• Group Footer #1
• Group Footer #2

26. Click Add.

An RCW_TalkTime summary for the Report Footer, Group Footer #1, and Group 
Footer #2 appears in the Summary Data list.
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Footer 1 generates a total for all data selected, Group Footer 1 generates a total for each 
selected skillset, and Group Footer 2 generates a total for each selected timestamp.

27. Click Next.
28. In the Report Layout window, double-click the Group Footer #1 section.

The section bar changes color from blue to purple and expands to reveal the summary 
fields in this section.

29. In the Group Footer #1 section, click CallsAnswered.

The Object Properties page appears on the left.

30. On the Object Properties page, in the Width box, type 80.

31. In the Group Footer #1 section, click RCW_TalkTime.

32. On the Object Properties page, in the Width box, type 80.

33. Double-click the Group Footer #2 section.

34. In the Group Footer #2 section, modify the following Object Properties:

Group Footer #2 field Width
CallsAnswered type 80
RCW_TalkTime type 80

35. Double-click the Report Footer section.

36. In the Report Footer section, modify the following Object Properties:

Report Footer field Width
CallsAnswered type 80
RCW_TalkTime type 80

37. Click the Group Footer #1 section.

38. Click the Add Text Field icon on the toolbar.

39. On the Object Properties page, modify the following properties:

• In the Title box, type Skillset.

• In the Width box, type 80.

• In the Height box, type 20.

• In the Left box, type 300.

• In the Top box, type 3.

• From the Text Align list, select Right.
• Select the Bold check box.

40. Click the Group Footer #2 section.

41. Click the Add Text Field icon on the toolbar.
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42. On the Object Properties page, modify the following properties:

• In the Title box, type Timestamp.

• In the Width box, type 80.

• In the Height box, type 20.

• In the Left box, type 300.

• In the Top box, type 3.

• From the Text Align list, select Right.
• Select the Bold check box.

43. Click the Report Footer section.

44. Click the Add Text Field icon on the toolbar.

45. On the Object Properties page, modify the following properties:

• In the Title box, type Totals.

• In the Width box, type 80.

• In the Height box, type 20.

• In the Left box, type 300.

• In the Top box, type 3.

• From the Text Align list, select Right.
• Select the Bold check box.

46. Double-click the Page Header section.

47. In the Page Header section, click Time.

48. On the Object Properties page, modify the following properties:

• From the Font Color list, select Purple.

• Select the Underline and Bold check boxes.

49. In the Page Header section, modify the following Object Properties:

Page Header field Title Width Font Color Check boxes
AgentLogin Agent Login 80 Purple Bold

Underline
RCW_AgentName Agent Name 120 Purple Bold

Underline
CallsAnswered Calls Answered 80 Purple Bold

Underline
Table continues…
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Page Header field Title Width Font Color Check boxes
RCW_TalkTime Talk Time 80 Purple Bold

Underline

50. Double-click the Group Header #1 section.

51. In the Group Header #1 section, click Skillset.
52. On the Object Properties page, modify the following properties:

• From the Font Color list, select Blue.

• Select the Bold check box.

53. Double-click the Group Header #2 section.

54. In the Group Header #2 section, click Timestamp.

55. On the Object Properties page, modify the following properties:

• From the Font Color list, select Blue.

• Select the Bold check box.

56. On the toolbar, click Save.

57. In the Save RCW Report window, select a folder in which to save the report.

58. In the Report Name box, type Agent By Skillset Performance.rpt.

Note:

Avaya recommends that you use a name different from the standard report definitions 
to quickly identify custom reports and to determine the type of data the report 
generates.

59. Click Save.

Creating an advanced report
Before you begin

• Start Report Creation Wizard. See Starting Report Creation Wizard on page 294.
• Ensure that you are familiar with the Report Creation Wizard.
• Configure the DSNs on the Contact Center Manager Server.
• Ensure that you understand table linking and joins.

About this task
Select the Create Advanced Report (via ODBC) option to use an ODBC DSN. You can choose a 
combination of views from the data source. However, the views must include a common key field. 
This option provides the maximum flexibility, but it also requires that you understand the database 
structure with which you work.
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Procedure
1. In the Report Type window, select the Create Advanced Report (via ODBC) option.

2. In the Data Source window, from the DSNs Available list, double-click a DSN.

The selected DSN moves to the DSNs Selected list.

Note:

You can select only one DSN system type, for example, a CCMS or CCMM DSN.

3. The User ID and Password boxes automatically contain the values you enter during the 
server configuration.

You can change the user ID and password, but these changes apply only if you create 
the report. If you generate the report in Historical Reporting, Historical Reporting uses the 
values you enter during the server configuration.

4. Click Next.
5. In the Table Selection window, from the Tables Available list, double-click a table.

The table moves from the Tables Available list to the Tables Selected list.

6. To add another table, repeat step 5 on page 302.

7. Click Next.
8. If you select one table only, proceed to step 14 on page 302.

9. If you select more than one table, in the Table Linking window, from each of the left and 
right Tables lists, select a table.

10. From each of the left and right Fields lists, select a field to join.

Note:

The selected field in the right Fields list must contain the same data as the selected 
field in the left Fields list.

11. From the join list, select a join type and click Link.

The selected tables, field, and join type appear in the Links list.

12. To remove an item from the Links list, select the item and click Remove.

13. Click Next.
14. In the Field Selection window, in the Fields list, double-click a field or formula to add to the 

report.

The selected field or formula moves from the Fields list to the Fields Selected list.

By default the table name is appended to the field name after you add the field to the 
Fields Selected list. To remove the table name, click the Toggle Table Name icon.
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Note:

If you remove a field from the Field Selection page, the field is removed only from the 
Details section, not from any other section.

15. To change the order of the selected fields, use the up and down arrows.

16. To modify the properties of a selected field, in the Selected Fields list, click a field, and 
then in the Width box, type a new width.

A default width of 80 pixels applies to all selected fields. The Title box is a read-only field.

17. Click Next.
18. To select a field to group by, in the Grouping window, from the Fields list, double-click a 

field or formula.

The selected field or formula moves to the Group by list.

19. To accept the default properties of the selected fields and formulas, proceed to step 23 on 
page 303.

20. To modify the properties of a group field, from the Group by list, select a field.

21. From the Sort Order list, select a sort order.

22. From the The section will be printed list, select a length of time that defines when the 
group changes.

Note:

This option is available only for Date, Time, and DateTime fields to determine when 
you print the group information. For example, selecting for each hour groups records 
together for each hour, and calculates group summaries for each hour.

23. Click Next.
24. In the Summaries window, from the Fields list, select a field.

25. From the Summation Type list, select a summation type.

As you select the fields in the Fields list, the Summation Type list dynamically updates to 
show the types available for the selected field.

26. From the Groups list, select the check box for each report section in which the summary 
appears on the report.

27. Click Add.

The summary appears in the Summary Data list.

28. Click Next.
29. In the Report Layout window, view or modify the report.

30. On the toolbar, click the Save Report icon.

31. In the Save RCW Report dialog box, choose a folder in which to save the report.
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32. In the Report Name box, enter a name for the report.

33. Click Save.

You can save the report after you select at least one field.

Example of creating an advanced Skillset Threshold report
About this task
An example of creating an advanced Skillset Threshold report.

Procedure
1. In the Report Type window, select the Create Advanced Report (via ODBC) option.

2. Click Next.
3. In the Data Source window, from the DSNs Available list, double-click a CCMS DSN.

The selected DSN is added to the DSNs Selected list.

4. In the Selected DSN Properties area, type the user ID and password to access the data 
source.

For configured servers on the Contact Center Manager Administration server, the user ID 
and password automatically appear.

5. Click Next.
6. In the Table Selection window, from the DSNs list, select the CCMS DSN.

Tables and views for the selected DSN appear in the Tables Available list.

7. From the Tables Available list, double-click dSkillsetStat and Skillset.

The selected tables move to the Tables Selected list.

8. Click Next.
9. In the Table Linking window, from the left Tables list, select iSkillsetStat.

10. From the left Fields list, select SkillsetID.

11. From the right Tables list, select Skillset.
12. From the right Fields list, select SkillsetID.

13. From the Join list, select Left Outer Join.

14. Click Link.

The linked SkillsetIDs appear in the Links list.

The result for the Left Outer Join includes all the records in which the skillsetID in both 
tables match exactly. The Left Outer Join also includes a row for every record in the 
iSkillsetStat table for which the SkillsetID has no match in the Skillset table.

15. Click Next.
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16. In the Field Selection window, from the Fields list, under the Skillset Formulas heading, 
double-click RCW_SkillsetNameID.

The selected field moves to the Fields Selected list.

17. From the Fields list, under the iSkillsetStat Formulas heading, double-click 
RCW_ApplicationNameID.

18. From the Fields list, under the dSkillsetStat heading, double-click the following fields:

• Timestamp
• Time
• CallsAnswered
• CallsAnsweredAfterThreshold

19. From the Fields list, under the iSkillsetStat Formulas heading, double-click 
RCW_CallsAnsweredBeforeThreshold.

20. From the Fields list, under the Skillset heading, double-click ServiceLevelThreshold.

21. To modify the Selected Field Properties, in the Fields Selected list, click a field.

22. In the Width box, type a new width.

23. Click Next.
24. In the Grouping window, from the Fields list, select the following fields to group by:

• Skillset Formulas: RCW_SkillsetNameID

• iSkillsetStat Formulas: RCW_ApplicationNameID

• dSkillsetStat heading: Timestamp

Each selected field moves from the Fields list to the Group by list.

25. To modify the Group Field Properties, from the Group by list, select a field, and then from 
the Sort Order list, select Descending Order.

26. Click Next.
27. In the Summaries window, from the Fields list, under the dSkillsetStat heading, select 

CallsAnsweredAfterThreshold.

28. From the Summation Type list, select Sum.

This summation type totals all calls answered after the threshold is reached.

29. From the Groups list, select the following check boxes:

• Report Footer
• Group Footer #1
• Group Footer #2
• Group Footer #3

30. Click Add.
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The CallsAnsweredAfterThreshold field, Sum summation type, and the selected report 
sections appear in the Summary Data list.

31. From the Fields list, under the iSkillsetStat Formulas heading, select 
RCW_CallsAnsweredBeforeThreshold.

32. From the Summation Type list, select Sum.

This summation type totals all calls answered before the threshold is reached.

33. From the Groups list, select the following check boxes:

• Report Footer
• Group Footer #1
• Group Footer #2
• Group Footer #3

34. Click Add.

The RCW_CallsAnsweredBeforeThreshold formula, Sum summation type, and the 
selected report sections appear in the Summary Data list.

35. Click Next.
36. In the Report Layout window, double-click the Page Header section.

37. In the Page Header section, click Time.

38. On the Object Properties page, in the Height box, type 80.

With a height of 80 pixels, the full text can print.

39. Select the Bold and Underline check boxes.

40. In the Page Header section, click the next field.

41. On the Object Properties page, in the Title box, change the title.

For example, change CallsAnswered to Calls Answered, and change 
RCW_CallsAnsweredBeforeThreshold to Calls Answered Before Threshold.

42. In the Height box, type 80.

43. Select the Bold and Underline check boxes.

44. Repeat step 40 on page 306 to step 43 on page 306 for the remaining Page Header fields.

45. Double-click the Group Header #1 section.

46. In the Group Header #1 section, click RCW_SkillsetNameID.

47. On the Object Properties page, in the Width box, type 300.

48. Select the Bold check box.

49. Double-click the Group Header #2 section.

50. In the Group Header #2 section, click RCW_ApplicationNameID.
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51. On the Object Properties page, in the Width box, type 300.

52. Select the Bold check box.

53. Double-click the Group Header #3 section.

54. In the Group Header #3 section, click Timestamp.

55. On the Object Properties page, click Remove.

56. Click the Formulas tab.

57. On the Formulas page, under the iSkillsetStat Formulas heading, click 
RCW_Timestamp.

The RCW_Timestamp is a dynamic formula that displays the data range and timestamp 
that you select when you import the report to Historical Reporting. Since this formula 
requires input from Historical Reporting, the results are not exact in the report preview in 
the Report Creation Wizard.

58. Click Add.

The RCW_Timestamp is added to the Group Header #3 section and the Object 
Properties page appears.

59. On the Object Properties page, in the Width box, type 300.

60. Select the Bold check box.

61. On the Object Properties page, select the Bold check box for all fields in the following 
report sections:

• Group Footer #1
• Group Footer #2
• Group Footer #3
• Report Footer

62. On the toolbar, click the Save Report icon.

63. Select the folder in which to save the report.

64. In the Report Name box, type Skillset Threshold.

65. Click Save.

Creating an integrated report
Before you begin

• Start Report Creation Wizard. See Starting Report Creation Wizard on page 294.

About this task
You must create an integrated report to run integrated Contact Summary reports.
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Procedure
1. In the Report Type window, select Create Advanced Report (via ODBC).
2. Select the configured CCMS ODBC DSN.

3. Select the required integrated view.

4. Select view columns and format the report.

5. On the toolbar, click Save Report.
6. On the toolbar, click Import to Historical Reporting.

Saving a report
Before you begin

• Create a report.
• Select at least one field when you create the report.

About this task
Save a report after you modify it.

Procedure
1. On the toolbar, click the Save Report icon.

2. In the Save RCW Report dialog box, choose a folder in which to save the report.

3. In the Report Name box, enter a name for the report.

4. Click Save.

Previewing a report
Before you begin

• Select fields.
• Save the report.

About this task
Click the Preview button to start the Report Viewer.
The Report Viewer supports standard features such as, export, print, and search.

Procedure
1. On the toolbar, click Preview Report.
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2. If the report contains any DateTime fields, the Preview Data filter dialog box appears.

If the report does not contain any DateTime fields, the RCW Report Preview appears.

3. On the Preview Data filter dialog box, select the Start date at and End Date at values.

4. Enter a time in the Start time at and End time at fields.

5. On the Preview Data filter dialog box, click Preview.

The RCW Report Preview appears.

Deleting a report
About this task
Delete a report that you no longer require.

Before you begin
Start Report Creation Wizard. See Starting Report Creation Wizard on page 294.

Procedure
1. On the toolbar, click the Delete RCW Template button.

2. In the Delete RCW Template dialog box, select one or more templates.

3. Click Delete.

Importing a report to Historical reporting
About this task
Before you can run and schedule a Report Creation Wizard report in Contact Center Manager 
Administration, you must save and import the report to Historical reporting. You can use the 
Import tool to import a Report Creation Wizard report into a standard group or into your private 
folder. After you import a Report Creation Wizard report, the system automatically identifies the 
supported data ranges (Interval, Daily, Weekly, and Monthly) during the import procedure.
You can import Report Creation Wizard reports to Contact Center Manager Server only.
Unlike user-imported reports, you need not synchronize Report Creation Wizard reports. After 
you import a Report Creation Wizard report, you can edit the report directly through the Report 
Creation Wizard. After you save the report, all changes are effective immediately.
The procedure to import advanced (ODBC) reports is similar to simplified reports, except for the 
following:

• You must manually enter the supported data ranges for each table referenced in the report.
• You must specify the report type.
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Procedure
1. On the toolbar, click the Import to Historical Reporting icon.

2. In the Import window, in the Report Title box, type the name for the report.

The name appears in Historical Reporting.

3. Click Browse.

4. In the Open RCW Report dialog box, browse to and select the report to import.

5. Click Open.

The Open RCW Report dialog box closes and the path appears in the Location box.

6. From the Time zone list, select the time zone the report uses as the default time zone.

Note:

Avaya recommends that you use the Client Timezone setting. This setting 
automatically adjusts the report interval based on the client time zone.

7. In the Comment box, type additional information about the report.

8. Click the Report Options header.

9. In the Report Options section, select a Report Mode. The options are Standard or 
Private. The Report Mode determines whether the report imports to a standard or private 
folder location.

10. For advanced reports only: From the Report Type list, select a report type.

11. From the Report Group list, select the standard report folder into which you import the 
report. For private reports, you import the report into your private folder.

12. In the Select Server list, select the servers to which to import the report.

13. Click the Data Range header.

14. If you import a simplified report, in the Data Range section, select the Interval Modes for 
which this report is generated, and then proceed to step 18. on page 311

15. If you import an advanced (ODBC) report, from the Table Alias list, select a table.

16. In the Table box, for the data range that matches the selected Table Alias time period, type 
the table name.

17. In the Timestamp box, for the data range that matches the selected Table Alias time 
period, type the name of the field.

For example, if report is based on the iSkillsetStat table alias, the entries for each data 
range appears in the following table:

Interval Mode Table Name Timestamp
Interval iSkillsetStat Timestamp
Daily dSkillsetStat Timestamp

Table continues…
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Interval Mode Table Name Timestamp
Weekly wSkillsetStat Timestamp
Monthly mSkillsetStat Timestamp

18. Click Import.

Example of importing the simplified Agent By Skillset 
Performance report to Historical Reporting

Procedure
1. On the toolbar, click the Import to Historical Reporting icon.

2. In the Import window, click Browse.

3. In the Open RCW Report window, click Agent By Skillset Performance.

4. Click Open.

The Open RCW Report window closes. The information in the Location box appears.

5. In the Report Title box, type Agent By Skillset.

6. From the Time zone list, select the time zone of the server to which to import the report.

Note:

Avaya recommends that you use the Server Timezone default setting. This setting 
automatically adjusts the report interval based on the server time zone.

7. In the Comment box, type additional information about the report.

8. Click the Report Options header.

9. For the Report Mode, select Private.

The Private Report Templates folder is automatically selected as the Report Group.

10. In the Select Server list, select the servers to which to import the report.

The Report Type is automatically selected based on the report definition. This field is 
read-only.

11. Click the Data Range header.

12. In the Data Range section, select all the Interval Mode check boxes to run the report for 
all time frames.

The Table and Timestamp boxes auto-populate based on the report definition and are 
read-only.

13. Click Import.

A message appears at the bottom of the import window stating “Report: Agent By 
Skillset imported successfully.”
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Example of importing the advanced Skillset Threshold report to 
Historical Reporting

Procedure
1. On the toolbar, click the Import to Historical Reporting icon.

2. In the Import window, in the Report Title box, type Skillset Threshold Report.

3. Click Browse.

4. In the Open RCW Report window, browse to the report location for the Skillset Threshold 
report.

5. Click Open.

The Open RCW Report window closes. The information in the Location box populates.

6. From the Time zone list, select the time zone of the server to which to import the report.

Note:

Avaya recommends that you use the Server Time zone default setting. This setting 
automatically adjusts the report interval based on the server time zone.

7. In the Comment box, type additional information about the report.

8. Click the Report Options header.

9. For the Report Type, select HistoricalNodal.
10. From the Select Server list, select the servers to which to import the report.

11. Click the Data Range header.

12. From the Table Alias list, select iSkillsetStat.
13. In the Table and Timestamp boxes, type the following for each Interval Mode.

Interval Mode Table Name Timestamp
Interval iSkillsetStat Timestamp
Daily dSkillsetStat Timestamp
Weekly wSkillsetStat Timestamp
Monthly mSkillsetStat Timestamp

14. Select all the Interval Mode check boxes.

15. Click Import.

A message appears at the bottom of the import window stating “Report: Agent By Skillset 
imported successfully.”
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Defining configuration settings
Before you begin

• Open a saved report in Report Creation Wizard.

About this task
Use the Configuration Settings window to define the default properties for the report.

Procedure
1. On the toolbar, click the Configuration icon.

2. In the Configuration Settings window, in the Report Layout section, select Portrait or 
Landscape.

3. From the Default Font list, select a default font to apply to fields, formulas, labels, or 
added summaries to a report section.

Variable definitions
Variable Definition
Report Layout Page orientation for the report: Portrait or 

Landscape.
Default Font Select a default font to apply to fields, formulas, 

labels, or summaries added to a report section. 
The fonts installed on the Contact Center Manager 
Administration server determine the available fonts.

The previously selected default font still applies to 
objects added before you select the new default 
font. If a font installed on the Contact Center 
Manager Administration server does not appear 
in the font list, it can be because the installed 
font has failed to meet certain requirements. For 
more information, see Troubleshooting Avaya Aura®

Contact Center.

Defining selection criteria
Before you begin

• Import a Report Creation Wizard report to Historical Reporting. See Importing a report to 
Historical reporting on page 309.

• Log on to Historical Reporting.
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About this task
Define selection criteria to determine the entities to include in a report. The following options are 
available when you define a Report Creation Wizard report in Historical Reporting:

• Define the selection criteria.
• Schedule to print the report.
• Schedule to send the report to a file.
• Save the report.
• Run the report immediately.

You define the selection criteria for Report Creation Wizard reports differently than you do for 
user-defined reports.

Procedure
1. In the left pane, click the server under which the Report Creation Wizard report is stored.

2. Navigate to the Report Creation Wizard report.

3. In the Report Properties window, click Selection Criteria.

The Selection Criteria heading expands. The fields of each selected Report Creation 
Wizard table appear in the fields list.

4. From the fields list, select a field.

The table name and the field data type appear in the criteria list.

5. From the criteria list, select one of the following values:

• Is equal to: If you select Is equal to, you can filter the selected field based on only one 
element. You can base the filter on a field from the tables that you include on the report, 
including fields that you did not select on the report.

• Is greater than
• Is less than
• Not equal to
• Between
• In: If you select In, you can filter the selected field based on multiple elements. You can 

base the filter on a field from the tables that you include on the report, including fields 
that you did not select on the report.

• Starts with
• Contains
• Ends with

The field data type determines the values available in the criteria list.

6. Click the ellipsis (...).
7. From the Select Elements dialog box, select a field value.
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If you select In from the criteria list, you can select multiple elements.

8. To select all elements, select the Select All check box.

9. Click Choose.

The Select Elements dialog box closes, and the selected field value appears in field value 
box.

10. Click Add.

The selection criterion appears in the Selection Criteria list.

11. To define additional selection criteria, from the join list, select AND or OR, and then repeat 
step 4 on page 314 to step 10 on page 315.

Moving a field
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard.
• Ensure that you are familiar with the Report Layout Window.

About this task
The column headings in the Page Header section link to the fields in the Details section. If you 
move a field in the Details section, the heading associated with this field moves.

Procedure
1. To move a field, perform one of the following activities:

• Click a field, hold down the left mouse button, and drag to the object.

• Highlight the object and use the up, down, left, and right arrow keys to move the object.

2. Click Save.

Resizing an object
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard.
• Ensure that you are familiar with the Report Layout Window.

About this task
To customize an object, you can modify the object size.
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Procedure
1. To resize an object, perform one of the following activities:

• Move the mouse to the end of the object outline, after the cursor changes to a resize 
cursor, hold down the left mouse button, and drag to increase or decrease the size of 
the object.

• Highlight the object, hold down the Ctrl key and use the left and right arrow keys to 
resize the object.

2. Click Save.

Adding a text field
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard.
• Ensure that you are familiar with the Report Layout Window.

About this task
Add a text field If necessary.

Procedure
1. Click a section in the Report View area.

2. Click the Add Text Object icon on the toolbar.

A new text field is added to the selected section.

Modifying object properties
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard and navigate to 
the Report Layout Window.

• Ensure that you are familiar with the Report Layout Window.

About this task
Use the Object Properties tab in the Report Layout window to modify group, field, or formula 
properties.

Procedure
1. Select a report section.

The selected report section expands to reveal fields and formulas.
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2. Select a field in a section to display the field properties in the properties bar.

The selected field appears with a yellow background.

3. Click the Object Properties tab.

4. Modify object properties.

5. Click Submit to save changes.

The updated field appears in the report view area.

6. Click Save.

Variable definitions
Variable Definition
Title Type the field name. The name appears on the 

report.
Height Type a numeric value for the field height in pixels.
Width Type a numeric value for the field width in pixels.
Left Type a numeric value for the horizontal position 

of the field on the report. The value you enter 
represents the number of pixels from the left margin 
that the field is placed on the report.

Top Type a numeric value for the vertical position of the 
field on the report. The value you enter represents 
the number of pixels from the top margin that the 
field is placed on the report.

Format Select a time or number format. The Format 
property is available only if you select a number, 
currency, Date, or Time data type object.

Currency Select a currency type. The Currency property is 
available only when you select a currency data type 
object.

Font Select a font type. The font type appears on the 
report for the selected field. The fonts installed on 
the Contact Center Manager Administration server 
determine the available fonts.

Note:

If an installed font on the Contact Center 
Manager Administration server does not 
appear in the font list, it can be because 
the installed font has failed to meet certain 
requirements.

Font Color Select the font color to appear on the report for the 
selected field.

Table continues…
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Variable Definition
Font Size Select the font size to appear on the report for the 

selected field.
Text Align Select one of the following: Right, Left, or Center. 

This represents the field text placement within the 
field.

Bold Apply bold to the field text that appears on the 
report.

Italic Italicize the field text that appears on the report.
Underline Underline the field text that appears on the report.
Suppress Suppress or hide the field on the report.

Suppressing a report section
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard.
• Ensure that you are familiar with the Report Layout Window.

About this task
Suppress sections to exclude the sections from the printed report.

Procedure
1. In the Report Layout window, select the section header to suppress.

The selected header appears in a color different from the others.

2. Select the Section Properties tab.

3. On the Section Properties page, select the Suppress check box.

The section header color changes to light grey.

4. Click Save.

Adding or removing a field in a report
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard.
• Ensure that you are familiar with the Report Layout Window.

About this task
In the Fields tab, add fields or remove fields to modify a report.

Report Creation Wizard
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Procedure
1. In the Report Layout window, select the section header to which to add a field.

2. Click the Fields tab.

3. On the Fields page, select the field.

4. To add the field, click Add.

If you add a field to the Details section of the report, the Report Creation Wizard adds 
a corresponding text heading to the Page Header section of the report. If you move that 
field, the heading also moves so that it remains horizontally aligned with the field.

5. To remove the field, click Remove.

Note:

If you remove a field from the Field Selection page, the field is removed only from the 
Details section, not from any other section.

6. Click Save.

Adding or removing a formula in a report
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard.
• Ensure that you are familiar with the Report Layout Window.

About this task
Add formulas or remove formulas to update a report. Formulas appear under the relevant 
headings in the Formulas list. Standard formulas appear under the Formulas heading. 
Formulas relating to views appear under separate headings for each view, for example, 
iAgentPerformanceStat formulas. Report formulas, and formulas that appear on the report and 
have no association with a Report Creation Wizard formula, appear in the Formulas list.
If you add a formula to the Details section of the report, a corresponding text heading appears in 
the Page Header section of the report. If you subsequently move the formula, the heading moves 
so that it remains horizontally aligned with the field. If you remove the field, you automatically 
delete the heading from the Page Header section.

Procedure
1. In the Report Layout window, select the section header to which to add a formula.

2. Click the Formulas tab.

3. On the Formulas page, select the formula.

4. To add the formula, click Add.

5. To remove the formula, click Remove.

Adding or removing a formula in a report
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6. Click Save.

Sorting the direction of a group, field, or formula
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard.
• Ensure that you are familiar with the Report Layout Window.

About this task
Use the Sorting tab to select the sort direction of a returned group, field, and formula data on the 
report.

Procedure
1. In the Report Layout window, click the Sorting tab.

2. To sort the direction of a group, on the Sorting page, click the Groups heading.

3. To sort the direction of a field or formula, click the Fields heading.

4. Select the group, field, or formula for which you want to change sort direction.

5. Select one of the following sort direction options:

• Ascending
• Descending
• Original Order (for Groups) or None (for Fields)

6. Click Save.

Sorting the order of a field or formula
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard.
• Ensure that you are familiar with the Report Layout Window.
• Assign a sort order to the selected field or formula. See Sorting the direction of a group, field, 

or formula on page 320.

About this task
Use the Sorting tab in the Report Layout window to select the sort direction of field and formula 
data on the report.

Procedure
1. In the Report Layout window, click the Sorting tab.

Report Creation Wizard
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2. On the Sorting page, click the Fields heading.

The heading expands to reveal selected fields and formulas for the report.

3. Click the field or formula for which you want to change the sort order.

4. Use the up and down arrows to change the sort order for the selected field or formula.

Group sorts always appear first, followed by field and formula sorts.

5. Click Save.

Editing a Report Creation Wizard report in Historical 
reporting

Before you begin
• Create a report in Report Creation Wizard. See Creating a simplified report on page 295 or 

Creating an advanced report on page 301.
• Import the report to Historical reporting. See Importing a report to Historical reporting on 

page 309.
• Log on to Historical Reporting.

About this task
To modify a saved Report Creation Wizard report, access Historical reporting.

Procedure
1. In the left pane, click the server to which you want to log on.

2. Navigate to the folder in which the Report Creation Wizard report to edit is stored.

The report icon for a Report Creation Wizard report is different from the report icon for a 
standard report.

3. Right-click the report, and then click Edit.

The report appears in Report Creation Wizard in the Report Layout window. All buttons in 
the navigation bar and the toolbar are enabled.

4. Edit the report.

5. On the toolbar, click Save.

All changes are effective immediately.

Editing a Report Creation Wizard report in Historical reporting
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Applying template changes to existing reports
Before you begin

• Log on to Report Creation Wizard. See Starting Report Creation Wizard on page 294.

About this task
Existing reports do not automatically receive the changes you make to report templates; therefore, 
you must apply the template to each report.

Procedure
1. Open the report in Report Creation Wizard.

2. Click the Configuration icon.

3. Change the Report Layout.

If the current setting is Landscape, change it to Portrait. If the current setting is Portrait, 
change it to Landscape.

4. Click Close.

5. Click the Configuration icon.

6. Change the Report Layout back to the original setting.

7. Click Close.

8. Click the Preview icon to confirm that the applied changes.

9. Click Save.

Report Creation Wizard
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Chapter 47: Access and Partition 
Management fundamentals

You can use the Access and Partition Management component to create Contact Center Manager 
Administration users and to assign to users appropriate access privileges to the system. CCMA 
users can log on and use the CCMA components to which they have access. You can control 
user access privileges by assigning Launchpad options, access classes, and partitions, including 
reporting agent combinations.

You can use Access and Partition Management to add, edit, view, or delete:

• access classes

• report groups (you cannot edit report groups)

• standard partitions

• user-defined partitions

• Contact Center Manager Administration users

• Ensure the host name of the Contact Center Manager Server can be resolved to an IP 
address.

• Under User Details > Partitions > Standard and Reporting Agents, select Configure for the 
added Contact Center Manager Server. Click Submit to add the user details.
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Chapter 48: Access classes

You can use access classes to control the actions that users can perform in the Contact Center 
Management, Real-Time Reporting, Historical Reporting, Prompt Management, Configuration, 
Scripting, and Access and Partition Management components.

Creating an access class
Before you begin

• Log on to CCMA.
• Open the Access and Partition Management component.
• Ensure that you know what access levels you want to assign to users.

About this task
Create an access class to control the actions that the user can perform in the following Contact 
Center Manager Administration components:

• Contact Center Management
• Configuration
• Historical Reporting
• Real-Time Reporting
• Scripting
• Access and Partition Management (under the default Administration server)
• Prompt Management

Access classes do not apply to the Audit Trail, Outbound, or Multimedia components. To perform 
functions in these components, users require only Launchpad option rights to the components.

Procedure
1. On the menu, choose Add > New Access Class.

2. In the New Access Class window, in the New Access Class Name box, type the name of 
the new access class.

Use a descriptive name for the user type having this access level, or the type of privileges 
available at this access level.
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3. Click Submit.
4. In the left pane, click the new access class.

5. Click the CC server.

The server access class elements appear in the Access Class Properties window.

6. From the list of access class elements, select the access levels for the elements that you 
want to make available to this access class.

7. Click Submit to save your choices on the server.

Editing an access class
Before you begin

• Log on to CCMA.
• Open the Access and Partition Management component.

About this task
Edit an access class to change any configured access class property except the access class 
name. To change the access class name, you must delete the access class and create a new 
access class with a new name.

Procedure
1. On the menu, choose View/Edit > Access Classes.

2. In the left pane, click the access class to edit.

3. In the left pane, click the CC server.

4. In the right pane, from the list of access class elements, select the access levels for the 
elements to make available to this access class.

5. Click Submit to save your changes.

Assigning an access class to a user
Before you begin

• Log on to CCMA.
• Open the Access and Partition Management component.

About this task
For each component controlled by access classes, you must assign at least one access privilege 
to the user, or the user cannot work in the component.

Editing an access class
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If the user has basic access to Contact Center Management, you must assign the user an access 
class that includes CCM access, Skillset Assignment access, or Supervisor Assignment access. If 
you assign the user an access class without at least one of these privileges, then the user cannot 
work in Contact Center Management.
If the user has basic access to Historical Reporting, you must assign the user an access class 
that includes either Run and Import access or Report Creation access. If you assign the user 
an access class without either of these access levels, then the user cannot work in Historical 
Reporting.
If the user has basic access to Real-Time Reporting, you must assign the user an access class 
that includes either Launch access, Create Private access or Create Public access for either the 
tabular or graphical displays (or both). If you assign the user an access class without at least one 
of these access levels, then the user cannot work in Real-Time Reporting.
If the user has basic access to Configuration, you must assign the user an access class to the 
user that includes at least one of the Configuration access class elements, such as skillsets. If you 
assign the user an access class without at least one of these privileges, the user cannot work in 
Configuration.
If the user has basic access to Scripting, you must assign the user an access class that includes 
privileges in at least one of the following Scripting components: Scripts, Script Variables, or 
Application Thresholds.
If you assign the user an access class without privileges in at least one of these components on at 
least one server, the user cannot work in Scripting.
If the user has basic access to Prompt Management, you must assign the user an access class 
that includes at least one of the Prompt Management access class elements, such as Read 
Update Create/Delete or Read and Update. If you assign the user an access class without at least 
one of these privileges, the user cannot work in Prompt Management.
If you assign a user to multiple access classes, Contact Center grants the highest level of access 
from the combined access classes to the user.

Procedure
1. On the menu, choose View/Edit > User Administration.

2. Select the user for whom you want to assign an access class.

3. Click the Access Classes heading.

The list of configured access classes appears.

4. Select the check box for each access classes to assign to the user.

5. To assign all access classes, select the Select All check box.

6. To remove all access classes from the user, clear the Select All check box.

7. Click Submit to save your changes.

Access classes
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Viewing the users assigned to an access class
Before you begin

• Log on to CCMA.
• Open the Access and Partition Management component.

About this task
View the users assigned to an access class to see a list of Contact Center Manager 
Administration users assigned to the access class and access and partition details for each user.
This information is read-only; you cannot assign or unassign access classes in this window. For 
information about assigning and unassigning access classes, see Assigning an access class to a 
user on page 325.

Procedure
1. On the menu, choose View/Edit > Access Classes.

2. In the left pane, select the access class to view the list of assigned users.

3. In the Access Class Members window, click the Members heading.

The list of users currently assigned to the access class appears in a table.

4. To sort the list of access class members alphabetically, click the Members Name heading.

5. To view the access and partition details for a user, click the user.

Deleting an access class
Before you begin

• Ensure that the access class has no members or that the existing members of the access 
class no longer require its access privileges.

• Log on to CCMA.
• Open the Access and Partition Management component.

About this task
Delete an access class to remove it from Contact Center Manager Administration.

Procedure
1. On the menu, choose View/Edit > Access Classes.

2. In the left pane, right-click the access class to delete, and then click Delete.

3. In the message box that appears asking you to confirm your choice, click Yes.

Viewing the users assigned to an access class
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Chapter 49: Report groups

Two categories of report groups are available in Historical Reporting:

• Public report groups—These report groups contain the standard public report templates. The 
seven public report groups are:

- Agent Performance
- Call-by-Call
- Configuration
- Contact Summary
- Multimedia
- Others
- Outbound

• User-defined report groups—These report groups contain the report templates that users 
belonging to the group customized and want to share with other members of the report 
group. The user-defined report groups that you create in this window are for use in Historical 
Reporting. You can assign any unique name to these groups.

Public report groups versus user-defined report groups
Unlike the public report groups that contain all of the standard templates, user-defined report 
groups contain no standard templates. The user-defined report groups that you create in Access 
and Partition Management are folders for Historical Reporting users who belong to the same 
group to share their customized reports. Users can customize a standard template and save it in 
their group folder so that other group members can use the same custom report.

You can create user-defined report groups to reflect each department in your Contact Center, 
such as the Sales Group or the Marketing Group. If you configure a shared Contact Center, you 
can also create separate groups for each company sharing the Contact Center, such as the Best 
Air Group and the Econo Air Group. In this way, you can keep customized reports that contain 
company information separate from other companies in the same Contact Center.

The data shown in each report is based on the partitions assigned to the user and the selection 
criteria the user applies to the report.

You can use report groups to grant a user access to a very limited number of reports. For 
example, if you do not want to give a user access to any of the standard report templates, you can 
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create a user-defined report group and add it to the partition assigned to the user. When the user 
opens Historical Reporting, they see only the user-defined report group folder, and can only see 
reports that other members of the group saved in the group folder.

After you create a report group, you can add it to a partition created under the same server as the 
report group. Then you can assign the partition to the users belonging to the report group. When 
these users log on to Contact Center Manager Administration, they see the report group name in 
Historical Reporting under the server where you created it.

Assign standard report groups to a user in the same way as standard partitions. There is no 
requirement to create and maintain a user-defined partition. The standard partition “All User 
Defined Report Groups” can also be assigned to a user on a per-sever basis. This allows the user 
access to any user-defined report groups created on that server.

Creating a report group
Before you begin

• Log on to CCMA.
• Open the Access and Partition Management component.

About this task
Create a report group to create a custom group to reflect a specific department in the Contact 
Center, such as the Sales Group or the Marketing Group. You can also create separate groups 
for each company sharing the Contact Center. In this way, custom reports that contain company 
information can be kept separate from other companies in the same Contact Center.
You can use report groups to grant a user access to a limited number of reports. For example, if 
you do not want to grant a user access to any standard report templates, you can create a custom 
report group and add it to the partition assigned to the user. When the user opens Historical 
Reporting, the user sees only the custom report group folder. The user can see reports only that 
other members of the group save in the report group folder.
After you create a report group, you must add it to a partition created under the same server as 
the report group. Then you must assign the partition to the users belonging to the report group. 
When these users log on to Contact Center Manager Administration, they see the report group 
name in Historical Reporting under the server where you created it.

Procedure
1. On the menu, choose Add > New Report Group.

2. In the Report Group Properties window, in the Report group name box, type the name of 
the new report group.

Use a descriptive, unique name for the user types assigned to this group or the company, 
or the department the group represents.

3. From the Create the group under server list, select the CC server.

4. Click Submit to save the report group.

Creating a report group
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5. Add the report group to a partition.

Deleting a report group
Before you begin

• Log on to CCMA.
• Open the Access and Partition Management component.

About this task
Delete a report group to remove a custom report group from Contact Center Manager 
Administration. You cannot delete any of the standard report groups included with Contact Center 
Manager Administration. However, you can delete the custom report groups that you create in 
Access and Partition Management.

Procedure
1. On the menu, choose View/Edit > Report Groups.

Important:

When you delete a report group, you delete all reports that users saved in it. 
Therefore, before you delete a custom report group, ensure that users who belong 
to the group do not require any of the custom reports that they saved in the group 
folder.

2. In the left pane, click the server containing the custom report group to delete.

The list of report groups appears.

3. Click the report group to delete.

4. In the Report Group Properties window, click Delete.

5. In the message box that appears asking you to confirm your choice, click Yes.

The report group and all saved reports are deleted.

Report groups

April 2024 Administering Avaya Contact Center Select 330
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AdministeringAvayaContactCenterSelect&p3=33


Chapter 50: Standard partitions and 
reporting agents

Partitions restrict the data that users can view in the following components of Contact Center 
Manager Administration:

• Historical Reporting

• Real-Time Reporting

• Contact Center Management

• Scripting

• Prompt Management

Note:

Partitioning applies to script variables within the Scripting component of CCMA; however, 
partitioning does not apply to Orchestration Designer.

An administrator can use the following ways to partition the data that users see:

• Full data across all servers—When an administrator first creates a user, the user is assigned 
the Full Data Across All Servers option by default so the user can view all data on the Contact 
Center server.

• Server rights—An administrator can assign a user access to all data or no data on the 
server. To configure standard partitions and reporting agents on the Contact Center server, 
an administrator must assign the Configure option on the server.

Standard partitions (this includes report groups)—A Standard partition contains all data of a 
particular type on the server. The administrator can assign all data on a per-component basis 
(only among those components to which the user is granted basic access). For example, the 
administrator can choose to grant the user access to All agents and All skillsets in both Contact 
Center Management and Real-Time Reporting on the Contact Center server. The administrator can 
choose from:

• All Agents & Supervisors

• All Skillsets

• All Applications

• All CDNs (Route Points)

• All DNISs
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• All Prompts

• All Script Variables

• All User Defined Report Groups

• All standard reports that are shipped with the software and selected components

Standard partitions are dynamic, which means that anytime a new data element is added to the 
system, it is automatically available to the Contact Center Manager Administration user. In this 
regard, Standard partitions are similar to Reporting Agents. Standard partitions can be assigned on 
a per-component basis. For example, the administrator can assign the All Skillsets partition to the 
Real-Time Reporting component only.

To assign a user a Standard partition, under Partitions, click the Standard & Reporting Agents 
heading, select the Standards tab, select the Configure option for the server and then select the 
server from the Configure Server list.

It is possible to assign Standard partitions by component:

• CCM—Contact Center Management

• RTR—Real-Time Reporting

• HR—Historical Reporting

• SCR—Scripting Component

• PTM—Prompt Management

In the following example, all agents and supervisors and all skillsets are assigned to the Contact 
Center Management and Real-Time Reporting components while only all CDNs (Route Points) are 
assigned to the Historical Reporting component.

Reporting agents
Use the Reporting Agent feature to dynamically link supervisors and all their reporting agents 
with one or more Contact Center Manager Administration users, thereby enabling the users to 
view the agents in Contact Center Manager Administration components, such as Real-Time and 
Historical Reporting, and Contact Center Management. You assign Supervisor/Reporting agent 
combinations to Contact Center Manager Administration users by using the Reporting Agents tab 
in the Standard & Reporting Agents section in the User Properties window of Access and Partition 
Management.

User types
It is important to know the difference between a Contact Center Manager Server user and a 
Contact Center Manager Administration user.

Standard partitions and reporting agents
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User type User definition Created in
Contact Center Manager 
Server user

agents, supervisor/agents Contact Center 
Management or the 
Configuration Tool

Contact Center Manager 
Administration user

anyone who logs on to Contact Center Manager 
Administration and monitors the performance and 
activities of Contact Center Manager Server using 
Contact Center Manager Administration; this user can 
be a supervisor user or an administrator user

Access and Partition 
Management

After you create a supervisor/agent Contact Center Manager Server user profile in Contact Center 
Management (or Configuration Tool), you must enable the supervisor/agent to log on to Contact 
Center Manager Administration. Therefore, you must also configure a Contact Center Manager 
Administration user profile for this supervisor/agent.

Users
Supervisors who do not need to use Contact Center Manager Administration do not need a 
Contact Center Manager Administration user profile; these supervisors require only a Contact 
Center Manager Server user profile.

When you configure the supervisor/agents Contact Center Manager Administration user profile, 
you can create a link between two user profiles (the Contact Center Manager Administration user 
profile and the supervisor's Contact Center Manager Server user profile) by using the Supervisors 
tab in the Standard & Reporting Agents area of the Partitions section in Access and Partition 
Management. Each name on the Supervisors tab represents a supervisor and all of their reporting 
agents by server. Therefore, when you link a supervisor's name with a Contact Center Manager 
Administration user, the user can automatically see all the supervisor's reporting agents.

This association is dynamic, meaning that each time a new agent is assigned to the supervisor, 
the agent is automatically associated with the supervisor's Contact Center Manager Administration 
user profile.

Use this feature to set up supervisors so they can view all of their own reporting agents, or you 
can enable one supervisor to see all the reporting agents of another supervisor. The following 
shows how to configure Reporting agents in Access and Partition Management.

Reporting agents and standard partition example
The company Best Air has two sales departments, Europe and Canada. The two corresponding 
supervisors for each department are Andrew Engel and Liz Matthews. The administrator creates 

Users
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two new Contact Center Manager Administration users for the two supervisors and assigns them 
both the following standard partitions on the server:

• Contact Center Management—All Skillsets

• Real-Time Reporting—All Skillsets

• Historical Reporting—All standard report groups, all CDNs (Route Points), and all DNISs

The administrator assigned this reporting agent configuration for all available components: 
Contact Center Management, Real-Time Reporting and Historical Reporting. Additionally, each 
User profile is assigned as a Supervisor/Reporting Agent.

Result in real-time reporting
In Real-Time Reporting (including Filters), Andrew can use all skillsets as he is assigned the All 
Skillsets standard partition for this component. He can also see any agents reporting to him as he 
is configured with the supervisor “Andrew Engel” for all components.

Result in historical reporting
In Historical Reporting, Andrew can use all CDNs (Route Points) and DNISs as these standard 
partitions are assigned to his user properties. He can also use all agents reporting to him. This is 
true for both selection criteria and filters.

Andrew can also see all of the standard report groups as these are included in his Standard 
partition configuration.

Result in Contact Center Management
Andrew has access to all skillsets and only the agents that are assigned to him. In the Supervisors 
view, only one supervisor (himself) is displayed.

For Andrew Engel to view all of Liz's reporting agents, include Liz Matthews in Andrew's user 
profile (in the Reporting Agents Tab). The administrator can also specify the components to 
make available to these agents. If only a subset of these agents is required, you can create a 
user-defined partition and assign it to Andrew's properties. Assigning user-defined partitions is 
covered in the next section.

Assigning a standard partition to a user
Before you begin

• Log on to CCMA.
• Open the Access and Partition Management component.
• Create a Contact Center Manager Administration user.

Standard partitions and reporting agents
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About this task
You can use partitions to restrict the data that users can view in the real-time displays, historical 
reports, Contact Center Management, Scripting, and Prompt Management. You can assign 
standard and user-defined partitions to users in Contact Center Manager Administration. Choose 
the type that best suits your organization, or choose a combination of both types.
Use standard partitions to assign all data of a particular type to the user on a per-component 
basis. For example, you grant the user access to all agents and all skillsets in both Contact Center 
Management and Real-Time Reporting on the Contact Center server.

Procedure
1. On the menu, choose View/Edit > User Administration.

2. In the left pane, select the user to whom you want to assign a Standard Partition.

3. In the right plane, click the Partitions heading to assign partitions to the user.

The heading expands to reveal a series of choices.

4. Clear the Full Data Across All Servers check box.

5. Click the Standard & Reporting Agents heading.

6. In the Standard & Reporting Agents area, select one of the following options for the 
Contact Center server:

• No Data—Select this option if you do not want the user to see any data on the Contact 
Center server.

• All Data—Select this option if you want the user to see all configured data on the 
Contact Center server.

• Configure—Select this option if you want to specify the data that the user can see, and 
then proceed to the next step.

7. From the Configure Server list, select the CC server.

8. Select the Standard tab.

9. On the Standard page, select one or more of the following standard partitions:

• All Agents & Supervisors

• All Applications

• All CDNs (Route Points)

• All DNIS

• All Prompts

• All Script Variables

• All Skillsets

• All User Defined Report Groups

• Standard Agent Performance Reports
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• Standard Call by Call Reports

• Standard Configuration Reports

• Standard Contact Summary Reports

• Standard Multimedia Reports

• Standard Other Reports

• Standard Outbound Reports

Only Contact Center Management, Real-Time Reporting, Historical Reporting, Scripting, 
and Prompt Management are applicable to partitions.

If the check box for a standard partition is disabled under one of the component 
headings, then this partition is not applicable for this component. For example, 
applications are not applicable to Contact Center Management so the All Applications 
standard partition is disabled for this component.

10. Click Submit to save your changes.

Viewing the users assigned to a partition
Before you begin

• Log on to CCMA.
• Open the Access and Partition Management component.

About this task
View the users assigned to a partition to see a list of Contact Center Manager Administration 
users assigned to the currently selected partition.
This information is read-only; you cannot assign or remove partitions in this window.

Procedure
1. On the menu, choose View/Edit > User Defined Partitions.

2. In the left pane, select the partition for which you want to view the list of assigned users.

3. In the Partition Members window, click the Members heading.

The list of users currently assigned to the partition appears in a table.

4. To sort the list of partition members alphabetically, click the Members Name heading.

5. To view the access and partition details for a user, click the user.
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Editing user properties
Before you begin

• Log on to CCMA.
• Open the Access and Partition Management component.

About this task
Edit user properties to change properties such as the password, last name, and first name after 
you added the user to the database.
You cannot change a user name. Instead, you must delete the user and create a new user with 
the new user name.

Note:
You cannot change certain Administrator user properties, or delete the Administrator user.

Procedure
1. On the menu, choose View/Edit > User Administration.

A list of configured users appears.

2. In the left pane, click the user whose properties you want to edit.

3. On the User Properties window, in the appropriate boxes, edit the following information 
about the user:

• Password

• Last name

• First name

4. Click the Access Classes heading to review the access classes assigned to the user.

5. To change the user's Launchpad Options, select or remove any of the following:

• Access and Partition Management

• Real-Time Reporting

• Historical Reporting

• Configuration

• Contact Center Management

• Scripting

• Emergency Help

• Audit Trail

• Outbound

• Multimedia

• Prompt Management
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6. Click the Partitions heading to review the current partitions assigned to the user. The 
heading expands to reveal a series of choices.

7. To grant the user full access to all data on the Contact Center server, select the Full Data 
Across All Servers check box.

OR

To refine the data that the user can see, clear the Full Data Across All Servers check 
box, and then proceed to the next step.

8. To review the standard partitions and supervisor/reporting agent combinations assigned to 
the user, click the Standard & Reporting Agents heading.

OR

If you do not want to make any changes to this area, proceed to step 16.

9. In the first table, there are three choices. You can choose a combination of all three. Select 
the option at the top of the table to make the same choice for all servers listed.

10. Select the No Data option for each server on which you do not want the user to see any 
data.

11. Select the All Data option for each server on which you want the user to see all 
configured data.

12. Select the Configure option for each server on which you want to specify the data that the 
user can see, and then proceed to the next step.

13. If you select the Configure option, from the Configure Server list, select the CC server.

14. To select standard partitions on the current server, select the check box for each item 
that you want the user to see in the applicable Contact Center Manager Administration 
component. You can choose from the following standard partitions:

• All Agents & Supervisors

• All Skillsets

• All Applications

• All CDNs (Route Points)

• All DNIS

• All Prompts

• All Script Variables

• All User Defined Report Groups

• Standard Agent Performance Reports

• Standard Call by Call Reports

• Standard Configuration Reports

• Standard Contact Summary Reports
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• Standard Multimedia Reports

• Standard Other Reports

• Standard Outbound Reports

Important:

Only Contact Center Management (CCM), Real-Time Reporting (RTR), Historical 
Reporting (HR), Scripting (SCR), and Prompt Management (PTM) are applicable to 
partitions. When you select the PTM check box, the current user gains access to all 
the prompts for that server in the Prompt Management component.

15. To review the supervisor/reporting agents currently assigned to the user, click the 
Reporting Agents tab.

The table lists all the supervisors configured on the currently selected server.

Each supervisor name represents the supervisor and all their reporting agents.

16. To grant the current user access to the supervisor's reporting agents in the components 
that you select, select the check box for each supervisor.

OR

To select all supervisors in a particular component, select the check box for that 
component.

17. To review the user-defined partitions assigned to the user, click the User Defined heading.

The heading expands to reveal the list of User Defined partitions configured on the Contact 
Center server.

18. Under the applicable components, select the check box for each partition to assign to the 
user.

OR

To select all partitions across a component, select the check box for that component.

19. Click Submit to save your changes.

Removing a partition from a user
Before you begin

• Log on to CCMA.
• Open the Access and Partition Management component.
• Before you remove a partition, ensure that the user does not need access to any of the 

partition properties.
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About this task
When you remove a partition from a user, the user can no longer view the partitioned data in the 
real-time displays, historical reports, in Contact Center Management, or in Prompt Management.

Procedure
1. On the menu, choose View/Edit > User Administration.

2. In the left pane, select the user whose properties you want to edit.

3. In the User Properties window, click the Partitions heading.

4. To remove a standard partition from a user, click the Standard & Reporting Agents 
heading.

5. On the Standard tab, locate the partition to unassign, and clear the check box.

You can assign or remove a standard partition based on a component (Contact 
Center Management, Historical Reporting, Real Time Reporting, Scripting, and Prompt 
Management).

6. To remove a User Defined partition, click the User Defined heading.

7. Locate the User Defined partition to unassign, and then clear the check box.

You can assign or remove a User Defined partition based on a component (Contact 
Center Management, Historical Reporting, Real Time Reporting, Scripting, and Prompt 
Management).

8. Click Submit to save your changes.
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Chapter 51: User-defined partitions

User-defined partitions are useful to restrict a user access to a specific list of data. You can use 
user-defined partitions in conjunction with standard partitions and reporting agents.

Important:

To improve performance, use standard partitions and reporting agents instead of user-defined 
partitions.

Use standard partitions in preference to user-defined partitions that contain all of a particular 
element, for example, All agents or All CDNs (Route Points) on a particular server. You can 
configure standard partitions in the user properties window. Standard partitions require no 
maintenance when you add new elements to the Contact Center Manager Server. Use user-defined 
partitions only if a specific set of data is required for the user.

When you edit user-defined partitions, note that the greater the number of users assigned to the 
partition that you edit, the greater your performance hit, particularly if these users have Real-Time 
Reporting filters configured.

Avaya recommends that you:

• Keep the amount of data included in each partition as minimal as possible because small 
partitions lead to more efficient application response time.

• Configure and assign your partitions according to your company internal departmental 
organization, granting users access only to the data that they regularly need to see.

• Use standard partitions where possible.

Partition properties
When you create a partition, you can specify the following types of data:

• agents

• skillsets

• report groups

• applications

• CDNs (Route Points)

April 2024 Administering Avaya Contact Center Select 341
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AdministeringAvayaContactCenterSelect&p3=33


• DNISs
• script variables
• prompts

When you assign a partition that contains all eight types of data to a user, the user sees either 
all data types in the partition, or a fraction of them, depending on the component to which the 
partition is assigned. The Contact Center Manager Administration components are each designed 
so users can work with particular types of data. For example, Contact Center Management is used 
strictly to configure and manage Contact Center supervisors and agents, and to assign agents 
to skillsets; therefore, the only partition elements that appear in Contact Center Management are 
agents and skillsets. If you configure for a user a combination of user-defined partitions, standard 
partitions and reporting agents, then the user sees the union of this data when using Contact 
Center Manager Administration components.

If you do not include certain types of data in a user's partition, then the user does not see this 
data. For example, if you do not include CDNs (Route Points) in the user's partition, then the user 
sees no CDNs (Route Points) in Historical Reporting.

A partition can contain any combination of the eight elements, but it does not have to contain all 
elements. For example, it can contain only skillsets and agents, but not CDNs (Route Points), 
applications, or report groups.

After you create the partition, you can select it in the user properties window, in the User Defined 
area of the Partitions section.

Partitions and your Contact Center
User-defined partitions are especially useful when competing companies share the same Contact 
Center. In the following example, the two companies that share the Contact Center are Best Air 
and Econo Air.

To grant users access to data pertaining only to their company, administrators can create 
partitions within the Contact Center and assign the partitions to different users, thereby restricting 
each user's view of the Contact Center data.

For example, there are 18 skillsets configured in Contact Center Manager Administration. Ten 
skillsets apply to agents answering calls for Best Air, while the remaining eight skillsets apply 
to agents answering calls for Econo Air. To divide the Contact Center so that supervisors see 
only the contact activity applicable to their company, the Contact Center administrator creates the 
following two partitions:

• The first partition contains the 10 Best Air skillsets and the agents that answer these calls.
• The second partition contains the 8 Econo Air skillsets and the agents that answer these 

calls.

After creating these partitions, the Contact Center administrator assigns them to the appropriate 
supervisors. When the supervisors view the Real-Time Reporting displays or the historical reports, 
they see only those elements in the partitions to which they belong.

Partitions can restrict only one element at a time. For example, when a user runs a Skillset by 
Agent Performance report, they can choose to view agents from among those in their partition 
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configurations. However, sometimes an agent in the user's partition configuration is assigned to 
a skillset that is outside the user's partition configuration. If a contact is routed to an agent for 
a skillset that is not in the user's partition configuration, then the call statistic (and possibly the 
skillset details) appear in the Skillset by Agent Performance report.

Partitions are also useful if you want to separate your Contact Center into different departments 
within the same company. For example, the administrator can create separate partitions for the 
Sales and Marketing departments, and assign each partition to supervisors working in each 
department.

When creating and assigning user-defined partitions, note that the following factors increase the 
performance hit for the users to whom you assign the partitions when they connect to Contact 
Center Manager Administration:

• The greater the amount of data that you include in each partition, the greater the 
performance hit.

• The more partitions you assign to users, the greater the performance hit.

Avaya recommends that you configure and assign your partitions according to your company 
internal departmental organization, granting users access only to the data that regularly need to 
see. Additionally, Avaya recommends that you use standard partitions whenever possible.

Creating a user-defined partition
Before you begin

• Log on to CCMA.
• Open the Access and Partition Management component.
• Create report groups.

About this task
User-defined partitions are different from the Standard partitions that come with Contact Center 
Manager Administration in that you specify certain types of data on the Contact Center server. 
For example, you can specify seven agents and two skillsets on the server. Standard partitions, 
however, include all of a certain type of data on the Contact Center server in particular 
components. For example, All Agents & Supervisors and All Skillsets on the Contact Center server 
in both real-time reporting and historical reporting.

Procedure
1. On the menu, choose Add > New User Defined Partition.

2. In the New Partition window, in the New Partition Name box, type the name of the new 
partition.

3. Click Submit.

The user-defined partition appears in the left pane.
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4. In the left pane, select the new user-defined partition.

The partition name expands to reveal the CC server.

5. Click the CC server.

The server partition elements appear in the partition properties window as a series of tabs.

6. To add agents to the partition, click the Agents tab.

Important:

If a large number of agents are configured on the server, when you click the Agents 
tab, wait a few moments while the system retrieves the agent data.

7. On the Agents page, click the Assign Agents heading. You can search for agents by 
name, supervisor, or by skillset.

8. To list all agents, click List All.
9. Select the check box for each agent to add to the partition.

10. To add skillsets, click the Skillset tab.

11. On the Skillset page, click the Assign Skillsets heading.

12. Search for skillsets or click List All.
13. Select the check box for each skillset to add to the partition.

14. To add report groups, click the Report Groups tab.

15. On the Report Groups page, select the check box for each report group to add to the 
partition.

16. To add applications, click the Applications tab.

17. On the Applications page, select the check box for each application to add to the partition.

18. To add CDNs (Route Points), click the CDNs (Route Points) tab.

19. On CDNs (Route Points) page, select the check box for each CDN (Route Point) to add to 
the partition.

20. To add DNISs, click the DNISs tab.

21. On the DNISs page, select the check box for each DNIS to add to the partition.

22. To add script variables to a partition, click the Script Variables tab.

23. On the Script Variables page, click the Assign Script Variables heading. You can search 
for script variables by name or type.

24. To list all script variables, click List All.
25. Select the check box for each script variable to add to the partition.

26. To add prompts to a partition, click the Prompts tab.

27. Select the check box for each prompt to add to the partition.
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28. Click Submit to save your changes.

Variable definitions
Name Description
Agents tab When you click this tab, two sections appear. The 

first section displays the agents included in the 
partition and in the second section you can search 
for agents to add to the partition. Select the check 
boxes beside the agents you want to include; clear 
the check boxes beside the agents you do not want 
to include.

Skillsets tab When you click this tab, two sections appear. 
The first section displays the skillsets included in 
the partition, and the second section displays the 
available skillsets to add to the partition. In the 
table of available skillsets, select the check boxes 
beside the skillsets to add to the partition, or select 
the Select All check box to add all skillsets to 
the partition. To remove a skillset currently in the 
partition, clear the check box beside the skillset, 
and then click Submit.

Report Groups, CDN (Route Points), DNISs, 
Applications tabs

When you click these tabs, a table appears from 
which you can select the items to add to the 
partition by selecting the check boxes beside the 
item. In each table, you can select the Select All 
check box to select all items in the table. To remove 
any items currently in the partition, clear the check 
box beside the item, and then click Submit.

Script Variables tab When you click this tab, two sections appear. 
The Assigned section displays all script variables 
assigned to this partition. In the Assign section, you 
can search for script variables by name or type. 
You can also list all script variables. Use the check 
boxes to determine which variables are included.

Prompts Tab When you click the Prompts tab, the system 
displays a table from which you can select the 
prompts to add to the partition by selecting the 
check box beside the prompt. You can select the 
Select All check box to select all prompts in 
the table. To remove any prompt currently in the 
partition, clear the check box beside the prompt. 
You can sort the prompts by Prompt Name. Once 
you have completed making your changes, click 
Submit to save your changes.
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Editing a user-defined partition
Before you begin

• Log on to CCMA.
• Open the Access and Partition Management component.
• Create a user-defined partition.

About this task
Edit a user-defined partition to add new elements, remove elements, or add new servers to the 
partition.

Procedure
1. On the menu, choose View/Edit > User Defined Partitions.

2. In the left pane, click the partition to edit.

The partition name expands to reveal the CC server.

3. Click the CC server.

4. In the Partition Properties window, click the tabs containing the elements to add to or 
remove from the partition.

5. To add an element, on the relevant page, select the check box for that element.

6. To remove an element, on the relevant page, clear the check box for that element.

7. Click Submit to save your changes.

Assigning a user-defined partition to a user
Before you begin

• Log on to CCMA.
• Open the Access and Partition Management component.
• Create at least one user-defined partition.
• Create at least one Contact Center Manager Administration user.

About this task
You can use partitions to restrict the data that users can view in the real-time displays, historical 
reports, and Contact Center Management. You can assign standard and user-defined partitions 
to users in Contact Center Manager Administration. Choose the type that best suits your 
organization, or choose a combination of both types.
User-defined partitions are different from the Standard partitions that come with Contact Center 
Manager Administration in that you specify certain types of data on the Contact Center server. 
For example, you can specify seven agents and two skillsets on the server. Standard partitions, 
however, include all of a certain type of data on the Contact Center server in particular 
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components. For example, All Agents & Supervisors and All Skillsets on the Contact Center server 
in both Real-Time Reporting and Historical Reporting.

Procedure
1. On the menu, choose View/Edit > User Administration.

2. In the left pane, select the user to whom you want to assign a user-defined partition.

3. In the User Properties window, click the Partitions heading.

4. Clear the Full Data Across All Servers check box.

5. Click the User Defined heading.

The heading expands to reveal the list of user-defined partitions configured.

6. For each component, select each partition to assign to the user.

OR

To select all user-defined partitions for Contact Center Management, Real-Time Reporting, 
Historical Reporting, Scripting, or Prompt Management, select the CCM, RTR, HR, SCR, 
or PTM check boxes, respectively.

7. To list all current members assigned to this partition, click the partition name.

8. Click Submit to save your changes.

Deleting a user-defined partition
Before you begin

• Log on to CCMA.
• Open the Access and Partition Management component.
• Before you delete a user-defined partition, verify that it is not assigned to users who need to 

view the partitioned data.

About this task
Complete this procedure to delete a user-defined partition.

Procedure
1. On the menu, choose View/Edit > User Defined Partitions.

2. In the left pane, right-click the user-defined partition, and then click Delete.

3. In the message box that appears asking you to confirm your choice, click Yes.
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Chapter 52: Contact Center Manager 
Administration users

These are the users who log on to Contact Center Manager Administration.

When you define Contact Center Manager Administration users, you assign to them:

• basic access to the appropriate components within the Launchpad Options section of Contact 
Center Manager Administration.

• access classes that control the actions they can perform in these components. You can view 
the Access Classes that you create in the Access Classes section.

• partitions and supervisor/reporting agent combinations that control the data they can see in 
these components. You can view the standard partitions and the list of all supervisors who are 
configured on each server in your network in the Standard & Reporting Agents area of the 
Partitions section. Each supervisor name represents the supervisor and all of their reporting 
agents. You can view the partitions that you create in the User Defined area of the Partitions 
section.

Users configured with Launchpad Options to Access and Partition Management access also require 
an access class with privileges set for each of the Access and Partition Management views. Users 
with full access rights in Access and Partition Management can perform almost all administrative 
functions.

If the User Administration access class configuration allows, users can update their own user details 
in Access and Partition Management. Users must authenticate using their current password before 
updating their user details.

Note:

You cannot delete the Administrator user.

Creating a Contact Center Manager Administration user
Before you begin

• Log on to CCMA.
• Open the Access and Partition Management component.
• Create access classes.
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• Create user-defined partitions (optional).
• If the user has basic access to Contact Center Management, you must assign the user 

an access class that includes CCM access, Skillset Assignment access, or Supervisor 
Assignment access. If you assign the user an access class without at least one of these 
privileges, the user cannot manage resources within Contact Center Management.

• If the user has basic access to Historical Reporting, you must assign the user an access 
class that includes either Run and Import access or Report Creation access. If you assign the 
user an access class without either of these access levels, the user cannot work in Historical 
Reporting.

• If the user has basic access to Real-Time Reporting, you must assign the user an access 
class that includes either Launch access, Create Private access or Create Public access 
for either the tabular or graphical displays (or both). If you assign the user an access class 
without at least one of these access levels, the user cannot work in Real-Time Reporting.

• If the user has basic access to Configuration, you must assign the user an access class 
to the user that includes at least one of the Configuration access class elements, such as 
skillsets. If you assign the user an access class without at least one of these privileges, the 
user cannot configure resources in the Configuration component.

• If the user has basic access to Scripting, you must assign the user an access class that 
includes privileges in at least one of the following Scripting components: Scripts, Script 
Variables, or Application Thresholds. If you assign the user an access class without privileges 
in at least one of these components, the user cannot work within the Scripting component.

• If the user has basic access to Prompt Management, you must assign the user an access 
class that includes at least one of the Prompt Management access class elements, such 
as Read Update Create/Delete or Read and Update. If you assign the user an access 
class without at least one of these privileges, the user cannot manage prompts in Prompt 
Management.

About this task
Create a Contact Center Manager Administration user to grant the users access to the appropriate 
components within Contact Center Manager Administration. Assign access classes to users to 
control the actions that they can perform, and assign supervisor/reporting agent combinations and 
partitions to users to control the data that they can see.
If you enable the Advanced Security mode, you can also configure a user as programmatic. 
Programmatic accounts are the accounts that you create for the non-interactive establishment of 
secure communication between internal processes, for example, when using Web Services for 
integration with third-party applications.

Procedure
1. On the menu, choose Add > New User.
2. In the User Properties window, in the User Details section, type the relevant information 

about the user in the following boxes:

• User ID

• First Name

• Last Name
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• Password

To view the password rules, hover the cursor over the Info icon next to the Password 
box.

Important:

You cannot modify the user ID after you add the user. You must delete the user and 
create a new one with the new name.

3. To configure a user as programmatic, select the Programmatic account check box.

4. In the Launchpad Options section, select the check box for each of the following 
components that the user can access:

• Access and Partition Management

• Real-Time Reporting

• Historical Reporting

• Configuration

• Contact Center Management

• Scripting

• Emergency Help

• Audit Trail

• Outbound

• Multimedia

• Prompt Management

5. In the Access Classes section, select the check box for each access class to assign to 
the user.

6. Click the Partitions heading to assign partitions to the user.

7. To grant the user full access to all data, select the Full Data Across All Servers check 
box, and click Submit.

8. To refine the data that the user can see, clear the Full Data Across All Servers check 
box.

9. To assign the user access to data, standard partitions, or supervisor/reporting agent 
combinations on particular servers, click the Standard & Reporting Agents heading.

10. In the Standard & Reporting Agents area, select one of the following options for each 
server:

• No Data—Select this option if you do not want the user to see any data on the CC 
server.

• All Data—Select this option if you want the user to see all configured data on the CC 
server.
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• Configure—Select this option if you want to specify the data that the user can see, and 
then proceed to the next step.

11. If you selected the Configure option for at least one server, from the Configure Server 
list, select the CC server.

12. On the Standard page, for each component, select one or more of the following Standard 
partitions:

• All Agents & Supervisors
• All Applications
• All CDNs (Route Points)
• All User Defined Report Groups
• All DNIS
• All Prompts
• All Script Variables
• All Skillsets
• All User Defined Report Groups
• Standard Agent Performance Reports
• Standard Call by Call Reports
• Standard Configuration Reports
• Standard Contact Summary Reports
• Standard Multimedia Reports
• Standard Other Reports
• Standard Outbound Reports

Important:

Only Contact Center Management (CCM), Real-Time Reporting (RTR), Historical 
Reporting (HR), Scripting (SCR), and Prompt Management (PTM) are applicable to 
partitions. When you select the PTM check box, the current user gains access to all 
the prompts in the Prompt Management component.

13. To grant access to reporting agents, or to grant access to the reporting agents of other 
supervisors, click the Reporting Agents tab.

The Reporting Agents page lists all supervisors configured on the CC server. Each 
supervisor name represents the supervisor and all their reporting agents.

14. On the Reporting Agents page, under each component, select the supervisors for whom 
you want the user to have access.

OR

To select all supervisors for Contact Center Management, Real-Time Reporting, or 
Historical Reporting, select the CCM, RTR, or HR check boxes, respectively.
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15. To assign a user-defined partition to the user, click the User Defined heading.

The heading expands to reveal the list of user-defined partitions configured.

16. For each component, select each partition to assign to the user.

OR

To select all user-defined partitions for Contact Center Management, Real-Time Reporting, 
Historical Reporting, Scripting, or Prompt Management, select the CCM, RTR, HR, SCR, 
or PTM check boxes, respectively.

17. Click Submit, to save your changes.

Variable definitions
Name Description
User ID The name that users type when they log on to 

CCMA.

Important:

Do not use an ampersand (&) in the user ID.
First Name The first name of the Contact Center Manager 

Administration (CCMA) user.
Last Name The last name of the CCMA user.
Password The user's password to access CCMA.
Submit Save the information.
Create Copy To create a new CCMA user based on the 

properties of an existing user, click Create Copy. 
When you click this button, the system copies all 
the user's properties, except the following:

• User ID

• First Name

• Last Name

• Password

Type the user details for the new user, change any 
of the user's access and partition information (if 
desired), and then click Submit to save the new 
CCMA user.

Delete Delete the current user.
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Copying the properties of an existing Contact Center 
Manager Administration user

Before you begin
• Log on to CCMA.
• Open the Access and Partition Management component.

About this task
Copy the properties of an existing Contact Center Manager Administration user to create a new 
user based on the properties of an existing user.

Procedure
1. Select a user to copy.

You copy all basic access rights, access classes, and partition information for the selected 
user.

2. Click Create Copy.

3. Type the new user details, change any partition or access information.

4. Click Submit to save the new user.

Deleting a Contact Center Manager Administration user
Before you begin

• Log on to CCMA.
• Open the Access and Partition Management component.

About this task
Delete a Contact Center Manager Administration user to remove a user that is no longer required.

Procedure
1. On the menu, choose View/Edit > User Administration.

2. In the left pane, right-click the user to delete, and then click Delete.

3. Click Yes.
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Assigning supervisor/reporting agent combinations to a 
user

Before you begin
• Log on to CCMA.
• Open the Access and Partition Management component.
• Create at least one Contact Center Manager Administration user.

About this task
When you configure a Contact Center Manager Administration user, you can assign the user one 
or more supervisor/reporting agent combinations to enable the user to see all the corresponding 
agents in the historical reports, real-time displays, and Contact Center Management. Each name 
on the Reporting Agents tab in the User Properties window represents a supervisor and all of 
their reporting agents on a per-server basis. Therefore, when you link a supervisor's name with 
a Contact Center Manager Administration user, you automatically enable this user to see all the 
supervisor's reporting agents.

Procedure
1. On the menu, choose View/Edit > User Administration.

2. In the left pane, click the user to whom you want to assign a supervisor/reporting agent 
combination.

3. In the User Properties window, click the Partitions heading.

4. Clear the Full Data Across All Servers check box.

5. Click the Standard & Reporting Agents heading.

6. In the Standard & Reporting Agents area, select one of the following options:

• No Data—Select this option if you do not want the user to see any data on the CC 
server.

• All Data—Select this option if you want the user to see all configured data on the CC 
server.

• Configure—Select this option if you want to specify the data that the user can see, and 
then proceed to the next step.

7. If you selected the Configure option, from the Configure Server list, select the CC server.

8. On the Standard page, for each component, select one or more of the following Standard 
partitions:

• All Agents & Supervisors

• All Applications

• All CDNs (Route Points)

• All DNIS
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• All Prompts

• All Script Variables

• All Skillsets

• All User Defined Report Groups

• Standard Agent Performance Reports

• Standard Call by Call Reports

• Standard Configuration Reports

• Standard Contact Summary Reports

• Standard Multimedia Reports

• Standard Other Reports

• Standard Outbound Reports

Important:

Only Contact Center Management (CCM), Real-Time Reporting (RTR), Historical 
Reporting (HR), Scripting (SCR), and Prompt Management (PTM) are applicable to 
partitions. When you select the PTM check box, the current user gains access to all 
the prompts for that server in the Prompt Management component.

9. To grant access to reporting agents, or to grant access to the reporting agents of other 
supervisors, click the Reporting Agents tab.

The Reporting Agents page lists all supervisors configured on the CC server. Each 
supervisor name represents the supervisor and all their reporting agents.

10. On the Reporting Agents page, under each component, select the supervisors for whom 
you want the user to have access.

OR

To select all supervisors for Contact Center Management, Real-Time Reporting, or 
Historical Reporting, select the CCM, RTR, or HR check boxes, respectively.

11. Click Submit to save your changes

Configuring a supervisor/agent
Before you begin

• Log on to CCMA.
• Open the Access and Partition Management component.
• Create any required access classes.
• Create any required user-defined partitions.
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• If you grant the supervisor/agent basic access to Contact Center Management, you must also 
assign an access class to the user containing at least one of the CCM, Skillset Assignments, 
or Agent to Supervisor Assignments access rights. If you do not assign this kind of access 
class to the user, then the user sees nothing in Contact Center Management. If the user's 
partitions do not contain any agents or skillsets, then the user sees no data in Contact Center 
Management.

About this task
When you create supervisor/agents in Contact Center Management and give them a Contact 
Center Manager Administration user ID and password to use Contact Center Manager 
Administration, their user profile automatically appears in Access and Partition Management 
under the Users folder. (In addition to being Contact Center users, they are also Contact Center 
Manager Administration users.) To properly configure these users, you must open their profile and 
give them basic access rights to the Contact Center Manager Administration components that they 
need to use.
When you configure these Contact Center Manager Administration users, you can assign the 
following to them:

• supervisor/reporting agent combinations—To enable the user to automatically see all of their 
reporting agents, or all the reporting agents of another supervisor. On the Reporting Agents 
tab of the User Properties window, click the check box beside the appropriate supervisor 
names.

• access classes—You must configure the access class that the user needs to work in Contact 
Center Management, and assign it to the user.

• partitions—In the User Properties window, assign the user the appropriate partitions 
containing the data that the user needs to see. You can assign a combination of standard 
partitions, user-defined partitions, or full data access.

Procedure
1. On the menu, choose View/Edit > User Administration.

2. In the left pane, select the user created in Contact Center Management.

3. In the User Properties window, click the Launchpad Options heading The heading 
expands to reveal a list of applications.

4. In the Launchpad Options section, select the check box for each of the following 
component that the user can access:

• Access and Partition Management

• Real-Time Reporting

• Historical Reporting

• Configuration

• Contact Center Management

• Scripting

• Emergency Help

• Audit Trail
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• Outbound

• Multimedia

• Prompt Management

5. In the Access Classes section, select the check box for each access class to assign to 
the user.

6. Click the Partitions heading to assign partitions to the user.

7. To grant the user full access to all data on the Contact Center server, select the Full Data 
Across All Servers check box, and click Submit.

8. To refine the data that the user can see, clear the Full Data Across All Servers check 
box.

9. To assign the user access to data, Standard partitions, or supervisor/reporting agent 
combinations on particular servers, click the Standard & Reporting Agents heading, and 
proceed to step 11 on page 357.

10. To assign user-defined partitions, click the User Defined heading, and proceed to step 17.

11. In the Standard & Reporting Agents area, select one of the following options:

• No Data—Select this option if you do not want the user to see any data on the CC 
server.

• All Data—Select this option if you want the user to see all configured data on the CC 
server.

• Configure—Select this option if you want to specify the data that the user can see, and 
then proceed to the next step.

12. If you selected the Configure option, from the Configure Server list, select the CC server.

13. On the Standard page, for each component, select one or more of the following Standard 
partitions:

• All Agents & Supervisors

• All Applications

• All CDNs (Route Points)

• All DNIS

• All Prompts

• All Script Variables

• All Skillsets

• All User Defined Report Groups

• Standard Agent Performance Reports

• Standard Call by Call Reports

• Standard Configuration Reports
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• Standard Contact Summary Reports

• Standard Multimedia Reports

• Standard Other Reports

• Standard Outbound Reports

Important:

Only Contact Center Management (CCM), Real-Time Reporting (RTR), Historical 
Reporting (HR), Scripting (SCR), and Prompt Management (PTM) are applicable to 
partitions. When you select the PTM check box, the current user gains access to all 
the prompts for that server in the Prompt Management component.

14. To grant access to reporting agents, or to grant access to the reporting agents of other 
supervisors, click the Reporting Agents tab.

The Reporting Agents page lists all supervisors configured on the selected server. Each 
supervisor name represents the supervisor and all their reporting agents.

15. On the Reporting Agents page, under each component, select the supervisors for whom 
you want the user to have access.

OR

To select all supervisors for Contact Center Management, Real-Time Reporting, or 
Historical Reporting, select the CCM, RTR, or HR check boxes, respectively.

16. To assign a user-defined partition to the user, click the User Defined heading.

The heading expands to reveal the list of user-defined partitions configured on the Contact 
Center server.

17. For each component, select each partition to assign to the user.

OR

To select all user-defined partitions for Contact Center Management, Real-Time Reporting, 
Historical Reporting, Scripting, or Prompt Management, select the CCM, RTR, HR, SCR, 
or PTM check boxes, respectively.

18. Click Submit to save your changes.

Unlocking locked Contact Center Manager Administration 
users

Before you begin
• Log on to CCMA as an administrator.
• Open the Access and Partition Management component.
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About this task
For security reasons, Contact Center Manager Administration locks user accounts that have not 
been logged in to the system for a long time period. When a locked user attempts to log in to 
Contact Center Manager Administration, the lockout notification appears and the login attempt 
fails. Locked users must contact their administrator, as only CCMA administrators have rights to 
unlock locked users.

Procedure
1. On the menu, choose View/Edit > User Administration.

2. In the left pane, select the user you want to unlock.

3. Deselect the Inactive Account Lockout check box.

4. Click Submit.

Contact Center Manager Administration unlocks the user account. The unlocked user now 
can log in to the system.
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Chapter 53: Outbound configuration

Avaya Contact Center Select supports outbound calls and campaigns. Use the Outbound Campaign 
Management Tool (OCMT) to create, modify, and monitor outbound campaigns. OCMT monitors a 
maximum of 100 simultaneous outbound campaigns with a maximum of 20 000 contacts (email or 
outbound) per campaign.

About Outbound Campaign Manager Tool
Use Outbound Campaign Manager Tool (OCMT) to create, monitor, and modify outbound 
telephone campaigns.
You can gain access to the components of OCMT from the toolbar on the left side of the OCMT 
window.

•  Create & Append: Create a new campaign, or add call data to an existing campaign. 
You can add call data manually, import data from an external source, edit the data, and 
export the data.

•  Modify Campaign: Pause, restart, or cancel a campaign. You can also change the 
properties of the campaign, including start date and time, end date and time, daily start and 
end time, and call rate.

•  Progress & Results: Monitor an ongoing campaign, view results of a completed 
campaign, and print a campaign summary. The system displays information on the screen 
graphically in a pie or bar chart.

•  Agent Script: Create and preview the agent script that includes an introduction and a 
conclusion, and design the interface for the questions with check boxes and drop-down lists 
for possible answers.

•  Disposition Codes: Add, update, and delete disposition codes that you can use in the 
agent script.

•  General Settings: View the Time Zone list and the configurations for the log files that 
are used to track problems in OCMT.
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•  Help: Get information on using OCMT.

Historical Reports
You can use historical reports to review campaign performance. Historical reports are available in 
the Historical Reporting component of Contact Center Manager Administration. Use the following 
standard historical reports to review outbound campaigns:

• Campaign Call by Call Details: Use this report to list all calls made for each campaign. If an 
agent does not process a contact, no call record exists in this report. If you select a data 
range for the report, the data range is based on Contact Closed Time.

• Campaign Script Result Details: Use this report to view the script answers for each 
campaign.

• Campaign Summary: Use this report to view a summary of each campaign and the 
disposition codes associated with each campaign.

• Script Summary: Use this report to view a summary of the answers for each agent script.

Scheduling callbacks
Agents can schedule callbacks using Agent Desktop. Agents specify a time and date for the 
scheduled callback. The Campaign Scheduler Service, which handles callback scheduling, runs 
at 10 minute polling intervals. If the agent schedules a callback to occur less than 10 minutes 
after the time of the original call, in certain scenarios the callback does not occur precisely at the 
scheduled time.

IP Office Default No Answer Time
The Minimum Dial Time specifies the length of time, in seconds, that Agent Desktop waits for the 
outbound call to be answered before disconnecting. In an Avaya Contact Center Select solution, 
the Default No Answer Time on IP Office can affect the OCMT Minimum Dial Time setting. If 
the Default No Answer Time is set to a value lower than the Minimum Dial Time, the Default No 
Answer Time overrides the Minimum Dial Time value. You can configure the Default No Answer 
Time on IP Office using IP Office Manager. The Default No Answer Time is 15 seconds by default.

Daily Start and Stop Times
When you define a campaign, you can specify a start time for the campaign. If you do not define 
the campaign start time, the campaign starts immediately. When you define the campaign start 
time, the campaign starts at the specified time. When the campaign starts, the system queues all 
contacts from that campaign to the chosen skillset. The system presents the contacts from the 
campaign to the agents who are assigned to that skillset.

To avoid calling customers at unsociable hours, you can define Campaign Dialing Hours, that is, 
the daily start and end time for a campaign. Use OCMT to specify a time the system starts to 
offer contacts to logged-on agents and a time the system stops presenting contacts to agents. For 
example, you can specify that the system offers contacts from the outbound campaign to agents 
who log on to the skillset at 08:00 and finish at 17:00.
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Use Campaign Dialing Hours to ensure that you respect the regulatory requirements that surround 
dialing hours. You specify the time according to the local time of the location of the Contact Center 
server. You can use the Time Zone list to ensure that the calls made to other time zones also meet 
the regulatory requirements for dialing hours.

Outbound capacity management
OCMT monitors a maximum of 100 simultaneous outbound campaigns. You cannot define more 
than 500 active and inactive campaigns. Active campaigns are campaigns that are currently 
running, waiting to run (pending a start time), or are paused. Inactive campaigns are campaigns 
that are completed, or cancelled, or expired. You must regularly archive your campaigns to ensure 
operational efficiency.

Each campaign can have up to 20 000 contacts (email or outbound). However, in order to optimize 
the system, you must not have more than 1 million contacts in the Multimedia database. You can 
use the following strategies to ensure that you do not exceed this limit, if your contact center 
operates at high capacity:

• Define campaigns only as needed, for example by, creating campaigns immediately prior to 
their usage. This prevents campaigns that are not required for some time from building up in 
the database. To avoid affecting system performance, load contacts into a campaign during 
non-peak or out-of-office hours.

• Cancel campaigns that you do not require manually. Use the Pause capability to defer 
campaigns indefinitely. If you resume a campaign, the system does not present the contacts 
that are already completed to agents the second time. For more information, see Canceling a 
campaign on page 388.

• Archive completed, cancelled, and expired campaigns when you no longer need the 
campaigns for reporting purposes.

Logging on to Contact Center Manager Administration for 
Outbound

Before you begin
• Ensure that your contact center is licensed for Outbound campaigns.

About this task
Open the Outbound Campaign Manager Tool in Contact Center Manager Administration to 
configure, monitor, and maintain an outbound contact campaign.

Procedure
1. Log on to Contact Center Manager Administration.
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April 2024 Administering Avaya Contact Center Select 362
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AdministeringAvayaContactCenterSelect&p3=33


2. On the CCMA Launchpad, select Outbound.

3. In the Left pane, select the CCMM server.

4. In the right pane, select Install prerequisite software and click Launch Outbound 
Client.

5. On the File Download box, click Run.

The Outbound Campaign Manager Tool prerequisite software takes some time to install.

6. When you are prompted to run the Outbound Campaign Manager Tool, click Run.

7. After the install, the Outbound Campaign Manager Tool appears.

Defining campaign settings
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.

About this task
Define campaign settings as the first step to creating an outbound campaign. You must define the 
following settings:

• campaign name
• campaign start date and time
• call priority
• daily start and end times (if required to comply with local laws)
• disposition codes

The following settings are optional:
• campaign description
• agent script
• dialer settings
• custom fields
• campaign end date and time

Procedure
1. In the Outbound Campaign Management Tool, click Create & Append.

2. On the Campaign Settings tab, click Start Configuring New Campaign.

3. Select Create New Campaign.

4. Under Campaign Details, type a name for the campaign and a description (optional).
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5. Under Campaign Start Date & Time, select either Start Immediately or Start at.

Important:

The campaign scheduler interval impacts the actual campaign start date and time. For 
example, if a campaign starts at 9:00 AM and the campaign scheduler interval is one 
minute, the first contact is queued to the Contact Center Manager Server at 9:01 AM.

6. If you chose Start At to start the campaign at a later date, select the start date and time.

7. From the Call Priority list, select a priority from 1 to 6, where 1 is the highest.

Consider the priority of your incoming calls when you select the priority for the outbound 
campaign. In most Contact Centers, incoming voice calls usually have a higher priority 
than outbound calls.

8. Under Agent Desktop Script, select a script. If you choose None, a script is not available 
for the agents who are handling the outbound calls in this campaign.

If you want to save the agent script results for a campaign, you must create disposition 
codes with the Save Agent Script option “yes”, and you must instruct your agents to use 
the disposition codes that save the agent script answers when the contact is closed.

The system disposition code Completed saves the agent script answers.

9. To display the optional fields, click Additional Options. To hide the optional fields again, 
click Additional Options again.

10. Select the Dialer option:

• If you want the agent to dial the number, select Manual Agent Dial (Preview).
• If you want the call dialed automatically for the agent, select Auto Dial Immediately 

(Progressive).
• If you want the call dialed after the agent reviews the contact details, select Auto Dial 

after (seconds), and then specify a number of seconds to allow the agent to review the 
information.

11. Click Enable Minimum Dial Time. If you enable the Minimum Dial Timeout, the telephone 
rings for the specified time. You can set a time between 1 and 180 seconds.

The Minimum Dial Time setting prevents an agent from making a call and then immediately 
hanging up.

12. If the agent needs to dial a number to access an external line for an outbound call, in the 
Trunk Access Code box, type the digit or ASCII character.

13. Optionally, add a custom field. Use custom fields to map information in the imported 
call data that cannot be mapped to the standard fields, or to provide editable fields on 
Agent Desktop where the agent can gather additional information from the customer (for 
example, the customer's birth date).

To add a custom field, in the Custom fields section click Add.

In the Insert Custom Field dialog box, type the custom field name, and then click Insert.
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14. To specify an end date for the campaign, click Enable, and then select the date and time.

15. To specify the campaign dialing hours, you can choose Anytime, Local - Current Time 
Zone Only, or Use Customers Time Zone. If you want to consider the Time Zones for all 
the customers, choose Use Customers Time Zone.

For more information about the Use Customers Time Zone option, see Example of using 
time zones on page 365.

16. From the list of available Disposition Codes, select the codes available to the Agent at 
the end of the calls for this campaign.

Procedure job aid: Using time zones
After you select the Use Customer Time Zone option in a campaign, the Time Zone tab appears in 
the Call Settings section. On the Time Zone tab, you can check which calls are linked to what time 
zone by checking the Use Time Zone check box. Three possible results can occur:

• Match

• Partial Match

• No Match Found

A Match occurs when the international code and area code are found in your time zone list.

A Partial match occurs when the international code is found but an area code is not. For example, 
Ireland has an international code of 353 and Dublin has an area code of 1. If you are creating 
an outbound campaign to Ireland, if you do not want to put in every possible area code, a partial 
match on 353 puts the contacts into the first found time zone for an area code.

A No Match occurs when neither the international code nor the area code are found. In this case, 
the contact is called on the Contact Center server time zone.

Any contacts that result in a Partial Match or a No Match are highlighted on the grid. You can still 
create the campaign with these warnings.

Example of using time zones
About this task
This example creates a campaign configured for time zones by importing contacts from a text file.

Procedure
1. Log on to Contact Center Manager Administration and launch the Outbound Campaign 

Management Tool.

2. Click Create & Append.

3. In the Name box, type a unique name for the campaign (for example, 
My_Time_Zone_Camp).

4. Click Additional Options.

5. In the Campaign Dialing Hours section, select Use Customers Time Zone from the list.
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6. Configure the remaining campaign settings as required, and then click the Call Settings 
tab.

7. On the Call Data Import tab, click Import Call Data.

8. On the Select Import Type dialog box, select Import from Text File.

9. Click Next.
10. Click Browse and navigate to your contact list text file.

For this example, we are using the following contacts:

Steve Smyth 17895555555
John Doe 12105555555
Gary lo 19075555555
Eddy Walsh 19175555555
Mary More 16045555555
Brian Bush 15205555555

11. Click Next.
12. In the Field delimiter section, select Tab.

13. Click Next.
14. Map Field 1 to First Name by dragging the Field 1 to the blank space to the left of First 

Name.

15. Map Field 2 to Last Name.

16. Map Field 3 to Phone Number.
17. Click Finish.

18. To split the phone number into an international code and an area code, click the Call Data 
Cleanup tab.

19. Click the Split Phone Number tab.

20. Beside Split Field into, select Intl. Code.

21. From the Number of digits to split list, select 1.

22. Click Split Phone Number.
23. On the OCMT Call Cleanup message box, click Continue.

The international code is removed from the Phone Number field and appears in the Intl 
Code field.

24. Beside Split Field into, select Area Code.

25. From the Number of digits to split list, select 3.

26. Click Split Phone Number.
27. On the OCMT Call Cleanup message box, click Continue.
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The area code is removed from the Phone Number field and appears in the Area Code 
field.

28. Click the Skillset Assignment tab.

29. From the Attach This Skillset To Rows list, select OB_Default_Skillset.
30. From the ..This Field Is.. list, select Intl Code.

31. In the ..To.. field, enter 1.

32. Click Update.

33. Click the Time Zone tab.

34. Select the Use Time Zone check box.

A message box appears, indicating that one call is in a warning state. This warning is 
highlighted on the Call Data Table as a Partial Match. You can either add a new time zone 
for this area code or accept the partial match. For this example, accept the partial match.

If your contact list does not have an international code, you can use the International Code 
feature on the Time Zone tab to quickly fill the entire data grid.

35. Click the Campaign Activation tab.

36. In the Campaign Summary, ensure that Time Zone is set to Enabled.

37. Click Create Campaign.

A message box appears indicating that no agent script has been configured for the 
campaign.

38. Click Yes.

A message box appears stating that the campaign was created successfully.

39. Click OK.

40. To review your campaign, click Progress & Results.

41. In the Campaign List section, select My_Time_Zone_Camp.

42. Click the Call Details tab.

You notice that not all contacts are running. The contacts that are currently in a waiting 
state are those that are not within the daily start and end times (9:00 to 18:00) in their time 
zone. You can also confirm the time zone for each contact under the Time Zone column.

Adding a time zone
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
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About this task
A list of time zones is configured by default in the Outbound Campaign Management Tool, 
however the default time zones cover the common countries. You can create your own entries 
in the time zone list to ensure that outbound calls are placed at appropriate times for various time 
zones.

Important:
If you have more than one Area Code in a location, you must create a new entry in the Time 
Zone list for each area code.

Outbound campaigns do not support Daylight Saving Time. The scheduled outbound campaign is 
set according to the configured system time and adjusts according to the configured time zone, 
regardless of whether the server or the customer time zone observes Daylight Saving Time.

Procedure
1. On the OCMT toolbar, click General Settings.

2. Click the Time Zone tab.

3. Review the list of predefined settings to see if the required time zone setting is present. 
The default time zone settings include those settings for Europe and North America.

4. If the time zone is not configured, click Insert.
5. In the Location Name box, type the name of the town or city for your time zone.

6. In the International Code box, type the number that is used to dial out of the country.

7. In the Area Code box, type an area code for the numbers in your location.

8. In the Time Zone box, select the time zone for the location. The abbreviations are 
expanded when you hover your mouse over the list of possible time zones.

9. Click Insert.

Updating a time zone
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.

About this task
Update a time zone to change the location name, international code, area code, or time zone.

Procedure
1. On the OCMT toolbar, click General Settings.

2. Click the Time Zone tab.

3. In the table, select the Time Zone you want to update.
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4. Click Update.

5. In the Update Time Zone dialog box, make the required changes.

6. Click Update.

Deleting a time zone
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.

About this task
Delete a time zone that is no longer required to remove it from the system.

Procedure
1. On the OCMT toolbar, click General Settings.

2. Click the Time Zone tab.

3. In the table, select the Time Zone you want to delete.

4. Click Delete.

5. In the message box, confirm the deletion and click Yes.

Importing call data from a text file
Before you begin

• Prepare the call data in a text file.

Important:
Ensure that the data you prepare for import does not contain information that violates 
legal requirements, such as numbers on a national or international Do Not Call register.

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Define the campaign settings. See Defining campaign settings on page 363.

About this task
Import call data from a text file database into your new outbound campaign to save time and 
prevent data entry errors. You can also add call data manually.
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You can also import call data from one of the following sources:
• ODBC database (Open Database Connectivity) — The database can be a user or system 

DSN, or a file DSN from the directory where the file DSNs are stored. Note: A user name and 
password can be required. See Importing call data from an ODBC database on page 371.

• Existing campaign — You can import call data from any existing campaign. See Importing call 
data from an existing campaign on page 372.

If a text file contains contacts with a restricted flag, the system deletes these contacts after clicking 
Create Campaign and displays the corresponding message.

Procedure
1. In the Outbound Campaign Management Tool, click Create & Append.

2. Click the Call Settings tab.

3. On the bottom of the Call Settings page, click the Call Data Import tab.

4. Click Import Call Data.

If the call data table already contains data, a confirmation message appears.

5. To replace the information in the Multimedia database, select the Overwrite existing 
customer data with new customer data option.

6. In the Select Import Type window, select the Import From Text File option.

7. Click Next.
8. Click Browse to navigate to the appropriate directory.

9. Select the file, and then click Open.

10. Click Next.
11. To select how the fields are separated in your source file, click Tab, Space, or Character. 

The default character is a comma.

12. To import a selection of records only from the source file, select the Enable Record 
Selection check box, and then select the beginning and end of the range of records to be 
imported.

13. If the first row of the source file contains column headers, select the check box.

14. Click Next.
15. In the File Source Fields box, click the first field name.

16. Drag the name to the Mapping column on the appropriate line of the OCMT Fields table.

17. To see which data Field #1 contains, refer to the Mapping Results table.

18. Check the mapping for all File Source Fields.

Important:

If the area code and/or international code is in the same field as your telephone 
number in the source file, map that field to Phone Number in the OCMT Fields. You 
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can split the number up into international code, area code and phone number in the 
Call Settings window.

19. Review the Mapping Results table.

20. To remove the mapping, select the mapping column in the OCMT Fields table and click 
Clear Mapping.

21. When you are satisfied with the mapping, click Finish.

Importing call data from an ODBC database
Before you begin

• Prepare the call data in an ODBC database.

Important:
Ensure that the data you prepare for import does not contain information that violates 
legal requirements, such as numbers on a national or international Do Not Call register.

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Define campaign settings. See Defining campaign settings on page 363.

About this task
Import call data from an ODBC database into your new outbound campaign to save time and 
prevent data entry errors. You can also add call data manually instead of, or after you import call 
data.
You can also import call data from one of the following sources:

• Text file — The data fields within a text file can be in any order; however, the order and the 
delimiter must be consistent throughout the file. See Importing call data from a text file on 
page 369.

• Existing campaign — You can import call data from any existing campaign. See Importing call 
data from an existing campaign on page 372.

If an ODBC database contains contacts with a restricted flag, the system deletes these contacts 
after clicking Create Campaign and displays the corresponding message.

Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. Click the Call Settings tab.

3. On the bottom of the Call Settings page, click the Call Data Import tab.

4. Click Import Call Data.

If the call data table already contains data, a confirmation message appears.
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5. To replace the information in the Multimedia database, select the Overwrite existing 
customer data with new customer data option.

6. In the Select Import Type window, select the Import From ODBC option.

7. Click Next.
8. To select an ODBC System DSN, select the ODBC System DSN from the list.

9. To select an ODBC User DSN, select the ODBC User DSN from the list.

10. To select an ODBC File DSN, click Browse and then navigate to the location of the DSN 
file.

11. Select the DSN file and click Save.

12. If the ODBC source requires a logon ID, in the Login Information section, type the user 
name and password.

13. Click Next.
14. Click the table name or view name from which to import.

15. Click Next.
16. In the Data Source Table Columns box, click the first column name.

17. Drag the column name to the Mapping column on the appropriate line of the OCMT Fields 
table.

18. Check the Data Source Table Columns mapping for all Data Source Table Columns.
19. If the area code and/or international code is in the same field as the telephone number in 

the source database table, map that field to Phone Number in the fields.

You can use the Call Settings window to split the number up into international code, area 
code and phone number.

20. To remove the mapping, select the mapping column in the OCMT Fields table and click 
Clear Mapping.

21. To import only a selection of records from the source file, click the Select Range check 
box, and then select the beginning and end of the range of records to import.

If the start record is the same as the end record, the data in that record (at least one) is 
imported.

22. When you are satisfied with the mapping, click Finish.

Importing call data from an existing campaign
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
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• Define campaign settings. See Defining campaign settings on page 363.

About this task
Import call data from an existing campaign into your new outbound campaign to save time and 
prevent data entry errors. You can also add call data manually. See Adding call data manually on 
page 373.
Avaya recommends that you ensure the new campaign uses the same custom fields as the 
campaign from which you are importing call data. You can ensure this by clicking Start Configuring 
New Campaign and selecting Create using previous campaign settings. and choosing a previous 
campaign. A list of available campaigns appears. Select the campaign you want to import contacts 
from and click OK.

Procedure
1. Click Create & Append.

2. Click the Call Settings tab.

3. On the bottom of the Call Settings page, click the Call Data Import tab.

4. Click Import Call Data.

If the call data table already contains data, a confirmation message appears.

5. To replace the information in the Multimedia database, select the Overwrite existing 
customer data with new customer data option.

6. In the Select Import Type window, select the Create From Existing Campaign option.

7. Click Next.
8. From the list, select the appropriate campaign.

9. Click Next.
10. To import all calls, select the Import All Calls option.

11. To filter the calls to import, select the Filter Calls option.

12. In the Call Filter list, select the check box for each Disposition Codes that determine which 
calls to import.

13. Click Finish.

Adding call data manually
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Define campaign settings. See Defining campaign settings on page 363.
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About this task
Add call data manually if you have no data to import to add the information to the call record for an 
outbound campaign.

Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. Click the Call Settings tab.

3. Click in the first empty row of the Call Data Table.

4. Type the customer information in the appropriate fields.

Validating a telephone number or code
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Define campaign settings. See Defining campaign settings on page 363.
• Add call data using an importing method, or by adding call data manually.

About this task
Validate a telephone number or code to ensure that the Phone Number, Area, and Intl Code 
columns contain only numbers and spaces. You must ensure that there are no non-numeric 
characters, such as hyphens or brackets.

Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. Click the Call Settings tab.

3. Click Call Data Cleanup.

4. On the Call Data Cleanup page, click Validate Call data.

The Call Validation window reports how many calls failed validation and gives you the 
option to delete or review these calls.

5. To review and correct the data, click Review.

The invalid calls are highlighted in the table.

6. To delete all the invalid calls, click Delete.
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Inserting text
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Define campaign settings. See Defining campaign settings on page 363.
• Ensure that you have data in the Call Data table.

About this task
Insert text into the call data to replace or change customer data for the outbound campaign. You 
can append, prepend, or replace the existing text.

Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. Click the Call Settings tab.

3. Click Call Data Cleanup.
4. Click the Insert Text tab.

5. Select one of the text change options, overwrite, prepend, or append.

6. In the Text to Add box, type the text you want to append, prepend, or replace in a field.

7. From the Select Field list, select a column to change or replace the text.

8. To search for and replace text in all rows of the table, click All Calls.

9. To search for and replace text in only selected rows of the table, select the specific rows, 
and then click Selected Calls.

10. Click Insert Text.
11. Click Continue to confirm you want to add the selected text.

12. Click OK.

Procedure job aid
Value Variable
Overwrite Replace the current contents of the field.
Prepend Add the text to the beginning of the current text in the field.
Append Add the text to the end of the current text in the field.
Text to add Type the text you want to appear.
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Removing text
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Define campaign settings. See Defining campaign settings on page 363.
• Ensure that you have data in the Call Data table.

About this task
Remove text from the Call Data table that is no longer valid.

Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. Click the Call Settings tab.

3. On the Call Settings page, click Call Data Cleanup.

4. Click the Remove Text tab.

5. In the Text to remove box, type the text for which to search and remove

6. To remove all text from the selected column, click Remove All Text.
7. From the Select Field list, select the column from which to search and remove the text.

8. From the Occurrence list, select the option that describes what you want to remove.

9. To search for and remove text in all rows of the table, click All Calls.

10. To search for and remove text in only selected rows of the table, select the specific rows, 
and then click Selected Calls.

11. Click Remove Text.
12. Click Continue to confirm that you want to delete the selected text.

13. Click OK.

Replacing text
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Define campaign settings. See Defining campaign settings on page 363.
• Ensure that you have data in the Call Data table.

About this task
Replace text in your Call Data table with corrected information in one location or more.
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Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. Click the Call Settings tab.

3. Click Call Data Cleanup.

4. Click the Replace Text tab.

5. In the Text to replace box, type the existing text for which to search and replace.

6. In the Text to replace with box, type the new text to replace.

7. From the Select Field list, select the column from which to search and replace the text.

8. To search for and replace text in all rows of the table, click All Calls.

9. To search for and replace text in only selected rows of the table, select the specific rows, 
and then click Selected Calls.

10. Click Replace Text.
11. Click Continue to confirm that you want to replace the selected text.

12. Click OK.

Splitting a phone number
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Define campaign settings. See Defining campaign settings on page 363.
• Ensure that you have data in the Call Data table.

About this task
Split a phone number in your Call Data table if the international code or area code is combined 
with the telephone number in the imported data. You must ensure that the phone number in the 
Call Data table is valid by removing a specified number of digits from the beginning of the Phone 
Number and adding those digits to the selected Intl or Area Code column.

Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. Click the Call Settings tab.

3. Click Call Data Cleanup.

4. Click the Split Phone Number tab.

5. From the Split Field into list, select Intl Code or Area Code.
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6. In Number of digits to split, type or select the number of digits to remove from the Phone 
Number and add to the selected Code column.

7. To split the phone number in all rows of the table, click All Calls.

8. To split the phone number in only selected rows of the table, select the specific rows, and 
then click Selected Calls.

9. Click Split Phone Number.
10. Click Continue to split the phone number.

11. Click OK.

Adding area and international codes
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Define campaign settings. See Defining campaign settings on page 363.
• Ensure that you have data in the Call Data table.

About this task
Add area and international codes if your imported data does not include area and/or international 
codes to ensure that your Call Data is complete. You can add the same code to multiple rows at 
the same time.
This operation overwrites existing data in the selected column and rows.

Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. Click the Call Settings tab.

3. At the bottom of the Call Settings tab, click Call Data Cleanup.

4. Click the Insert Text tab.

5. Select Overwrite.

6. In the Text To Add box, type the international code or area code to add.

7. In Select Field, select either Intl Code or Area Code in which to add the code.

8. To add the code in all rows of the table, click All Calls.

9. To add the code in only selected rows of the table, select the specific rows, and then click 
Selected Calls.

10. Click Insert Text.
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Checking the length of fields
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Define campaign settings. See Defining campaign settings on page 363.
• Ensure that you have data in the Call Data table.

About this task
Check the length of fields in the Call Data table to determine the validity of a field in a customer 
record. For example, you can see which records contain the incorrect number of digits for the 
telephone number. When the search results appear, you can either correct the content of the field 
or delete the record.

Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. Click the Call Settings tab.

3. On the Call Settings tab, click Call Data Search.

4. Click the Length Search tab.

5. From the Select Field list, select the column on which to search the length.

6. In the Operation box, select that mathematical operation that applies to your search:

• Greater than

• Equal to

• Less than

7. In the Number of digits box, type or select the number of digits that each entry in the 
column must contain.

8. If you want the length check to ignore spaces, select the Ignore Spaces check box.

9. To check the length on specific rows of the table, select the rows, and then click Selected 
Calls.

10. Click Search.

Call data that matches your criteria are highlighted and moved to the top of the Call Data 
Table.

11. Change the data.

12. To delete the rows, click Delete Checked Calls.
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Checking for alphabetic characters
Before you begin

• Define campaign settings. See Defining campaign settings on page 363.
• Ensure that you have data in the Call Data table.

About this task
Check the fields for particular alphabetic characters or symbols to correct the data or delete the 
entire record from the Call Data table in the outbound campaign.

Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. Click the Call Settings tab.

3. On the Call Settings page, click Call Data Search.

4. Click the Numeric Search tab.

5. From the Select Field list, select the column on which to do the digit check.

6. To do the digit check on specific rows of the table, select the rows, and then click Selected 
Calls.

7. Click Search.

Rows that include non-numeric characters in the selected column are highlighted and 
moved to the top of the table.

8. Change the data.

9. To delete the rows, click Delete Checked Calls.

Checking for a value
Before you begin

• Define campaign settings. See Defining campaign settings on page 363.
• Ensure that you have data in the Call Data table.

About this task
Check for fields that contain a specific value (for example, to find records with a particular area 
code) in your Call Data table to ensure that the records are all valid. For example, you can search 
for records where the telephone numbers are not in your local area.

Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. Click the Call Settings tab.
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3. On the Call Settings page, click Call Data Search.

4. Click the Value Search tab.

5. From the Select Field list, select the column on which to do the value search.

6. In the Operation box, select the operation for the required condition:

• Equal to

• Not equal to

• Contains

• Does not contain

7. In the Select Value box, type the information that corresponds to the operation and 
selected field to locate.

8. To do the length check on specific rows of the table, select the rows, and then click 
Selected Calls.

9. Click Search.

Call data that matches your criteria are highlighted and moved to the top of the Call Data 
table.

10. Change the data.

11. To delete the rows, click Delete Checked Calls.

Checking for duplicate call data
Before you begin

• Define campaign settings. See Defining campaign settings on page 363.
• Ensure that you have data in the Call Data table.

About this task
Check the records in your Call Data table for duplicates in a field or in fields that you select. You 
can choose to delete all duplicate records, to review them before changing or deleting them, or to 
allow duplicate calls in the campaign.

Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. Click the Call Settings tab.

3. At the bottom of the Call Settings page, click Call Data Cleanup.

4. Click Duplicate Calls.

5. In the Select fields: list, select the field or fields on which to search for duplicate 
information.
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6. Click Select Duplicate Calls.

If duplicate records are found, the Outbound Campaign Management Tool Duplicate Calls 
dialog box asks if you want to delete or review the duplicates.

Important:

Duplicates are only found on records that you selected in the Duplicate Field Search. If 
you didn't choose all fields, you do not see unique records.

7. Click Review to review the duplicate calls.

The duplicate calls appear at the top of the table and the second (and third or more) of 
each group of duplicate calls is highlighted.

8. To allow duplicate calls to remain in the campaign, select the duplicate calls and click 
Allow Selected Duplicates.

Duplicate Allowed appears in the Duplicate Status column for the selected duplicate 
calls.

9. To delete the duplicate calls, click Delete to retain a single copy of each record and delete 
the duplicate records.

Checking customer matches
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Define campaign settings. See Defining campaign settings on page 363.
• Ensure that you have data in the Call Data table.

About this task
Check customer matches to determine if customers present in the call data table match or closely 
match a customer record in the Contact Center Multimedia database. The customer match feature 
indicates a close match to existing customers in the Multimedia database so the Administrator 
creating the outbound campaign can determine whether the information in the call data table is a 
new customer, for which you must create a new record, or an existing customer.
For example, if Mike Smith 091 12345 is present in the Multimedia database, and Michael Smith 
091 12345 is in the call data table, when you run a customer match, the similarities are displayed 
to the Administrator.
If Enable Partial Match is selected, similarities between the call data table and the Multimedia 
database are shown based on partial matches of the telephone number. For example, if the 
call table contains Michael Smith 12345, and the Multimedia Database contains Mike Smith 091 
12345, the partial match highlights the similarities. If Partial Match is not enabled, the entry in the 
call data table is considered new.
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Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. Click the Call Settings tab.

3. At the bottom of the Call Settings tab, click the Customer Match tab.

4. To compare information based on a partial phone match, select the Enable Partial Match 
check box.

5. Click Check Customer Association.

All calls with matching phone numbers, but differences in the other fields, are highlighted in 
the call data table. A check box appears in the Customer Status column of each row.

6. To resolve the conflicting information for a call, select the check box in the Customer 
Status column.

7. In the Customer Matching window, compare the Campaign Customer Details with the 
Existing Customer Details.

8. Select whether to add this record as a new customer, or use the existing customer 
information.

9. Click OK.

10. Review all conflicting call data.

11. Click OK.

Procedure job aid
Variable Value
Partial Match Select to compare information based on a partial phone match.

Entries can be matched with entries in the Contact Center 
Multimedia database where the area code and international code do 
not match. This allows information in the Contact Center Multimedia 
database or the call data table to be updated.

Comparing call data with the Do Not Call list
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Define campaign settings. See Defining campaign settings on page 363.
• Ensure that you have data in the Call Data table.
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About this task
Compare call data with the Contact Center Multimedia Do Not Call list to ensure that you are not 
violating laws or making incorrect calls to numbers such as an emergency number.
Contact Center Multimedia maintains an internal Do Not Call list of numbers. This list contains 
numbers that Contact Center agents have dispositioned as Do Not Call after previous contacts 
with customers. When you import a new campaign you must check the campaign numbers against 
the internal Do Not Call list to remove Do Not Call numbers from the campaign.

Important:
The internal Do Not Call list is not the same as statutory registers of do not call numbers–you 
must check your call data against external registers before importing it to Contact Center.

If you do not run this check manually, or do not delete the highlighted calls, the calls are created in 
Contact Center Multimedia. However, the calls are closed immediately and the disposition code is 
set to Do Not Call, ensuring that the call is not presented to an agent.
Any customer number dispositioned as 'Do Not Call' is tagged as a 'Do Not Call' (DNC) number 
in the Contact Center Multimedia Do Not Call list. To set or clear the barred status of any required 
number, Agent Desktop is used to edit the phone number associated with the relevant customer 
record. You can use Agent Desktop to clear a number from the Do Not Call list or barred status.

Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. Click the Call Settings tab.

3. On the Call Settings page, click the Do Not Call tab.

4. Click Select ‘Do Not Call’ Numbers. The status of each call appears in the call data table, 
and any calls with the status Call Not Permitted is highlighted.

5. Review the highlighted calls and, if desired, delete them from the call data table.

Assigning skillsets to outbound campaign calls
Before you begin

• Define campaign settings. See Defining campaign settings on page 363.
• Ensure that you have data in the Call Data table.

About this task
Assign skillsets to outbound campaign calls to determine which groups of agents work on the 
campaign. You create the assignment based on the value of a field you specify from the outbound 
call data.

Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. Click the Call Settings tab.
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3. On the Call Settings page, click the Skillset Assignment tab.

4. From the Attach This Skillset To Rows list, select a skillset to which you want to assign 
calls in this campaign.

5. From the ..This Field Is.. list, select the field that you want to use as a criterion for 
assigning a campaign call to the skillset.

6. In the ..To.. field, enter the value that you want to a campaign call to match in the specified 
field to assign it to the skillset.

7. Click Update.

8. Click Continue.

9. Click OK.

Printing a summary of a new campaign
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Complete the outbound campaign.

About this task
Print a summary of a new campaign when you are finished defining the campaign settings to 
record all of the settings for the current campaign.

Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. Click the Campaign Activation tab.

3. Click Print Campaign Summary.

Activating a campaign
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Complete configuring the outbound campaign.

About this task
Activate a campaign to load the call data and campaign settings into the Contact Center 
Multimedia database so that the campaign is ready to begin on the date selected.
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You cannot activate a campaign until it is validated by the Outbound Campaign Manager Tool.

Procedure
1. On the Outbound Campaign Manager Tool, click Create & Append.

2. Click the Campaign Activation tab.

3. Click Create Campaign.

A message confirms that the campaign was created successfully.

Note:

If call data contains contacts with a restricted flag, the system deletes these contacts 
from the campaign and displays the corresponding message.

4. Click OK.

Procedure job aid
The Outbound Campaign Manager Tool performs a validation on the Call Data table. The Call 
Data must meet the following requirements:

• The campaign size cannot exceed 20 000 contacts.
• Any customer can receive only one call per campaign.
• Duplicate customers based on an exact email match or exact first name and last name and 

phone number (international code, area code, and phone number) are not permitted.
• The mandatory phone number field must contain only numeric values and spaces, and 

cannot exceed 32 characters.
• The area code must contain only numeric values and spaces, and can not exceed 10 

characters.
• The international code field must contain only numeric values and spaces, and cannot 

exceed 10 characters.
• The first name field cannot exceed 50 characters.
• The last name field cannot exceed 100 characters.
• If an email address field is included, an @ symbol is required, and the address cannot 

exceed 128 characters.
• All other Call Data table fields cannot exceed 128 characters.

Adding call data to an existing campaign
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
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• Understand how to add call data manually, or import call data from an external source.
• Understand how to edit the call data in your outbound campaign.
• Understand how to activate the campaign. See Activating a campaign on page 385.

About this task
Add call data to an existing campaign to add new customers to a campaign already in progress.

Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. On the Campaign Settings tab, click Append Calls to Existing Campaign.

3. In the Existing Campaigns box, select the campaign from the list.

4. Click OK.

5. On the Call Settings tab, add or import the call data.

6. Edit the new call data in your campaign.

7. Activate the changed campaign.

Changing campaign settings
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Understand how to add call data manually, or import call data from an external source.
• Understand how to edit the call data in your outbound campaign.
• Understand how to activate the campaign. See Activating a campaign on page 385.

About this task
Change campaign settings such as the start and end date and time, the daily start and end times, 
the dialer settings, the agent script, and disposition codes to modify an existing campaign.
You cannot change other settings in the campaign, such as agent skillset.
If the campaign has already started, you cannot change the start date and time or the agent script.

Procedure
1. On the Outbound Campaign Manager Tool, click Modify Campaign.

2. In the Campaign List box, select the campaign to modify.

3. To change date and time information for the campaign, click the Date/Time Settings tab, 
and then select the new campaign start date and time, the new campaign end date and 
time, or the new daily start and end time.

Changing campaign settings

April 2024 Administering Avaya Contact Center Select 387
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AdministeringAvayaContactCenterSelect&p3=33


4. Click Modify Date/Time Settings to save changes

5. To change the dialer settings for the campaign, click the Dialer Settings tab, and then 
specify the new dialer mode setting and the new dialer miscellaneous settings.

6. Click Modify Dialer Settings to save changes

7. To change the Agent Script for a campaign, click the Agent Script tab, and then specify 
the new agent script.

8. Click Apply Selected Agent Script to save any changes.

9. To change the disposition codes for a campaign, click the Disposition Codes tab, and 
then select the additional disposition codes, and clear check boxes beside the disposition 
codes you do not want.

10. Click Apply Selected Disposition Codes to save any changes.

Pausing a campaign
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Ensure that your outbound campaign is running.

About this task
Pause a campaign to stop the current outbound campaign. This action changes the state of the 
contacts in the selected campaign in the Contact Center Manager Server and in the Contact 
Center Multimedia database to waiting.

Procedure
1. On the Outbound Campaign Management Tool, click Modify Campaign.

2. In the Campaign List box, select the campaign you want to pause.

3. Click the Campaign Status tab.

4. Click Pause Campaign.

5. Click OK to confirm the pausing of the campaign.

Canceling a campaign
Before you begin

• Log on to Contact Center Manager Administration.
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• Open the Outbound component.
• Ensure that you have an outbound campaign configured.

About this task
Cancel a campaign to permanently stop routing the outbound calls from the campaign. By 
canceling a campaign, you delete the contacts in the selected campaign from the Contact Center 
Manager Server. Their status is set to Closed in the Contact Center Multimedia database, and the 
contacts are assigned the disposition code of Campaign cancelled.

Procedure
1. On the Outbound Campaign Management Tool, click Modify Status.

2. In the Campaign List box, select the campaign you want to cancel.

3. Click the Campaign Status tab.

4. Click Cancel Campaign.

5. Click OK to confirm the cancellation of the campaign.

Next steps
Campaigns remain in the OCMT Campaign List as long as any associated contacts remain in the 
Multimedia database. You cannot remove or delete a campaign directly from the OCMT.
If you want to remove the campaign from the Campaign List, create an Outbound Campaign 
cleanup rule, using the Delete Campaign option, and run a cleanup task with this rule.

Restarting a campaign
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.

About this task
Restart a campaign that you paused or cancelled to continue routing outbound calls to customers.

Procedure
1. On the Outbound Campaign Management Tool, click Modify Campaign.

2. In the Campaign List box, select the campaign you want to restart.

3. Click the Campaign Status tab.

4. Click Restart Campaign.

5. Click OK to confirm the restarting of the campaign.
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Monitoring campaign progress and results
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Ensure that an outbound campaign is running, or complete.

About this task
Monitor and outbound campaign progress and results to see how the outbound campaign is 
progressing, and the types of responses your agents are receiving. You can monitor the progress 
and results of any campaign. Both summary and detailed information are available for each 
campaign.

Procedure
1. On the Outbound Campaign Management Tool toolbar, click Progress & Results.

2. In the Select Campaign box, select the campaign you want to monitor.

A summary of the campaign settings and progress appears in the Campaign Summary 
box.

3. To view a summary of the contact status for all contacts in the selected campaign, click the 
Call Status Chart tab.

4. To view a summary of the disposition codes for all closed contacts in the selected 
campaign, click the Disposition Codes Chart tab.

5. To view detailed information for each call in the campaign showing status of each call, as 
well as the customer information defined during the campaign setup, click the Call Details 
tab.

6. To view the history of status changes for the campaign, click the Campaign History tab.

7. To change the display in the Call Status Chart and Disposition Codes Chart tabs from a pie 
chart to a bar chart, or vice versa, click Display Pie Chart or click Display Bar Chart.

8. To refresh the data displayed in this window, click Refresh.

Printing a summary of an existing campaign
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Ensure that the outbound campaign is complete.
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About this task
Print a summary of an existing campaign to review the settings and results of the completed 
campaign in printed format.

Procedure
1. In the Outbound Campaign Management Tool, click Progress & Results.

2. In the Campaign List box, select the campaign you want to print.

A summary of the campaign settings and progress appears in the Campaign Summary 
box.

3. Click the Print Campaign Details button.

Creating a new agent script
Before you begin

• Prepare between one and 40 questions for the agent script, an introduction and a conclusion.
• Prepare the possible answers for the agent if you want specific wording in a response from 

the customer.
• Log on to Contact Center Manager Administration.
• Open the Outbound component.

About this task
Create a new agent script that contains the introductory and concluding text the agent reads, as 
well as a maximum of 40 questions the agent can ask the customer. The campaign administrator 
can customize the script by specifying default and possible allowed answers to questions.
You cannot change an agent script after you save it. Avaya recommends that you click Preview 
Script, and carefully review the script before saving it.
To save the agent script results for a campaign, you must create a disposition code with the save 
agent script option set to Yes.

Procedure
1. In the Outbound Campaign Management Tool, click Agent Script.
2. Click Configure New Agent Script.
3. In the Introduction box, type the text the agent reads to begin the call.

4. In the Conclusion box, type the text the agent reads at the end of the call.

5. Under Agent Script Questions, in the Question box, type the first question.

6. If you want to specify the possible answers to the question, in the Allowed Answers box, 
type the answers, separated by a comma; otherwise, leave this box blank.

7. In the GUI Component box, select a format for the agent to record the response.

Creating a new agent script

April 2024 Administering Avaya Contact Center Select 391
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=AdministeringAvayaContactCenterSelect&p3=33


8. If you want the agent to see a default answer to a question, in the Default Answer box, 
type the appropriate response.

9. If the response requires a text box, for example, for name or address, then in the Allow 
Free Text box, click the check box.

10. Create additional questions.

11. Click Preview Script.

The format of the script questions is validated. If errors are found, the incorrect questions 
are highlighted.

12. If errors are found, correct the errors, then click Preview Script again.

13. In the Save Agent Script box, type a name, and then click Save Script.

Variable definitions
Name Description
Agent Script name The name of the agent script. The agent script 

name must be unique.
Allow free text A text box that allows an agent to type responses 

that cannot be recorded using a GUI component.

You must have a text box if there is no other user 
interface component. You can also include a text 
box with a combo box or radio buttons. The text box 
allows the agent to enter addition information.

Allowed Answers The possible answers an agent can enter based 
on the customer's answers to each question. Each 
answer must be separated by a comma.

You can leave this box blank and allow any 
answers.

The maximum number of allowed answers is 32.
Conclusion The text that an agent reads to conclude the 

outbound call. A conclusion is a mandatory part 
of the agent script and cannot exceed 1024 
characters.

Default answer The answer automatically selected in the agent 
script. The default answer must exist in the allowed 
answers for a question in the agent script.

Table continues…
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Name Description
GUI component If you specify allowed answers, you must also 

specify how the agent selects the answers. You can 
use one of the following:

• None

• Combo Box

• Radio Button

• Check Box

• Check List Box

If you select a GUI component, you must ensure 
there is at least one allowed answer.

Introduction The text that an agent reads to begin the outbound 
call. An introduction is a mandatory part of the 
agent script and cannot exceed 1024 characters.

Questions The text that an agent asks the caller in an 
outbound call. Between one and 40 questions 
can be included in a script. Each question cannot 
exceed 1024 characters.

Creating an agent script from an existing script
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Prepare between one and 40 questions for the agent script, an introduction and a conclusion.
• Prepare the possible answers for the agent if you want specific wording in a response from 

the customer.

About this task
Create agent script from an existing script to copy details from another script to a new campaign 
and modify them.
You cannot make changes to an agent script after it has been saved.

Procedure
1. On the Outbound Campaign Management Tool, click Agent Script.
2. Click Create from Existing Agent Script.
3. In the Existing Agent Scripts box, from the list, select the script.

4. Change the introduction, questions, or conclusion as required.
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5. Change or add questions as required.

6. To delete a question (or questions) from the script, select the row (or rows) containing the 
question you want to delete, and then click Delete Selected Question.

To delete more than one question at a time, press the CTRL key while selecting the rows 
that contain the questions you want to delete.

7. To preview the script as the agent sees it, click Preview Script.

The format of the script questions is validated. If errors are found, the incorrect questions 
are highlighted.

8. If errors are found, correct the errors, and then click Preview Script again.

9. To save the script, type a new name in the Save Agent Script box, and then click Save 
Script.

Adding a disposition code
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.

About this task
Add a disposition code to an outbound campaign to provide a mechanism for agents to record the 
status of an outbound call. You can view the disposition code status for each campaign.
Nine standard disposition codes are provided, but you can add more disposition codes. You can 
configure a maximum of 40 disposition codes.

Procedure
1. On the Outbound Campaign Management Tool, click Disposition Codes.

2. Click Insert.
3. In the Insert Disposition Code dialog box, in the Disposition Code Name box, type a 

descriptive name.

4. In the Retry Timeout box, type the length of time in minutes after which the contact is 
presented again to an agent.

5. If you do not want a retry call made, leave this field blank.

6. In the Max Number of Retries box, type the number of times a contact is presented after 
the initial offering to an agent.

7. To configure whether the agent script is saved on contact closure, Select Yes or No.

8. To configure whether a voice call is required to complete the contact, select Yes or No.

9. Click Insert.
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Variable definitions
Name Description
Disposition Code Name The name of the disposition code. The name 

reflects the purpose of the closing of the outbound 
contact.

Nine standard disposition codes are provided:

• Number Busy

• No Answer

• Answer Machine

• No such number

• Hung up!

• Wrong Number

• Do Not Call

• Re-schedule Call

• Completed
Retry Timeout The length of time in minutes after which the 

contact is presented again to an agent.

If you create a disposition code that indicates the 
call was not completed, such as Re-schedule call, 
you can configure the amount of time before the 
contact is presented again to an agent.

Only appropriate disposition codes, such as 
Number Busy, include a retry timeout.

Maximum number of retries The number of times a contact is presented to an 
agent.

If you create a disposition code that indicates the 
call was not completed, such as Re-schedule call, 
you can configure the maximum number of times to 
retry the call.

Save Agent Script Click yes to save the agent script results for a 
campaign along with the disposition code. Instruct 
your agents to use the disposition codes that 
save the agent script answers when the contact is 
closed.

If you sell a product, create a disposition code, Sale 
Made, with the Save Agent Script option Yes, to 
save the customer answers for future marketing.

Table continues…
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Name Description
Voice Call Required Click yes if a voice call is required to complete the 

contact.

If an agent cannot speak the same language as a 
customer, the agent can select a disposition code 
that does not require a voice call to be made.

Updating a disposition code
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Create a disposition code. See Adding a disposition code on page 394.

About this task
Update a disposition code to change the properties of the code the agent uses to record the 
outcome of an outbound call.

Procedure
1. On the Outbound Campaign Management Tool, click Disposition Codes.

2. In the table, click the disposition code you want to update.

3. Click Update.

4. In the Update Disposition Code dialog box, change the Name, Retry Timeout and/or 
Max Number of Retries as required.

5. Click Update.

Deleting a disposition code
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Ensure that the disposition code is not used in a campaign. If it is, you must first archive 

or purge the campaign from the Multimedia database using the Contact Center Multimedia 
Administration Archive utility.

• Ensure that the disposition code that you want to delete is not one of the nine standard 
disposition codes—Number Busy, No Answer, Answer Machine, No Such Number, Hung Up!, 
Wrong Number, Do Not Call, Re-schedule Call, or Completed.
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About this task
Delete a disposition code only if no campaign uses that disposition code.

Procedure
1. On the Outbound Campaign Management Tool, click Disposition Codes.

2. In the table, click the disposition code to delete.

3. Click Delete.

4. Click OK to confirm the deletion.

Closing a contact with a disposition code
About this task
You can close one or more campaign contacts when a campaign is running, and can apply a 
disposition code to the closed contacts.

Before you begin
• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• Ensure that your outbound campaign is running.

Procedure
1. On the Outbound Campaign Manager Tool, click Progress & Results.

2. Under Campaign List, select the campaign containing the contacts you want to close.

3. Click the Call Details tab.

4. From the list, select the call that you want to close.

To select multiple calls, press the Ctrl key while you select each call.

5. Right-click on the selected calls and select Close With Code.

The Select Disposition Code drop-down list appears.

6. From the drop-down list, select the disposition code and click OK.

OCMT closes the selected calls and applies the selected disposition code.

Important:

System disposition codes configured with Max Number of Retries do not close a call 
until OCMT attempts all retries, and OCMT excludes these disposition codes from the 
drop-down list. OCMT also excludes user-defined disposition codes configured with 
Max Number of Retries from the drop-down list.
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Including UTF-8 characters in exported data
About this task
If you want to export outbound campaign data or campaign summary information that contains 
UTF-8 characters such as Chinese or Japanese characters, you must perform the following steps 
to include the characters from the Chinese or Japanese operating systems to successfully display 
the characters in the exported data.

Procedure
1. On the Contact Center server, locate the OCMTappsetting.xml file.

2. Add the following line to the text file within <appsetting> and </appsetting>:

<EnableFileEncodingConfig>true</EnableFileEncodingConfig>

Exporting campaign call data
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• If you work on a Chinese or Japanese operating system, include the UTF-8 characters in the 

configuration file. See Including UTF-8 characters in exported data on page 398.

About this task
You can export either the campaign summary or all the call data, including the call status, to an 
external file.

Procedure
1. On the Outbound Campaign Management Tool, select Progress & Results.

2. In the Campaign List box, select the campaign to export.

3. Click Export Call Data.

4. In the Outbound Campaign Management Tool Export Wizard, select the Campaign Call 
Data option.

5. Click Next.
6. In the Select Calls to Export window, to export all calls in a campaign, select the All Calls 

option (This is the default option).

7. To select a specific call range, select the Select Call Range option, and then enter the 
start and end call records into the boxes provided.

8. To filter all calls in a campaign by disposition code, select the Filter Calls by Disposition 
Code option, and then click the check boxes beside the desired disposition codes.

Only the calls that match the selected disposition codes are selected.
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9. Click Next.
10. In the Select Call Details window, in the Call Details Fields box, select the check box for 

each field of data to export.

11. To select multiple fields, click Check All, and then click to clear the boxes for fields you do 
not want to export.

12. To clear all check boxes, click Uncheck All.
13. To change the order of fields, click on the field name to highlight the row, and then click the 

up or down arrow.

14. To select how the fields are separated in the exported file, click Tab, Space, or Character.

The default character is a comma. To change this character, type the desired character in 
the text box.

15. If you want the first row of the exported file to include the column headers, click the check 
box.

16. Click Next.
17. In the Preview Data window, click Next.
18. In the Select File window, click Browse to navigate to directory where you want to save the 

exported data.

19. Type the name for your exported data file, and then click Save.

20. In the Export Wizard, click Finish.

Exporting manually entered call data
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• If you work on a Chinese or Japanese operating system, include the UTF-8 characters in the 

configuration file. See Including UTF-8 characters in exported data on page 398.

About this task
If you enter data manually, you can export it to an external file to re-import to future campaigns, 
create databases, or share the Call Data table entries with a different department or application.

Procedure
1. On the Outbound Campaign Management Tool, click Create & Append.

2. Click the Campaign Settings tab.

3. Click Append Calls to Existing Campaign or Start Configuring New Campaign.

Exporting manually entered call data
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4. Verify or enter the campaign settings.

5. Click Call Settings.

6. Manually enter additional call data in the Call Data Table rows.

7. Select the rows of the Call Data Table that you want to export. To select all the data, click 
Check All.

8. Click Export Checked Calls.

9. On the Call Details dialog box, in the Call Details Fields box, click the check box beside 
each field of data you want to export.

If you are selecting many fields, click Check All to check each box, then click to clear the 
boxes for fields you do not want to export.

10. Click Uncheck All to clear all check boxes.

11. To change the order of fields, click the field name to highlight the row, and then click the up 
or down arrow.

12. To select how the fields are separated in the exported file, click Tab, Space, or Character. 
The default character is a comma. To change this character, type the desired character in 
the text box.

13. If you want the first row of the exported file to include the column headers, click the First 
row shall contain column headers check box.

14. Click Next.
15. In the Preview window, click Next.
16. In the Select File window, click Browse to navigate to directory where you want to save 

the exported data.

17. Type the name for your exported data file, and then click Save.

18. In the Export Wizard, click Finish.

Exporting campaign summary data
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.
• If you work on a Chinese or Japanese operating system, include the UTF-8 characters in the 

configuration file. See Including UTF-8 characters in exported data on page 398.

About this task
Export campaign summary data such as all calls, a specific call range, or all calls in a campaign 
with a certain disposition code, so that you can use the information in another outbound campaign.

Outbound configuration
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Procedure
1. On the Outbound Campaign Management Tool, select Progress & Results.

2. In the Select Campaign box, select the campaign to export.

3. Click Export Call Data.

4. In the Outbound Campaign Management Tool Export Wizard, select Campaign Summary.

5. Click Next.
6. In the Select Campaign Summary Data window, in the Campaign Summary Data box, 

select the check box for each field of data to export.

To select multiple fields, click Check All, and then click to clear the boxes of fields you do 
not want to export.

7. To clear all boxes, click Uncheck All.
8. To change the order of fields click on the field name to highlight the row, and then click the 

up or down arrow.

9. Click Next.
10. In the Preview Data window, click Next.
11. In the Select File window, click Browse to navigate to directory where you want to save the 

exported data.

12. Type the name for your exported data file, and then click Save.

13. In the Export Wizard, click Finish.

Viewing log files
Before you begin

• Log on to Contact Center Manager Administration.
• Open the Outbound component.

About this task
You can open the OCMT log file to view action, warning and error log messages.
You can view the location of the current log file in the Log file name field. You cannot select the 
location of the log files in the Log file name field. You can select the location of the log files in 
the Contact Center Trace Control application. You can also view the logging level of the log files 
in the Maximum log file size field, the maximum log file size of the log files in the Maximum log 
file size field, and the number of backup log files that the system must create in the Number of 
backup log files field.

Viewing log files
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Note:
The Log file name, Maximum log file size, Maximum log file size and Number of backup 
log files fields are read-only.

Procedure
1. On the OCMT toolbar, click General Settings.

2. Click the OCMT Client Logging tab.

3. Click View.

The system opens the OCMT log file, and you can view the log messages.

Outbound configuration
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Chapter 54: Emergency Help

Use Emergency Help to monitor whether the agents configured on the Contact Center server 
require your assistance. You can keep the display open on your desktop, or you can minimize the 
display to continue working in Contact Center Manager Administration. When an agent presses the 
Emergency key, the minimized Emergency Help display automatically opens on your desktop.

For each agent who presses the Emergency key, one line of data appears in the Emergency Help 
display. The display shows information about the agent, including the agent's name, location, and 
time when the agent pressed the Emergency key.

Agents can press the Emergency key when they require assistance from the supervisor, for 
example, if the caller is abusive.

Starting the Emergency Help display
About this task
Start the Emergency Help display to monitor whether the agents configured on the Contact Center 
server require your assistance. You can keep the display open on your desktop, or you can 
minimize the display to continue working in Contact Center Manager Administration. When an 
agent presses the Emergency key, the minimized Emergency Help display automatically opens on 
your desktop.

Procedure
1. Log on to Contact Center Manager Administration.

2. On the Launchpad, click Emergency Help.

3. In the left pane, select the CC server.

The Emergency Help display appears.

Printing an Emergency Help display
Before you begin

• Log on to Contact Center Manager Administration Emergency Help.
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About this task
Complete this procedure to print an Emergency Help display.

Procedure
In the Emergency Help display, click Print.

Exporting an Emergency Help display
Before you begin

• Log on to Contact Center Manager Administration Emergency Help.

About this task
You can export a snapshot of an Emergency Help display to the application server for future 
reference. The system saves the snapshot data as HTML files with a name containing your user 
name, a prefix relating to the type of display that you are exporting, and the date and time when 
you exported the data.

Procedure
1. In the Emergency Help display, click Export.

A message box appears, informing you of the HTML file name that you exported.

2. To view the exported display, click View.

Viewing an exported Emergency Help display
Before you begin

• Log on to Contact Center Manager Administration Emergency Help.

About this task
View an exported Emergency Help display to view a snapshot of an Emergency Help display that 
you exported as an HTML file to the Contact Center Manager Administration server.

Procedure
1. In the Emergency Help display, on the menu, choose Displays > Manage Exported 

Displays.

2. On the Exported Displays dialog box, from the list of HTML files, click the file to view.

The snapshot of the Emergency Help display appears in a browser window.

Emergency Help
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Deleting an exported Emergency Help display
Before you begin

• Log on to Contact Center Manager Administration Emergency Help.

About this task
You can delete from the Contact Center Manager Administration server Emergency Help displays 
that you exported as HTML files.

Procedure
1. On the menu, choose Displays > Manage Exported Displays.

2. In the Exported Displays section, from the list of HTML files, select the check box for 
each file to delete.

3. Click Delete to remove the selected files from the Contact Center Manager Administration 
server.

Deleting an exported Emergency Help display
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Appendix A: Default sample data

This section lists the default sample data available in Contact Center Manager Administration after 
you log on for the first time. It also provides user account and password details for logging on to and 
using Contact Center Manager Administration.

Note:
The values for the sample supervisors, agents, and CDN are configurable. You configure 
these values using the Ignition Wizard. This appendix lists the default values for the sample 
supervisors, agents, and CDN.

Default user accounts
Account name Password Description
Administrator Administrator Default Contact Center Manager Administration 

administrator user.
reporting1 reporting1 A default Contact Center Manager Administration 

supervisor user.
reporting2 reporting2 A default Contact Center Manager Administration 

supervisor user.
accssync accssync The account IP Office uses to synchronize agent and 

supervisor details from Avaya Contact Center Select.

Sample supervisors and agents
Login ID Last Name First Name Supervisor Assigned to skillset
6001 supervisor sample1 supervisor sample1 

(6001)
• Skill1

• Skill2

• EM_Skill1

• FX_Skill1

• OB_Skill1

• SD_Skill1

• SM_Skill1

• VM_Skill1

• WC_Skill1

Table continues…
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Login ID Last Name First Name Supervisor Assigned to skillset
6002 agent1 sample1 supervisor sample1 

(6001)
• Skill1

6003 agent2 sample2 supervisor sample1 
(6001)

• Skill1

6004 agent3 sample3 supervisor sample1 
(6001)

• Skill1

6005 agent4 sample4 supervisor sample1 
(6001)

• Skill1

6006 agent5 sample5 supervisor sample1 
(6001)

• Skill1

6007 supervisor sample2 supervisor sample2 
(6007)

• Skill1

• Skill2
6008 agent6 sample6 supervisor sample2 

(6007)
• Skill1

6009 agent7 sample7 supervisor sample2 
(6007)

• Skill1

6010 agent8 sample8 supervisor sample2 
(6007)

• Skill1

Sample Activity Codes
Name Number Display Name Type
Bathroom 8702 Bathroom Not Ready Reason
Breakfast 8701 Breakfast Not Ready Reason
CCNotReady 8799 CCNotReady Not Ready Reason
Default_ACW 00000 Default_ACW After Call Work Item
Lunch 8700 Lunch Not Ready Reason
Work 8500 Work Activity Code

Sample Call Presentation Classes
Name Presentation Option
Call_Center_Administrator Return To Queue
Contact_Force Call Force Delay
Agent_Accept Return To Queue

Sample CDNs
Name Number Call Type
SampleCDN 3000 Local
Multichannel - Open Queue Local
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Default Contact Types
Name Default Skillset
Voice Skill1
EMail EM_Skill1
Web_Communications WC_Skill1
Outbound OB_Skill1
Scanned_Document SD_Skill1
Fax FX_Skill1
SMS SM_Skill1
Voice_Mail VM_Skill1

Sample Multiplicity Presentation Classes
Name Asssigned Contact Types
Voice_Email • Voice

• EMail
Voice_Email_Web • Voice

• Email

• Web_Communications

Sample Skillsets
Skillset name (including prefix) Contact Type Default activity code
Skill1 Voice 8799, CCNotReady
Skill2 Voice 8799, CCNotReady
EM_Skill1 Email 8799, CCNotReady
WC_Skill1 Web_Communications 8799, CCNotReady
OB_Skill1 Outbound 8799, CCNotReady
SD_Skill1 Scanned_Document 8799, CCNotReady
FX_Skill1 Fax 8799, CCNotReady
SM_Skill1 SMS 8799, CCNotReady
VM_Skill1 Voice_Mail 8799, CCNotReady

Sample Threshold Classes
Name Type Threshold enabled by default
agent Agent • Idle

• Break

• Not Ready

Table continues…

Default sample data
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Name Type Threshold enabled by default
skillset Skillset • Calls Waiting

• Calls Answered

• Agent Not Ready

• Service Level Threshold
applications Application • %Service_Level

• %Calls_Abandoned

• Calls Waiting

• Service Level Threshold

Sample prompts
Prompt name Content Group Prompt transcript Orchestration Designer 

flow using this prompt
Welcome_CS Avaya Aura® MS locale 

name (for example, 
en_us)

“Welcome to the Contact 
Center.”

Customer_Service

Menu_Selection_CS Avaya Aura® MS locale 
name (for example, 
en_us)

• “Press 1 to speak to an 
agent at the help desk.

• Press 2 to speak to 
an agent in the support 
center.

• Press 3 to Enter your 
Pin Number or any 8 
Digits of your choosing.

• Press 4 to leave a 
voice mail.

• Press * to repeat this 
menu.”

Customer_Service

Voicemail_CS Avaya Aura® MS locale 
name (for example, 
en_us)

“Please wait while we 
direct you to our 
voice messaging system 
mailbox.”

Customer_Service

EnterDigits_CD Avaya Aura® MS locale 
name (for example, 
en_us)

“Please enter your pin 
number or digits up to 
a maximum of 8 digits 
followed by the # key.”

Collect_Digits

ConfirmDigits_CD Avaya Aura® MS locale 
name (for example, 
en_us)

“The digits you entered 
were ...”

Collect_Digits

Table continues…
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Prompt name Content Group Prompt transcript Orchestration Designer 
flow using this prompt

ValidateDigits_CD Avaya Aura® MS locale 
name (for example, 
en_us)

“If that is correct press 
1 followed by the # key 
or press 2 if you wish to 
retry followed by the # 
key.”

Collect_Digits

InvalidEntry_CS Avaya Aura® MS locale 
name (for example, 
en_us)

“That is an invalid entry 
please try again.”

Customer_Service

NoData_Entry_CS Avaya Aura® MS locale 
name (for example, 
en_us)

“You have not entered 
any data Please try 
again.”

Customer_Service

Emergency_CS Avaya Aura® MS locale 
name (for example, 
en_us)

“The contact center is 
now in emergency mode 
and closed. We will 
reopen shortly.”

Customer_Service

OutOfHours_CS Avaya Aura® MS locale 
name (for example, 
en_us)

“The contact center is 
now closed as it is out of 
hours.”

Customer_Service

Holidays_CS Avaya Aura® MS locale 
name (for example, 
en_us)

“The contact center is 
now closed for holidays.”

Customer_Service

OutOfService_CS Avaya Aura® MS locale 
name (for example, 
en_us)

“All departments are out 
of service at this time. 
Please call back at a 
later time.”

Customer_Service

PromptSubmenu_CS Avaya Aura® MS locale 
name (for example, 
en_us)

“Press 0 to speak to an 
agent, Press 1 to leave a 
voice mail, press, Press 
9 to return to the main 
menu.”

Customer_Service – 
submenu 1 and 2

FirstRAN_CD Avaya Aura® MS locale 
name (for example, 
en_us)

“This is the first 
announcement. Please 
wait while we try to 
connect you to our 
agents.”

Collect_Digits – Queuing 
Tab

SecondRAN_CD Avaya Aura® MS locale 
name (for example, 
en_us)

“This is the second 
announcement. All our 
agents are still busy 
please wait.”

Collect_Digits – Iterate 
Queue Tab

Sample_Music1 Sample_Music - -
Sample_Music2 Sample_Music - -

Default sample data
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Sample Routes
Name Number
Sample_Music 511

Historical Reporting templates
The following table lists the historical reporting templates available in Avaya Contact Center Select. 
For more information on each of these reporting templates, see Contact Center Performance 
Management Data Dictionary.

Report Group Report Title
Administration Access Classes
Administration Reports Groups
Administration User Defined Partitions
Administration Users
Agent Performance Activity Code By Agent
Agent Performance Agent Average Calls Per Hour
Agent Performance Agent Average Calls Per Hour, Bottom 5
Agent Performance Agent Average Calls Per Hour, Top 5
Agent Performance Agent by Activity Code
Agent Performance Agent by Application Performance
Agent Performance Agent By Skillset Performance
Agent Performance Agent DN Performance
Agent Performance Agent DN Performance Calls Answered, Bottom 5
Agent Performance Agent DN Performance Calls Answered, Top 5
Agent Performance Agent Efficiency
Agent Performance Agent Efficiency by Contact Type
Agent Performance Agent Efficiency by Skillset
Agent Performance Agent Login/Logout
Agent Performance Agent Performance
Agent Performance Agent Performance by Supervisor
Agent Performance Agent Performance Calls Answered, Bottom 5
Agent Performance Agent Performance Calls Answered, Top 5
Agent Performance Agent Short Calls
Agent Performance Agent Transferred/Conferenced Activity
Agent Performance Not Ready Reason Codes By Agent
Agent Performance Skillset By Agent Performance
Call By Call Call By Call Statistics
Configuration Config - Agent Properties

Table continues…
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Report Group Report Title
Configuration Config - Agent Skillset Assignment
Configuration Config - Logged in Agent
Configuration Config - Skillset Properties
Contact Summary Activity Code by Address
Contact Summary Agent by Address
Contact Summary Contact Duration
Contact Summary Contact Duration by Agent
Contact Summary Contact Summary
Contact Summary Contacts By Agent
Contact Summary Originator By Disposition
Multimedia Contacts Closed by Reason Code
Multimedia Contact Closed by Skillset
Multimedia Contacts Details
Multimedia Contacts Outstanding Detail
Multimedia Contacts Outstanding Summary
Multimedia Contacts Received by Skillset
Others Activity Code By Application
Others Application By Activity Code
Others Application By Skillset
Others Application Call Treatment
Others Application Delay before Abandon
Others Application Delay Before Answer
Others Application Performance
Others CDN (Route Point) Statistics
Others Crosstab - Application Performance
Others Crosstab - Skillset Performance
Others DNIS Statistics
Others Skillset By Application
Others Skillset Performance
Others Skillset Timeline
Others Skillset Timeline By Contact Type
Outbound Campaign Call Details
Outbound Campaign Performance
Outbound Campaign Script Results Details
Outbound Campaign Summary
Outbound Script Summary

Default sample data
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